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About the Author

Ellen Finkelstein learned AutoCAD in Israel, where she always got to pore over the manual because it was
in English. After returning to the United States, she started consulting and teaching AutoCAD as well as
other computer programs, including Microsoft Word, Excel, and PowerPoint. She has also taught courses
on Web writing and usability. Her Web site, www.ellenfinkelstein. com, contains tips and techniques
for AutoCAD and PowerPoint, and she publishes a monthly AutoCAD Tips Newsletter. Ellen has written
extensively on AutoCAD, including articles for Autodesk’s Web site, such as three white papers on dynamic
blocks, and features for AutoCAD’s Help system. She is also the editor of Inside AutoCAD, a monthly
newsletter published by Eli Journals.

Ellens first book was AutoCAD For Dummies Quick Reference. Since then, she has written books on
PowerPoint, OpenOffice.org (OpenOffice.org For Dummies), Flash (such as Flash CS3 For Dummies), and Web
technologies (for example, Syndicating Web Sites with RSS Feeds For Dummies). You're holding the ninth edi-
tion of this book, which previously appeared for AutoCAD releases 14, 2000, 2002, 2004, 2005, 2006,
2007, and 2008.
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ongratulations!

Whether you are a new or expert user with AutoCAD, you have truly made a worthwhile investment
with the AutoCAD Bible. This book will be a valuable addition to your library that you will use on a reg-
ular basis as a reference and guide to using AutoCAD. With each release of AutoCAD and its new feature
set, the AutoCAD Bible is an excellent resource for learning and getting up to speed quickly on all things
AutoCAD.

Everything from the basics of AutoCAD including 3D and programming is covered in this book. The
information is well organized and a comprehensive index makes retrieving information that you need a
cinch.

You'll see real-world examples and AutoCAD drawings on the DVD that will quickly help you under-
stand and learn new concepts through the exercises. Even more helpful is the fact that the drawings are
available in both a before and after format, allowing you to use the after format as a reference.

Ellen has been writing books about AutoCAD for so long that she is practically a household name here
at Autodesk and in the AutoCAD world. She is an active participant in our beta program and helps
shape the direction of future releases of AutoCAD. You are truly learning from one of the finest and
experienced professionals in this field.

Although the in-depth coverage of this book may seem overwhelming, do not feel discouraged by the
books thickness. Pick out the tools that you want to learn about and then proceed from there, or if you
are interested in learning new features, pick a different topic each week to learn about.

Thank you, Ellen, for creating another great edition of the AutoCAD Bible. I know our customers will
benefit from reading it as I have.

Doug Cochran
AutoCAD Product Manager
Autodesk, Inc.






AutoCAD LT, you'll find complete explanations of all the powerful features that you need to
know about to design and draw anything. This book is designed to be your comprehensive
guide to both the AutoCAD and AutoCAD LT programs.

'W‘elcome to the AutoCAD 2009 & AutoCAD LT 2009 Bible. Whether you use AutoCAD or

This book covers every significant AutoCAD and AutoCAD LT feature. If you're a beginning user, you'll
find everything you need to start out; if you're already using AutoCAD or AutoCAD LT regularly, the
book covers advanced material, as well. Although you can use this book as a tutorial if you're just start-
ing out or learning a new set of features, it also provides a solid reference base to come back to again and
again. The short tutorials on almost every topic will quickly have you creating professional-level draw-
ings. The DVD is chock-full of drawings, a trial version of AutoCAD 2009, and add-in programs (which
are mostly for AutoCAD only). This book is all that you need to make full use of either program.

For AutoCAD 2009, the emphasis is on a new interface, quick access to information, navigation, and a
new macro recorder. Most of the new features are in AutoCAD LT 2009, as well.

Is This Book for You?

The AutoCAD 2009 & AutoCAD LT 2009 Bible covers all of the essential features of AutoCAD and
AutoCAD LT and includes clear, real-life examples and tutorials that you can adapt to your needs.

Although I fully cover the basics, I have also included material on the many advanced features, such as
external database connectivity, AutoLISP, Visual Basic for Applications (VBA), 3D modeling, rendering,
and customization. (Most of the advanced features apply to AutoCAD only.) The following categories
should help you decide whether this book is for you.

If you are a new AutoCAD or AutoCAD LT user

If you are new to AutoCAD or AutoCAD LT, the AutoCAD 2009 & AutoCAD LT 2009 Bible guides you
through all that you need to know to start drawing effectively, whatever your field. Just start at the
beginning.

If you are upgrading to AutoCAD 2009 or AutoCAD LT 2009

This book highlights all of the new features and helps you to make the upgrade transition as seamless as
possible. Look for the New Feature icons.
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If you are switching from another CAD program

You already know what CAD is all about. This book clearly explains the AutoCAD and AutoCAD LT way of
drawing the models that you have already been drawing. In addition, you'll find a great deal of essential
information about transferring files and data from other formats.

How This Book Is Organized

This book is divided into eight parts.

Part I: AutoCAD and AutoCAD LT Basics

Part I provides the background information that you need to start drawing. It starts with a “quick tour” that
has you drawing right away, and then covers how to start a drawing, use commands, specify coordinates,
and set up a drawing.

Part II: Drawing in Two Dimensions

Part II covers all of the commands and procedures for drawing and editing in two dimensions. In addition, I
discuss how to control the drawing process with layers, zooming, and panning. Also included in this part is
information about dimensioning, plotting, and printing.

Part I1l: Working with Data

Part I1I covers many ways to organize and share data, including blocks, attributes, external references, and
external databases.

Part IV: Drawing in Three Dimensions

Part IV explains everything that you need to know to draw in three dimensions. It also discusses how to
present 3D drawings using hiding, shading, and rendering techniques.

Part V: Organizing and Managing Drawings

Part V helps you to incorporate AutoCAD and AutoCAD LT into your work world by explaining how to set
standards, manage drawings, and work with other applications. It concludes with a chapter on creating
electronic output.

Part VI: Customizing AutoCAD and AutoCAD LT

Part VI introduces the tools that you need to customize commands, toolbars, linetypes, hatch patterns,
shapes, fonts, and the ribbon. You'll also find a chapter on creating macros with script files as well as the
Action Recorder.

Part VII: Programming AutoCAD

Part VII introduces you to programming AutoCAD. It includes three chapters on AutoLISP and Visual LISP,
and one chapter on Visual Basic for Applications. This part applies to AutoCAD only.
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Part VIII: Appendixes

Part VIII provides additional information for AutoCAD and AutoCAD LT users. Appendix A gives instruc-
tions for installing and configuring AutoCAD and AutoCAD LT. Appendix B covers additional resources for
AutoCAD and AutoCAD LT users. Appendix C explains what you'll find on the DVD.

2y The DVD contains a complete copy of this book in nonprintable PDF format.

How to Use This Book

You can use this book in two ways: as a tutorial and learning tool, or as a reference.

As a tutorial

The overall organization of the book goes from simple to complex, and each chapter has several step-by-
step exercises. This enables you to use the book as a tutorial, from beginning to end. You can always go
back and redo any exercise when you need to refresh your memory on a particular feature.

For newcomers to AutoCAD or AutoCAD LT, Parts I (AutoCAD and AutoCAD LT Basics) and II (Drawing in
Two Dimensions) are essential. After that, you can refer to chapters that interest you. Parts 11T (Working
with Data) and V (Organizing and Managing Drawings) are also useful for beginners. Intermediate users will
probably be familiar with most of the material in Part I and will be more likely to skip around, looking for
the specific topics that they need. However, don't forget that many new features are introduced in Part .
Enough material appears in this book to bring intermediate users up to a fairly advanced level.

I have designed this book to be comprehensive and to include every significant feature of AutoCAD and
AutoCAD LT. Therefore, do not be concerned if some of the material seems too advanced. It will be there
when you are ready for it.

As a reference

The AutoCAD 2009 & AutoCAD LT 2009 Bible is organized as a reference that you can refer to whenever you
are stuck, or when you try to do something for the first time. Each chapter covers a topic completely, mak-
ing it easy to find what you're looking for. Each Steps exercise (with a few exceptions) can be done on its
own without doing the other exercises in the chapter. You can easily look up a topic and complete a related
exercise without having to go through the entire chapter. A complete index at the back of the book can also
help you to find features and topics.

Doing the Exercises

AutoCAD is a very customizable program. To a lesser extent, AutoCAD LT can also be customized in many
ways. This book assumes that you are working with the default setup. However, a number of changes may
have been made to your system that could result in the user interface and drawings appearing or even func-
tioning differently from those shown in this book. If you installed AutoCAD or AutoCAD LT yourself and
made some adjustments, you know what changes you have made. However, if you are using a computer
that was set up by someone else, it may help to talk to that person first, to see what changes they made.
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In addition, as you work through some of the exercises in this book, you will make certain changes in the
program’s setup. Most of these are minor changes that any user would make while drawing. For safety,
Cautions and Tips accompany all changes that could have serious consequences, such as customizing the
menu. For example, when customizing the menu, you will be instructed to copy the menu file under a new
name, and you will then work with the new menu file, not the original one. Nevertheless, if you are work-
ing on a network or sharing your computer with someone else, it is important to consult with others who
may be affected by the changes that you make.

If you do the exercises, I recommend that you do them from the beginning. Important instructions are
given during earlier exercises that may affect your system later. For example, one of the first exercises is to
create a new folder to hold your drawings from the exercises. This folder keeps your exercise drawings sep-
arate from other drawings that have been created in your office. However, each exercise stands on its own
so that you can go back and do only the exercise that you need.

f’: =8 You can create your own configuration to help ensure that some changes that you make will
BAASER not affect others. Instructions for doing this appear in Appendix A under the heading “Creating
Multiple Configurations.”

The exercises in the AutoCAD 2009 & AutoCAD LT 2009 Bible have been carefully checked by a technical
editor to ensure accuracy. However, we cannot anticipate all situations, due to either varying hardware and
software configurations or customization. If you have a problem with an exercise, contact me at the e-mail
address listed at the end of this Preface so that I can correct the problem in the book’s next edition. T will
also try to give you the information that you need to complete the exercise.

Conventions Used in This Book

Given all the ways in which you can execute a command in AutoCAD and AutoCAD LT, you'll find it useful
to read this section, which describes this book’ typographical conventions. You will find this section helpful
for doing the step-by-step exercises as well.

Using commands

AutoCAD and AutoCAD LT offer workspaces (covered fully in Appendix A) that provide very different ways
of executing commands. The default workspace, 2D Drafting & Annotation, uses the ribbon and menu
browser, whereas the Classic workspace uses more traditional menus and toolbars. I use this default
workspace (or the 3D Modeling workspace for 3D drawing in AutoCAD) throughout the book. All
workspaces offer a command line, where you can execute a command by entering its name.

When I explain how to execute a command, I give the instructions for doing so on the ribbon, if possible.
In addition, I almost always provide the name of the command so that you can enter it on the command
line.

The new ribbon created a quandary for me, because I know that some people, especially those upgrading
from earlier releases, will not use it; instead, they will prefer to use the Classic workspace with its familiar
menus and toolbars. However, I felt that explaining how to execute each command in three ways (the rib-
bon, the menu/toolbar, and on the command line) would be awkward, perhaps confusing, and space-
consuming. What should you do if you are using this book with the Classic workspace?
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In many cases, especially if you're upgrading, you'll already know where to find familiar commands. For
new commands, it’s easy to find their location in the Classic workspace by going to the Help system. Follow
these steps:

1. Press F1 to open the Help window.
Click the Contents tab on the left.
Expand the Command Reference and then the Commands item.

Expand the listing of the commands first letter and click the command.

ook W

Look at the top of the right-hand pane, where you'll find instructions for all the available methods
of executing the command.

When referring to the ribbon, I might say, “Choose Home tab & Draw panel & Line,” which means to click
the Home tab if it’s not already displayed, look for the Draw control panel, and click the Line button in that
panel. If you're not sure which button to click, hover the mouse cursor over a button to see its tooltip,
which provides more information. You can expand many control panels by clicking their title at the bottom
of the ribbon; if a command is on the expanded section, I indicate that in the instruction.

A few of the ribbon control panels have drop-down lists (or flyouts), which are equivalent to sub-menus.
Therefore, to indicate which button to choose, I may need to tell you to choose Home tab = Utilities panel
= Zoom drop-down list® Zoom Extents. Although I haven't found a good alternative, this is not com-
pletely satisfactory for two reasons. First, it’s a mouthful! Second, the flyout names do not appear, making it
hard to know which is the Zoom drop-down list. However, in most cases, the button icon will make it obvi-
ous which drop-down list I'm talking about.

To indicate that you should choose a command from the menu, for example, I say, “Choose Menu
Browser & View = Viewports,” which means that you should click the Menu Browser button at the upper-
left corner of the application window, then click the View menu, and finally click the Viewports menu item.

Every command also has a command name that you can type on the command line, which appears at the
bottom of your screen. Command names are shown in capital letters, as in CIRCLE. AutoLISP functions
(which apply to AutoCAD only) are shown in small capital letters, as in COMMAND.

Figures

In order to create clear, legible figures, I have used a white background in AutoCAD and AutoCAD LT.
However, many people use a black drawing area. In Appendix A, I explain how to change this color. As you
read through the book, you should be aware that you may see on your screen a negative image of what I
show in the figures — a dark background and light-colored objects. Once you get used to this difference,
you'll easily recognize what you see in the figures.

In AutoCAD, the 3D environment further changes what you see on your screen. The default 3D background
is gray. Again, I have sometimes changed the background color to white for the purpose of creating a clear
figure.

Prompts, your input, and instructions

In the step-by-step exercises, most instructions are presented in the same font and style that you are reading
now. However, when I reproduce the command line, the prompts appear in a nonproportional font.
Other instructions (such as “Type the first coordinate”) are shown in italic. In any context, input that you
need to type appears in bold.
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The Dynamic Input feature shows prompts near your cursor, but additional options only appear if you click
the down arrow on your keyboard. To make clear all of the available options, I use the command line for-
mat of prompts.

Here’s a sample step-by-step section. In this exercise, you click the proper ribbon button (which is shown in
the margin), type the number shown in bold, press Enter where indicated by the bent arrow () symbol,
and follow the instructions that appear in italic.

E_ 8. To create a second rectangle inside the first one, choose the Home tab => Modify panel &> Offset.
r el

(I cover this and other editing commands in Chapters 9 and 10.) Follow these prompts:

Specify offset distance or [Through/Erase/Layer] <Through>: 4 .

Select object to offset or [Exit/Undo] <Exit>: Click the rectangle to
select it.

Specify point on side to offset or Exit/Multiple/Undo] <Exit>: Click
anywhere inside the rectangle.

Select object to offset or [Exit/Undo] <Exit>: J

Often I refer to specific elements in a drawing. References to these elements appear in the text as numbers
in circles, such as @), @, €, and so on. You'll find the corresponding number in the figure to which the
text refers.

Mouse and keyboard terms

You can draw using a mouse or a puck. The mouse is familiar to all users. A puck (or sometimes a stylus) is
used with a digitizing tablet. Because most users do not have a digitizing tablet, I do not directly refer to it
in this book. If you have one, follow the instructions for using the mouse in the same way, but using your
puck.

A mouse can have two or more buttons. Many users like using a mouse with at least three buttons because
you can customize the buttons to suit your needs. However, because many mice have only two buttons, I
assume only two. The left mouse button is used to choose commands and toolbar buttons, and to pick
points in your drawing. For this reason, it is sometimes called the pick button. The right button usually
opens a shortcut menu.

The time-sensitive right-clicking feature enables you to use the right button either to open a shortcut menu
or as the equivalent of pressing Enter. Because this feature is not on by default, I do not assume that you
have turned it on. I use the term right-click when you need to access a shortcut menu. If you have time-
sensitive right-clicking turned on, you need to hold down the right mouse button more than 250 milli-
seconds (by default) to display the shortcut menu. See Chapter 3 and Appendix A for more details.

If T say one of the following

B Choose Menu Browser & Tools = Options
B Choose Home tab= Draw control panel &> Line

B Select the circle in your drawing
it means that you need to use the left button of your mouse.

When [ say to press Enter, it means that you need to press the key that is marked Enter, Return, or < on
your keyboard. Often I use the bent arrow symbol () that you see on your Enter key to indicate that you
should press Enter.
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I also use the mouse terms listed in the following table.

Mouse Terms
Term Description
Cursor The shape on your screen that shows you where the mouse is pointed. It can take a number of
shapes, such as crosshairs, pickbox, or arrow. It is also known as the mouse pointer.
Pickbox A type of cursor consisting of a small box, used to select drawing objects.
Crosshairs A type of cursor consisting of intersecting lines, sometimes with a pickbox at their center.
Pick Point to a drawing object and click the left mouse button.
Click Press the left mouse button once and release it.
Double-click Press the left mouse button twice in rapid succession.

Click and drag

Click the left mouse button and hold it down while you move the mouse, dragging an object
on your screen with it.

Choose

Click a ribbon item, menu item, toolbar button, or dialog box item. You can sometimes
choose an item using the keyboard, as well. | also use this word when you need to choose a
command option, which you can do by choosing from a shortcut menu with a mouse, but
also by typing the option’s abbreviation on the keyboard.

Right-click

Press the right mouse button once and release it. If you have turned on time-sensitive right-
clicking, hold the right mouse button at least 250 milliseconds (by default) before releasing it.

Shift and click

While holding down the Shift key, press the left mouse button once and release it.

Shift and right-click

While holding down the Shift key, press the right mouse button once and release it.

Shift and mouse wheel

A new shortcut in AutoCAD for temporarily starting the 3DORBIT command requires you to
press the Shift key and hold down the mouse wheel, using it like a button.

Select

Highlight an object in a drawing by picking it or by using another object selection method, or
highlight text in a dialog box or text document.

What the Icons Mean

AutoCAD 2009 & AutoCAD LT 2009 Bible is liberally sprinkled with icons — symbols in the left margin that
call your attention to noteworthy points.

This icon means that the feature that I am discussing is not available in AutoCAD LT.

The Caution icon means that you should pay special attention to the information or instruc-
tions because a possibility exists that you could cause a problem otherwise.

"= Cross-References refer you to a related topic elsewhere in the book. Because you may not read
Atit ==s this book straight through from cover to cover, you can use cross-references to quickly find
just the information you need.

eee

X
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F=r The New Feature icon means that a feature is new to AutoCAD 2009 or AutoCAD LT 2009 or
& has been significantly changed.

I A Note icon alerts you to some important point that requires special attention, or additional
& information that may be helpful.

=% The On the DVD icon highlights references to related material on the DVD.

I ATip shows you a way to accomplish a task more efficiently or quickly. You'll find plenty of
i practical advice here.

About the DVD

The DVD contains all of the drawings that you need to do the exercises in this book. These drawings are a
great resource to help you learn using real-world drawings. In addition, the DVD includes the drawings that
result after you finish an exercise or tutorial. In this way, you can check whether you have done an exercise
correctly.

The DVD also contains many add-on programs that I hope you will find useful. T am especially pleased to
include 30-day trial versions of AutoCAD 2009 and AutoCAD LT 2009 on the DVD, as well as this entire
book in (nonprintable) PDF format.

Other Information

If you are already an advanced user but need tips and secrets for getting the most out of AutoCAD or AutoCAD
LT, this book will probably not add too much to your already great store of knowledge. However, few people
know everything about these complex programs, and so you may be surprised by what you can learn.

This book assumes that you know the basics of Windows, although the instructions that you'll read here are
usually detailed enough to get you through any task.

AutoCAD 2009 & AutoCAD LT 2009 Bible covers AutoCAD 2009 and AutoCAD LT 2009. However, most of
the information also applies to the 2008 release of both programs. I have used AutoCAD in Windows Vista,
but almost everything also applies to Windows XP, although some of the screens will look different. If you
are using AutoCAD LT 2009, again, some of the screens will look different. Where there is a significant dif-
ference between AutoCAD and AutoCAD LT, I explain the difference.

Contacting the Author

I would be happy to hear any comments that you have about this book. The best way to contact me is by
e-mail at ellen@ellenfinkelstein.com. You can also use the United States Postal Service (a.k.a. snail
mail) and write to me in care of Wiley. Please note that I can’t provide technical support for my readers. The
publisher maintains a page on its site that includes the drawings used in the exercises (in case you lose your
DVD) and any errata at www.wiley.com/go/autocad2009bible. I have my own Web site at
www.ellenfinkelstein.com that contains information on my books and on AutoCAD, including
many AutoCAD tips. I invite you to sign up there for my free AutoCAD Tips Newsletter, so that you can
continue the learning process.
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AutoCAD and

AutoCAD LT Basics

need to know to start drawing in AutoCAD or AutoCAD LT.

These chapters are essential for the beginner, but even cur-
rent users can find some new tips and pointers especially related to
features that are new to AutoCAD 2009 and AutoCAD LT 2009.
The Quick Start chapter is a beginner’ tutorial to get you up and
running immediately. You'll draw a window and have the opportu-
nity to use many of the 2D features of AutoCAD and AutoCAD LT.
This tutorial will provide a firm basis for the knowledge in the rest
of this book.

The six chapters in Part [ provide all of the basics that you

Chapter 1 introduces you to AutoCAD and AutoCAD LT and sur-
veys the main screen, including the menus, toolbars, command
line, and status bar. You'll learn how to launch the program, execute
a command in a variety of ways, save a drawing, close a drawing,
and exit the program. Chapter 2 explains how to create and open
drawings. Chapter 3 covers the many ways to use commands, while
Chapter 4 discusses how to specify coordinates. Chapter 5 con-
cludes Part I with an explanation of how to set up a drawing.

If you feel that you know enough to skip to Part II, skim this part
for New Feature icons to find out about the latest developments in
AutoCAD and AutoCAD LT.

IN THIS PART

Quick Start
Drawing a Window

Chapter 1
Starting to Draw

Chapter 2
Opening a Drawing

Chapter 3
Using Commands

Chapter 4
Specifying Coordinates

Chapter 5
Setting Up a Drawing
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earning AutoCAD or AutoCAD LT is a bit like trying to decide which came

first — the chicken or the egg. On one hand, you need to know the basics

before you can start drawing. On the other hand, understanding the basics
can be very difficult if you haven’t had the experience of drawing something. In
this Quick Start chapter, you resolve this problem by drawing, dimensioning,
and printing a simple window in AutoCAD or AutoCAD LT.

This Quick Start chapter is meant for beginners. You'll get the feel of AutoCAD’%
precision drawing tools and experience how to build a drawing. The AutoCAD/
AutoCAD LT interface, including the toolbars and menus, is very customizable.
Note that the instructions for the exercise in this chapter assume that no one has
made major changes to the default settings.

Chapters 1 through 5 fill you in on basic information that you need to move on
to drawings that are more complex. By experiencing the drawing process first,
you will find the initial learning curve to be easier and smoother.

' Don’t worry if you don’t immediately understand everything

3 ! you're doing. It all becomes clear as you progress through this
book. If you haven’t read the Preface, now is a good time to go back and read the
part that explains how to follow the exercises. When you type the X and Y coordi-
nates (shown in bold), type the first number, a comma, and then the second num-
ber, with no spaces between them. The ! symbol means to press Enter on your
keyboard.

This chapter assumes that you're using the default 2D Drafting & Annotation
Workspace. Click the Workspace Switching button on the right side of the status
bar at the bottom of your screen, and choose 2D Drafting & Annotation if it’s not
already checked.

1. Start AutoCAD or AutoCAD LT.

You see the new drawing. (If you are prompted for a template, skip to
Step 2, third sentence.)
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2. Choose Menu Browser & File & New. The Select Template dialog box opens. Navigate to the
Drawings folder of the DVD of this book, choose abgs-a . dwt, and click Open. You see a
blank drawing. (I explain more about templates and opening drawings in Chapter 2.)

I To access the Menu Browser, click the red letter A in the upper-left corner of your screen.

3. To save the drawing and give it a name, choose Menu Browser = File &> Save. In the Save Drawing
As dialog box, use the Save In drop-down list to navigate to any convenient folder, such as the My
Documents folder. Type abqs-01 in the File Name text box and click Save. (I go into more detail
about saving a drawing in Chapter 1.)

= r t‘ In Chapter 1, | provide instructions for creating a special AutoCAD Bible folder for all the
At exercises in this book. If you want to create this folder now, do so and save the drawing in

that folder.

4. To free up the drawing area, close any windows or palettes that are open by clicking their Close
(X) button, so that your screen looks like Figure QS.2.

5. At the top of the screen, you see a tabbed palette filled with buttons, called the ribbon, which con-
tains the Layers control panel (section) on the Home tab, as shown in Figure QS.2. From the Layer
Control drop-down list in the Layers control panel, click the down-arrow and choose WINDOW,
as shown in Figure QS.1. (Layers help you organize the objects in your drawing; I cover them in
detail in Chapter 11.) Anything you draw will now be on the WINDOW layer.

FIGURE QS.1

Choose the WINDOW layer from the list of layers.

Defpoints
DETAILING
DIMENSION

6. With your left mouse button (also called the pick button), choose Home tab = Draw control
E panel = Rectangle. (Using the ribbon is only one way to give AutoCAD and AutoCAD LT com-
mands. I explain other ways in Chapter 3. You can find more about drawing lines and rectangles
in Chapter 6.)

Move your mouse so that the cursor is in the main drawing area. Your screen should look like
1= Figure QS.2. If you don't see the tooltip bar — also called the Dynamic Input tooltip — near the
cursor, then click the Dynamic Input button on the status bar at the bottom of your screen.

7. Follow these prompts to draw a rectangle that is 44" wide and 80" high.

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/
widthl: 0,0 J
Specify other corner point or [Area/Dimensions/Rotation]: 44,80 .
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Starting to draw a rectangle.

Layers control Layer Control
panel drop-down list Ribbon
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) Dynamic Input
Crosshairs tooltip
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You see the full prompt shown here in the Command window at the bottom of your screen.
Slalh You see an abbreviated version of the same prompt in the Dynamic Input tooltip that appears
near the mouse cursor. In an architectural drawing, distances are assumed to be in inches, so you don’t need
to specify a unit (although you can if you want).

Notice that the text that you type appears next to the cursor in the Dynamic Input tooltip. When
you press Enter, the text that you typed is echoed in the Command Line window at the bottom of
the screen.

8. To create a second rectangle inside the first one, choose Home tab = Modify control panel =
G‘ Offset. (I cover this and other editing commands in Chapters 9 and 10.) Follow these prompts:

Specify offset distance or [Through/Erase/Layer] <Through>: 4 .

Select object to offset or [Exit/Undo] <Exit>: Click the rectangle's
border to select it.

Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: Click
anywhere inside the rectangle.

Select object to offset or [Exit/Undo] <Exit>: J
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9. You can draw from geometric points on objects such as endpoints and midpoints. (I explain how

to specify coordinate points in Chapter 4.) To draw a line between the midpoints of the inner rec-
tangle, choose Home tab = Draw control panel = Line, and follow these prompts:

Specify first point: Press and hold the Shift key and right-click.
From the shortcut menu that opens, choose Midpoint. Place the
cursor near the midpoint of the left side of the inner rectangle.
When you see a triangle and the Midpoint tooltip, click.

Specify next point or [Undol]: Press and hold the Shift key and right-
click. From the shortcut menu that opens, choose Midpoint. This
time, place the cursor near the midpoint of the right side of the
inner rectangle. When you see the Midpoint tooltip and triangle,
click.

Specify next point or [Undo]: J

Your drawing should now look like Figure QS.3. (Your window should be green.)

FIGURE QS.3

The beginning of a window.

10. You will now draw a temporary construction line to help you find a starting point for the pane

in the top of the window. Again, choose Home tab = Draw control panel &> Line. Follow these
prompts:

Specify first point: Press Shift and right-click. Choose Endpoint
from the shortcut menu. Pick the left endpoint of the last line
you drew.

Specify next point or [Undol: 4,4 J. (This notation specifies that
the endpoint of the line is 4 units above and to the right of the
first point. Chapter 4 explains more about specifying coordinates
in this manner.)

Specify next point or [Undo]l: J
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11.  Again, choose Home tab => Draw control panel = Rectangle. Follow these prompts:

E Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/
Width]: Press Shift and right-click. Choose Endpoint and pick the
final endpoint of the diagonal line you just drew.

Specify other corner point or [Area/Dimensions/Rotation]: 2'4",2'4" .|

This notation specifies 2 feet, 4 inches in the X and Y directions.

] 12. Choose Home tab=> Modify control panel & Erase. At the Select objects: prompt, click
_|'.'£ the short, diagonal construction line that you drew in Step 9. The Select objects: prompt
appears again. Press Enter to end the command. (Chapter 9 explains the ERASE command as well
as other simple editing commands.)
13. Click the Ortho Mode button on the status bar at the bottom of the drawing area if it is not
|:|_ already selected (blue). The Ortho feature constrains drawing to right angles — either horizontal
or vertical. (You can find more about Ortho in Chapter 4.)
14. To finish the bottom of the window, choose Home tab & Draw control panel &> Line. Follow these
/ prompts:
Specify first point: 8",3'4"
Specify next point or [Undo]: Move the mouse cursor down from the
start point of the line. You see a temporary drag line. Then type
the following length of the line. 2'8-7/16 .

You can see what you type in the Dynamic Input tooltip as you are typing. Therefore, you can
check that you've typed the right numbers before you press Enter.

Specify next point or [Undol]: Move the cursor horizontally to the
right and type 28 .

Specify next point or [Close/Undo]: Now try entering the distance
using decimal notation, instead of feet and inches. Move the
cursor up and type 32.4375 J

Specify next point or [Close/Undo]:

15. To draw shutters, first change the layer. Choose Home tab = Layers control panel, click the Layer
Control drop-down list, and choose EXWALL.

/ 16. Choose Home tab = Draw control panel & Line. Follow the prompts:

Specify first point: Press Shift and right-click. Choose Endpoint
from the shortcut menu. Click the upper-left corner of the window.
Specify next point or [Undol: Move the cursor to the left. Type 1'6" J
Specify next point or [Undo]: Move the cursor down. Type 6'8" .l
Specify next point or [Close/Undo]: Type #0,0 J. (The pound sign
ensures that your line goes to 0,0 no matter where you are.)
Specify next point or [Close/Undo]:

17. To draw the opposite shutter, you'll mirror the first shutter that you just drew. (I cover the MIR-
_ﬂ||'j,_ ROR command and many other editing commands in Chapter 10.) Choose Home tab = Modify
control panel &> Mirror, and follow these prompts:
Select objects: Click the three lines that make up the shutter.
Select objects:
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18.

r_,| 19.

view of your drawing in Chapter 8.

Specify first point of mirror line: Press Shift and right-click.
Choose Midpoint from the shortcut menu.

Place the cursor near the middle of the top horizontal line of the
window. Click when you see the triangle and Midpoint tooltip.
Specify second point of mirror line: (The Ortho Mode button should

still be blue. If it isn't, click it.) Move the cursor downward
and pick any point.
Erase source objects? [Yes/No] <N>:

The window should look like Figure QS.4.

FIGURE QS.4

The completed window.

i

To add a dimension to the bottom of the window, you should first change the layer. Choose
Home tab = Layers control panel = Layer Control drop-down list, and choose DIMENSION.
(Chapters 14 and 15 explain how to create and format all types of dimensions.)

v

To place the dimension, choose Home tab => Annotation control panel, and click the Dimension
drop-down list. Choose Linear from the list of dimension types. Follow the prompts.

Specify first extension line origin or <select object>: J
(Pressing Enter lets you select an object to dimension.)

Select object to dimension: Pick the bottom horizontal line of the
window (the bottom of the rectangle).

Specify dimension line location or [Mtext/Text/Angle/Horizontal/
Vertical/Rotated] :Move the cursor down until the dimension 1is
nicely spaced below the window. Click to place the dimension line.

If you don’t have enough room to place the dimension below the window, click the down
arrow of the vertical scroll bar as necessary. I explain additional techniques for changing the
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Quick Start: Drawing a Window

Click Save on the Quick Access toolbar at the upper-left corner of the window to save your work.

To prepare for printing, click the A Title Block-Landscape button, which is the second button
from the left in the right-hand group of buttons on the status bar at the bottom of your screen.
You then see the window inside a titleblock and border, as shown in Figure QS.5. This titleblock
and border come with the template to help you easily prepare the drawing for printing. (Chapter
17 explains how to lay out and print/plot a drawing.)

To set the scale for printing, click the magenta viewport border (labeled in Figure QS.5). Choose
View tab &> Palettes control panel = Properties. In the Properties palette’s Misc. section, click the
Standard Scale item. (To see this item, you may have to scroll down in the Properties palette or
enlarge it by dragging on its bottom and right edges. If the palette collapses to a thin bar, pass
your cursor over the bar to expand it.) Click the down arrow that appears to the right of this item
and check that the scale is set to 1" = 1'-0". Click the Close button at the top of the Properties
palette. (I explain more about scales in Chapter 5.)

If the window and its dimension are not centered in the viewport window, double-click inside the
viewport border. Then choose Home tab = Utilities control panel & Pan. Click and drag as neces-
sary to center the window in the viewport. Press Esc to exit Pan mode. Double-click outside the
viewport border to return to the layout.

FIGURE QS.5

The window with a titleblock as it appears on the Layout tab.
Title border
Page border

Viewport border

e e ———— —— —— ——— — —— ]

Title block
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25.
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28.

To add some text to the titleblock, you need to zoom in. (I explain zooming in more detail in
Chapter 8.) On the status bar at the bottom of your window, click Zoom. At the first prompt,
click slightly above and to the left of the words Project Name. At the next prompt, click slightly
below and to the right of the words City ST ZIP.

These words should now appear very large in the drawing area. They are already placed and for-
matted, so all you need to do is replace them. (I explain all about how to create and edit text in
Chapter 13.)

Double-click the Project name text. A new Multiline Text tab appears, along with a ruler, as
shown in Figure QS.6.

Select the text by dragging from the upper-left corner to the lower-right corner. Type the following:
Double-hung window

2010 Coral Lane

Anytown, A 12345

Click the Close button at the right end of the Multiline Text tab to close the In-Place Text Editor.

To return to your previous view, choose Home tab = Utilities control panel &> Zoom (drop-down
list) & Previous.

Click Save on the Quick Access toolbar to save your drawing.

FIGURE QS.6

Editing text for a drawing.
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29. You're ready to print your drawing! Depending on your setup, either you can print directly to
@ your printer, or if you have a plotter available, you can use that. (The layout is set up to fit on an
8'4-x-11-inch or A-size sheet of paper.) Choose Plot on the Quick Access toolbar. The Plot dialog
box opens. (I cover printing and plotting in Chapter 17. Appendix A explains how to configure a
printer or plotter.)

30. In the Printer/Plotter section of the Plot dialog box, click the Name drop-down list and choose the
printer or plotter that you want to use.

31. Click the Preview button to open the preview window. You should see the window and its title-
block laid out as shown in Figure QS.7.

FIGURE QS.7

Viewing the window in Preview mode.

1 [ He —

Aaran Archirect, A&
123 Anystreet
Tty ST 12M5

|
Dicubla-hung window
201U Coral Lane
Fairlieh, 14 12343

T

LR
e of w
=1

T If things don’t seem right, click the Close Preview Window button and review the previous
B steps to see if you can find the problem. Also, see the sidebar, “Help! My Drawing Doesn’t
Look Like the Figure.”

& 32. Make sure your printer or plotter has an 8/:-x-11-inch or A-size sheet of paper, and click the Plot
button on the Preview window’s toolbar. Congratulations! You've just created and printed your
first drawing!

33. Click the Close button at the upper-right corner of the AutoCAD application window to close
both AutoCAD and the drawing. Click Yes to save your changes.

11
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Help! My Drawing Doesn’t Look Like the Figure

f your drawing doesn’t look like the image shown in Figure QS.7, there could be several reasons. To fix the
problem, try one of the following solutions:

B You may have made a mistake when creating the drawing. If you think that’s the case, start over
and follow the prompts again.

m You may have started AutoCAD or AutoCAD LT based on a template with different properties from
the default. Be sure to use the template on the AutoCAD 2009 and AutoCAD LT 2009 Bible DVD,
as explained in Step 2 of the previous exercise. Then follow the prompts again.

B [f your drawing still seems wrong, put the DVD that accompanies this book in your DVD drive.
Choose Menu Browser = File &> Open and use the Open dialog box to find abgs-01. dwg in the
Results folder on the DVD. This drawing contains the end result of the exercise. You can try to
find the difference between this drawing and yours. You can also copy abgs-01 . dwg from the
DVD to your hard drive and print or plot it.

One of the preceding options should solve your problem.

=

I It's important to understand that this Quick Start tutorial used techniques that are easiest to
:«f\:@- SESS understand for beginners; as a result, the techniques were sometimes a little awkward.
AutoCAD and AutoCAD LT have many capabilities that make drawing easier and faster. You learn all these
features in this book.

Summary

In this exercise, you practiced many of the skills that you need to use AutoCAD or AutoCAD LT effectively.
Most of your work in AutoCAD or AutoCAD LT builds on these basic skills. The rest of the chapters in
this book explain these procedures in more detail as well as many features not covered in this Quick Start
exercise.

12



little background, T discuss the basics of the screen that you see when you
open AutoCAD or AutoCAD LT, and how to use it. If you've never used
AutoCAD before, do the “Quick Start: Drawing a Window” chapter first.

In this chapter, I explain the essentials that you need to start drawings. After a

AutoCAD and its younger brother, AutoCAD LT, are both created by Autodesk.
Together they are the most widely used technical drawing programs anywhere.
AutoCAD alone has more than 6,000,000 registered users. According to Autodesk,
CAD stands for computer-aided design, but it can also stand for computer-aided
drafting or drawing.

The first version of AutoCAD, running under DOS, came out in 1982. AutoCAD
was the first significant CAD program to run on a desktop computer. At the time,
most other technical drawing programs ran on high-end workstations or even
mainframes. AutoCAD LT was introduced in 1993, as a less expensive alternative
to AutoCAD, for people who don't need all of AutoCAD’s advanced features.

AutoCAD’s Advantages

AutoCAD? success has been attributed to its famous open architecture — the flexi-
bility that the end user has to customize the program using source code files in
plain text (ASCII) format— and programming languages (such as AutoLISP and
Visual Basic for Applications).

As a result, AutoCAD is an extremely flexible drafting program, applicable to all
fields. AutoCAD’s support for languages other than English, including those
using other alphabets, is unparalleled, making AutoCAD highly popular abroad.
As a result, AutoCAD is used in all disciplines and in more than 150 countries.

Through a high level of technical innovation and expertise, Autodesk has created
a program with advanced features and capabilities, including 3D surface and
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solid modeling and visualization, access to external databases, intelligent dimensioning, importing and
exporting of other file formats, Internet support, and much more.

The major disciplines that use AutoCAD are:

Architectural, Engineering, and Construction (AEC)
Mechanical

Geographic Information Systems (GIS)

Surveying and Civil Engineering

Facilities Management

Electrical/electronic

Multimedia

However, AutoCAD has many other lesser-known uses, such as pattern making in the garment industry,
sign making, and so on. In this book, I provide examples from several fields. The world of AutoCAD is very
broad, and you can learn from seeing the many approaches that AutoCAD makes possible.

Comparing AutoCAD and AutoCAD LT

AutoCAD LT’ advantages are its lower cost and its compatibility with AutoCAD. The programming code
that is used to create AutoCAD LT is a subset of the code used in AutoCAD. Here are the major differences
between AutoCAD and AutoCAD LT:

AutoCAD includes features that enable CAD managers to hold drawings to certain standards,
such as for layer names and text styles. AutoCAD LT doesn’t contain these features.

AutoCAD LT is not as customizable as AutoCAD, which is both programmable and fully cus-
tomizable. It also doesn't include the Action Recorder.

AutoCAD LT includes minimal options for 3D; AutoCAD includes a full-featured 3D capability.

AutoCAD LT has fewer presentation features than AutoCAD, which includes gradient fills and
3D rendering.

AutoCAD LT is deployable on a network but does not have AutoCAD’s network license manage-
ment feature that includes reporting and flexible licensing.

AutoCAD LT does not offer the database connectivity feature, but you can use tables to connect to
data in a Microsoft Office Excel file; AutoCAD offers the flexibility to connect to other types of
databases, create labels from the data, and so on.

AutoCAD LT does not include AutoCAD’s quick-dimensioning feature, which allows you to
quickly insert a number of dimensions, one after the other.

AutoCAD LT does not come with Express Tools, a set of additional routines that ship with
AutoCAD.

AutoCAD LT does not include the sheet set feature, which was introduced in AutoCAD 2005.

AutoCAD and AutoCAD LT have a few other minor differences, as well. Some of these differences are only
in the user interface, so you can accomplish the same task but the procedure is slightly different.

14



Starting to Draw _

Starting AutoCAD and AutoCAD LT

This section starts a quick tour of AutoCAD and AutoCAD LT. The first step is to start the program.

oy The DVD contains a 30-day trial version of AutoCAD 2009 and AutoCAD LT 2009.

This book covers AutoCAD 2009 and AutoCAD LT 2009 running on Windows XP Home/Professional, or
Windows Vista. (Most of the figures were taken in Windows Vista.) Every computer is set up somewhat dif-
ferently, so you may need to adjust the following steps slightly. If you didn't install the software yourself and
are unfamiliar with the folders (also called directories) on your computer, get help from someone who is
familiar with your computer system.

=y If you need information on installing AutoCAD or AutoCAD LT, see Appendix A. Appendix A
also covers configuring the software and printers or plotters.

NI OEI

By default, installing AutoCAD or AutoCAD LT places a shortcut on your desktop. You can double-click
one of the shortcuts to launch the program that is installed on your machine, or use the Start menu to
choose one of the following:

B For AutoCAD: Start= All Programs = Autodesk &> AutoCAD 2009 = AutoCAD 2009

B For AutoCAD LT: Start = (All) Programs = Autodesk = AutoCAD LT 2009 &> AutoCAD LT 2009

Creating a New Drawing

After you launch AutoCAD or AutoCAD LT, it automatically opens a new drawing named Drawingl . dwg.
You can see the drawing name on the title bar. You can start drawing immediately. In Chapter 2, I explain
how to start a drawing based on a template and how to open an existing drawing.

STEPS: Starting AutoCAD or AutoCAD LT

1. Click Start on the Windows task bar at the bottom of your screen.
2. Choose one of the following:
For AutoCAD: Start = (All) Programs = Autodesk = AutoCAD 2009 = AutoCAD 2009

For AutoCAD LT: Start = (All) Programs = Autodesk &> AutoCAD LT 2009 => AutoCAD LT
2009

You see a blank drawing named Drawingl . dwg.

If you are continuing with this chapter, keep this drawing open. I cover exiting from AutoCAD and
AutoCAD LT later in this chapter.

Using the AutoCAD and AutoCAD LT Interface

AutoCAD offers three quite different preset workspaces, depending on how you want to work. For example,
these workspaces determine the ribbon components, toolbars, and other interface items that you see.
AutoCAD offers both 2D and 3D environments. The 3D environment is quite different from the AutoCAD
LT screen, but the AutoCAD 2D and the AutoCAD LT environments are similar. In this section, I discuss the

15
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2D environment. Both AutoCAD and AutoCAD LT offer two 2D workspaces: 2D Drafting & Annotation and
AutoCAD (or AutoCAD LT) Classic. The 2D Drafting & Annotation workspace is the default workspace and
displays the ribbon for executing commands. The AutoCAD Classic and AutoCAD LT Classic workspaces
display toolbars and a menu instead.

I AutoCAD’s 3D Modeling workspace creates a 3D environment including the drawing tem-
S8 plates acad3D.dwt and acadiso3D.dwt. (I cover templates in Chapter 2.) I cover this 3D
environment in Part IV, “Drawing in Three Dimensions.”

Figure 1.1 shows the default screen that appears when you first open AutoCAD or AutoCAD LT. Your
screen may look somewhat different — remember that AutoCAD and AutoCAD LT can be customized in
many ways — but the general features will be the same. If you see other items open on your screen, you can
close all these items by clicking their Close (X) button.

= By default, the screen is now off-white, rather than black. You can leave it that way or change
i the drawing area color, as I explain in Appendix A.

If you find yourself in a 3D environment in AutoCAD, you'll see a gray background and a perspective view.
To work in 2D in AutoCAD, you need to switch to a 2D environment. To switch to a 2D environment, fol-
low these steps in AutoCAD:

1. From the Workspace Switching pop-up menu, choose 2D Drafting & Annotation. This displays
the Dashboard with 2D commands.

2. Choose Menu Browser = File & New. From the Select Template dialog box, choose acad. dwt
and click Open. This places you in a 2D view and turns off the grid.

The AutoCAD and AutoCAD LT screens consist of four important areas. These are discussed in the follow-
ing sections.

The drawing area

The blank area in the middle of the screen, called the graphics window or drawing area, is where you draw.
You can think of this as a sheet of drafting paper, except that this piece of paper can be any size — even the
size of a huge factory or an entire county!

By default, you draw in model space, so called because that’s where you draw your models. When you create
anew drawing, by default, you are in model space, so you can just start drawing. You can lay out your
drawings for plotting in paper space, also called a layout. To switch from model space to a layout, you use
the Layout button on the status bar. You use the Model button to switch back to model space. (See Chapter
17 for details.)

I Instead of the model and layout buttons, you may see two tabs at the bottom-left of the draw-
- | ing area that you can use to switch between model space and paper space. You can switch
between buttons and tabs by right-clicking either feature and choosing from the shortcut menu.

When you start to draw, you need to specify where to start drawing. One way is to use coordinates. To spec-
ify a coordinate, the universally accepted convention is to put the X coordinate first, followed by a comma,
and then the Y coordinate. Examples are -3,5, 3,2, 6,—2, and —1,-1. These coordinates specify points in the
drawing area.

I Chapter 4 is devoted to explaining how to specify coordinates. To create three-dimensional
& models, you need to add a Z coordinate when specifying a point. Chapter 21 discusses three-
d|mensmnal coordinates.
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The AutoCAD and AutoCAD LT screens are very similar.

Application Drawing, Minimize, Maximize, and Close buttons

Ribbon Help button

Menu Browser Application Minimize, Maximize, and Close button

Title bar Pickbox

Quick Access toolbar

R S TETErERt futo CAD DrawingT.dwy
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. Status bar Workspace Switching pop-up menu
USCicon

Drawing area Crosshairs Status bar menu

Clean Screen button

If you want the maximum amount of free space for drawing, click the Clean Screen button at
the right side of the status bar to remove the ribbon. Click the same button to get it back. You
can also press Ctrl+0 to toggle between the two displays. You can double-click the active tab to cycle
through three display states of the ribbon that collapse and expand the ribbon.

The UCS icon

Notice the symbol with two arrows in the drawing area in Figure 1.1. This symbol is called the User
Coordinate System (UCS) icon. The arrows point to the positive directions of the X and Y axes to help you

keep your bearings. (In a 3D environment, you see a Z axis as well.) You can change the look of this icon,
and turn it on and off, as I explain in Chapter 8.
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The crosshairs

In the drawing area of Figure 1.1, notice the intersecting lines with a small box at their intersection. The
small box is called the pickbox because it helps you to select, or pick, objects. The lines are called crosshairs.
They show you the location of the mouse cursor in relation to other objects in your drawing.

As you move your mouse around, the pickbox and crosshairs move with your mouse. At the bottom of your
screen, at the left end of the status bar (described later), you can see the X,Y coordinates change as you
move your mouse.

The ribbon and Quick Access toolbar

At the top of your screen is the title bar, and directly beneath the title bar is the ribbon. On the left side of
the title bar is the Quick Access toolbar. I explain how to work with the ribbon and the Quick Access tool-
bar in Chapter 3.

- \1-” :_ The ribbon and Quick Access toolbar are new for AutoCAD 2009 and AutoCAD LT 2009. They
=fisdietdastl replace the menu and toolbars of previous versions. The ribbon has tabs, and each tab is
divided into control panels (sometimes called panels), sections of related commands.

The AutoCAD Classic and AutoCAD LT Classic workspaces do not show the ribbon; instead,

- you see three toolbars (the Draw, Modify, and Draw Order toolbars) which are usually docked
at the left and right sides of the screen. From the Workspace Switching pop-up list, try switching between the

2D Drafting & Annotation workspace and the AutoCAD or AutoCAD LT Classic workspace to see which one

you prefer. In Appendix A, I explain how to customize workspaces.

On the Home tab, in the Draw control panel of the ribbon, hover the mouse cursor over the leftmost but-
ton. You see a tooltip that says Line, as shown in Figure 1.2. Below the tooltip, a description tells you that
this button creates straight-line segments. If you continue to hover the cursor over the Line button, the
tooltip expands to provide more information about the command.

You use buttons on the ribbon to execute commands. For example, to draw a line, you click the Line button
on the Draw control panel of the ribbon’s Home tab. You get some practice drawing lines in the exercise that
follows. (In the AutoCAD Classic or AutoCAD LT Classic workspace, you would click the Line button on
the Draw toolbar to draw a line.)

FIGURE 1.2

Hovering the cursor over the Line button displays a tooltip that shows the command and a description of its function.

Creates straight line scgments
o LINC

[2] Press F1 for more help

If you inadvertently start a command that you don’t want to use, press Esc.
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The Quick Access toolbar contains a few often-used commands that are useful to have available all the time.
Examples are commands to start a new drawing, open an existing drawing, and save a drawing.

Because you can customize the ribbon and the Quick Access toolbar to suit your needs, your screen may
appear somewhat different. (See Chapter 29 for information on customizing the Quick Access toolbar, and
see Chapter 33 for information on customizing the ribbon.) Remember that if the current workspace is
AutoCAD Classic or AutoCAD LT Classic, you won't see the ribbon or Quick Access toolbar; instead, you'll
see a menu bar at the top and several toolbars.

You can lock the position of ribbon control panels (if they’re not docked), toolbars, and win-

% dows (palettes). On the right side of the status bar, at the bottom of the screen, is a Lock icon.
Click th|s icon to open a menu allowing you to individually lock specific window, panel, or toolbar compo-
nents. You can also choose the All option and lock or unlock everything. Locking these interface components
prevents you from moving them inadvertently.

Using the Menu Browser

When you click the Menu Browser button, a menu opens, giving you access to an entire menu system that
you can use to give AutoCAD or AutoCAD LT commands, as shown in Figure 1.3.

I The Menu Browser is new for AutoCAD 2009 and AutoCAD LT 2009. It replaces the menu bar
b3l that appeared at the top of previous releases. The menu itself has not changed much, so if you
are used to the menu, you can usually go to the Menu Browser and find the command you need there. The
same menu items that were horizontal are now vertical. Hover the cursor over any menu item to display the
submenu items.

FIGURE 1.3

The Menu Browser offers a vertical menu, recently opened drawings, a Search box, access to other open drawings,
and a quick way to repeat recent commands.
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When you open the Menu Browser, you can type a search term in the Search text box to find a command.
On the right, you see a list of drawings that you opened recently. At the top of the list of drawings, you can
click a drop-down arrow to choose to display them alphabetically (ordered list), by date, or by type. To the
right, you can click a drop-down arrow to display the drawings as icons, or as small, medium, or large
images. However, even if you display just icons, if you hover the cursor over any drawing name, an image
of the drawing appears.

Click Recent Actions at the bottom of the Menu Browser to display a list of recent commands you used.
Click one to repeat that command. The Options button, also at the bottom of the Menu Browser, opens
the Options dialog box where you can specify many settings that affect how AutoCAD works. I explain the
Options dialog box in detail in Appendix A.

The command line and dynamic input tooltip

At the bottom of the drawing area, you see a separate window showing approximately three lines of text.
(You can change it to show as many lines as you like by dragging the top edge of the window up or down.)
Notice the word Command : . This is the command line. You can execute any command by typing it on the
command line.

Even if you use a menu item or the ribbon to execute a command, you may see a response on the command
line. AutoCAD and AutoCAD LT often provide options that must be typed on the keyboard. Text that you
type appears on the command line. For example, when you type coordinates specifying a point, they appear
on the command line.

The Dynamic Input tooltip allows you to see the text that you type at the cursor. This tooltip doesn’t appear
until you start typing a command. You can also choose options near the tooltip. (For more information, see
Chapter 3.)

To see more of the command line, press F2 to open the AutoCAD or AutoCAD LT Text Window. You can
scroll back through previous commands. Press F2 again to close the window. You can also simply hide the
Text window by clicking in the AutoCAD or AutoCAD LT window for easy access to the Text window later
from the Windows task bar.

The status bar

At the very bottom of the screen is the status bar (refer to Figure 1.1). At the left are the X,Y coordinates. As
you move your mouse, these coordinates change. (If they don’t change, click them and move your mouse
again.) The status bar also contains several buttons that I explain later in this book.

I The status bar has been updated. The previous text-based buttons are now image icons, and
=fis-Ofdasdll several new features have been added. These features are discussed where appropriate
throughout the book.

At the right side of the status bar is a small down arrow. Click it to open the status bar menu. This menu
determines which buttons appear on the status bar. If you don’t use a certain button, choose it on the menu
to remove its checkmark and make it disappear. You can always go back and choose the item again to redis-
play the button.

Creating a New Folder

For your work with this book, you should create a new folder so that you can save your exercise drawings
where they won't get mixed up with other drawings. The following directions leave it up to you where to
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create this new folder. Each computer system is organized differently. If you aren’t sure what to do, choose
the drive (not the folder) where AutoCAD or AutoCAD LT is installed and create a new folder there.

I do not recommend creating a subfolder in the AutoCAD 2009 or AutoCAD LT 2009 folder.

A This folder contains the files that make up the program. If you keep your drawings here, it is
too easy to make a mistake and delete necessary program files. Some people create a subfolder in the My
Documents or Documents folder.

STEPS: Creating a New Folder

1. Move the mouse cursor to the Windows task bar at the bottom of your screen and right-click the
Start button.

2. Choose Explore.

3. On the left pane of Windows Explorer, click the drive where you want to create the new folder. If
you don’t know where to create the folder, choose the drive where AutoCAD or AutoCAD LT is
installed. If you're on a network, choose the drive that represents your computer. If you keep your
work in subfolders of the My Documents (Documents in Windows Vista) folder, click that
folder.

4. 1f you want to make a subfolder (a folder within a folder), choose the folder where you want to
create the subfolder.

5. From the Explorer menu, choose File &> New = Folder. (In Windows Vista, click Organize = New
Folder.) A new, highlighted folder, named New Folder, appears in the right pane. You may have
to scroll down to see it.

6. Type AutoCAD Bible for the folder name and press Enter. (If you did the exercises from a previ-
ous edition of this book, such as AutoCAD 2008 and AutoCAD LT 2008 Bible, and you already
have a folder named AutoCAD Bible, first rename the original folder to something such as
ACAD2008Bible.)

Save all drawings that you create for this book in your AutoCAD Bible folder.

Creating a folder for your drawings as described in the previous steps is essential before you
go on to exercises in the rest of this book.

Using the Interface

If you did the Quick Start exercise, you had the experience of drawing a window, but I chose the simplest
method of completing each task because I had not yet described the AutoCAD and AutoCAD LT screen. In
the following exercise, you draw some simple objects, but experiment with all the features of the user inter-
face to get a feel for how they work. (Chapter 3 explains in more detail how to use commands.)

For this exercise, simply follow the instructions exactly. When you type the X and Y coordinates (shown in
bold), type the first number, a comma, and then the second number, with no spaces between them.

Don’t worry if you don’t understand everything you're doing. It all becomes clear as you
: S5 progress through this book. If you haven’t read the Preface, now is a good time to go back and
read the part that explains how to follow the exercises.

Follow the prompts shown next. As explained in the Preface, you type what appears in bold.
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STEPS: Drawing a Line in Four Ways
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e

1.

Start AutoCAD or AutoCAD LT.

You see a new drawing. (If you are prompted for a template, type or choose acad.dwt or
acadlt.dwt.)

From the ribbon, choose Home tab = Draw control panel = Line.

Move your mouse to move the crosshairs cursor around the screen. Notice the Dynamic Input
tooltip that follows the cursor around, as shown in Figure 1.4. (If you don't see the Dynamic
Input tooltip, click the Dynamic Input button on the status bar.) At the same time, notice the
coordinates changing on the left side of the status bar.

FIGURE 1.4

When you move the mouse around, the Dynamic Input bar follows the cursor, displaying the
current coordinates.

Specify first point: [T 16.1132 |

Anywhere on the screen, stop moving the mouse and click the left mouse button to pick a point.
When you move the mouse again, the Dynamic Input bar changes to prompt you to specify the
next point and to show you the angle and length of the cursor from the original point you picked,
as shown in Figure 1.5.

FIGURE 1.5

After specifying the first point of a line, the Dynamic Input bar prompts you for the next point.

Pick any point to create a line segment. You see the same Dynamic Input tooltip as before, which
means that you can continue to create more line segments. (Chapter 6 explains all about drawing
lines.)

Press Enter to end the command and finish your line.
For your second line, choose Menu Browser & Draw = Line. Again, pick any point on the screen.

Move your mouse so you can see the length and angle tooltips. Notice the value for the length.
Now type a different value and press Enter. For example, if the Length tooltip says 13.7638,
type 5 .
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9. Press Enter to end the command. The line’s length is based on what you typed, not where the cur-
sor was, but the line’s angle is the same as it was before you typed in the length.

10. For your third line, type line. Notice that the text appears in the Dynamic Input tooltip as you
type, but not in the command-line area.

11. Press Enter. You now see the command that you typed in the command line area as well as the
Dynamic Input prompt to specify the first point.

12. Click in two places to pick a start point and an endpoint.

13. This time, to end the line, right-click anywhere in the drawing area. By default, this opens a short-
cut menu, but it may end the command. If so, youre done. If you see the shortcut menu, choose
Enter from the shortcut menu to end the command.

14. For your fourth line, click the Workspace Switching button on the right side of the status bar, and
choose AutoCAD Classic or AutoCAD LT Classic. The entire interface changes: the ribbon is gone,
and in its place you see a menu bar at the top, and several toolbars. If you don't see the Draw
toolbar (it’s usually docked vertically on the left side of the application window), right-click any
toolbar that is already displayed and choose Draw from the list of toolbars. Click the Line button
on the Draw toolbar. Move the mouse so that the cursor is in the drawing area. Pick two different
points and press Enter.

15.  Use the Workspace Switching button to return to the 2D Drafting & Annotation workspace.
Leave the drawing on your screen and complete the next exercise to save the drawing,.

You should now have four lines on the screen. You can see how the interface offers several ways to work.
You can use the method that suits you best.

Saving a Drawing

Saving a drawing is similar to saving any other file in Windows. You should get in the habit of saving your
work every 10 to 15 minutes to avoid losing your work in case the software or your computer system
crashes.

Saving a drawing for the first time is different from saving it subsequently because you have to name the
drawing the first time you save it.

To save a drawing, click Save on the Quick Access toolbar or choose Menu Browser = File = Save. If you're
E saving a drawing for the first time, the Save Drawing As dialog box appears, as shown in Figure 1.6.

Down the left side of the dialog box are several buttons, called the Places list, to help you find a location to
save drawings more quickly.

Conveniently, you can reorder the buttons in the Places list. Just drag any button to a new
location.

Of course, you can also choose a location from the Save In drop-down list to which you want to save the
file. To save a file, type a filename in the File Name text box and click Save to save the file.

Use the Views drop-down list of the dialog box to specify how you want to display files in this dialog box,
such as List, Details, Thumbnails, or Preview.
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FIGURE 1.6

The Save Drawing As dialog box.
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Use the Tools drop-down list of the dialog box to do the following:

B Add or Modify FTP Locations: FTP sites are locations on the Internet for transferring files. To
add or modify FTP locations, choose Tools = Add/Modify FTP Locations from the menu of the
Save Drawing As dialog box. You need to list the name of the FTP site, choose a logon type
(Anonymous or User), and specify your user name and password if you're logging on as a User.
You can then save drawings (called uploading) to FTP locations by clicking the Save In drop-down
list and choosing FTP Locations. This feature makes an intranet or any server with FTP capability
as accessible as your own computer system.

B Add Current Folder to Places: If you save to a specific folder often, you can navigate to that
folder and then choose Tools &> Add Current Folder to Places. The Places Bar then displays a new
button for that folder so that you can easily click the button to go straight to the folder.

B Add to Favorites: When you have navigated to a folder, you can add it to the Favorites folder
by choosing Tools=> Add to Favorites. You can also select a file in a folder and add it to the
Favorites folder.

B Options: The Options dialog box opens, where you can specify certain settings relating to saving
drawings. I discuss these options in Chapter 8 and Appendix A.

B Security Options: Choose this setting to set a password or attach a digital signature. I discuss

these features in Chapter 26.
75i) \‘B’Nﬂ % The SAVEALL command of the Express Tools saves all open drawings, without closing them.
afistineiimnll Choose Menu Browser = Express = File tools & Save All Drawings. If a drawing hasn’t been
saved, you are prompted for a filename. For information on installing Express Tools, see Appendix A.
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¥ The DVD includes a small program, saved. 1sp, that automatically backs up your drawing to
@ the CD/DVD drive after you’ve saved it on your hard drive. If you use this drive for backups,
this program can be useful. Look in \Software\Chapter 01\Saved. The file contains instructions for
changing the drive to any letter you use (AutoCAD only).

STEPS: Saving a Drawing for the First Time
= 1. The four lines you created earlier in this chapter should still be on your screen. Click Save on the
|-|-_-. Quick Access toolbar. The Save Drawing As dialog box opens.

2. Click the Save In drop-down list. If necessary, choose the drive where you created your AutoCAD
Bible folder for this book.

3. Double-click the AutoCAD Bible folder.

In the File Name text box, select the default filename that appears. Type ab01-01 and press Enter
(or click Save).

5. Keep your drawing on the screen and go to the next exercise.

AutoCAD saves your drawing under the name ab01-01.dwg. This numbering system will help you organ-
ize your drawings from this book and find equivalent drawings on the DVD more easily. It just means that
this is the first drawing from Chapter 1 of AutoCAD 2009 and AutoCAD LT 2009 Bible.

Closing a Drawing and Exiting from
AutoCAD and AutoCAD LT

You can close your drawing and keep AutoCAD or AutoCAD LT open. The simplest way to do this is to use
the Drawing Close button at the upper-right corner of the drawing. You can also choose Menu Browser =
File &> Close.

You can choose Menu Browser => Window > Close All to close all open drawings. If any of
the open drawings have unsaved changes, AutoCAD or AutoCAD LT prompts you to save the
changes. If you have AutoCAD, you can choose Menu Browser > Express = File tools => Quick Exit, which
closes all open drawings (prompting you to save if necessary) and then exits the program.

To exit AutoCAD or AutoCAD LT, click the Close (X) box at the top-right corner of your screen. You can
also exit out of AutoCAD or AutoCAD LT by typing quit on the command line and pressing Enter. Another
method is to choose Menu Browser = File = Exit.

If you've made any changes to your drawing since last saving it, AutoCAD or AutoCAD LT asks you if you
want to save your changes. Choose Yes or No as your situation requires. Choosing Cancel returns you to
your drawing. If you have opened more than one drawing to which you have made changes, you have a
chance to save each drawing in turn so that you don't exit AutoCAD or AutoCAD LT without saving all the
changes you've made in your open drawings.

STEPS: Closing Your Drawing and Exiting AutoCAD or AutoCAD LT

1. Your drawing should still be on your screen. Choose Menu Browser = File = Close. You now see a
gray screen with no drawing. (Repeat this process if you have other drawings open. Save or cancel
the changes to these extra open drawings as you like.)

2. Click the Close button in the upper-right corner to exit AutoCAD or AutoCAD LT. The program
closes immediately.
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Summary

In Chapter 1, I explained how to start AutoCAD and AutoCAD LT and create a new drawing. I gave you a
tour of the screen and explained how to save a drawing. This chapter provided the basis for all your work in
AutoCAD and AutoCAD LT.

In this chapter, you learned the following:

A brief history of AutoCAD and AutoCAD LT

Some of the different disciplines that use AutoCAD and AutoCAD LT
How to start AutoCAD and AutoCAD LT

How to start a new drawing

The user interface and its various sections, including the drawing area, the UCS icon, the
crosshairs, the ribbon, the Quick Access toolbar, the command line, and the status bar

How to start a command from the ribbon
How to start a command from the command line

How to start a command from the menu

How to start a command from the Draw toolbar in the AutoCAD Classic or AutoCAD LT Classic
workspace

B How to save a drawing for the first time
B How to close a drawing
B How to exit AutoCAD and AutoCAD LT

You may have several questions at this point, but “well begun is half done.” The next chapter explains all
the ways to start a new drawing as well as how to open an existing drawing.
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utoCAD and AutoCAD LT offer a number of options for opening new and

existing drawings. These options create a great deal of flexibility and save

you time as well. You can create complex templates to avoid doing the
same basic setup and drawing over and over.

Creating a New Drawing
from a Template

A template is a special file that contains drawing settings and often objects (such
as a titleblock and text). A template has a DWT filename extension. When you
use a template as the basis for a new drawing, the drawing takes on all the set-
tings and objects contained in the template. Use templates to avoid re-creating
settings and redrawing objects for new drawings. AutoCAD and AutoCAD LT
come with many templates that you can use as is or customize. You can also cre-
ate your own templates.

' AutoCAD and AutoCAD LT offer a Startup dialog box that pro-

=4 ! vides choices for starting a new drawing as well as opening
eX|st|ng drawmgs To display the Startup dialog box whenever you open AutoCAD
or AutoCAD LT, type startup on the command line and press Enter. Then type 1
and press Enter again.

To create a new drawing based on a template, choose Menu Browser = File =
New to open the Select Template dialog box, which lists all the available tem-
plates, as shown in Figure 2.1. Click a template to see its preview, if any. Double-
click a template to create a new drawing based on that template. Because
AutoCAD or AutoCAD LT opens with Drawingl . dwg, the new drawing is
named Drawing2 .dwg. Subsequent drawings that you create are named
Drawing3.dwg and so on. When you save and name your drawing, the original
template file is unaffected.
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The QNEW command is useful if you always start a new drawing based on the same template. You set a
default template and then click QNew on the Quick Access toolbar to start a new drawing immediately,
based on that default template. To set the default template, follow these steps:

1. Choose Menu Browser = Tools = Options and click the Files tab.

2. Double-click the Template Settings item.

3. Double-click the Default Template File Name for QNEW item.

4

. Click the listing under the Default Template File Name for QNEW item (which says None by
default).

5. Click Browse to choose the template that you want.
6. Click OK to close the Options dialog box.
You can specify whether this default template uses metric or imperial measurements by setting the MEA-

SUREINIT system variable. (System variables are discussed further in Chapter 5.) On the command line,
type measureinit. Enter 0 .J for imperial units and 1  for metric units.

The default template is acad. dwt for AutoCAD and acadlt.dwt for AutoCAD LT. Another default tem-
plate is acad -Named Plot Styles.dwt or acadlt -Named Plot Styles.dwt, which refers to
named plot styles. (See Chapter 17.)

FIGURE 2.1

Choose a template from the Select Template dialog box.
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STEPS: Opening a Drawing Based on the Default Template

1. Start AutoCAD or AutoCAD LT.
2. Choose Menu Browser = File = New.
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3. From the Select Template dialog box, choose acad. dwt (for AutoCAD) or acadlt.dwt (for
AutoCAD LT) from the list.

4. Click Open. You now have a blank drawing named Drawing2 . dwg, as shown in Figure 2.2.

FIGURE 2.2

When you create a drawing based on a template, AutoCAD or AutoCAD LT creates a new drawing.
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The default workspace is 2D Drafting & Annotation. However, you can choose another 2D

. 55 workspace, AutoCAD Classic (for AutoCAD) or AutoCAD LT Classic (for AutoCAD LT), from
the Workspace Switching pop-up button on the right side of the status bar. For 2D drawing, make sure that

you’re not in the 3D Modeling workspace if you are using AutoCAD. I discuss workspaces in Appendix A.

In both AutoCAD and AutoCAD LT, you may see palettes (windows) open that you don’t want to use right
now. You can close these by clicking their Close (X) buttons.

Working with Templates

A template contains ready-made settings to get you started drawing quickly. These settings include the size
of the drawing (called limits), the unit type (such as decimal or feet and inches), and others. An important
part of setting standards in an office where people work together on drawings is the creation of a template
so that all users work with an identical setup. Templates may contain more than just settings — they often
contain a complete titleblock, for example, and may include boilerplate (standardized) text as well.

I In Chapter 5, 1 explain the options available for setting up a drawing. In Chapter 26, I cover
the process of setting standards for drawings.

Customizing the default template

Most people customize the default template to create one or more templates that suit their particular needs.
After your templates are created, you don’t have to worry about most settings; they are already available for
you, and you can quickly start to draw.

To customize acad.dwt or acadlt.dwt, follow these steps:

1. Create a drawing based on a template as described in the previous section.
2. Make any changes you want.

3. Click Save on the Quick Access toolbar.

4

In the Save Drawing As dialog box, click the Files of Type drop-down list box. Choose AutoCAD
Drawing Template or AutoCAD LT Drawing Template (* . dwt). In the list of template files,
choose the template that you want to customize. Click Save.
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5. When asked if you want to replace it, click Yes.

In the Template Options dialog box, revise the description as you like. (For information about the
New Layer Notification option, see Chapter 26.)

7. From the Measurement drop-down list, choose English (Imperial) or Metric, depending on the
type of units you plan to use.

8. Click OK.

If you’re using someone else’s computer, don’t change the templates that come with AutoCAD
=28 or AutoCAD LT without first checking with the computer’s owner. Also, if you create new tem-
plates, put them in their own folder to avoid losing them when you upgrade or reinstall AutoCAD.

Creating your own templates

You may want several templates to choose from on a regular basis. For example, you may create drawings of
several sizes. AutoCAD and AutoCAD LT let you create as many templates as you want. To create your own
templates, either start a drawing based on a template and make the changes you want, or open an existing
drawing that already has some of the settings you want and make any further changes you need. Follow
these steps:

1. If you start a new drawing based on a template, choose Save from the Quick Access toolbar. If you
open an existing drawing, choose Menu Browser = File &> Save As from the menu.

2. Make any changes you want.

3. In the Save Drawing As dialog box, click the Files of Type drop-down list box. Choose AutoCAD
Drawing Template or AutoCAD LT Drawing Template.

In the File Name text box, type a name for your template. Click Save.

5. In the Template Options dialog box, enter the description as you want. From the Measurement
drop-down list, choose English (Imperial) or Metric, depending on the type of units you plan to
use. (I discuss the New Layer Notification option Chapter 26.) Click OK.

I Name your templates in a way that clearly differentiates them from regular drawings. You may
SAEES want drawings set up for each of the standard paper sizes (A through E), with a titleblock in
each Useful names might be tb-a.dwt, tb-b.dwt (tb meaning titleblock), and so on.

Most AutoCAD and AutoCAD LT users take advantage of these techniques as a standard practice. You can
usually make profitable use of a template as the basis for a new drawing.

Creating a Drawing with Default Settings

Occasionally, you may want to create a drawing without any settings. It is actually impossible for a drawing
to have no settings at all, but you can create a drawing with the minimum possible presets. You might want
to do this if you're working on someone else’s computer and don’t want to take the time to get rid of a large
number of complex settings that aren’t helpful for your work.

To create a drawing with the fewest possible settings, choose Menu Browser = File &> New. Instead of choos-
ing a template, click the arrow to the right of the Open button (see Figure 2.1). Choose one of the following
options:

B Open with No Template — Imperial

B Open with No Template — Metric



Opening a Drawing

Opening an Existing Drawing

Often you need to open an existing drawing, either to complete it or to make changes. Opening a drawing
in AutoCAD or AutoCAD LT is like opening a file in any Windows program. You can find existing drawings
by name or by viewing a thumbnail, or preview image, of the drawing.

Choose Open from the Quick Access toolbar, or choose Menu Browser = File &> Open. The Select File dia-

ﬁ log box appears, as shown in Figure 2.3. In the Look In drop-down list box, choose the drive where your
drawing resides. In the main box, double-click the folder you need. Then choose your drawing. You can
also use the Places list at the left side of the dialog box to find drawings. The Preview box enables you to
quickly look at the drawing to see if it’s the one you want. (If you don’t see a preview, choose Preview from
the Views drop-down list in the dialog box.) Click Open. The drawing opens.

FIGURE 2.3

The Select File dialog box is equivalent to the Open dialog box in most Windows programs.
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= If you have opened the drawing recently, choose Menu Browser > Recent Documents (from
@ the bottom of the Menu Browser window) to display the list on the right. You can change the
number of drawings that appear on the list. Choose Menu Browser => Tools => Options and click the Open
and Save tab. In the Number of Recently Used Files text box, enter a number from 0 to 50.

At the top of the file list, click the arrow button to choose Ordered List (alphabetical — the default), Group
by Date, or Group by Type (file type). At the upper-right corner is a small button that you can click to view
icons or small, medium, or large images of the files. When you hover the cursor over any drawing, a panel
displays, showing you a preview of the drawing, the full path location, the last date it was modified, the
release version, and the last person who saved the drawing. Finally, you can click the Pin icon next to a
drawing to stick it to the list; the file remains there until you “unpin” it. All these features can help you easily
find the drawing you want.
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FIGURE 2.4

I5

Using other ways to open drawings

You can double-click a drawing in Windows Explorer to open it. If AutoCAD or AutoCAD LT is not run-
ning, Windows loads the program and the drawing as well. If AutoCAD or AutoCAD LT is running and a
drawing is active, the drawing opens as a second drawing within the program.

You can also open a drawing from the DesignCenter —a feature for managing both drawing files and many
of their components. First, choose View tab = Palettes control panel = DesignCenter from the ribbon. The
DesignCenter palette opens, displaying an Explorer-like list of drawings in the left pane. (If you don't see
the list of drawings, click the Tree View Toggle button on the DesignCenter toolbar.) Navigate to the folder
containing the drawing and choose the drawings folder in the left pane. The drawings in the folder are
listed in the right pane. Right-click the drawing of your choice and choose Open in Application Window.
For more information on the DesignCenter, see Chapter 26.

You can open a drawing using the Sheet Set Manager (AutoCAD only). I cover sheet sets in Chapter 26.

Switching among open drawings

When you open more than one drawing, by default, AutoCAD and AutoCAD LT display only one button on
the Windows task bar. If you want to display a separate task bar button for each drawing, type taskbar on
the command line and press Enter. At the Enter new value for TaskBar <0>: prompt, type 1 and
press Enter. Then you can click any drawing’s button to display that drawing.

If you're using the default task bar setting, switch from drawing to drawing in one of the following ways:

B Choose Menu Browser & Open Documents (at the bottom of the Menu Browser window), and
choose from the files listed on the right.

B Click the Quick View Drawings button on the status bar to display previews of all the open draw-
ings, as shown in Figure 2.4. Above the drawings, you see a second level, showing model space
and layouts (which I cover in Chapter 17). Click the drawing, or layout, that you want to display.
The small toolbar below the drawings lets you pin them (so they remain displayed), start a new
drawing, open an existing drawing, and close the Quick View display.

= Quick View is a new feature for AutoCAD 2009 and AutoCAD LT 2009; it offers an easy way to
& see, and switch among, open drawings.

The Quick View feature lets you see other open drawings and switch among them.
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Opening a Drawing

. B v The drawing used in the following exercise on opening a drawing, abgs-01 . dwg, is in the
b f*.(‘- U=t Results folder of the AutoCAD 2009 and AutoCAD LT 2009 Bible DVD.

STEPS: Opening a Drawing

If AutoCAD or AutoCAD LT is not open, start the program.
Click Open on the Quick Access toolbar.

ﬁ In the Select File dialog box, choose the drive for your DVD in the Look In drop-down list box.
In the main box, double-click the Results folder.

In the main box, click abgs-01 . dwg.

SR wN =

Click Open. The drawing opens. Keep this drawing open for the next exercise.

Using an Existing Drawing as a Prototype

Although a template can be very useful, if you plan to use the objects and settings in a drawing only a few
times, you can simply use one drawing as a prototype for other drawings. You may often need to draw a
series of related drawings — perhaps several related electrical schematics or a group of similar apartments in
an apartment complex. When a significant part of the first drawing is applicable to subsequent drawings,
don't start over — open an existing drawing, and immediately save it under a new name, as described in the
next section. Make the necessary changes and resave the drawing.

Saving a Drawing under a New Name

Whether you want to use an existing drawing as a prototype or simply make a copy of a drawing, you need
to save the drawing under a new name. First open the drawing and then choose Menu Browser = File &>
Save As.

In the Save Drawing As dialog box, type a new name in the File Name text box. Then click Save. You
may also want to change the location of the new drawing by changing the folder in the Save In drop-down
list box.

>y The drawing used in the following exercise on saving a drawing under a new name, abgs-01.
# dwg, is in the Results folder of the AutoCAD 2009 and AutoCAD LT 2009 Bible DVD.

STEPS: Saving a Drawing Under a New Name

1. If you have the drawing open from the previous exercise, use it. Or, if you did the exercise in the
Quick Start chapter, open abgs-01.dwg from the folder where you saved it. (I suggested the My
Documents or the AutoCAD Bible folder.) Otherwise, open the drawing from the Results
folder of the AutoCAD 2009 and AutoCAD LT 2009 Bible DVD.

= If you're using AutoCAD, make sure that the 2D Drafting and Annotation workspace is chosen
RS from the Workspace Switching pop-up menu on the right side of the status bar. Also, close any
palettes that may be open.

2. Choose Menu Browser = File &> Save As. The Save Drawing As dialog box opens.

3. In the File Name text box, change the filename to ab02-01.dwg. Choose your AutoCAD Bible
folder and click Save.
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4.

E -

6.

On the status bar, click the Model button.

Choose Home tab = Layers control panel = Layer Control. From the Layer Control drop-down

list, choose the DETAILING layer.

Choose Home tab = Draw control panel = Rectangle to start the RECTANG command. Follow the

prompts, entering the text in the Dynamic Input tooltip:

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/
wWidth]: -15,3 J

Specify other corner point or [Dimensions]: 12,6'1 .J

Again, start the RECTANG command. Leave the crosshairs to the right of the window and follow

the prompts:

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/
wWidth]l: 3'11,3 J

Specify other corner point or [Dimensions]: 12,6'1 J

Your drawing should look like Figure 2.5.

FIGURE 2.5

The window with added detailing.

m
un)
w

2_ge |

Click the drawing’s Close box, which is at the upper-right corner of the drawing area. Because you
haven't saved the changes to the drawing, a message asks if you want to save them.

9. Click Yes. AutoCAD or AutoCAD LT saves and closes the drawing.
10. Click the application’s Close box (X) to close AutoCAD or AutoCAD LT.
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Summary

In this chapter, you explored the various ways of opening a drawing. You learned the following:

Starting a new drawing based on a template
Customizing a template
Creating your own templates

Starting a new drawing with no template

Opening an existing drawing and switching among open drawings

B Saving a drawing under a new name

In the next chapter, you read about using commands.
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utoCAD and AutoCAD LT have been around for a long time. As a result,

the way you give the program commands — called the user interface —is

somewhat unique. You can give the same command in several ways. In
this chapter, you read about the various possibilities and start to get acquainted
with all of them.

Commands are important. In a word processing program, you can simply start
typing, and in a spreadsheet program, you can begin by entering data; but in
most cases nothing happens in AutoCAD or AutoCAD LT until you give it a
command.

The AutoCAD and AutoCAD LT
Interface

Many new commands have been added to AutoCAD and AutoCAD LT over the
years. Often, older commands that were no longer necessary were kept to main-
tain compatibility with earlier releases. A number of these older commands, as
well as certain rarely used commands, are not found in the menus. Other than
this idiosyncrasy, the menus are similar to those of other Windows programs.

Using the ribbon

You give AutoCAD and AutoCAD LT commands using the buttons on the ribbon.
The Home tab contains many of the commands that you use most often. The
ribbon is divided into control panels (panels, for short). Each panel contains a
related group of commands. Many of the panels have an arrow at their lower-
right corner that you can click to display more buttons for commands that you
don’t use as often.
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boxes, toolbars, and palettes

Working with Dynamic Input
and the command line

Repeating, canceling, undoing,
and redoing commands

Executing a command within
another command

Executing two commands
concurrently

Using the Help system
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The Screen Menu

I n early releases, AutoCAD provided a menu on the right side of the screen, called the screen menu. If you're
still using the screen menu, | suggest that you adjust to the new interface. You'll find its consistency with
other Windows programs to be an advantage.

If you must have the screen menu, you can easily display it. Choose Menu Browser => Tools = Options. Click
the Display tab. In the Window Elements section, choose Display screen menu. Click OK.

AutoCAD’s current default is to not show the screen menu, so | don’t use it in this book. Therefore, the word
menu always means the pull-down menu at the top of the AutoCAD screen. AutoCAD LT doesn’t offer a
screen menu.

= In place of the menus, toolbars, and the Dashboard, AutoCAD 2009 and AutoCAD LT 2009 use

B A= a ribbon, which is a horizontal, tabbed area at the top of the screen. The ribbon contains but-
tons Ilke a toolbar, but is wider. You can drag it to the right side of your screen to make it vertical, like the
Dashboard of the previous two releases. You can customize the ribbon, as I explain in Chapter 33. The rib-
bon is the user interface in the default workspace, 2D Drafting & Annotation. It’s also the user interface for
the 3D Modeling workspace that comes with AutoCAD (but not AutoCAD LT). You can return to the earlier
user interface by switching to the AutoCAD Classic or AutoCAD LT Classic workspace. Click the Workspace
Switching button on the right side of the status bar, and choose AutoCAD Classic or AutoCAD LT Classic
from the pop-up menu.

This book provides instructions for executing a command using the default workspace. To find the location of
a command in the Classic workspace, look up the command name (which I usually provide) in Help’s
Command Reference. | explain how to use the Help system at the end of this chapter.

To execute a command, click the tab that you need, and click the command’s button. If the button doesn’t
have a label, hover the mouse cursor over it to read its tooltip and a brief description of the button’s com-
mand. If you continue to hover a little longer, the description expands, explaining the command in more

detail.

The ribbon has several states that you can choose from to balance between convenience and space. Click
[E:I the button to the right of the Output tab to toggle between three states:

B Full ribbon: Displays the current tab and all its buttons

B Tabs: Displays one row of the tab names only

B Panel titles: Displays the tab names and the control panel names for the current tab
To move the ribbon to the right of your screen in a vertical configuration, right-click any blank space on the
tab bar, and choose Undock. The ribbon undocks and then functions like a palette, which I cover later in

this chapter. You can dock it on the right and auto-hide it. Right-click the gray, vertical title bar for more
options.

Using menus
s R\E u In the default workspace (2D Drafting & Annotation), the menus are hidden. You click

the menu browser to access them. Then click the menu you want to display its items on
the right. You can display the former menus by using the AutoCAD Classic or AutoCAD
LT Classic workspace; click the Workspace Switching button on the right side of the status bar and choose
AutoCAD Classic or AutoCAD LT Classic.
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Using Commands

A menu item can do three things — execute a command, open a submenu, or open a dialog box. As in all
Windows programs, the menu items provide clues to let you know what is going to occur after you click a
menu item, as follows:

B A right arrow opens a submenu with more options.

B Anellipsis (. . .) opens a dialog box.

B A plain menu item immediately executes a command.
Looking at the command line whenever you click a menu option is important. Any command that you
choose on a menu is repeated on the command line, and a prompt or list of options may appear. If you have
Dynamic Input on, the tooltip displays the prompt. (Click the Dynamic Input button on the status bar to

turn it on—and off.) See the section “Responding to commands” later in this chapter for more information
on what to do next.

The menu browser has four items at the bottom of the menu list:

B Recent Documents: Before you click any menu, you see a list of recently used drawings; click a
drawing to open it. To redisplay that list after clicking a menu, choose Recent Documents at the
bottom of the menu list.

B  Open Documents: Click to display the drawings that you have open. You can use the list to
switch from drawing to drawing.

B Recent Actions: Click to display recent commands that you've used. Choose an action to
repeat it.

B Options: Opens the Options dialog box. This item is on the bottom-most bar of the menu

browser.

3= In the menu browser, you can use the new Search box to search for a command. The results
ASE show you the menu picks to find that command. Choose Exit AutoCAD at the lower-right cor-
ner of the menu browser to close AutoCAD.

Using shortcut menus

Shortcut menus appear when you right-click your mouse. The purpose of shortcut menus is to speed up
your work; they can be faster than using the command line because you don't have to take your eyes off the
screen. The shortcut menus try to anticipate the most common tasks you might want to complete. As a
result, the menu that appears when you right-click depends on the situation:

B If you have neither started a command nor selected any objects, you get the default menu when
you right-click in the drawing area. Here you can cut, copy, paste, undo, pan, zoom, and so on.

B If you've selected any objects, you see the edit-mode menu, which lists the most common editing
commands.

B If you've started a command, the command-mode menu opens, letting you choose an option for
that command. I explain this in more detail later in this chapter.

B  When a dialog box is open, you can right-click active sections to see the dialog-mode menu,
which varies with the dialog box.

B Other menus include the toolbar list you get when you right-click a toolbar and the command-
line history you see when you right-click the command line and choose Recent Commands.

These menus are explained as appropriate throughout this book. You also have an opportunity to use many
of them in the exercises.
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In earlier releases, right-clicking was equivalent to pressing Enter. You can customize how right-clicking
works —and that includes changing it back to the way it worked in earlier releases. Choose Menu Browser &>
Tools = Options and choose the User Preferences tab. Then click the Right-click Customization button. For
more information, see Appendix A.

When you set right-click customization, you can turn on time-sensitive right-clicking. Time-
sensitive right-clicking is a great feature that gives you the best of two worlds — the right
mouse button can be used both as an equivalent to pressing Enter and as a way to open the shortcut menus.
If you turn on time-sensitive right-clicking, a quick right-click is equivalent to pressing Enter and will repeat
the last command or end any commands that require Enter to end. A longer right-click (hold your finger

on the mouse button slightly longer) opens the shortcut menu. You can specify the length of time required
for the longer right-click, which is 250 milliseconds by default.

Using dialog boxes

Dialog boxes offer the user a simple way to control AutoCAD or AutoCAD LT without memorizing a lot of
technical commands and option names. They guide you through a task by clearly laying out all the choices.

If you're familiar with any other Windows program, you're familiar with dialog boxes. As a brief example,
look at the Hatch and Gradient dialog box (choose Home tab = Draw control panel = Hatch), which
enables you to specify how you fill enclosed areas. This dialog box has most of the common features of a
dialog box and is shown in Figure 3.1. (The AutoCAD LT version of this dialog box doesn’t include the
Gradient tab.) I cover this dialog box in detail in Chapter 16.

B You can enter mathematical expressions for values in dialog box text boxes; start an expression
; & with an equal sign (=). For example, in the Angle box in Figure 3.1, you can enter =20+10.
Press Alt+Enter to complete the process. You can also enter mathematical expressions in palette text boxes.

' If a dialog box has a question mark (?) icon in the top-right corner, click it to change the cur-
& sor to a question mark. Then click an item in the dialog box to display a brief explanation of
that item. Also, many drop-down lists let you enter text as well as choose an item from the list. For example,
in the text box of the Angle drop-down list in Figure 3.1, you can type an angle, such as 32, that is not on the
drop-down list.

When you've finished using a dialog box, click OK to accept any settings you specified, or click Cancel to
discard any changes.

Using toolbars

Toolbars provide a quick way to execute a command with one click of the mouse. If you're not sure what a
toolbar button does, hover the cursor over a button and read the tooltip.

= In the default 2D Drafting & Annotation workspace (and in the 3D Modeling workspace in
#ds=d AutoCAD only), no toolbars are displayed, except for the Quick Access toolbar. Instead, you
use the ribbon to execute commands, as described earlier in this chapter. To display the toolbars from previ-
ous releases, switch to the AutoCAD Classic or AutoCAD LT Classic workspace; click the Workspace
Switching button on the right side of the status bar and choose AutoCAD Classic or AutoCAD LT Classic.

‘EEATUR.E The Quick Access toolbar contains a few often-used commands, starting with QNEW, OPEN,
mdinsietdast QSAVE, PLOT, UNDO, and REDO. In Chapter 29, | explain how to customize the tools that
are on this toolbar.

When you click a toolbar button, in order to complete the command, you usually need to look at the
Dynamic Input tooltip or the command line to follow the prompts there. I explain the command line
and Dynamic Input later in this chapter.



FIGURE 3.1

Using Commands

The Hatch and Gra

dient dialog box is typical of many AutoCAD and AutoCAD LT dialog boxes.
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When you work in the AutoCAD Classic or AutoCAD LT Classic workspace, you have many more toolbars.
Here are some points about the toolbars in the AutoCAD Classic and AutoCAD LT Classic workspace:

toolbar th
AutoCAD

A few of the toolbars have flyouts, attached toolbars containing additional buttons. For example,
on the Standard toolbar, the Zoom button has a tiny arrow on its lower-right corner. Click and
hold a second and the flyout flies out, revealing several other buttons, all related to zooming in
and out. Drag down and choose any one of the options.

To display a toolbar, right-click any toolbar and choose the toolbar you want to display. Displayed
toolbars have a checkmark next to their name. To hide a toolbar, follow the same procedure —
choose the toolbar to deselect it.

To display the Express Tools (AutoCAD only) or Autodesk Impression toolbar, right-click in

the gray space outside any toolbar. From the shortcut menu, choose EXPRESS and then the

at you want to display. (Autodesk impression is another Autodesk product that works together with
to create models that look hand-drawn.)

As soon as a toolbar is open, you can close it by clicking the Close button at the upper-right cor-
ner, as long as it is not docked — that is, parked at one edge of the screen. Toolbars can float within
the drawing area or even outside the application window (when it is not maximized). You can
move them by dragging them, and reshape them by dragging any edge. To dock a floating toolbar,
drag it by its title bar to any edge of the application window. Docked toolbars have grab bars
(which look like a double line) at one end; grab bars enable you to easily undock and move the
toolbars.
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FIGURE 3.2

To prevent a toolbar from docking as you move it to the edge of the screen, press Ctrl as you
L =8 drag. To close all the toolbars and palettes, press Ctrl+0. You now have more space to draw. To
get back your toolbars and palettes, press Ctrl+0 again.

Using palettes

A palette is a window that you can dock or float (like a toolbar). Palettes combine related functions in one
place. AutoCAD and AutoCAD LT have several palettes that are covered throughout this book. To see
palettes only when you need them, you can auto-hide them. Right-click the palette’s title bar and choose
Auto-hide from the shortcut menu. To dock a palette, choose Allow Docking from the same shortcut menu.

You can dock and auto-hide a palette. Right-click the palette’s title bar and choose Anchor

S5 Right or Anchor Left. The palette collapses to a thin vertical strip and opens only when you
hover the mouse cursor over it. You can also anchor more than one palette on a site. They fit together on the
right or left side and unroll to their full length when you hover the cursor over them.

Tool palettes

Tool palettes are another way to give AutoCAD and AutoCAD LT commands. To open the Tool Palettes win-
dow, shown in Figure 3.2, choose View tab = Palettes control panel = Tool Palettes. The palettes are actually
a collection of tabs that are used to organize tools with similar functionality. Because of the number of tabs,
some of the tabs are bunched up at the bottom. To choose these tabs, right-click those bottom tabs and
choose a tab from the list that appears. The AutoCAD LT Tool Palettes window contains fewer tabs, and
some of the tabs are slightly different.

The Tool Palettes window, shown in AutoCAD.
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FIGURE 3.3

Using Commands

Each of the items on a tool palette is a tool. The tools on the Command Tool Samples tab contain com-
mands that you can use. For example, you can draw a line by clicking the Line tool. The effect is the same
as choosing Home tab = Draw control panel = Line.

The first two tools have flyouts, which are like toolbar flyouts. Click the small arrow and the flyout
appears, containing other command buttons. Click the command button that you want in order to start
that command.

T You can use tool palettes to insert objects, fill in closed areas, and add other content. For more
iBA==idl information, see Chapter 26. | also explain how to customize tool palettes in Chapter 29. For
example, you can put custom commands on a tool palette.

The Command Line and Dynamic Input

You can execute a command by typing it directly on the command line, directly to the right of the
Command: prompt. The command line is a place to enter commands as well as coordinates and values, as
shown in Figure 3.3.

The command line.

[

Commana:
| Counmand ;

Command:

toolpalettes

The command line is actually a window that you can move like a palette. By default, it is docked at the bot-
tom of the drawing area. The window usually shows three lines of text, the Command: prompt, where you
type, and two lines of text from the previous command. You can drag the top edge of the window to display
more than three lines.

By default, AutoCAD and AutoCAD LT display the command line. You can hide the command-
WSS line window using the COMMANDLINEHIDE command, and display it with the COMMAND-
LINE command. An easier way is to press Ctrl+9, which toggles the Command window on and off. Another
option for the command line is to undock the Command window, right-click the window’s title bar on the
left, and choose Auto-hide. The Command window collapses to its title bar until you place the cursor over it.

Commands that you choose from the ribbon, a toolbar button, a menu, or a tool palette are all echoed on
the command line.

Using Dynamic Input

You can use the Dynamic Input feature to execute commands that you type. Dynamic Input displays what-
ever you type in a tooltip box near the cursor. Dynamic Input also displays prompts at the cursor, so that
you don’t have to look down at the command line. Note that Dynamic Input does not completely replace
the command line; in some situations the command line displays necessary prompts that the Dynamic
Input tooltip omits. For more information about Dynamic Input settings, see Chapter 4.

You can turn Dynamic Input on and off using the Dynamic Input button on the status bar. When Dynamic
Input is on, a tooltip box echoes what you type, displays prompts, and then displays your responses at the
cursor as you type, as shown in Figure 3.4. This input is echoed on the command line after you press Enter.
When Dynamic Input is off, commands and other input that you type appear on the command line only.
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FIGURE 3.4

The Dy

namic Input tooltip prompts you for input and then displays your input as you type.

. T—

TABLE 3.1

clrcle

Specify center point for circle or B m 4]

Understanding command names

All commands have a special one-word command name. This may or may not be the same as the wording
that appears on the toolbar’s tooltip or on the menu. However, you can be sure of one thing: every com-
mand can be executed by typing its name on the command line or in the Dynamic Input tooltip. Fast typ-
ists often prefer to type the command because they find it faster than searching for a command on the
ribbon, a menu, a toolbar, or a palette. Most users use a combination of the command line and other user
interface options.

Some of the commands are easy to type, such as LINE or ARC. Others are long and harder to remember,
such as HATCHEDIT, DDPTYPE, or EXTERNALREFERENCES. Command names such as these can quickly
drive you to use a menu or toolbar.

= If you like typing commands, you can create short versions of the command names, called
=248 aliases. Many are already included with AutoCAD and AutoCAD LT. Aliases are covered in

Chapter 29.

You can edit what you have typed on the command line. If you type a long command or a difficult coordi-
nate, and make a mistake, you can backspace up to the mistake and retype the last part correctly. Table 3.1
shows how to use the keyboard edit keys to edit the command line.

B When you start to type a command, and you aren’t sure of the exact spelling, you can start

& typing what you know and then press the Tab key to cycle through all the possibilities in the
Dynamlc Input tooltip or on the command line. Press Enter when you see the command that you want. This
AutoComplete feature works for system variables (which I cover in Chapter 5) and command aliases as well.
For example, several commands start with “COPY”. You can type copy and then repeatedly press Tab to see
these commands.

Command-Line Editing Keys

Key Function

Backspace Backspaces through the text on the command line, erasing each letter as it backspaces.
Left arrow Moves backward through the text of the command, without erasing.

Right arrow Moves forward through the text of the command, without erasing.

Home Moves the command-line cursor to the beginning of the text.
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Key Function

End Moves the command-line cursor to the end of the text.

Insert Toggles between Insert/Overwrite modes. Insert mode inserts text. Overwrite mode types over
existing text. Note that there is no visual confirmation of which mode you are in.

Delete Deletes the character to the right of the cursor on the command line.

Ctrl+V Pastes text from the Windows Clipboard.

You can scroll through and reuse previous command-line entries. To repeat the last line you entered, press
the up arrow. Press Enter to execute it. To see more of the command-line entries, press F2 on your keyboard
to open the Text Window. Scroll until you find the entry you want, highlight it, and then right-click and
choose Paste To CmdLine from the shortcut menu. You now see the highlighted text on the current com-
mand line. You can copy selected text from the command-line history or the entire history to the Clipboard.
You can also choose Recent Commands from the Text Window’s shortcut menu and choose one of the com-
mands from the submenu that appears.

Switching from the mouse to the keyboard and back is time-consuming. In general, if you're

o =58 picking points using the mouse (covered in Chapter 4), using the ribbon and other graphic user
interfaces to give commands is faster. If you’re typing coordinates as you did in Chapter 1, your hands are
already at the keyboard, so typing commands at the keyboard is easier.

Responding to commands

When you execute a command by any method, you usually need to respond to the command. AutoCAD
displays a prompt that tells you what you need to do next.

The format for command prompts on the command line is as follows:
current instruction or [options] <current value>:

The current instruction explains what you need to do. For example, if you choose an editing command, the
prompt usually instructs you to “Select objects.” The text in the square brackets lists the various options
available for the command. The angled brackets tell you the current value or default option for the com-
mand, if any.

In the Dynamic Input tooltip, you first see the following;
current instruction or |

If the current instruction is to specify a point, you also see the cursor’s X and Y coordinates. Figure 3.5
shows a prompt for the CIRCLE command. After specifying the center of the circle, this command has a
current instruction to specify the radius, an option to specify the diameter, and a current value of 1.0000,
the radius of the previously drawn circle.

Throughout this book, I show the prompt as it appears on the command line, because this
&% prompt includes the options. If you are looking at the Dynamic Input tooltip, press the down
arrow to display the options at the tooltip or right-click to display the shortcut menu.
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To see the options and a current value (if any) in the Dynamic Input tooltip, press the down arrow on your keyboard.
=N _H“\
(-

\x__,_/

When you see a prompt, the possible types of responses are as follows:

fy radius of circle or

B Specify a point: You can pick a point by clicking with the mouse. You can also enter an X,Y coor-
dinate or displacement — whatever you type appears both in the Dynamic Input tooltip and on
the command line. Chapter 4 explains how to specify points.

B Enter a value or text: You type the value or the text and press Enter. If Dynamic Input is on, you
see your input as you type in the tooltip but you don’t see the value on the command line until
you press Enter. If Dynamic Input is off, you see your input as you type on the command line.

B Select an object: Most editing commands require that you select one or more objects. You can
click an object to select it. I explain all the other methods to select objects in Chapters 9 and 10.

B Choose an option. Many commands have options that you need to choose before continuing to
use the command. To choose an option using the command line, do one of the following:

Type the one or two letters that are capitalized in the option name — usually (but not always)
the first letter(s) of the option. You can type the letter(s) in lowercase. Press Enter.

Press Enter to choose a default option or current value.

Right-click in the drawing area and choose one of the options from the shortcut menu. This
works best for options that won't need any numerical input on the command line.

To choose an option using the Dynamic Input tooltip, press the down arrow on your keyboard to
display the options. If there is a default value, you see a mark next to it. Then click one of the
options.

At this point, additional options and prompts may appear; you respond in the same way that I have just
described, depending on the type of information that the command needs.

In the following exercise, you practice using command options and picking points on the screen with the
mouse.

STEPS: Using Command Options

1. Open a new drawing using the acad.dwt or acadlt.dwt template. Make sure that the 2D
Drafting & Annotation workspace is chosen from the Workspace Switching pop-up list at the
right side of the status bar. Close any palettes that may be open.

2. Choose Home tab = Draw control panel & Polyline. (A polyline can contain both line and arc seg-
n—:-} ments. I discuss polylines in Chapter 16.)
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3. Look at the command line and the Dynamic Input tooltip. (If you don't see the Dynamic Input
tooltip near the cursor, click the Dynamic Input button on the status bar.) You see the following
prompt:

Specify start point:

You also see the current coordinate location of the cursor in the Dynamic Input tooltip. Move the
mouse cursor anywhere in the middle of the screen, and click to specify the start point. This is
called picking a point.

4. Now you see the following prompts, the first on the command line and the second in the
Dynamic Input tooltip:

Specify next point or [Arc/Halfwidth/Length/Undo/Width]:
Specify next point or N

Suppose that you want to specify the width of the polyline. Because specifying the next point is
the main instruction, right-click to display the shortcut menu and choose Width, which is one of
the options. The program responds with the Specify starting width: prompt. Follow the
prompts:
Specify starting width <0.0000>: .5
Specify ending width <0.5000>: .25 .

5. The prompt to specify the next point returns. Move the mouse so that your cursor is away from
the first point that you picked and pick another point. You now see the same prompt repeated.

6. This time, you want to change the width. To specify the width this time, type w . Follow the
prompts:
Specify starting width <0.2500>: J to accept the default value.
Specify ending width <0.2500>: J to accept the default value again.

7. Move your mouse so that the new segment is at a different angle than the first one. Pick any point
on the screen. The same prompt appears again.

8. Press the down arrow to display the Dynamic Input shortcut menu. Choose Close from the menu.
AutoCAD closes the polyline so that you now have a triangle, and ends the command.

Do not save this drawing.

You may have noticed an underscore (_) before commands. This mark allows translation to for-
eign languages and can be ignored.

Command Techniques

To make working with commands easier, AutoCAD and AutoCAD LT offer shortcuts for repeating and can-
celing commands as well as sophisticated undo and redo options. You can also use certain commands in the
middle of another command.

You can have more than one command in process concurrently, one in each open drawing. You can switch
from one open drawing to another without interrupting your commands. For example, if you're in the mid-
dle of drawing a circle in one drawing, you can open a new drawing and start another command to get
some information you need for the circle. Then you can return to the first drawing and complete the circle.
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Repeating commands

The most common way to repeat a command you have just used is to press Enter. The most recent com-
mand appears again.

B You can also press the Spacebar at the Command: prompt to repeat a command you just used.
S8 This technique works well if you want to keep one hand on the mouse and use the other hand
to press the Spacebar.

If you know in advance that you'll be using a command several times, you can use another technique —
type multiple . At the Enter command name to repeat: prompt, type the command name on the
command line. The command automatically reappears on the command line. For example, you could type
multiple and then arc if you knew you were going to draw several arcs in a row. To stop repeating the com-
mand, press Esc.

B If you create a ribbon or toolbar button that executes a customized set of actions (as I explain
. &% in Chapters 29 and 33), right-click and choose the top option of the shortcut menu to repeat
the action of the custom button. You cannot press Enter to get this effect.

Using recent input

You may need to use the same input again and again. For example, you may want to draw several circles
with the same radius. You can use the recent input list to choose a recently used radius instead of typing it
again. You can access recent points, values (such as distances and angles), and text strings.

When you see a prompt for input, right-click and choose Recent Input from the shortcut menu. (In a few
instances, no shortcut menu is available, so you can't use this feature.) You can then choose one of the
recent input items from the list. You can also press the up or down arrows to cycle through the recent input
in the Dynamic Input tooltip.

The Recent Input feature displays items that are appropriate for the current prompt. For example, if the
prompt asks for a radius, you don’t see angles or X,Y coordinates; you see only lengths.

Canceling commands

Sometimes you start a command and then realize you don't need it. In this situation, you can cancel the
command and then choose a different command. Press the Esc key to cancel a command that you've already
started. The Command: prompt reappears.

In the following exercise, you practice the techniques for repeating and canceling commands, as well as
using recent input.

STEPS: Repeating and Canceling Commands

1. Start a new drawing using the acad.dwt or acadlt.dwt template. Make sure that the 2D
Drafting & Annotation workspace is chosen from the Workspace Switching pop-up list at the
right side of the status bar. Close any palettes that may be open.

2. Choose Home tab = Draw control panel &> Circle.
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3. Atthe Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:
prompt, pick a center point anywhere near the center of the screen.

4. Atthe Specify radius of circle or [Diameter]: prompt, type 2 . The circle appears in
the drawing area.

5. Press Enter. The CIRCLE commandss first prompt appears again.

6. Follow these prompts:

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:
Right-click and choose 2P from the shortcut menu.

Specify first end point of circle's diameter: Pick any point on the
screen.

Specify second end point of circle's diameter: Press Esc.

The prompts disappear.

7. Press the Spacebar. Looking at the Dynamic Input tooltip, you see the Specify center point
for circle or L : prompt. Pick any point on the screen.

8. At the Specify radius of circle or |: prompt, right-click and choose Recent Input =
2.0000 from the shortcut menu to create another circle with a radius of 2.

Do not save this drawing.

Undoing a command

Most Windows applications offer Undo and Redo commands. AutoCAD and AutoCAD LT are no different.
Some applications remember a list of your last few actions so that you can undo them one by one. AutoCAD
and AutoCAD LT remember every command you execute starting from the time you open a drawing. You
can therefore undo every action and return your drawing to its condition when you opened it.

Actually, there are a few obvious exceptions. For example, if you print a drawing, you can’t unprint it, and
you can’t unsave a drawing, either. Similarly, commands that provide you with information, such as the
coordinates of a point, cannot be undone.

i~ Some commands have their own undo options. I explain these undo options when I discuss
AL these commands throughout the book.

Each time you click Undo on the Quick Access toolbar, you undo one command. If you continue back to
ﬁ the first command of the session, you undo all the commands and get the message:

Everything has been undone

When you start the UNDO command, which you enter on the command line, you see the following
options:
Enter the number of operations to undo or [Auto/Control/BEgin/End/Mark/
Back] <1>:

Enter the number of operations to undo is the default instruction. If you type a number, such as 3,
you undo your last three commands. This action is equivalent to clicking the Undo button three times.
Table 3.2 explains the other options.
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Options of the UNDO Command

What It Does

Auto

Can be On or Off. Applies to a menu item that executes more than one command at a time. When
Auto is On (the default), the entire menu item is undone in one step. When Auto is Off, UNDO
undoes each step one at a time.

Control

Offers three suboptions. All, the default, gives you the full UNDO capability. None disables the
UNDO command. One enables you to undo only one step at a time, effectively turning the UNDO
command into the U command.

Begin

Works with the End option. This starts a group at the current point of the list of commands. Then,
when you use the End option, UNDO undoes all the commands in the group. The U command also
undoes everything within a group.

End

Marks the end of all commands in the group created using the Begin option.

Mark

This option works with the Back option. It is somewhat similar to the Begin option, but you can
place several marks as you work.

Back

When you use this option, AutoCAD or AutoCAD LT undoes only to the most recent Mark point. The
next Back option you use undoes to the Mark point before that.
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As you undo commands, the command line lists the commands that are being undone. Sometimes, you see
the word Group, which means that a group of commands is being undone. However, sometimes the word
Group is used even for a single command. This use of the word Group is not significant and can be ignored.

You can tell AutoCAD or AutoCAD LT to combine consecutive zooms and pans when you undo

S5 commands to help you quickly get back to your previous situation. Choose Menu Browser -
Tools = Options and click the User Preferences tab. Then check the Combine Zoom and Pan Commands
check box in the Undo/Redo section.

Using the Back option when no mark has been created undoes everything you have done in a drawing ses-
sion! Luckily, you get the following warning message:

This will undo everything. OK? <Y>

Type n < if you do not want to undo everything.

Redoing a command

If you undo a command, you might realize that you want to undo the undo. This is called redoing a com-
mand. Don't confuse redoing a command with repeating a command. Redoing only applies when you have
just undone a command.

The REDO command on the Quick Access toolbar redoes the effect of the previous UNDO command. You
can redo multiple UNDO commands.

The MREDO command lets you undo multiple UNDO commands at one time. You can enter it
% on the command line.

In the following exercise, you practice using the UNDO and REDO commands.
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STEPS: Undoing and Redoing Commands

1. Start a new drawing using acad.dwt or acadlt.dwt as the template. Make sure that the 2D
Drafting & Annotation workspace is chosen from the Workspace Switching pop-up menu on the
right side of the status bar.

2. Choose Home tab=> Draw control panel = Line.

3. Follow the prompts to draw one line, and press Enter to end the command.

4. Choose Home tab = Draw control panel = Arc.

5. Using the default options, pick any three points to draw an arc.

6. Choose Home tab=> Draw control panel = Circle.

7. Pick one point to be the center of the circle and another nearby point to specify the radius. Your
drawing now contains a line, an arc, and a circle, and looks something like Figure 3.6. Of course,
your objects will look different because you picked different points.

8. Click the Undo button on the Quick Access toolbar; the circle disappears.

9. Click the Undo button on the Quick Access toolbar; the arc disappears. Click the Undo button

again; the line disappears.

10. Click the Redo button on the Quick Access toolbar three times. All three objects reappear because
ﬁ they were undone by the previous UNDO commands.

Do not save this drawing. If you are continuing, keep the drawing on the screen for the next
exercise.

FIGURE 3.6

Your drawing should contain a line, an arc, and a circle.

| The OOPS command restores the most recently erased object or set of objects, even if you
have used other commands in the meantime. See Chapter 18 for further information.

Using one command within another command

Certain commands can be used within another command. These are called transparent commands. After a
transparent command is completed, the original command continues its regular operation. Many transpar-
ent commands help you display the drawing differently so that you can complete the original command
easily. Other transparent commands change settings. In fact, almost any command that doesn’t select objects,
create new objects, cause regeneration, or end the drawing session can be used transparently. When you
start transparent commands from the ribbon or menus, they are automatically transparent. If you want to
type a transparent command on the command line or in the Dynamic Input tooltip, you need to type an
apostrophe ( *) before the command name.
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In this exercise, you practice using transparent commands and two commands concurrently.

>y The drawing used in the following exercise on using transparent commands and two com-
& mands concurrently, abgs-01.dwg, is in the Results folder on the DVD.

STEPS: Using Transparent Commands and Two Commands Concurrently

1. From the previous exercise, you have a line, an arc, and a circle on the screen. If not, begin a new
drawing using acad.dwt or acadlt.dwt as the template and draw a line and an arc anywhere
on the screen. (You don’t need the circle.) Because you haven't saved this drawing, it is called
drawingl . dwg.

Y _ r ¥ If you start a new drawing, make sure that the AutoCAD 2D Drafting & Annotation workspace
SOMIES is chosen from the Workspace Switching pop-up menu on the right side of the status bar. Close
any palettes that may be open.

2. Choose Menu Browser & View & Zoom = Out. The drawing zooms out, appearing smaller.

3. Choose Open from the Quick Access toolbar and open abgs-01 . dwg from the Results folder
on the DVD. This is a drawing of a window from the Quick Start chapter.

4. Choose Menu Browser & Open Documents = drawingl . dwg to display your original drawing.
5. Choose Home tab = Draw control panel & Circle. The following prompt appears:

Command: Specify center point for circle or [3P/2P/Ttr (tan tan
radius)]: Pick any point at the center of your screen.
Specify radius of circle or [Diameter]:

6. At this point, say that you want to see the drawing closer up to properly decide where to place the
radius of the circle. Type 'zoom . The following appears on the command line. (You may need to
press F2 to see the entire prompt. Press F2 again to close the Text Window.) Follow the prompts.

>>Specify corner of window, enter a scale factor (nX or nXP), or

[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real
time>: 2x

Resuming CIRCLE command.

Specify radius of circle or [Diameter]:

7. Lets say that you want the radius to be equal to the width of the window in your other drawing.
Choose View tab = Window control panel &> Open Drawings = abgs-01 . dwg.

8. The dimension text clearly states that the window is 3'8" wide, which is 44 inches.
9. Choose View tab = Window control panel &> Open Drawings = drawingl . dwg.

10. Type 44  to create the circle. Type Zoom I on the command line, and then e ! to see the entire
drawing, including the circle that you just drew.

11. Close abgs-01.dwg. Do not save drawingl . dwg.
Looking carefully at the prompts for the transparent use of the ZOOM command, note three features:

B The ZOOM command is preceded by an apostrophe. This is the sign of a transparent command.

B The prompt for the transparent command is preceded by >>. This helps you distinguish between
the prompts of the original command and the transparent command that is embedded in it.

B When the transparent command is complete, the prompt tells you. In this case, you see
Resuming CIRCLE command.

Experiment using transparent commands, and you'll soon find them indispensable.
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Of Mice and Pucks

For the sake of simplicity, this book assumes that you're using a mouse, but some people use a digitizing
tablet and a puck (or a stylus). A typical digitizing tablet and puck are shown in Figure 3.7. A puck often
has more buttons than a mouse and also has crosshairs on a transparent area that you can use for accurately
picking points from a paper drawing.

FIGURE 3.7

A digitizer and puck.

The digitizing tablet is generally configured to include an area that represents the screen you draw on as
well as a customizable command area that you use for commands. This command area of the tablet func-
tions as another menu. Figure 3.8 shows the default tablet provided with AutoCAD. (AutoCAD LT has a
similar one.) Usually, you would customize the tablet to suit individual needs. Each square is equivalent to a
toolbar button and executes a command when you click it. The top area is left blank for you to include
your own commands. This area is often used to insert parts from a library of standardized parts. Examples
would be gaskets and valves in a mechanical drawing environment or doors and windows in an architec-
tural environment.
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The standard tablet menu.
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The square area in the right-center represents the drawing area. In this area, the puck functions like a
mouse to draw, as well as to access menus and dialog box options. The tablet can also be used for a process
called digitizing, which means transferring data from paper into AutoCAD or AutoCAD LT. This transference
is often done by putting a paper document directly on the tablet and using the entire tablet as a drawing
area. Because the puck has crosshairs on a transparent surface, you can pick points on the drawing, which
then become endpoints of lines, for example.

Getting Help

AutoCAD and AutoCAD LT have so many commands with so many options that every user needs help at
some time. AutoCAD and AutoCAD LT come with a very complete Help system. A complete set of links
and tabs makes navigating through the topics and finding related material easy.

"= See Appendix B for help that is available on the Internet and other resources for AutoCAD and
i AutoCAD LT.

Getting help on a command

The easiest way to get help on a command is to start the command and press F1. The Help screen for that
command opens up. Figure 3.9 shows the screen that opens when you type zoom I and then press F1.
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FIGURE 3.9

The Help screen for the ZOOM command.
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After you have opened the Help window one time, when you press F1 it may only cause the
il window to blink on the Windows task bar. Go to the task bar and click the blinking button to
open the Help window.

Finding help with Quickstart links

Quickstart links are hyperlinks that you find at selected locations to help you understand a feature or con-
cept. For example, if you choose Plot from the Standard or Standard Annotation toolbar, the Plot dialog box
opens with a link to more help on plotting. Some other locations for these links are on a new tool palette
and on the Sheet Set Manager (both discussed in Chapter 26). If the feature is new, the link goes to the New
Features Workshop, which I cover later in this chapter.

Using the main Help system

When you have a question, try the Help system. AutoCAD and AutoCAD LT come with the most complete
Help documentation I have ever seen in a program. Pressing F1 (with no command active) or clicking the
question mark at the right end of the ribbon opens the User Documentation window, shown in Figure 3.10.
Click the Show button to display four tabs to the left.

The Help system has three tabs that offer different ways of finding the help you need. You might need to
drag the border between the tabs and the right panel to see the rightmost tab.

The Contents tab

The Contents tab displays help organized by topic. It’s like the table of contents of a book. Double-click
the icon of a book to open that topic and see subtopics. Click a topic to see it displayed in the right panel.
Double-click Command Reference on the Contents tab to get help on commands and system variables.
Double-click User’s Guide for the “how-to” manual.

55



FIGURE 3.10
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The main Help window in AutoCAD.
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The Index tab

If you have an idea in your head but don't know the command name, you may want to use the index. The
index is an alphabetical listing of topics. In the text box, type the first few letters of the word or words for
which you want help. As you type, the list jumps to the closest match. When you've found the topic you
want, highlight it and click Display (or double-click it). Sometimes subtopics appear from which you can
choose.

The Search tab

The Search tab enables you to ask a question. Type a question or phrase in the text box and click the Ask
button. Choose a topic to display it on the right.

Working with Help screens

The Help screens have several features that you should know so you can make the best use of them. Many
of the topics displayed on the right have three tabs:

B Concept: The overall description
B Procedure: How to do it
B Quick Reference: Related commands and system variables or the documentation of a command,
for example, depending on the topic
After you arrive at the Help screen you want, look for links to related topics.

At the top of most screens are several buttons. The selection of buttons depends on which aspect of Help
you're accessing. These buttons help you navigate the Help system quickly and easily:
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B Hide/Show: Hides the left pane so that you can work and look at a Help screen at the same time.
When hidden, the button becomes a Show button that displays the left pane.

B Back: Returns you to the previous Help screen you viewed.

B Forward: Returns you to the Help screen you viewed before you clicked the Back button.

B Home: Displays the main Help window.

B Print: Prints the topic.

B Options: Offers further options such as going to the Home help page and refreshing the screen.

Using the InfoCenter

The InfoCenter is a simple way to access Help, the Communication Center, and Favorite resources. This
tool is located in the upper-right corner of the AutoCAD or AutoCAD LT window, as shown in Figure 3.11.

FIGURE 3.11

The InfoCenter gives you easy access to Help, the Communication Center, and your Favorite resources.
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InfoCenter Favorites

Communication
Center

Search Help

The Search field enables you to enter a search term and get results from the Help files and the New Features
Workshop. Enter one or more terms and press Enter. The results drop down, and you can choose the item
you want in order to open it in the Help window.

You can add your own resources to search through those, as well. Click the InfoCenter button
& B85S and click the Settings button to open the InfoCenter Settings dialog box. Click the New button
to add resources. You can add resources from the following file types: TXT, DOC, CHM, HLP, HTML, HTM,
PDF, and XML. This is a great place to reference your CAD Standards Manual and/or those of your clients.

You can also choose which of the standard resources you want to search, depending on your needs.

The Communication Center

The Communication Center tool in the InfoCenter shows Live Updates (software updates), subscription
announcements and lessons (for subscription members), articles, and tips. It also displays RSS feeds of the
knowledge base, blogs, and the discussion group. You can customize the settings. For more information, see
Chapter 26.

Favorites

These are quick links to items that you have tagged as useful. You can tag these items from your Search
results or in the Communication Center drop-down list. To the right of each item is a white star. Click the
star to turn it yellow and add it to the Favorites list.

In this exercise, you practice using the Help system.
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STEPS: Using AutoCAD Help
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1.

10.

11.

12.

13.

14.

15.

16.

If AutoCAD or AutoCAD LT is not open, start the program with the acad. dwt or acadlt.dwt
template. If the program is already open, you can do this exercise with any drawing on the screen.
Make sure that the 2D Drafting & Annotation workspace is chosen from the Workspace Switching
pop-up menu on the right side of the status bar. Close any palettes that may be open.

Choose Home tab = Draw control panel = Circle. At the prompt, press F1 on the keyboard.
The Circle Help screen opens. (If it doesn’t open, click the Help window’s button on the Windows
task bar.)

Click 2P (Two Points), which appears underlined. The 2P description appears. Read the descrip-
tion of the 2P option.

Click the Close button at the top-right corner of the Help screen. Press Esc to exit the CIRCLE
command.

Click the Help (question mark) button on the right side of the ribbon. Click the Help window’s
button on the Windows task bar. If the left, tabbed pane does not appear, click the Show button
in the Help window.

Click the Contents tab if it is not on top. Double-click User’s Guide. From the list, double-click
The User Interface and then click the plus sign next to The Ribbon, Menus, and Other
Tool Locations.

Click other Tool Locations, and then click Shortcut Menus. Read the text in the right
pane.

Click the Procedures tab in the right pane of the Help window. Click the To Display a Shortcut
Menu link and read the text.

On the left side of the Help window, click the Index tab.

In the text box at the top, type transparent commands. (Don't press Enter.) Double-click the
Transparent Commands item.

From the Topics Found window, double-click the Enter Commands on the Command Line
item.

In the right pane, scroll down until you see the Interrupt a Command with Another
Command or System Variable item and read the text.

In the left pane, click the Contents pane again. Scroll down and double-click Command
Reference, then double-click Commands.

Double-click Commands, and then click CIRCLE. You see the Circle Help screen again. You can
find help on any command from the Command Reference. Close or minimize the Help window.
In the AutoCAD InfoCenter window, type transparent commands in the Search text box and
press Enter. Choose Enter Commands on the Command Line (Concept). If necessary,
click the Help button on the Windows task bar. You should see the same content that you saw
previously.

Click the Close button of the Help window.
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Summary

In this chapter, you read all you need to know about how to use AutoCAD and AutoCAD LT commands.
Specifically, you read about:

Using the ribbon

Using menus and shortcut menus

Using dialog boxes

Working with toolbars

Using tool palettes

Understanding command names

Using and editing the command line

Using the Dynamic Input tooltip to enter and respond to commands
Responding to command options and using the command line and shortcut menus
Repeating and canceling commands

Undoing and redoing commands

Using transparent commands

Using a puck and digitizing tablet to enter commands

Getting help

In the next chapter, I explain how to specify coordinates, an essential skill before you start to draw.
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pecifying points in a drawing is one of the most fundamental tasks you do

in AutoCAD and AutoCAD LT. Unless you know how to specify a point,

you can’t draw anything real, whether a house or a gasket. Most objects
you draw have a specific size, and you need to specify that information. You

draw lines, arcs, and circles by specifying the coordinates of points on the screen.

As with most tasks, AutoCAD and AutoCAD LT offer many ways to accomplish
this.

Understanding the X,Y
Coordinate System

AutoCAD and AutoCAD LT work the same way as the graphs with X and Y axes
that you plotted in high school. Look at two displays of the User Coordinate
System (UCS) icon, as shown in Figure 4.1. The UCS icon on the left is the
default for 2D drawing; the one on the right is the default for 3D drawing and
includes the Z axis. In this chapter, I focus on the X and Y axes.

C RO S R EF The UCS icon can take on different appearances. See Chapter

it | 8 for details. For information on the UCS icon in 3D work and
3D coordinates, see Chapter 21.
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Working with absolute, relative,
and polar coordinates

Using direct distance entry,
orthogonal mode, and polar
tracking

Using snap settings

Working with object snaps

Locating points
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FIGURE 4.1

The UCS icon shows the direction of the X and Y axes. If you're in a 3D display, you also see the Z axis.

R
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The X arrow points along the X axis in the positive direction. This means that as you go in the direction of
the arrow, the X coordinates increase. The Y arrow points along the Y axis in the positive direction. Using
this system, every 2D point on the screen can be specified using X and Y coordinates. This is called a
Cartesian coordinate system. The universal convention is to place the X coordinate first, then a comma (but
no space), and then the Y coordinate. By default, the intersection of the X,Y axes is 0,0. Use negative num-
bers for points to the left of the X axis or below the Y axis.

Drawing units

When you draw in AutoCAD or AutoCAD LT, you draw in undefined units. A line from point 3,0 to point
6,0 is three units long. While you're drawing, these units can be anything— a millimeter, a centimeter, a
meter, an inch, a foot, or a mile. In reality, you should know exactly what the units represent. After all, you
don’t want your 36-foot-wide house to end up 36 inches wide!

When you set up a drawing, you specify how units are displayed — for example, whether partial units show
as decimal points or fractions. (I cover units in Chapter 5.) However, you don't actually specify what the
units represent until you print or plot your drawing — covered in Chapter 17.

To ensure accuracy, you should draw full size. If you're drawing a plan for a factory that will be 120 feet
long, for example, you create lines with those measurements. On the screen, you can zoom in to see small
details or zoom out to see the whole factory, so that you have no reason not to use the actual line lengths.
It’s only when you need to print those 120-foot-long lines on a real sheet of paper that you have to specify
how to plot out your drawing at a reduced scale.

Types of measurement notation

Users are typically familiar only with the type of notation used in their own field of specialty, whether scien-
tific, architectural, engineering, or whatever. However, you should be at least somewhat familiar with all the
major forms of measurement notation.

If you are using engineering or architectural units, AutoCAD and AutoCAD LT display parts of

85 inches (fractions) differently than the format you must use to type them in. You must type in
coordmates without any spaces because in AutoCAD a space is equivalent to pressing Enter, and that ends
your input. Use a hyphen between whole and partial inches — for example, 3'2-1/2". (You can omit the "
after the number because inches are assumed in engineering and architectural units if no symbol follows a
number.) However, this appears on the status bar as 3'-2 1/2". This can be confusing because the hyphen is in
a different place, and you see a space between the whole and partial inches.
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Typing Coordinates

One of the more basic ways to specify the location of an object is to type its coordinates using the keyboard.
You can enter several types of coordinates. Use the type of coordinates that suit your specific situation.

I If you need to enter a coordinate that you've typed recently, use the Recent Input feature.
SUESS Right-click and choose Recent Input from the shortcut menu. Then choose the coordinate that
you want from the list that appears.

Using the Dynamic Input tooltip to enter coordinates

Dynamic Input enables you to enter text input near the cursor. In Chapter 3, I explained how to use
the Dynamic Input tooltip for commands and command options. Here I explain how to use it to enter
coordinates.

The Dynamic Input button on the status bar turns Dynamic Input on and off. Because you can look at the

+= tooltip near the cursor when you enter text, you can keep your attention on the drawing area, rather than
looking down at the command line. Dynamic Input applies to commands that you type, responses to
prompts, and coordinates.

Typing coordinates in the Dynamic Input tooltip

You can type 2D coordinates in the Dynamic Input tooltip in the same way you type them on the command
line —in the format x,y. You can press Tab between the X and Y coordinates instead of typing a comma,
but typing the comma is probably easier and therefore more accurate.

When you draw a line, after you specify the first point, you see only one tooltip box because AutoCAD
assumes that you want to enter only the distance, using the current angle of the temporary line shown on
the screen. However, as soon as you type a comma or press the Tab key, a second box appears so that you
can enter the Y coordinate, as shown in Figure 4.2. The same situation applies when you want to move or
copy an object and want to specify an X,Y displacement.

In Figure 4.2, note the lock next to the X coordinate. Before you type any part of the coordinate, both the X
and Y values vary as you move the mouse. When you enter a value for the X coordinate, you fix this value,
as the lock indicates. However, the Y coordinate is still unlocked until you type a value.

FIGURE 4.2

As you enter an X,Y coordinate, two boxes appear, one for each part of the coordinate.

Specifying Dynamic Input settings

You can specify how Dynamic Input works for coordinates that you type. Changing the settings gives you
very different results when you type coordinates, so you should familiarize yourself with the settings. To
specily settings for the Dynamic Input feature, right-click the Dynamic Input button on the status bar and
choose Settings to display the Dynamic Input tab of the Drafting Settings dialog box, as shown in Figure 4.3.

63



AutoCAD and AutoCAD LT Basics

FIGURE 4.3

Use the Dynamic Input tab of the Drafting Settings dialog box to specify how your Dynamic Input works when you
type coordinates.
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Pointer Input section. The Enable Pointer Input check box is selected by default, which means that the
Dynamic Input tooltip includes an input box where you can type coordinates at the start of any command.
If you uncheck this check box, you see these first coordinates only on the command line as you enter them.
However, whether the check box is checked or not, as long as the Dynamic Input button is selected on the
status bar, you see the input box for subsequent coordinates in a command. For example, if you are draw-
ing a line, and the Enable Pointer Input check box is not checked, you don’t see coordinates that you type
for the start point in the Dynamic Input tooltip, but for the next point, you see the input box and coordi-
nates that you type appear in that box.

Click the Settings button to open the Pointer Input Settings dialog box. Here you can make the following
choices:

B Default format for second or next points. You can choose to default to polar or Cartesian for-
mat. The default is polar format, which shows distances. I explain polar format in the “Polar
coordinates” section later in this chapter. You can also choose between relative and absolute coor-
dinates, as shown in Figure 4.4. The default is relative coordinates, which indicate a distance and
direction from a previously specified point. I explain both absolute and relative formats in the
next few sections of this chapter.

B Tooltip visibility. You can specify that you see the tooltip only when you start typing a point in
response to a prompt, automatically at a prompt for a point (the default), or always.

I The settings in this dialog box are very important for determining how all your coordinate

i entries work when Dynamic Entry is turned on. If you are upgrading from an earlier version
of AutoCAD, you are used to the entry of X,Y coordinates denoting absolute, not relative, coordinates.
However, with Dynamic Input turned on, the default is relative coordinates. This is a great default and will
speed up your coordinate entry, but could be very confusing if you are unaware of this setting or where to
change it.
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The Pointer Input Settings dialog box sets important options for Dynamic Input.

B Pointer Input Settings (5]
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Dimension Input section. The Enable Dimension Input Where Possible check box is selected by default.
This section has nothing to do with dimensions! Instead, it refers to distances or lengths as well as angles, as
opposed to points or coordinates. With this check box selected, after you indicate a first point, such as the
start of a line or the center of a circle, you see a dimension tooltip that shows the length of the line segment
or radius of the circle, as shown in Figure 4.5. You specify the length by typing in this tooltip. If you
uncheck the check box, you don't see this dimension tooltip.

FIGURE 4.5

The so-called dimension input tooltip shows distances and angles.
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Click the Settings button in this section of the dialog box to open the Dimension Input Settings dialog box.
Here you can change settings relating to dimension input during grip editing. I discuss grip editing in
Chapter 10.

(7!

S

= If you uncheck both the Enable Pointer Input and the Enable Dimension Input Where Possible
check boxes, you turn off Dynamic Input.

Dynamic prompts section. The Show Command Prompting and Command Input Near the Crosshairs
check box enables the display of command prompts and your input in response to these prompts in the
Dynamic Input tooltip. This part of Dynamic Input is supposed to take the place of the command line.
However, the prompts are not an exact echo of what you see on the command line, and certain prompts do
not appear in the tooltip.
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If you like Dynamic Input, try turning off the command line using the COMMANDLINEHIDE

&8 command or by pressing Ctrl+9. You can get the command-line window back with the
COMMANDLINE command or by pressing Ctrl+9 again. You can also undock the Command Line window,
right-click its title bar, and choose Auto-hide. Then, the Command Line window collapses to just its title bar;
when you place the cursor over it, it automatically expands again.

Click the Drafting Tooltip Appearance button to open the Tooltip Appearance dialog box. Here you can
change the color of the tooltip, change its size and transparency, and apply the settings to all drafting
tooltips in AutoCAD.

Overriding Dynamic Input settings

The default Dynamic Input settings ensure that your input in the tooltip is always interpreted as polar, rela-
tive coordinates. However, you may want to override this setting for an individual coordinate. You can over-
ride this setting by using a symbol before your X coordinate as you type it. AutoCAD provides three
overrides that you can use:

B Absolute: To override the default setting of relative coordinates and enter an absolute coordinate,
type #. For example, you could type #0,0 to specify the 0,0 coordinate. See the next section of
this chapter for more information on absolute coordinates.

B Relative: If you have set your Dynamic Input for absolute coordinates, you can enter @ to over-
ride the setting and type a relative coordinate. For example, you could type @3,4. See the
“Relative Cartesian coordinates” and “Polar coordinates” sections for a detailed explanation of
relative coordinates.

B World: Normally, coordinates that you type are interpreted in the current User Coordinate
System. The default coordinate system is called the World Coordinate System. If you have created
a custom coordinate system but want to enter a World Coordinate System coordinate, type *
before the X coordinate. For more information, see Chapter 8 (for two-dimensional drawings) and
Chapter 21 (for three-dimensional drawings).

To temporarily turn off Dynamic Input, press and hold the F12 key. You might do this while
you are picking points if you find that the tooltip obscures objects that you need to see. As
soon as you release the F12 key, Dynamic Input returns.

Absolute Cartesian coordinates

When you type a line and enter the actual coordinates, such as a line from point 3,2 to 6,9, you are using
absolute Cartesian coordinates. Absolute coordinates are measured from 0,0.

If you have Dynamic Input on with the default setting of relative units, you must enter the # symbol before
entering the X portion of an absolute Cartesian coordinate when specifying the second or next point, as
explained in the previous section. In this exercise, you practice entering absolute Cartesian coordinates.

STEPS: Entering Absolute Cartesian Coordinates

1. Start a new drawing using the acad.dwt or acadlt.dwt template. Close any palettes that may
be open.

2. If you have Dynamic Input on, right-click the Dynamic Input button on the status bar and choose
1= Settings. In the Pointer Input section, click the Settings button. In the Pointer Input Settings dia-
log box, click the Absolute Coordinates option (unless this option is already selected). Click OK
twice to return to your drawing.
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3. Choose Home tab = Draw control panel = Line. Follow these prompts:
Specify first point: -10,-5 J
Specify next point or [Undo]l: 21,-5 .
Specify next point or [Undol]l: 21,49 .
Specify next point or [Close/Undo]: -10,49 .
Specify next point or [Close/Undo]l: ¢ 4 (to close the rectangle)
Most of the lines are off the screen. By default, a new drawing starts with 0,0 at the lower-left cor-
ner of your screen; therefore, negative coordinates do not show.

4. Choose Menu Browser = View = Zoom = Zoom Out. If you still can’t see the entire rectangle,
choose Zoom Out again until you can see it.

' : If the prompt responds with Invalid Point or Point or option keyword required,
OIL - you have entered a coordinate incorrectly. Try typing the coordinate again. Also, don’t forget
that you can undo a command if you make a mistake. (See Chapter 3 for details.)

5. Start the LINE command again and follow these prompts:
Specify first point: -8,-2
Specify next point or [Undo]l: 19,-2 .
Specify next point or [Undo]l: 19,21.5 J
Specify next point or [Close/Undo]: -8,21.5 .
Specify next point or [Close/Undo]l: ¢ J
6. Once more, start the LINE command and follow these prompts:
Specify first point: -8,22.5 .
Specify next point or [Undo]: 19,22.5 J
Specify next point or [Undol: 19,46 .
Specify next point or [Close/Undo]: -8,46 .
Specify next point or [Close/Undo]l: ¢ J
7. 1If you changed the Dynamic Input settings in Step 1, you should change them back. Right-click
the Dynamic Input button on the status bar and choose Settings. In the Pointer Input section,
click the Settings button. In the Pointer Input Settings dialog box, click the Relative Coordinates
option. Click OK twice to return to your drawing.

8. Save this drawing in your AutoCAD Bible folder as ab04-01. dwg.
You can now see that you've drawn a simple window, as shown in Figure 4.6.

Two questions may have occurred to you during this exercise. First, isn’t there a better way of entering
absolute coordinates? Typing them in is slow and prone to error. Second, how do you know the absolute
coordinates for what you're drawing? Read on for the answers.

Relative Cartesian coordinates

In practice, you usually don’t know the absolute coordinates of the points you need to specify in order to
draw an object. Whether you're drawing an architectural layout, a physical object (as in mechanical draw-
ing), or an electrical schematic, you don't have X,Y coordinates from which you can work. However, you
often do have the measurements of what you're drawing. Usually, you start from any suitable point and
work from there. In this situation, you know only the length of the lines you're drawing (if you're drawing
lines). Real life doesn’t have a 0,0 point. Relative coordinates were developed for these situations.

67




AutoCAD and AutoCAD LT Basics

A window drawn with absolute coordinates.

Relative coordinates specify the X and Y distance from a previous point. They are called relative coordinates
because they have meaning relative only to a point previously specified. Suppose that you need to draw a
window. You can start the window from any point. From there, you have the measurements you need.

If you have Dynamic Input on—set to the default option of relative units —X,Y coordinates are automati-
cally relative. If you have Dynamic Input off or have set Dynamic Input to absolute coordinates, as
described earlier in this chapter, you specify that the coordinates are relative by using the @ symbol. For
example, if you start a line by picking any point with the mouse, and you know it should be two units long,
you can specify the next point as @2,0. The result is a line starting with the first point you picked and end-
ing two units along the X axis, as shown in Figure 4.7. The line is horizontal because the Y coordinate is 0.
In a relative coordinate, this means that the Y distance does not change.

FIGURE 4.7

A line whose start point could be anywhere and whose endpoint is specified with the relative point @2,0 is a hori-
zontal line two units long.

Start point End point=@2,0

Relative Cartesian coordinates are often used for lines drawn at 90-degree angles (that is, they are either
horizontal or vertical). These are called orthogonal lines. However, when you create a diagonal line from
point 3,3 to point @25, the length of the line is not immediately obvious.
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When you specify a positive number, such as the 2 in @2,0, the direction is positive. If you want to draw a
line in the negative direction of an axis, type a minus sign before the number. Figure 4.8 shows how to
draw lines in four directions using relative coordinates.

FIGURE 4.8

Drawing lines in the four orthogonal directions with relative coordinates. The arrow on each line shows the direction
of the line.

®
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Polar coordinates

Another common situation is to know the distance and angle of a point from either 0,0 or a previous point.
In this case, you can use polar coordinates, which can be either absolute or relative. Most commonly, you use
relative polar coordinates.

Polar coordinates take the form distance<angle. (To type the angle symbol, use the less-than symbol on your
keyboard.) If you have Dynamic Input on, set to the default options of relative coordinates, polar coordi-
nates are automatically relative. If you have Dynamic Input off or have set Dynamic Input to absolute coor-
dinates, as described earlier in this chapter, you need to add the @ sign before a relative polar coordinate. If
you also have the default option of polar format selected, you first see coordinates in polar format. Enter the
distance, press the Tab key, and then enter the angle. You can also type the angle (<) symbol instead of
using the Tab key. To switch to Cartesian format, just type a comma between the X and Y coordinates.

With Dynamic Input on, angles are measured from 0 to 180, with O to the right, going either clockwise or
counterclockwise. Watch the dotted lines near the angle’s tooltip to see exactly what the angle shown in the
tooltip is measuring. You can use negative angles. With Dynamic Input off, angles are measured counter-
clockwise, with 0 to the right, ranging from 0 to 360.

In the following series of steps, you draw part of a portico, the decorative molding above a door or window.
You'll use architectural units. In this case, only inches are used, which don’t need to be specified. You can
specify feet by using an apostrophe (also called a prime) after any number.

When typing architectural units, partial inches are indicated by fractions in the form a/b. You need to sepa-
rate the fraction from the whole inches by a hyphen. This can be a little confusing because the hyphen is
also used for negative numbers. For example, to draw a horizontal line of 5% inches in the negative direc-
tion of the X axis, you would type -5-1/4,0. (The 0 indicates no change in the Y axis because it is a horizon-
tal line.)
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‘ VD The drawing used in this exercise on using relative and polar coordinates, ab04-a . dwg, is in
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& the Drawings folder on the DVD.

STEPS: Using Relative and Polar Coordinates

1.
2.

4.

5.

6.

Open ab04-a.dwg from the DVD. Close any palettes that may be open.

As you move your mouse around, notice that the coordinates displayed on the status bar are in
architectural units (that is, in feet and inches). If the coordinates are grayed out, click them to
turn them on.

Save the drawing in your AutoCAD Bible folder as ab04-02 . dwg.

The next steps involve some complex typing. If you get an error message, try typing the coordi-
nate again. If you realize you made a mistake after ending the command, click Undo on the

Standard toolbar. This exercise assumes that you are using the default Dynamic Input settings of polar format
and relative coordinates and that Dynamic Input is on. See the “Using the Dynamic Input tooltip to enter
coordinates” section earlier in this chapter for details.

Choose Home tab = Draw control panel & Line to start the LINE command. Follow these

prompts:

Specify first point: Pick any point at the lower-left corner of your
screen.

Specify next point or [Undol: 0,-3/4 .

Specify next point or [Undo]: 75-1/4,0 J

Specify next point or [Close/Undo]: 0,3/4 J

Specify next point or [Close/Undo]l: ¢ J

Start the LINE command again. Follow the prompts:

Specify first point: J. This starts the line at the last endpoint you
specified.

Specify next point or [Undo]: 4-3/4,0 J

Specify next point or [Undo]: 43<40 .

Specify next point or [Close/Undo]: 43<-40 .J

Specify next point or [Close/Undo]: -2-1/4,0 J

Specify next point or [Close/Undo]: 39-7/8<140 .

Specify next point or [Close/Undo]: 39-7/8<-140 .

Specify next point or [Close/Undo]: J to end the command.

B In this exercise, you draw a line on top of a line, which is not good drawing practice. Later in
& this chapter and in upcoming chapters, you learn techniques to avoid this.

Save your drawing. You have created a portion of a portico, which goes over a window of a house,
as shown in Figure 4.9.

E You can type @ J at the first prompt of any drawing command to indicate the most recent
& coordinate specified.

Notice that using relative coordinates, both Cartesian and polar, is much more realistic than using absolute
coordinates. However, typing in coordinates is still awkward. Typing in coordinates is often the only way to
get exactly what you want. Nevertheless, several other techniques for specifying coordinates are easier in
many circumstances. I discuss these techniques in the next few sections.
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FIGURE 4.9

Part of a portico over a window, drawn using relative Cartesian and polar coordinates in archi-
tectural notation.

Direct distance entry

One shortcut for entering coordinates is direct distance entry. After you specify the start point of a line, at
the Specify next point or [Undo] : prompt, simply move the mouse cursor in the direction you want
the line to go and type in the line’s length. It works best in orthogonal mode or with polar tracking (dis-
cussed in the following section), which makes specifying exact angle easy.

You can use direct distance entry for any command that requires you to specify a distance and
a direction, including both drawing and editing commands.

Orthogonal mode

Lines drawn at 0, 90, 180, and 270 degrees are called orthogonal lines. When in orthogonal mode — ortho
for short— you can only draw orthogonal lines with the mouse. Ortho Mode also affects editing. For exam-
ple, with Ortho Mode on, you can only move objects vertically or horizontally. Combined with snap and
grid, Ortho Mode makes drawing easier and more efficient. Ortho Mode is also great for direct distance
entry.

Click Ortho Mode on the status bar to toggle Ortho Mode on and off. You cannot have polar tracking on at
the same time that Ortho Mode is on. Polar tracking is discussed next.

Orthogonal mode only affects points picked directly on the screen by using your mouse. Any
relative or absolute coordinates that you type in the Dynamic Input tooltip or on the com-
mand line override orthogonal mode. For example, if you use a polar coordinate of 5<45 in the Dynamic
Input tooltip, you’ll get a line at an angle of 45 degrees, even when Ortho Mode is on.

Polar tracking

Polar tracking guides you, using a tooltip and vector line, when you want to draw (or edit) at an angle other
than the four orthogonal angles, as shown in Figure 4.10. You can use polar tracking for orthogonal angles
as well. If you have Dynamic Input on, just look for the word “Polar” to distinguish between the Dynamic
Input and the polar tooltips.

Polar tracking makes it easy to use direct distance entry to specify distances for many angles. To use polar
tracking, you first set the angles that you want to use.
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Setting polar tracking angles

To set the angles, right-click the Polar Tracking button on the status bar and choose Settings. The Drafting
Settings dialog box opens, which you can see in Figure 4.11.

&

FIGURE 4.10

When polar tracking is on, a tooltip appears when you move the cursor close to one of the polar angles. Here you
see a tooltip indicating an angle of 45 degrees.

FIGURE 4.11

The Polar Tracking tab of the Drafting Settings dialog box.
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To set polar tracking, you can define two types of angles:

B Increment angle: To set the increment angle, click the Increment Angle drop-down arrow, where
you can pick from angles that range from every 90 degrees to every 5 degrees. You can also type
your own incremental angle in the text box. Polar tracking will then apply to that angle and its
multiples.

B Additional angles: If you think that you'll need other angles, check Additional Angles, click New,
and then type in an angle. You can add up to 10 additional angles. Note that additional angles
that you add are not incremental angles — if you type 35, only 35 degrees will be marked, not 70
degrees or other multiples of 35. To delete an additional angle, select it and click Delete.

On the right side of the dialog box, you can choose how polar tracking works with object snap tracking
(covered later in this chapter). You can set object snap tracking to use all the polar angle settings or limit it
to orthogonal angles only. You can also set whether polar angles are measured absolutely (relative to O
degrees) or relative to the segment drawn most recently. By default, absolute angles are used. To turn on
polar tracking, check the Polar Tracking On check box in the dialog box. If you are not in the dialog box,
press F10 or click the Polar Tracking button on the status bar.

&

To customize how polar tracking works, click Options in the Drafting Settings dialog box to open the
Options dialog box with the Drafting tab on top. The following settings in the AutoTracking Settings section
apply to polar tracking:

B Display polar tracking vector turns on and off the polar tracking vector, which is the faint dot-
ted line that extends to the end of the screen.

B Display AutoTrack tooltip turns on and off the tooltip that tells you the distance and angle.

Using polar tracking

To use polar tracking, you need to move the cursor slowly through the angles to allow time for the calcula-
tion and display of the vector and tooltip. Suppose that you're drawing a line. Specify the start point. To
specify the second point, move the cursor in the approximate angle of the line you want to draw. When you
see the polar tracking vector and tooltip, leave the mouse where it is and type the length of the line. Then
press Enter to create the line with the proper length and angle. You'll find this method easier than typing
polar coordinates for lines with angles specified in your polar tracking settings.

! Turn on NumLock on your keyboard and use the numerical pad for typing lengths. Use the
i Enter key on the numerical pad as well.

You can specify a polar angle for just one command. If you're drawing a line, after specifying the first point,
for example, type the angle preceded by the angle symbol (<). The next segment is then locked to that angle
while you type its length. A polar angle specified in this way is called a polar override angle because it over-
rides the current polar angles in effect. Of course, a polar override is not faster than simply typing a polar
coordinate, but it does let you see the angle of the line segment before you type its length.

In the following exercise, you practice using direct distance entry with Ortho Mode and polar tracking.

2y The drawing (ab04-b. dwg) used in the following exercise on using direct distance entry with
4 Ortho Mode and polar tracking is in the Drawings folder on the DVD.

STEPS: Using Direct Distance Entry with Ortho Mode and Polar Tracking

1. Open ab04-b.dwg from the DVD. Close any palettes that may be open. Check that polar track-
ing is set for 45 degrees, as described previously in this chapter.
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10.
11.
12.
13.

14.
15.

16.

Save the drawing in your AutoCAD Bible folder as ab04-03 . dwg. If Ortho Mode is not on,
click the Ortho Mode button on the status bar.

Choose Home tab = Draw control panel & Line to start the LINE command and, at the Specify
first point: prompt, type 2,2 .

Move the mouse horizontally to the right and then type .5 .
Move the mouse up vertically (in the 90-degree direction) and then type .5 .

Move the mouse horizontally to the right and then type 2 . Your drawing should look like
Figure 4.12.

FIGURE 4.12

Drawing with direct distance entry enables you to specify coordinates by typing in a length after
you move the pointer in the desired direction.

=
B —

Move the mouse up in the 90-degree direction and then type .5 .

Move the mouse to the left in the 180-degree direction and then type 2 .

Move the mouse up in the 90-degree direction and then type .5 .

Move the mouse to the left in the 180-degree direction and then type .5 .

Type ¢ J to close the figure. Press Enter again to end the command.

Click Polar Tracking on the status bar. The Ortho Mode button becomes deselected.

Start the LINE command again. Press Enter to start the new line from the most recent point. At
the Specify next point or [Undo] : prompt, move the cursor diagonally up and to the left
so the line is approximately in the 135-degree direction. When you see the tooltip confirming the
angle, release the mouse button and type .7071 .

Move the cursor up until you see the polar tracking tooltip confirming a 90-degree angle. Type .5 .

Move the cursor diagonally in the 45-degree direction until you see the tooltip. Type .7071 .
Press Enter again to end the LINE command.

Save your drawing. It should look like Figure 4.13.

FIGURE 4.13

The completed drawing of a bolt.
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Displaying Coordinates

As you work, you can refer to the coordinate display on the status bar. This display helps you know where
your cursor and objects are when you draw and is also helpful when editing, by informing you how far and
in what direction you are moving or copying objects.

I You can set the Dynamic Input tooltip to show coordinates all the time, even when you're not
& in a command. See the “Specifying Dynamic Input settings” section earlier in this chapter.

AutoCAD and AutoCAD LT have three coordinate display modes:
B Dynamic absolute coordinates (absolute): Absolute coordinates that change as you move the
mouse, as shown in Figure 4.14 on the left.

B Static absolute coordinates (off): Absolute coordinates that change only when you specify a
point, as shown in Figure 4.14 in the middle. The coordinate display is dimmed.

B Dynamic polar coordinates (relative): Polar coordinates that change continuously as you move
the mouse, as shown in Figure 4.14 on the right. They appear after you've already specified a
point and are ready to specify the next point, as when you're in the process of drawing a line.

FIGURE 4.14

Dynamic absolute coordinates, static absolute coordinates, and dynamic polar coordinates.

07409, 2.1450, 0.0000 03485, 3.0654 . 0.0000 1.4580< 23 . 0.0000

Dynamic absolute coordinates.  Static absolute coordinates. Dynamic polar coodinates.

The easiest way to change the coordinate display is to click the coordinates area on the status bar. You can
also right-click the coordinate display and choose Relative, Absolute, or Off from the shortcut menu.

For purposes of this chapter, I ignore the Z coordinate that follows the X and Y coordinates (in AutoCAD
only). In two-dimensional drawings, the Z coordinate is always zero.

In the following exercise, you practice using the coordinate display options. You can do this exercise with
any new or existing drawing open on the screen. If you have Dynamic Input on, compare the display in the
Dynamic Input tooltip and the display on the status bar.

STEPS: Using Coordinate Display Options
1. Look at the coordinate display on the status bar. It should be shown in black. If the coordinates
are shown in gray, click the coordinates.

2. Move the mouse around in a few directions. Notice how the coordinates constantly change with
the mouse movement.

3. Right-click the coordinates and choose Off. The coordinate display is grayed out.

Move the mouse around again. The coordinate display does not change with the movement of the
mouse.

5. Start the LINE command and pick any point on the screen.
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6. Watch the coordinate display as you pick any point at the Specify next point or [Undo] :
prompt.

7. Pick several other points and watch as the coordinate display changes only when you pick a
point. This is the static coordinate display.

Click the coordinates again without ending the LINE command.

9. Move the mouse to another point that you would like to pick, but watch the coordinate display
before you pick the point. This time, the length and angle of the new line segment are shown.
These are dynamic polar coordinates.

10. Pick a few more points, watching the polar coordinates.
11. Right-click the coordinates and choose Absolute to return to dynamic absolute coordinates.
12. Press Enter to end the LINE command. Do not save your drawing.

Picking Coordinates on the Screen

The easiest and quickest way to specify coordinates is to pick them directly on the screen with the mouse.
Several techniques are available to help you do so accurately.

You can adjust the size of the crosshairs that cross the cursor. By default, they are 5 percent of screen size.
To change the crosshair size, choose Menu Browser = Options, and click the Display tab. In the Crosshair
size text box, you can type a new percentage or drag the bar to increase or decrease the percentage. Click OK.

Snap settings
The SNAP command is often an alternative to tedious entry of coordinates. This command restricts the cur-
sor to an incremental distance that you choose, such as 0.5 units. You can set the snap size to anything you

want. For example, if all your measurements are rounded off to the nearest 0.25 units, you can set your
snap to 0.25.

The snap technique is not very useful when you need to draw to three or more decimal places of accuracy.
And when you're zoomed out in a large drawing, the snap points may be so close together that you cannot
easily find the one you want. But in the right situation, snap is one of the quickest, most accurate drawing
techniques available. AutoCAD and AutoCAD LT provide two types of snap settings, Grid Snap and
PolarSnap.

Snapping to a grid

When you snap to a grid, an invisible grid becomes active (which you can make visible using the GRID
command, discussed in the next section). As soon as you turn on Grid Snap, the mouse cursor can move
only to the Grid Snap points.

To set the snap size, right-click the Snap Mode button on the status bar and choose Settings. The Drafting
Settings dialog box opens, as shown in Figure 4.15. In the Snap X Spacing text box of the Snap Spacing sec-
tion, type the spacing you want between snap points. Make sure that Grid Snap and Rectangular snap are
checked in the Snap Type section of the dialog box. Click OK.



FIGURE 4.15
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The Snap and Grid tab of the Drafting Settings dialog box. (The AutoCAD LT dialog box is slightly different.)
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"= In Chapter 8, I discuss rotating the angle of the snap and grid. Chapter 8 also discusses
% Isometric snap, used for isometric drawing.

Usually you want the X spacing (going across) to be the same as the Y spacing (going up and down). By
default, the Equal X and Y Spacing check box is selected, so you need to specify only the X spacing; the Y
spacing changes automatically to equal the X spacing. X and Y spacing will be different only if you type a
different number in the Snap Y spacing box.

You can also turn snap on in this dialog box by clicking the Snap On check box. However, the most com-
:22! mon way to turn snap on, after you've set the spacing, is to click the Snap Mode button on the status bar
(or press the F9 key). Click it again to turn snap off.

Snapping at polar angles

After you set polar tracking settings, discussed earlier in this chapter in the “Polar tracking” section, you can
snap to increments along the polar angles you have set. When PolarSnap is on, the polar tooltip only shows
distances in increments of the snap setting. When you see the distance you want, just click. PolarSnap
makes it easy to draw accurately without having to type coordinates.

To use PolarSnap, follow these steps:
1. Right-click the Snap Mode button on the status bar and click Settings to open the Drafting
Settings dialog box with the Snap and Grid tab displayed.
Check PolarSnap in the Snap Type section of the dialog box (refer to Figure 4.15).
Type a distance in the Polar Distance text box.
Click OK to close the dialog box.
Click Snap Mode on the status bar.

ok oW
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FIGURE 4.16

Note that PolarSnap and Grid Snap are mutually exclusive. If PolarSnap is on, the cursor will not snap to
the grid. Used with polar tracking, PolarSnap is a powerful tool. Remember that you can polar track along

orthogonal as well as other angles.

You can choose either PolarSnap or Grid Snap (switch between them) by right-clicking Snap
Mode on the status bar. A shortcut menu lets you choose the type of snap you want, or turn

both off.

The grid

Sometimes you may find it helpful to see a grid of dots to help get your bearings while you draw, as shown
in Figure 4.16. If the dot grid is not visible, click Grid Display on the status bar or press the F7 key. Notice
how you can quickly judge the approximate width of a windowpane, knowing that the grid dots are half a
foot apart. If you turn on snap, the grid helps you visualize the snap points. However, the grid dots do not
have to be set to the same spacing as the snap points.

A portion of a drawing with the grid turned on and set to 6 inches.

sl¥zan|
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Thanks to Henry Dearborn, AlA, Fairfield, lowa, for this drawing.

Some users find the grid annoying, but when you first start to use AutoCAD or AutoCAD LT, you may find
it helpful. Even accomplished users can take advantage of the grid, especially when starting a new drawing.

If you’re working with a small snap spacing and the dot grid is too dense, set the dot grid to
two or more times the size of the snap spacing.

To set the grid size, right-click the Grid Display button on the status bar and choose Settings to open the
Drafting Settings dialog box (refer to Figure 4.15). In the X Spacing text box of the Grid Spacing section,
type the spacing you want between grid points. Click OK.

As with the snap feature, you usually want the X spacing (going across) to be the same as the Y spacing
(going up and down). You only need to specify the X spacing; the Y spacing automatically changes to be the
same, as long as the Equal X and Y Spacing check box is selected in the Drafting Settings dialog box. X and
Y spacing will only be different if you type a different number in the Y Spacing box.
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You can turn on the grid in this dialog box by clicking the Grid On check box, but its easier to click Grid
Display on the status bar (or press F7).

In the following exercise, you practice using Polar and Grid Snap points as well as grid dots.

I The drawing used in the following exercise on using snap points and grid dots, ab04-b . dwg,
is in the Drawings folder on the DVD.

STEPS: Using Snap Points and Grid Dots

1.
2.
3.

10.

11.

12.
13.

14.

15.

Open ab04-b. dwg from the DVD. Close any palettes that may be open.
Save the drawing in your AutoCAD Bible folder as ab04-04 . dwg.

Right-click the Snap Mode button on the status bar and choose Settings. The Drafting Settings
dialog box opens with the Snap and Grid tab displayed. In the Snap Type section, make sure that
Grid Snap and Rectangular snap are selected.

In the Snap Spacing section, the Snap X Spacing should be 0.5.

In the Grid Spacing section, the Equal X and Y Spacing check box should be selected. The Grid X
spacing should be 0.5. Click OK.

On the status bar, click Snap Mode, Grid Display, and Ortho Mode. The grid appears. Make sure
that the Object Snap and Object Snap Tracking buttons on the status bar are off.

Choose Menu Browser = View = Zoom = All.

Move the mouse around and watch the coordinates on the status bar. (Right-click the coordinate
and choose Absolute if they are in static mode.) They show halves of units because you have set
the snap to 0.5.

Choose Home tab = Draw control panel = Line to start the LINE command. At the Specify
first point: prompt, click when the coordinates on the status bar show 2.0000,2.0000.
(AutoCAD users can ignore the third Z coordinate, which is always 0.0000 in 2D drawings.) If
you have Dynamic Input on, you'll find the coordinates in the Dynamic Input tooltip easier to
read.

Move the mouse around and watch the coordinates. If you don’t see polar coordinates (for exam-
ple, 3.0000<0), right-click the coordinates and choose Relative.

Move the mouse to the right until the coordinates read 8.5000<0 and click the Pick button. You
have drawn a horizontal line with a length of 8.5 units.

Right-click and choose Enter to end the LINE command.

Move the mouse cursor away from the end of the new line and back to it again, and the absolute
coordinates appear. They should be 10.5000,2.0000.

Right-click and choose Repeat LINE to start the LINE command again. Use the coordinate display
to start the line at 1.5000,1.5000. (For the rest of this exercise, ignore the Dynamic Input tooltip.)
Continue to pick points (rather than type them) and draw the following line segments, as shown
in the coordinate display:

0.5000<0

3.0000<90

0.5000<180

3.0000<270

End the LINE command.
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FIGURE 4.17

16. Start the LINE command and pick points, drawing the following line segments (as shown in the
coordinate display) starting from 10.5000,1.50. Then end the LINE command:

0.5000<0
3.0000<90
0.5000<180
3.0000<270

17.  Starting from 2.0000,4.0000 draw an 8.5-unit line at O degrees. End the LINE command.

18. Start the LINE command again. At the first prompt, pick 11.0000,2.0000. Right-click the Snap
Mode button on the status bar and choose Settings. In the Snap Type section, choose PolarSnap.
(This is equivalent to choosing the PolarSnap On feature on the SNAP button’s shortcut menu.) In
the Polar Spacing section, change the Polar Distance to 0.5. Choose the Polar Tracking tab and set
the Increment Angle to 45 degrees. Click OK. Click Polar Tracking on the status bar.

19. Move the cursor in a 45-degree direction from 11.0000,2.0000 until you see the tooltip.
Move along the polar tracking vector until the tooltip says 3.5000 < 45° and click. End the
LINE command.

20. Right-click the Snap Mode button and choose Grid Snap On. Start the LINE command and, at the
Specify first point: prompt, choose 11.0000,4.0000.

21. Right-click the Snap Mode button and choose PolarSnap On. Move the cursor in a 45-degree
direction until the tooltip says 3.5000 < 45° and click. End the LINE command.

22. Save your drawing. Your drawing should look like Figure 4.17.

As you no doubt experienced, this is a much easier way to draw compared to typing in coordinates. Note
that drawing with Snap on works better when you're drawing small objects. However, even when drawing
an office building, you spend a great deal of time working on small details that may be easier to draw with
snap on.

The completed pipe section.
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Object snaps

Often you need to draw relative to an existing object. For example, you may need to start a line from the
endpoint or midpoint of an existing line. Object snaps (OSNAPS for short) enable you to precisely specify a
point by snapping to a geometrically defined coordinate on an existing object. Object Snap provides a very
precise and efficient way to draw.



Specifying Coordinates

Here are three ways to specify an object snap:
B Right-click, choose Snap Overrides from the shortcut menu, and then choose the object snap that
you want from the menu.

B Access the Object Snap shortcut menu by holding down the Shift key and right-clicking. Choose
the object snap that you want from the shortcut menu.

B Type the object snap’s abbreviation on the command line.
I On multibutton mice, you can customize one of the buttons to show the Object Snap menu.

<% Displaying the Object Snap menu with the click of a mouse button is very convenient.
Customizing the mouse is discussed in Chapter 33.

When you specify an object snap, a prompt for that object snap appears on the command line. For exam-
ple, if you choose a midpoint object snap, you see mid of on the command line. Unfortunately, the
Dynamic Input tooltip does not show this prompt.

T When you use Dynamic Input and object snaps together, the tooltip alternates between show-
ing the Dynamic Input tooltip and the object snap tooltip, or displays them as separate
tooltlps To keep all the tooltips together, set the TOOLTIPMERGE system variable to 1.

Table 4.1 lists the object snaps. Use the abbreviation to type the object snap from the keyboard.

TABLE 4.1

Object Snaps
Object Snap Abbreviation Uses
Endpoint End Lines, arcs, and so on.
Midpoint mid Lines, arcs, and so on.
Intersection Int Intersection of lines, circles, arcs.
Apparent Intersection* App The intersection that would be created if two objects were extended

until they met.

Extension Ext Extends lines, arcs, and so on past their endpoints but in the same
direction. After choosing this object snap, pause over the endpoint of a
line or arc until you see a small plus sign. As you move the mouse cursor
along the extension path, a temporary extension path appears so that
you can draw to or from points on the extension path.

Center Cen Circles, arcs, ellipses.

Quadrant Qua Nearest quadrant (0-, 90-, 180-, or 270-degree point) of a circle, arc, or
ellipse.

Perpendicular Per Arc, circles, ellipses, lines, multilines, polylines, rays, splines, or

construction lines. The Deferred Perpendicular mode lets you draw a
line perpendicular from one of these objects. Start the line command
and choose the Perpendicular object snap. Click the object that you
want to draw perpendicular from and then move the cursor away from
that object. You see the Deferred Perpendicular tooltip and a temporary
perpendicular line that follows your cursor along the original object. You
can then complete the perpendicular line.

continued
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Object Snap Abbreviation Uses

Parallel Par Continues a line, polyline, and so on so that it’s parallel to an existing
line or other straight-line segment. After you choose this object snap,
pause over the line you want to draw parallel to until you see a small
parallel line symbol. As you move the mouse cursor parallel to the
object, a temporary parallel path appears to help you create the parallel

segment.
Tangent Tan Starts or continues a line from or to a point tangent with an arc, circle,
or ellipse.
Node Nod Point objects (discussed in Chapter 7).
Insertion Ins Insertion point of text (see Chapter 13) or a block (see Chapter 18).
Nearest Nea Nearest point on any object.
None Non Turns off any object snap modes.

* Apparent Intersection also applies to 3D objects that appear to intersect because of the angle of view.

When drawing a line, think of it as having a starting point and an ending point. After the line is drawn,
however, both of these points are considered endpoints in terms of object snaps. When picking the end-
point of a line for the endpoint object snap, pick a point on the line closer to the endpoint that you want.
The same applies to arcs. Although the arc prompts read Start point and End, both are considered end-
points for purposes of object snaps.

AutoSnap is a feature that helps you work with object snaps. When you move the cursor near the geometric
point you have specified, such as an endpoint, you are notified in three ways:

B Marker: An object snap shape appears. Each object snap has a differently shaped marker.
B AutoSnap tooltip: A label displays the name of the object snap.

B Magnet: A pull gently moves the cursor toward the geometric point.

Figure 4.18 shows an endpoint marker and AutoSnap tooltip.

FIGURE 4.18

AutoSnap shows you the endpoint of the line.

= Marker

[Endpoint—Tooltip

You can customize the AutoSnap feature to suit your needs or make it go away completely if you want.
Choose Menu Browser & Options, and click the Drafting tab. Here you can individually turn on and off the
marker, the AutoSnap tooltip, and the magnet. You can also change the marker size and color. For more
information, see in Appendix A.
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In the following exercise, you practice using object snaps.

STEPS: Using Object Snaps

1. Start a new drawing using the acad.dwt or acadlt.dwt template. Close any palettes that may
be open.

2. Save the drawing in your AutoCAD Bible folder as ab04-05 . dwg.

3. Click Ortho Mode on the status bar to turn on Ortho Mode. If the Object Snap button on the sta-
tus bar is on, click it to turn off running object snaps (covered in the next section).

4. Choose Home tab = Draw panel = Line to start the LINE command. Follow the prompts:

Specify first point: 2,7 J. Move the cursor downward.

Specify next point or [Undol: 4 J. Move the cursor to the right.
Specify next point or [Undol: 4 J. Move the cursor up.

Specify next point or [Close/Undo]: 4 J

Specify next point or [Close/Undo]: Press Enter to end the command.

Your drawing should look like Figure 4.19. The circled numbers are reference points for this
exercise.

FIGURE 4.19

These three lines are the start of a mounting bracket.

5. Choose Home tab = Draw control panel &> Arc. Follow these prompts:

Specify start point of arc or [Center]: Right-click. From the
shortcut menu, choose Snap Overrides@w Endpoint.

_endp of Move the cursor to 0 in Figure 4.23. When you see the
endpoint marker and AutoSnap tooltip, click.

Specify second point of arc or [Center/End]: Right-click and choose
Center.

Specify center point of arc: Press Shift and right-click. Choose
Midpoint from the shortcut menu.
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_mid of Move the cursor to Q and pick.
Specify end point of arc or [Angle/chord Length]: end J. Move the
cursor to @ and pick.

6. Choose Home tab = Draw panel = Circle. Follow the prompts:

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:
Choose Center from the Object Snap shortcut menu.
cen of Move the cursor over the arc until you see the Center marker
and tooltip, and then click.
Specify radius of circle or [Diameter]: .75
7. Start the LINE command and use any method you want to draw a line from the endpoint at @) to
the endpoint at ). End the LINE command.

When you press Shift and right-click to get the object snap menu, the mouse pointer must be
: in the drawing area. If it is on a toolbar, you get the Toolbars list. If that happens, press the Esc
key, or hold down the Shift button and right-click again in the drawing area.

8. Save your drawing. It should look like Figure 4.20.

FIGURE 4.20

The start of a drawing of a mounting bracket (including a construction line that would later be
erased). It was created by using the endpoint, midpoint, and center object snaps.

Running object snaps and Object Snap mode

The Endpoint object snap is probably the most commonly used of all the object snaps. It would be nice to
have a method of using object snaps that you use often without resorting to a menu, toolbar, or keyboard

entry. The solution is to set a running object snap, which keeps one or more object snaps on until you turn

them off.

Many users like to work with three or four running object snaps on at once, such as Endpoint,
Midpoint, Center, and Intersection. If you can’t find the object snap you want because you
have several object snaps near each other, press the Tab key to cycle through the object snaps, one by one,
until you find the one that you want.
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FIGURE 4.21

Use the

Specifying Coordinates

To set running object snaps, right-click the Object Snap button on the status bar and choose the object
snaps that you want from the list that pops up. Because the list closes after each choice, you may want to
choose Settings to open the Drafting Settings dialog box, as shown in Figure 4.21. Choose the object snaps
that you want and click OK. To clear a checked object snap, click it. Click Clear All to clear all running
snaps.

Object Snap tab of the Drafting Settings dialog box to set running object snaps.

B Drafting Settings =<

[ Snap and fri | Polas Tracking| Obiecl Sty | Dignamic Input | Qusck Propeties
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') To track from an Dsnap paint, pause over the point while in a
3-( command. A tracking vector appears when pou move the cursor.
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You use the Object Snap button on the status bar to turn on your running object snaps. If you want to turn
them off temporarily, just click the Object Snap button or press F3. This capability to toggle running object
snaps on and off makes it easy to work with running object snaps on almost all the time because you can
turn them off at the click of a button.

Overriding Coordinate Settings

Sometimes you're in the middle of a command and want to turn off an object snap just for a second. You're
trying to pick a point and that pesky object snap marker keeps appearing just when you don’t want it. Or
you may want to turn Snap mode on or off for part of a command. Temporary overrides exist for this pur-
pose. There are two kinds of temporary overrides:

B Toggles: You press a key or combination of keys. The setting switches on or off. You then press
the same keyboard shortcut to reverse the setting. For example, if you have Ortho Mode on, you
can press F8 to turn it off. To turn Ortho Mode back on, press F8 again.

B Temporary overrides: You press and hold a key or key combination. The setting switches on or
off only while you’re holding down the keyboard shortcut. The setting reverts to its original set-
ting when you release the key or key combination. For example, if you have Ortho Mode on, you
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can press Shift to temporarily turn it off. As soon as you release the Shift key, Ortho Mode comes
back on.

Table 4.2 lists these overrides. Note that each setting has two shortcuts, one for your left hand and one for
your right hand. Use whichever one you like. You can customize the keys for these overrides. (For more
information, see Chapter 33.)

TABLE 4.2

Coordinate Setting Overrides

Setting Toggle  Temporary Override Description

Toggle Object F3 Shift+A; Shift+’ Equivalent to clicking the Object Snap button on the

Snap mode status bar.

Turn on Object Shift+S; Shift+; Use when Object Snap mode is off and you want to

Snap mode briefly turn it on.

Endpoint object Shift+E; Shift+P Temporarily turns on an Endpoint object snap when

snap Object Snap mode is off.

Midpoint object Shift+V; Shift+M Temporarily turns on a Midpoint object snap when Object

snap Snap mode is off.

Center object Shift+C; Shift+, Temporarily turns on a Center object snap when Object

snap Snap mode is off.

Turn off Object Shift+D; Shift+L Equivalent to deselecting both the Object Snap and the

Snap and Object Object Snap Tracking buttons on the status bar. (I explain

Snap Tracking modes object tracking in the next section.)

Ortho Mode F8 Shift Equivalent to clicking the Ortho Mode button on the
status bar.

Snap mode F9 Equivalent to clicking the Snap Mode button on the
status bar.

Polar mode F10 Shift+X; Shift+. Equivalent to clicking the Polar Mode button on the
status bar.

Object Snap F11 Shift+Q; Shift+] Equivalent to clicking the Object Snap Tracking button on

Tracking mode the status bar (I explain this in the next section).

Dynamic Input F12 Equivalent to clicking the Dynamic Input button on the

status bar.

TIP

adjust the Repeat Rate control.

| To customize the hold-down time for temporary overrides, go to the Windows Control Panel
& (Start= Control Panel) and double-click the Keyboard item. In the Character Repeat section,

In the following exercise, you practice using running object snaps with Object Snap mode.
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STEPS: Using Running Object Snaps with Object Snap Mode

1. Start a new drawing using the acad.dwt or acadlt.dwt template. Close any palettes that may
be open.

2. Save the file in your AutoCAD Bible folder as ab04-06 . dwg.

o 3. Right-click the Object Snap button on the status bar and choose Settings. Choose Endpoint.
| | Uncheck all other object snaps and click OK.

Start the LINE command and start the line at 2,2.

5. Turn on Ortho Mode by clicking the Ortho Mode button on the status bar. If Object Snap mode is
not on, click it on the status bar.

6. Move the mouse in the O-degree direction and type 6 .
Move the mouse up in the 90-degree direction, type 3 I, and end the LINE command.

8. Start the ARC command. At the Specify start point of arc or [Center] : prompt, pick
the endpoint at @), shown in Figure 4.22. (Look for the marker and AutoSnap tooltip.)

FIGURE 4.22

Drawing a steam boiler with an endpoint running object snap.
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9. Atthe Specify second point of arc or [Center/End] : prompt, right-click (or press
the down arrow if Dynamic Input is on) and choose End. Pick the endpoint at @), shown in
Figure 4.22.

10. At the Specify center point of arc or [Angle/Direction/Radius] : prompt, right-
click (or press the down arrow if Dynamic Input is on) and choose Angle, and then type 180 .

11. Start the LINE command and at the Specify first point: prompt, pick the endpoint at @,
shown in Figure 4.22.

12. Move the mouse to the left in the 180-degree direction, type 6 !, and end the LINE command.

13. Right-click the Snap Mode button on the status bar and choose Settings. Make sure that the Equal
X and Y Spacing check box is selected. Click Grid Snap in the Snap type section. Set the Snap X
spacing to 0.25. Check the Snap On check box. Click OK.

T If the boiler is too small, choose Menu Browser = View > Zoom = All.

14. Start the LINE command. At the Specify first point: prompt, place the cursor 0.25 units
above @, as shown in Figure 4.22 (at 2,5.25). If you see the endpoint marker for the nearby line,
press F3 to turn off the running Object Snap temporarily. Pick point 2,5.25.
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15. At the Specify next point or [Undo] : prompt, pick point 2,1.75. (If necessary, right-click
the coordinates and choose Absolute to get absolute coordinates.)

16. If Dynamic Input is not on, click the Dynamic Input button on the status bar. Follow the prompts:

Specify next point or [Undol]: Pick .5<180. (This means that you see a
length tooltip of .5 and an angle tooltip of 180°.)

Specify next point or [Close/Undo]: Pick 3.5<90.

Specify next point or [Close/Undo]: (If you turned off Object Snap
mode in Step 13, press F3 to turn it on again.) Pick the endpoint
at @ in Figure 4.26.

Specify next point or [Close/Undo]:

17. Save your drawing.

Even if you have running object snaps, if you specify an object snap during a command, it
2 overrides the running object snap. For example, having a running endpoint object snap does
not mean you can’t use a midpoint object snap for any specific drawing command.

By default, if you type absolute or relative coordinates, they take precedence over any running object snaps.
This lets you leave running object snaps on but override them with keyboard entry of typed coordinates
whenever you want. In general, the default gives you the most control and flexibility. However, you can
change this default to give running object snaps precedence. To change the default, choose Menu Browser =
Options, click the User Preferences tab, and use the Priority for Coordinate Data Entry section of the

dialog box.

Locating Points

Sometimes you need to locate a point that is not on an existing object. For example, you may need a point a
certain distance and angle from an existing object. This section explains three techniques that enable you to
locate points that are not on objects — object snap tracking, point filters, and the From feature.

Object snap tracking

The purpose of object snap tracking is to let you specify a point based on the object snaps of existing
objects. Temporary tracking lines are drawn from points you specify, and guide you so that you can easily
specify the point that you want. Use the Object Snap Tracking button on the status bar to turn object snap
tracking on and off. Object snap tracking can easily handle all the following tasks and many more:

B You're drawing a line and have specified the start point. You want the endpoint to be exactly verti-
cal to the endpoint of an existing line.

B You're drawing a circle inside a rectangle (which could be a hole inside a sheet-metal plate). You
want the center of the circle to be exactly centered inside the rectangle, at the intersection of the
midpoints of the rectangle’s two sides.

B You want to start a line at the point where two existing lines would intersect if they were
extended.

To start using object snap tracking, at least one object snap must be active. Turn on a running object snap,
as explained in the previous sections. Then click the Object Snap Tracking button on the status bar.

With object snap tracking on, follow these steps:

1. Start a command that requires you to specify a point.
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2. Place the cursor briefly over an object snap, such as the endpoint of a line, to temporarily acquire
it. You can acquire more than one point. These acquired points are used to calculate the tracking
paths. You see a small plus sign (+) over the object snap as confirmation, as shown in Figure 4.23.

FIGURE 4.23

When you pause over an object snap and then move the cursor slightly, you see a plus sign (+)
at the acquired point to show that the point has been acquired and can now be used for object
snap tracking.

Acquired point

Cursor

e |

3. Move the cursor away from the object snap toward your desired point. You see the temporary
alignment paths as you move the cursor over available drawing paths, as shown in Figure 4.24. If
Ortho Mode is on, you see only horizontal and vertical paths. If Polar mode is on, you see polar
paths based on the polar angle settings, as explained earlier in this chapter.

FIGURE 4.24

With the endpoint object snap active and Ortho Mode on, AutoCAD displays temporary
alignment paths based on the acquired point.

Acquired endpoint of existing arc
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Temporary
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/ Cursor
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Tooltip

4. When you see a tooltip and a small x, click it. You can now continue or complete the command
using this point.
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After you acquire a point, you can clear it in any one of three ways:

B Move the cursor back over the point’s plus sign.

B Click the Object Snap Tracking button on the status bar to turn it off.

W Start any new command.
You can customize the following features of object snap tracking on the Drafting tab of the Options dialog
box (choose Menu Browser = Options):

B Uncheck Display Polar Tracking Vector to eliminate the tracking paths.

B Uncheck Display Full-Screen Tracking Vector to display the tracking paths only from the cursor to
the object snap point.

B Uncheck Display AutoTrack Tooltip to eliminate the tooltips.
B In the Alignment Point Acquisition section, choose Shift to Acquire, which will require you to
press Shift to acquire a point when the cursor is over an object snap point.

In the following exercise, you practice locating points with object snap tracking.

Wi py The drawing used in the following exercise on locating points with object snap tracking,
m-:é ab04-c.dwg, is in the Drawings folder on the DVD.

STEPS: Locating Points with Object Snap Tracking

1. Open ab04-c.dwg from the DVD. Close any palettes that may be open.

i 2. Save the drawing as ab04-07 . dwg in your AutoCAD Bible folder. This drawing is a section of
a simple plan layout of an apartment. Set endpoint and midpoint running object snaps only. Make
sure that Object Snap mode and Object Snap Tracking are on and that Polar mode and Ortho
Mode are off.

3. Choose Home tab = Draw panel = Line to start the LINE command. At the Specify first
point: prompt, pick the endpoint at @), as shown in Figure 4.25. Be sure to pick the endpoint
itself, in order to acquire it.

4. At the Specify next point or [Undo] : prompt, pass the cursor over @. Move the cursor
down a little, and you see the small plus sign showing that this endpoint has been acquired.

5. Move the cursor down until it is to the left of @ and vertical to @@. When you see the tooltip
(reading Endpoint: < 270°, Endpoint: < 180°) and the small x marking the intersection of the two
points, click to end the line segment.

6. Atthe Specify next point or [Undo] : prompt, click at @ and end the LINE command.

7. Start the LINE command again. At the Specify first point: prompt, pick the endpoint of
the arc at @), as shown in Figure 4.25. If you're not sure that you found the right endpoint, press
Tab until the arc is highlighted. Make sure that you've acquired the endpoint by clicking the end-
point itself or passing the crosshairs over it.

8. At the Specify next point or [Undo] : prompt, pass the cursor over @@ until you see the

small plus sign. Move the cursor slightly to the left until you see the tooltip (reading Endpoint:
< 90°, Endpoint: < 180°) and click.

9. Atthe Specify next point or [Undo] : prompt, pick the endpoint at @) and end the LINE

command.
10. Choose Home tab=> Draw panel &> Circle to start the CIRCLE command. At the Specify
center point for circle or [3P/2P/Ttr (tan tan radius)]: prompt, pass the

cursor over @ and then over @ to acquire both midpoints.
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FIGURE 4.25
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The tub, door, and sink to be completed in this plan layout.

Move the cursor to the middle of the sink, where lines from both midpoints would intersect until
you see the tooltip (reading Midpoint: < 270°, Midpoint: < 180°) and click.

At the Specify radius of circle or [Diameter] : prompt, type 7.5 - to complete the

sink.

Save your drawing. It should look like Figure 4.26.

FIGURE 4.26

The completed drawing.
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Using the temporary tracking feature
The temporary tracking feature is similar to object snap tracking, but limits you to horizontal and vertical
directions. Follow these steps:

1. Start a command.

2. Ata prompt to specify a point, enter tracking ! (or tk .I) at the command prompt.

3. Atthe First tracking point: prompt, specify a point (usually using object snaps) that is
horizontal or vertical to the final point you want to specify.

4. Immediately move the cursor horizontally or vertically toward the final point that you want to
specify. You see a rubber-band line.

5. Atthe Next point: prompt, move the cursor from the rubber-band line to specify a second
point that is also vertical or horizontal to the final point.

6. Press Enter to end tracking and continue the command.

The cursor moves to the intersection of the vertical and horizontal rubber-band lines. You can now continue
your command.

Point filters

Point filters enable you to specify a coordinate using the X coordinate of one existing object snap and the Y
coordinate of another. You construct an X,Y coordinate based on coordinates of existing objects. If this
sounds complicated, it is. Object snap tracking should mostly eliminate the need to go back to the old point
filter way of doing things. (Point filters have been around for a long time.)

Here’s how to use point filters:

1. Start a command to draw an object.

2. To specify a coordinate, type .x or .y on the command line. You can also find point filters on the
Object Snap shortcut menu (Shift+right-click).

3. The prompt requests a point. Generally, you specify the point by using an object snap.
The prompt requests the other coordinate value, which you generally provide by using an object
snap. (If you're working in 2D, ignore the request for a Z coordinate.)

5. Continue your command.

You don’t need to use existing coordinates for both the X and Y portions of the coordinate. For
855 example, you can construct an X,Y coordinate by using the Y coordinate of an existing line and
p|ck|ng the X coordinate anywhere on the screen.

From feature

The From feature enables you to create a new object starting at a known distance and direction from an
existing object. It like creating one or more invisible lines between the existing object and the new object,
helping you to start the new object in the proper place. Use the From feature when the point you need to
specify is a known X,Y distance from an object snap but not on any object snap itself. Here’s how to use the
From feature:

1. Start a command to draw an object, such as LINE.

2. Press Shift+right-click, and choose From on the shortcut menu. You can also type from on the
command line or in the Dynamic Input tooltip.
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3. The prompt requests a base point, which you usually provide by using an object snap, such as an
endpoint.

4. The prompt requests an Offset, which you provide by using relative or polar coordinates. You can
type coordinates or look at the coordinates in the Dynamic Input tooltip or on the status bar and
click when you see what you want.

B When you specify the offset for the From feature, you need to use the @ symbol to indicate

% relative coordinates, even if Dynamic Input is set to the default of relative coordinates. The
Dynamlc Input relative coordinate’s setting only applies to the second coordinate that you enter. For exam-
ple, if you are drawing a line, the first coordinate you enter is considered absolute, and subsequent coordi-
nates are considered relative.

5. Continue the command you started (in Step 1).
In the following exercise, you practice using the From feature.

> The drawing used in the following exercise on using the From feature, ab04-06 . dwg, is in the
# Results folder on the DVD.

STEPS: Using the From Feature

1. Open ab04-06.dwg, which you created in an earlier exercise. If you did not do the previous
exercise, open the drawing from the Results folder of the DVD. Close any palettes that may be
open. Make sure Ortho Mode is on and Snap mode is off. Object Snap should be on. Set a run-
ning object snap for Endpoint.

Save the drawing as ab04-08 . dwg in your AutoCAD Bible folder.
Choose Home tab = Draw panel = Line to start the LINE command.

From the Object Snap shortcut menu, choose From.

ok

The prompt asks you for a base point. Pick the endpoint at @), as shown in Figure 4.27.

FIGURE 4.27

Using the From feature to complete the steam boiler.

6. Atthe <Offset>: prompt, type @-1,0.5 .

7. You are now ready to continue the line at the Specify next point or [Undo] : prompt. Press
F3 to turn off Object Snap mode. Move the cursor in the 90-degree direction and type 2 .

8. Move the mouse in the 180-degree direction and type 1 .
9. Move the mouse in the 270-degree direction and type 2 .

93



AutoCAD and AutoCAD LT Basics

94

10.

11.

Right-click and choose Close from the shortcut menu to close the rectangle and end the LINE
command.

Save your drawing. It should look like Figure 4.28.

FIGURE 4.28

The completed steam boiler.

]

Summary

This chapter covered a great deal about specifying coordinates. These skills form the basis for all your future
work with AutoCAD and AutoCAD LT. You read about:

The X,Y coordinate system

Using Dynamic Input

Using absolute Cartesian coordinates

When and how to use relative Cartesian coordinates
Absolute and relative polar coordinates

Direct distance entry

The orthogonal (Ortho) mode

Using polar tracking

Controlling the display of coordinates on the status bar
Grid and PolarSnap settings

Using the visible grid

Using object snaps to specify geometric points on objects
Running object snaps and turning Object Snap mode on and off
Temporarily overriding coordinate settings

Using object snap tracking to locate points

Using point filters to locate points

The From feature for locating points not on an object

The next chapter introduces you to the basics of setting up a drawing.



ften, the first step after you start a new drawing is to set its size and unit

type. These and other setup options are discussed in this chapter. The

entire process of setting up a drawing is essential for ensuring accurate
results. You can save most of these settings in a template to avoid having to re-
create them each time you start a new drawing.

Choosing Unit Types

One of the first tasks in setting up a drawing is to choose the unit type. Units
define how objects are measured. You can save the unit type in a template.

The coordinates you use in AutoCAD or AutoCAD LT are measured in units that
can represent any real-world measurement, such as inches or millimeters. A sur-
veyor or city planner might even use miles or kilometers as the base unit.
However, different disciplines have customs that express units differently, and
you should use the unit type appropriate for the type of drawing you're creating.
This ensures that everyone involved understands the drawing. AutoCAD and
AutoCAD LT offer five types of units, as shown in Table 5.1. The sample meas-
urement column shows how a line 32.5 units long would be displayed in the var-
ious unit types.
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Unit Types
Unit Type Sample Measurement Description
Decimal 32.50 Number of units, partial units in decimals
Engineering 2'-8.50" Feet and inches, partial inches in decimals
Architectural 2'-8 12" Feet and inches, partial inches in fractions
Fractional 3212 Number of units, partial units in fractions
Scientific 3.25E+01 Base number + exponent
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Notice how the engineering and architectural units translate a line of 32.5 units into feet and inches.
Engineering and architectural units assume a unit of 1 inch, unlike the other unit types, which can repre-
sent any measurement.

The unit type affects how coordinates are shown on the status bar and how information about objects is
listed. You generally input coordinates by using the type of units you've chosen, although in some cases you
can input coordinates in another unit type.

If you're using engineering or architectural units, AutoCAD and AutoCAD LT display partial

= 85 inches differently than the format you must use to type them in. You must type coordinates
WIthout any spaces, because a space is equivalent to pressing Enter, and that ends your input. Use a hyphen
between whole and partial inches, for example, 3'2-1/2". (You can omit the " after the inches because inches
are assumed in engineering and architectural units if no symbol follows a number.) However, this appears on
the status line as 3'-2 1/2". This can be confusing because the hyphen is in a different place, and you see a
space between the whole and partial inches.

Setting the drawing units

When you know the units you want to use, you set them in the Drawing Units dialog box. To set the units,
choose Menu Browser & Format = Units, to open the Drawing Units dialog box, shown in Figure 5.1. The
left side of the Drawing Units dialog box enables you to choose which unit type you want to use. In the
Precision box in the Length section, click the arrow and a list of precision options drops down. Click the
one you want.

AutoCAD and AutoCAD LT round off measurements to the nearest precision value you choose.
A Say that you choose a precision of two decimal places, using decimal units. You want to draw a
line so that it is 3.25 units long, but when you type the coordinate, by accident you press the 4 key at the
end, resulting in a line 3.254 units long. This line is displayed as 3.25 units long, making it difficult for you to
spot the error. Therefore, setting a higher precision than you need to show is a good idea.

Setting the angle type

As with units, your choice of angle type depends on your profession and work environment. Decimal
Degrees is the default. Table 5.2 lists the types of angles.
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The Drawing Units dialog box.
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TABLE 5.2

Angle Types
Angle Type Name Sample Measurement Description
Decimal Degrees 32.5 Degrees, partial degrees in decimals
Deg/Min/Sec 32°30'0" Degrees, minutes, and seconds
Grads (gradians) 36.1111g Gradians
Radians 0.5672r Radians
Surveyor N 57d30' E Surveyor (directional) units

A minute is Yo degree and a second is % minute. Gradians and radians are simply alternate
ways of measuring angles. A gradian is a metric measurement equal to 0 of a right angle.
Radlans measure an angle by placing a length, equal to the radius, along the circle’s circumference. Radians
range from 0 to 2 x IT instead of from 0 to 360 as degrees do. A radian is approximately 57.30 degrees.
Surveyor units measure angles in directions, starting with north or south and adding an angle in degrees/
minutes/ seconds format that shows how far the angle is from north or south and in which direction

(east or west).

To set the angle type, choose the option you want from the Type drop-down list of the Angle section of the
Drawing Units dialog box (shown in Figure 5.1).

fE"F Changing these angle settings does not automatically change the way your dimension annota-
(EAst=idil tions appear. Use the Dimension Style Manager, which is discussed in Chapter 15, to change
dimensions.
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Setting the angle measure and direction

By convention, degrees increase in a counterclockwise direction, and you measure angles so that 0 degrees
starts to the right, also called the East direction. To change the angle direction, click Clockwise in the
Drawing Units dialog box. To change the direction of 0 degrees, click Direction to open the Direction
Control dialog box, shown in Figure 5.2.

FIGURE 5.2

The Direction Control dialog box.
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Here you can choose to have O degrees start in a direction other than East. You can also choose Other and
type any other angle or click the Pick an Angle button to pick two points on your screen that specify an
angle. Click OK to close the Direction Control dialog box. Click OK to close the Drawing Units dialog box.

 Changing the angle direction affects what happens when you input angles and what you see in
' &8 the coordinate display. It does not change the absolute coordinates, which are set according to
the User Coordinate System (UCS). Chapter 8 covers using and customizing UCSs.

If you are using Dynamic Input, the angle that you see in the Dynamic Input tooltip never goes above 180°.
This angle in the tooltip represents the angle to your current point and goes from 0° to 180° in both the
clockwise and counterclockwise directions.

"= At the bottom of the Drawing Units dialog box, you can choose units for lighting. See my dis-
& cussion of lighting in Chapter 25 for more information.

STEPS: Setting Drawing Units

1. Begin a new drawing using the acad.dwt or acadlt.dwt template. Close any palettes that may
be open. If Dynamic Input isn't on, click the Dynamic Input button on the status bar.

2. Save the drawing as ab05-01 . dwg in your AutoCAD Bible folder.

3. Choose Menu Browser & Format = Units, to open the Drawing Units dialog box.

4. In the Length section, choose Architectural.

5. Click the arrow to the right of the Precision drop-down list box in the Length section. Choose
0'-0 1/8".

6. In the Angle section, choose Deg/Min/Sec.

7. In the Precision box, choose 0d00".

8. In the Units to Scale Inserted Content drop-down list, set the units to Inches.
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9. Click OK.

10. Choose Home tab > Draw panel = Line to start the LINE command. Follow the prompts:
Specify first point: 2,2 J
Specify next point or [Undo]: 1'<0 .
Specify next point or [Undo]: 6-3/4<153 .
Specify next point or [Close/Undol]: Right-click and choose Close.

11.  Choose Menu Browser = View = Zoom &> All to zoom to the entire drawing. Save your drawing. If
you're continuing through the chapter, keep it open.

Te ' You would not actually use Deg/Min/Sec for angles in an architectural drawing, but the exer-
SOBES cise gives you the opportunity to set the angular units.

Drawing Limits

You can specify the area of your drawing, also called the limits. The drawing limits are the outer edges of the
drawing, specified in X,Y units. You need to set only the width and length of the drawing. Together, these
two measurements create an invisible bounding rectangle for your drawing.

Almost universally, the lower-left limit is 0,0, which is the default. Therefore, the upper-right corner really
defines the drawing size. Remember that you typically draw at life size (full scale). Therefore, the size of
your drawing should be equal to the size of the outer extents of what you're drawing, plus a margin for a
titleblock (if you plan to add one), annotation, and dimensioning. If you want to show more than one view
of an object, as is common in both architectural and mechanical drawings, you need to take this into
account.

To decide on the upper-right corner limits (the width and length) for your drawing), you need to consider
what the drawing units mean for you. Generally, the smallest commonly used unit is used, often inches or
millimeters. Therefore, if you're drawing a plan view of a house that is approximately 40 feet across (in the
X direction) by 30 feet deep (in the Y direction), this translates to a top-right corner of 480,360. Adding
room for a titleblock brings you to about 500,380.

! In Chapter 17, I explain how you can put the titleblock on a layout. A layout simulates the
; sheet of paper that you will use to plot the drawing. If you use a layout, you don’t need to
leave room for the titleblock when you set the limits.

The limits define an artificial and invisible boundary to your drawing. However, you can draw outside the
limits. The limits affect the size of the grid, when displayed. (See Chapter 4 for a discussion of the grid.)
The ZOOM command with the All option also uses the limits, but only if no objects are outside the limits.
(See Chapter 8 for a discussion of the ZOOM command.)

To set the drawing limits, choose Menu Browser &> Format = Drawing Limits, to start the LIMITS command.
Press Enter to accept the lower-left corner default of 0,0 that appears on the command line. Then type the
upper-right corner coordinate that you want and press Enter.

Understanding Scales

You need to consider the fact that your drawing will most likely be plotted onto a standard paper (sheet)
size. The standard orientation for drafting (and the default for most plotters) is landscape orientation, mean-
ing that as you look at the drawing, the paper is wider than it is tall. Figure 5.3 shows an example. These
conventions have carried over from the days of hand drafting. (In a computer program, this is not really
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FIGURE 5.3

necessary, because you can rotate the drawing when you plot it.) To scale a drawing onto a piece of paper in
a pleasing manner requires a rectangular shape that somewhat resembles the proportions of standard paper
sizes.

Drawings are usually oriented horizontally, as in this example.

Thanks to Henry Dearborn, AlA, Fairfield, lowa, for this drawing, which I have altered somewhat.
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In addition, although you specify the scale at plotting time, it helps to be aware of the scale you'll use when
plotting your drawing at the outset. The scales used for Geographic Information Systems (GIS), where you
might be drawing an entire county, will be different from those used when drawing a house. The scales used
in mechanical drafting are again totally different. In fact, in mechanical drafting, if you're drawing a very
small object, such as a 2-inch screw-plate, you might scale up (that is, enlarge the drawing when plotting).

One important reason for establishing the scale at the beginning is to ensure that text, whether annotations
or dimensions, is readable in its final plotted form. Applying a scale ensures that text remains a reasonable
size even as the rest of the drawing is scaled up or down. Scale also affects linetypes that contain dots or
dashes.

Some drawings are not scaled. Examples are electrical or electronic schematics, piping diagrams, and rail-
road schematics. These drawings are representations of electrical or electronic connections but do not
resemble the actual physical object that will eventually be created from the drawing. These drawings can be
any size as long as they are clear and organized.

5 You can lay out various views of your drawing on an imaginary piece of paper, called a paper
AT space layout, to prepare it for plotting. You can annotate on a paper space layout to avoid hav-
ing to adjust the size of these components to the scale of the drawing. See Chapter 17 for more information
on layouts and plotting.

When determining your scale to fit a drawing on a sheet of paper, be aware that a plotter cannot print on
the entire sheet. A certain amount of the margin around the edge is not available for drawing. Plotters differ
in this respect. The plotter’s manual can let you know the width of this unprintable margin. On average,
you can assume a half-inch margin on each side; thus you should subtract 1 inch from both the length and
width sheet measurements to determine the actual drawing space. Table 5.3 shows standard U.S. sheet
sizes.
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Standard Paper Sheet Sizes in the United States (in inches)

Size Width Height Size Width Height
A 11 8'%h D 34 22

B 17 11 E 44 34

C 22 17

TABLE 5.4

Table 5.4 lists standard metric sheet sizes.

Standard Metric Paper Sheet Sizes (in millimeters)

Size Width Height Size Width Height
A4 297 210 Al 841 594
A3 420 297 A0 1,189 841
A2 594 420

Working with scale formats

A scale is often indicated in the format plotted size=actual size or plotted size:actual size. Because you draw at
actual size, the actual size is also the drawing size. For example, a scale of /:"=1' means that % inch on the
drawing, when plotted out on a sheet of paper, represents 1 foot in actual life —and in the drawing. This is
a typical architectural scale. A windowpane 1 foot wide would appear "i-inch wide on paper.

From the scale, you can calculate the scale factor. You use the factor when you set the size for text (see
Chapter 13) or for dimensions (see Chapter 15). To do this, the left side of the scale equation must equal 1,
and the two numbers must be in the same measurement (for example, both in inches). This requires some
simple math. For 4"=1', you would calculate as follows:

1AI|: 1
1"=4 Both sides of the equation multiplied by 4
1"=48" 4' converted to 48"

Therefore, the scale factor is 48. This means that the paper plot is Ys of real size.

In mechanical drawing, you might draw a metal joint that is actually 4 inches long. To fit it on an 8'4-x-11-
inch sheet of paper, you could use a 2"=1" scale, which means that 2" on the paper drawing equals 1" in
actual life and the drawing. Calculate the scale factor:

2n=1"
11|=1/2|l

The scale factor is 2. This means that the paper plot is twice the real size.
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Most professions use certain standard scales. Therefore, you do not usually have a choice to pick any scale
you want, such as 1":27'. Instead, the conventions of your profession, client, or office dictate a choice of
only a few scales. Some typical architectural scale factors are:

B 192:1/16"=1'

m 96:1/8"=1"
B 48:1/4"=1
B 24:172"=1"
" 12:1"=1

Civil engineering scales are somewhat different and range to larger sizes—a bridge is bigger than a house.
Some typical scale factors are 120 (1" =10") and 240 (1" =20".

Metric scales can be used for any purpose. Example scale factors are 1,000 (1mm = 10 meters), 500
(Imm = 5 meters), or 100 (1 mm = 1 meter).

Using annotative scales

You can assign an annotative property to certain objects so that they automatically resize to the proper scale
when you lay out the drawing for plotting. The following types of objects can be annotative:

B Text (see Chapter 13)

B Dimensions and leaders (see Chapters 14 and 15)
B Hatches (see Chapter 16)

B Blocks and attributes (see Chapter 18)

You would especially use annotative scaling when you need to display your drawing at more than one scale.
For example, you might display the entire drawing at one scale and a detail at another scale. (See Chapters
13, 14, 15, 16, 17, and 18 for more detailed information on annotative styles and objects.)

Using annotative objects avoids the necessity to manually figure out how large these objects need to be;
when you scale them, they will be the proper size. For example, if your drawing scale will be 1:48, as in the
example in the previous section, and you want your text to be /4" high, then you would need to multiply
the desired height of the text (4") by the scale factor to get a text height of 12. However, by setting the
annotative scale for the text to 1/4" = 1'-0", you can simply set the height of the text to '4" and not worry
about the calculations.

The procedure for creating annotative objects differs somewhat for each type of object, but the overall
process is the same:

1. If necessary, create an annotative style and make it current. Annotative text, dimensions, and mul-
tileaders require an annotative style.

2. Decide on the scales that you will use for each object. For example, you might have two text
objects each at a different scale, or one text object that you need to display at two different scales.

variable. This system variable, when on, automatically adds scales to annotative objects as
you add annotative scales; the result is that each object has more than one scale. To turn
ANNOAUTOSCALE off, click the icon on the right side of the status bar to the left of the
Annotation Scale pop-up list. When on, there’s a yellow lightning bolt; when off, the lightning
bolt is gray.

1_;_-__: 3. If you want each text object to have a different scale, turn off the ANNOAUTOSCALE system
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Set the annotation scale for the first object. To do so, click the Annotation Scale button at the
right side of the status bar to display the scale list and choose the scale you want. For example,
choose 1/4" = 1'-0" if you plan to display the text at the 1/4" = 1'-0" scale. (In the next section, I
explain how to customize this scale list.)

Create the object.

When you're ready to plot, you can set the desired annotative scale, and plot. You can also create
viewports and set their scale. See Chapter 17 for details and an exercise using annotative objects.

If you want one object to have more than one scale, you can add an annotative scale to it. Follow these

steps:

1.
2.

4.

Select the object and right-click in the drawing area.

Choose Annotative Object Scale &> Add/Delete Scales to open the Annotation Object Scale dialog
box, as shown in Figure 5.4.

FIGURE 5.4

The Annotation Object Scale dialog box enables you to add an annotation scale to an annotation
object.

B Annotation Object Scale Es
Object Scale List
12 [ oAk, |

1 papet unit = 2 draving urits
@ List all scalles for selected objects
List scales common to all selected obiects only

[ 0K [ Coancel |[ Feb |

Click Add to display the Add Scales to Object dialog box, where you can choose one or more
scales.

Click OK twice to close both dialog boxes.

You can also open the dialog box by displaying the Properties palette, clicking the Annotative Scale item,
and clicking the Ellipsis button that appears.

For each scale that you assign to an object, AutoCAD or AutoCAD LT automatically creates a representation
of that object in an appropriate size. Therefore, you may have a text object shown at three sizes. At any
time, you can view any single scale for an annotative object, or view all its scales. If you don't see all scales
of an annotative object, click the Annotation Visibility button on the right side of the status bar. This button
controls the ANNOALLVISIBLE system variable. By default, it is on, displaying all scales. When you turn it
off, you see only the text for the current annotative scale. To immediately plot, you would turn off this sys-
tem variable so that you plot only the text for the current annotative scale.
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FIGURE 5.5

Customizing the scale list

You generally choose a scale during the process of laying out a drawing. AutoCAD and AutoCAD LT have a
list of scales from which you can choose. You can find this list in several places (which I discuss throughout

the book):

B On the Annotation Scale list on the status bar, as mentioned in the previous section
In the Add Scales to Object dialog box, also mentioned in the previous section
In the VP Scale list of the status bar, when you select a viewport (see Chapter 17)
In the Plot Scale drop-down list section of the Page Setup dialog box (see Chapter 17)
In the Plot Scale section of the Page Setup dialog box (see Chapter 17)
In the Viewports toolbar drop-down list

In the Standard scale item of the Properties palette when a viewport is selected (see Chapter 17)

In the Sheet Set Manager (AutoCAD only), when placing a view on a layout (see Chapter 26)
B In the Layout Wizard (see Chapter 17)

You might use unusual scales in your office or want a list that includes only the scales that you use. You can
customize the scale list for this purpose.

To customize the scale list, choose Annotate tab & Annotation Scaling = Scale List. The Edit Scale List dia-
log box opens, shown in Figure 5.5.

Use the Edit Scale List dialog box to create your own custom scales.

B Edit Scale List =

Srale |id
[ . | [ .|
12
14
15 I |
18
1:10 A Muve Up
118
:jﬂ | Move Down
14an
160 Dralete
1:100
E} - Reset
1 o unil = 1 drawing ursl

[ ok ][ cance |[ Hep
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To add a new scale, click Add. In the Add Scale dialog box, name the scale. The name is what will show on
the list. Then define the scale by completing the Paper Units and Drawing Units text boxes. For example, to
add a 1:12 scale, you would name the scale 1:12, set the Paper Units to 1 and the Drawing Units to 12.

To delete scales that you don’t use, select the scale and click Delete. You can also edit existing scales (select
the scale and click Edit), move them up or down in the order of the list, and reset the list (click Reset) to its
original status. Click OK when you’re done.
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AutoCAD 2009 stores the scales list within the drawing file, so this list can vary with the draw-
: ing. Scales used in any externally referenced files will also show up in this list, even if they
weren’t originally set in your host file.

Deciding on a scale and sheet size

As soon as you know the size of your drawing and the scale appropriate for your situation, you need to con-
sider the sheet size of the paper on which you want to plot. Again, you often find that certain factors limit
your choices. Your plotter or printer may be limited to certain sheet sizes. The conventions used in your
discipline or working environment also affect your decision. You may be working on a series of drawings
that are all to be plotted on the same size sheet of paper.

As an example, the architectural drawing in Figure 5.3 is 175 feet wide by 120 feet high. The two most typ-
ical scales for a drawing of a house are '4"=1"and '4"=1'. On a small plotter, you might have a choice of
sheet sizes A, B, or C. The following steps show the calculations you need to do in order to decide on a
scale, obtain the scale factor, and determine the appropriate sheet size.

In this exercise, you practice determining the scale and sheet size. You need only a sheet of paper and a
pencil. Use Figure 5.3 as a reference.

STEPS: Determining the Scale and Sheet Size

1. To calculate the plotted size of the drawing at 4"=1", you can start with the width, which is 175".
Take one-quarter of 175 to get the width of the drawing in inches, which is 43%".

2. Take one-quarter of the height, 120", to get the height of the drawing in inches, which is 30".
3. A C-size sheet (see Table 5-3) is 22"x17", which is too small for a 43%"x30" drawing.

Recalculate the drawing at '4"=1". Take one-eighth of 175 to get 217 Take one-eighth of 120 to
get 15",

5. The actual drawing space (minus the margins the printer requires) on a C-size sheet is about
21"x16". The height of the drawing at this scale is adequate, but the width is 74" too long.
Therefore, the best option is to simply make the drawing 4" narrower because the drawing has
some extra room. This lets you fit the drawing on a C-size sheet.

6. To calculate the scale factor of a '4"=1" scale, multiply 1' by 8 to get 8' and convert it to inches,
which is 96 (8x12).

Rearranging the views, dimensions, and text on a drawing to fit a standard scale factor and sheet size is a
typical task. There is no actual setup step for setting the drawing scale, but you use it when you insert text
or dimensions and when you plot the drawing.

Creating a Titleblock

A titleblock is a rectangle that includes spaces for the drawing title, company name, drafter name, and so on.
It generally comes with a border that bounds your drawing. Many drawings require titleblocks. You can
insert an existing titleblock in two ways:

B When creating a new drawing, choose Menu Browser = File &> New to open the Select Template
dialog box. Choose one of the templates that include a titleblock, either one that comes with
AutoCAD or a custom template that you created. For example, tutorial-iArch.dwt includes

105



AutoCAD and AutoCAD LT Basics

a titleblock and border that fit on a D-size sheet. The titleblock and border appear on a layout tab.
(Chapter 17 covers layouts.)

B After you open a drawing, you can insert a drawing of a titleblock into it. Choose Insert tab =
Block. (Chapter 18 covers blocks.) In the Insert dialog box, type the name of the drawing or
block, or click Browse to find it. To insert the file or block at 0,0 with no scaling or rotation,
uncheck all the Specify On-Screen check boxes. Check Explode if you expect to edit the inserted
titleblock after it’s in your drawing. Click OK.

To find the location of the templates, choose Menu Browser &> Tools & Options, and click the Files tab.
Double-click Template Settings and then double-click Drawing Template File Location. You see the path to
the location displayed. (The path is very long!) This folder may be hidden in Windows Explorer. For
instructions on displaying hidden folders, go to Windows Help and type hidden folders in the search box.

[ As explained in Chapter 2, you can create your own titleblock, make a template from it, and
then start a drawing based on that template.

Specifying Common Setup Options

A few other items are generally set up in advance and are included in a template. Other chapters of this
book cover the following:

B Layers (covered in Chapter 11) enable you to organize your drawing into meaningful groups. In
an architectural drawing, for example, you might create a layer for walls, another for doors, and
one for electrical fixtures.

B Text styles (covered in Chapter 13) enable you to format the font and other text characteristics.

Table styles (covered in Chapter 13) format tables.

B  Multileader styles (covered in Chapter 14) create styles for multileaders (leaders that can contain
more than one arrow).

B Dimension styles (covered in Chapter 15) format the dimensions that measure your objects.

If you know you’ll be using snap, grid, and ortho modes (covered in Chapter 4) a lot in certain drawings,
and you know the suitable settings for snap and grid, you can set these and save them in a template because
these settings are saved with the drawing. In other cases, you might want to leave them off and turn them
on only when you need them.

Many settings, such as running object snaps, the type of snap (grid or polar), and the polar distance when
you're using PolarSnap, are saved in the Windows registry, not in your drawing. As a result, when you open
AutoCAD or AutoCAD LT, they’re automatically set to the same setting that you had when you last closed
the program, regardless of the setting in the drawing. Therefore, you cannot save these settings in a
template.

In this exercise, you practice specifying the drafting settings and creating a template.

2y The drawing used in the following exercise on setting drawing aids and creating a template,
i ab05-01.dwg, is in the Results folder on the DVD.

STEPS: Setting Drawing Aids and Creating a Template

1. If you did the exercise on setting drawing units, use that drawing or open ab05-01 . dwg from
the Results folder of the DVD.

2. Save the drawing as ab05-02.dwg in your AutoCAD Bible folder.
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System Variables

hen you change AutoCAD or AutoCAD LT settings, such as the unit type, angle type, drawing limits,

blip marks, snap mode (on or off), grid mode, or ortho mode, you actually changing system variables.
These are simply settings that are stored in each drawing or in the Windows registry (which stores settings that
apply to all drawings). Usually, you don’t need to pay any direct attention to them, but they’re the nuts and
bolts behind the dialog boxes that you use to change the settings. When you start customizing AutoCAD, you
need to learn about them because programming code and script files (macros) cannot access dialog boxes.
Also, a few system variables are accessible only by typing them directly on the command line. Throughout
this book, | occasionally mention system variables when using them directly is useful. Some system variables
store information about a drawing or the drawing environment, such as the drawing name and path. These are
read-only, meaning that you cannot change them. They exist to provide information and are often used in
AutoLISP programs. (AutoLISP works in AutoCAD only.)

Information about each system variable, where it is stored, its default, and whether it is read-only is in the
Help system. Press F1 (with no command active) and double-click Command Reference on the Contents tab.
Then double-click System Variables. In the Options dialog box (Menu Browser => Tools &> Options), system
variables that are stored in a drawing have a drawing file icon next to them.

You can type system variables on the command line, just like regular commands. The Express Tools (AutoCAD
only) contain an editor (choose Menu Browser &> Express = Tools &> System Variable Editor) that enables you
to edit system variable values in a dialog box; it also provides helpful supporting information.

3. Right-click the Snap Mode button on the status bar, and choose Settings.

4. On the Snap and Grid tab, the snap spacing is set to 4". In the Grid Spacing section, change the X
and Y spacing to 1". Make sure the Snap Type is set to Grid Snap and Rectangular Snap. Click OK.

5. Click Snap Mode and Grid Display on the status bar to turn them on. Make sure Object Snap
Mode is turned off.

6. Choose Menu Browser = Format = Units. Change the Angle Type back to Decimal Degrees (if
necessary). Click OK.

7. Using the coordinate display as your guide, start the LINE command and draw line segments
from 2.5, 1.5 to0 .5<270 to 11<0 to .5<90. End the LINE command.

8. Restart the LINE command. Again use the coordinate display to draw line segments from 2,2 to
.5<270 to 12<0 to .5<90. End the LINE command.

9. Save your drawing. It should look like Figure 5.6. Notice how the grid and snap settings facilitate
the drawing process.

The architectural units create a different drawing experience than decimal units would. Setting up
a drawing creates a drawing environment suited to your work needs.

10. Choose Menu Browser = File &> Save As. In the Save Drawing As dialog box, click the Files of
Type drop-down list box and choose AutoCAD Drawing Template (* . dwt) or AutoCAD LT
Drawing Template (* . dwt). Notice that you're automatically in the Template folder.

11. In the File Name text box, change the name to archroof . dwt. Click Save.

12. In the Template Options dialog box, type Arch units, 16,10 limits, snap & grid and click OK.
The Measurement drop-down list should be set to English.
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FIGURE 5.6

The final architectural drawing.

13. Choose Menu Browser = File &> New. Choose the archroof template and click Open. A new
drawing is created based on the template.

14. Move the cursor around and look at the coordinate display to confirm that the grid is set to 1",
although the snap is set to /2"

Do not save this new drawing.

Customizing with the MVSETUP Command

The MVSETUP command is used in two different ways: to set up a drawing and to create viewports for
paper space layouts (covered in Chapter 17). This command does not exist in AutoCAD LT.

MVSETUP provides a command-line routine to walk you through some of the basic setup functions dis-
cussed in this chapter. You can use MVSETUP when you start to customize AutoCAD to set up a drawing
from a script file or AutoLISP program (topics covered in Parts VI and VII of this book). To use MVSETUP,
type mvsetup J on the command line. AutoCAD responds with the following prompt:

Enable paper space? [No/Yes] <Y>:
Type n J to use MVSETUP without entering paper space.
The next prompt lets you enter the units type:

Enter units type [Scientific/Decimal/Engineering/Architectural/Metric]:

Choose the option you want. Then AutoCAD displays a list of scale factors appropriate to the units option
you chose. (To see them all, you may have to press F2 to open the AutoCAD Text Window.) At the Enter
the scale factor: prompt, type in a numeric scale factor.

Finally, AutoCAD prompts you to set the drawing limits with the following two prompts:

Enter the paper width:
Enter the paper height:
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After each prompt, enter a number based on the size of the paper on which you plan to plot. AutoCAD
draws a rectangle of the size that you indicated for the drawing limits.

Using the Setup Wizards

There are two wizards to help you set up a drawing. You need to activate the Startup dialog box to find

them:

On the command line, or in the Dynamic Input tooltip, enter startup !, and then enter 1 .
Choose Menu Browser = File => New. You see the Startup dialog box.

Click the Use a Wizard button. Choose Quick Setup for fewer options or Advanced Setup for
more options.

Click OK and follow the prompts of the wizard.

Summary

This chapter explained setting up a drawing so that it behaves the way you want it to. You read about:

Setting the unit type

Setting the angle type, measure, and direction

Drawing limits

Using scales and calculating a scale factor

Setting drawing aids and creating a template that includes the settings that you want

Using MVSETUP (AutoCAD only) or the setup wizards to set up your drawing

This chapter ends Part I, “AutoCAD and AutoCAD LT Basics.” Now that you know the basics, you can go
on to Part II, “Drawing in Two Dimensions.” The next chapter covers drawing simple lines, polygons, rec-
tangles, and infinite construction lines.
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ines are the most commonly drawn object in 2D AutoCAD drawings —

you'll use the LINE command a lot! Straight edges just happen to be very

common in the real world. Related commands for drawing rectangles,
polygons, and construction lines are also important, so you should have all these
commands in your arsenal. This chapter explains how to draw all these types of
objects.

Using the LINE Command

The LINE command draws straight line segments. Part I included several exer-
cises in which you drew lines. However, the LINE command has several options,
and you can still learn a few tricks of the trade by focusing on the actual LINE
command.

To draw a line, choose Home tab = Draw panel &> Line. At the Specify first
point: prompt, specify any point. Continue to specify points until you're fin-
ished. Press Enter to end the command. You can also right-click and choose
Enter from the shortcut menu. The LINE command assumes that you will con-
tinue to use it over and over. For this reason, the command continues to prompt
you until you press Enter.

If you continue to draw line segments, the subsequent prompts are different.
Here’s how to use them:

B The command displays the Specify next point or [Undo] :
prompt for the next two segments. Right-click (or press the down-
arrow key if you have Dynamic Input turned on) and choose Undo
(or type u J) to undo only the last line segment that you created —
without exiting the LINE command.

B After creating at least two line segments, the command displays the
Specify next point or [Close/Undo] : prompt. Right-click (or
press the down-arrow key if you have Dynamic Input on) and choose
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Close (or type ¢ J) to automatically draw a line from the endpoint of the last segment to the origi-
nal start point, thereby creating a closed figure. You can continue to use the Undo option as well.

If you previously drew a line, press Enter at the Specify first point: prompt to start the line at the
endpoint of the last line. If you most recently drew an arc, press Enter to start the line at the endpoint of the
arc and draw it tangent to the arc.

STEPS: Using the LINE Command
1. Start a new drawing by using the acad.dwt or acadlt.dwt template.

This exercise assumes that you have Dynamic Input on (click the Dynamic Input button on the

Y status bar to turn it on, if necessary) and that you are using the default settings of polar format
and relative coordinates. Make sure that the 2D Drafting & Annotation workspace is chosen from the
Workspace Switching pop-up list on the status bar. Close any palettes that may be open.

2. Save the drawing in your AutoCAD Bible folder as ab06-01 . dwg.

3. Start the LINE command. At the Specify first point: prompt, choose any point in the cen-
ter of your drawing.

Click the Ortho Mode button on the status bar.
5. Move the cursor to the right in the 0-degree direction and type .4667 ..

Type .7341<129 . (Instead of typing the < symbol, you can press the Tab button to move to the
Dynamic Input angle tooltip.)

Move the cursor to the right in the 0-degree direction and type .4668 .
8. Assume that this was a mistake. Type u .

The Specify next point or [Close/Undo] : prompt reappears. With the cursor still in the
0-degree direction, type .4667 .

10. Type c < to close the figure. This ends the LINE command.

11.  Start the LINE command again.

12. At the Specify first point: prompt, press Enter. The line starts at the previous endpoint.
13. Type .8071<270 J and press Enter to end the LINE command.

14. Save your drawing. It should look like Figure 6.1.

FIGURE 6.1

The completed gate valve symbol.

3 @5 : £ Other aspects of lines are covered elsewhere in this book. Chapter 11 explains how to draw
S 5 dashed and dotted lines. Chapter 16 explains how to create polylines, which combine line seg-
ments and curves into one object. Chapter 16 also covers multilines and dlines —sets of parallel lines that
you draw all at once. Chapter 21 discusses how to draw 3D lines and polylines.
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Drawing Rectangles

The RECTANG command draws rectangles. Rectangles are used in all disciplines. The RECTANG
command has a number of options that specify how the rectangle appears and how you define the
rectangle’s dimensions.

To draw a rectangle, choose Home tab => Draw panel = Rectangle. The first prompt is as follows:

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/
width]:

Select one of the options. If you don’t want to use any of the options, just specify one corner of the rectan-
gle, using any method of specifying a coordinate.

I You can chamfer and fillet the corners as you create the rectangle. (Chapter 10 covers cham-

As=tddl fering and fllletmg ) You can specify a width for the rectangle’s line (see Chapter 16). You can
also create a 3D box by usmg the elevation and thickness options (see Chapter 21). The RECTANG command
creates a polyline, meaning that all four sides of the rectangle are one object, instead of four separate line
objects. Chapter 16 covers polylines.

If you use one of the options, the first prompt returns so that you can specify the first corner point or use
another option. After you specify the first point, you see the Specify other corner point or [Area/
Dimensions/Rotation] : prompt.

To immediately create the rectangle, specify the corner diagonally opposite the first corner that you speci-
fied. You can use any method of specifying coordinates. For example, if you know that the rectangle should
be 6 inches wide and 3 inches high, you can specify the second point as 6,3. (If Dynamic Input is turned off
or set to absolute coordinates, add the @ symbol before the X,Y coordinates.) You can also use one of the
options below:

B Area: If you know the area of the rectangle, and only its length or width, then use this option.
First you enter the area. Then you specify either the length or the width, and AutoCAD calculates
the side that you didn’t specify, based on the area you entered.

B Dimensions: If you know the length and width of the rectangle, then use this option (although it
may be simpler to specify the opposite corner, as I described earlier). You are prompted for the
length and width. You then need to move the mouse to specify if you want the second corner to
be above and to the right, or in any other direction from the first corner. When you see the rec-
tangle you want, click it.

B Rotation: If you want to rotate the rectangle as you create it, then simply enter a rotation angle
and pick the opposite corner. Alternatively, instead of entering a rotation angle, you can pick two
points to specify a rotation angle and then pick the opposite corner. This last option is great if you
want to align the rectangle with an existing object.

All the options for rectangles, except for Area, remain as defaults for future rectangles that you
draw. As a result, you can use the Dimensions option to quickly draw a number of identical

rectangles

Drawing Polygons

The POLYGON command enables you to draw multi-sided, closed figures with equal side lengths. You
ﬂ can draw polygons that have from 3 to 1,024 sides. To draw a polygon, choose Home tab = Draw panel =
Polygon.

115



m Drawing in Two Dimensions

First specify the number of sides. Then choose one of three methods of defining the polygon, as described
in Table 6.1.

TABLE 6.1

POLYGON Command Options

Option Description

Edge Right-click and choose the Edge option. Specify the two endpoints of any edge of the
polygon to complete the polygon.

Inscribed in circle After specifying the center, right-click and choose Inscribed in Circle. Then specify the
radius from the center to a vertex (point). This defines the polygon with reference to an
imaginary circle whose circumference touches all the vertices of the polygon.

Circumscribed about circle After specifying the center, right-click and choose Circumscribed about Circle. Then
specify the radius from the center to the midpoint of a side. This defines the polygon
with reference to an imaginary circle whose circumference touches all the midpoints
of the polygon’s sides.

If you type a number for the radius, then the bottom edge of the polygon is horizontal. However, if you
pick a point for the radius with your mouse, you can specify the orientation of the polygon. As you rotate
the mouse cursor around the center, you see the polygon rotate. Click when you like what you see.

Sy .‘- When you type a number for the radius, the bottom edge actually aligns with the snap rotation
As=idi angle, which is usually 0. Chapter 8 explains how to change this angle.

The POLYGON command creates a polyline, meaning that the entire polygon is one object, rather than a
series of line segments.

In the exercise that follows, I indicate inches with a double prime (") and feet with a single prime (). You
may find this notation clearer when a measurement has both feet and inches, but you do not actually need
to type the double prime for inches. When you have a measurement that is only in inches, it saves time to
leave out the double prime.

™ The drawing used in this exercise on drawing rectangles and polygons, ab06-a . dwg, is in the
4l Drawings folder on the DVD.

STEPS: Drawing Rectangles and Polygons

1. Open ab06-a.dwg from the DVD.

2. Save the drawing in your AutoCAD Bible folder as ab06-02 . dwg. Verify that snap and grid are
on, set at 1". Object Snap should be off.

This exercise assumes that you have Dynamic Input on (click the Dynamic Input button on the
: status bar to turn it on, if necessary), that you use the default settings for the polar format and
relative coordinates, and that you are in the default 2D Drafting & Annotation workspace (if necessary, click
the Workspace Switching button on the status bar to choose it).

3. Choose Home tab = Draw panel & Rectangle.
E 4. Atthe Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/
width] : prompt, move the cursor to 0'-1",0'-1" and click. At the Specify other corner
point or [Area/Dimensions/Rotation]: prompt, type 2'1",1'9" .
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Start the RECTANG command again. At the Specify first corner point or [Chamfer/
Elevation/Fillet/Thickness/Width] : prompt, Shift+right-click and choose the

From object snap. Pick the bottom-left corner of the rectangle. At the <Of£set>: prompt, type
@2,2 o start the second rectangle 2 inches up and 2 inches to the right of the first rectangle.
At the Specify other corner point or [Area/Dimensions/Rotation] : prompt, type
1'9".1'3" .

Right-click and choose Repeat RECTANG. At the prompt, find 0'8",1'7" (on a snap point) and
click. At the Specify other corner point or [Area/Dimensions/Rotation]:
prompt, type 11,2 1. (You don't need to type the double-prime for inches.)

Again, start the RECTANG command. At the prompt, find 1'1",1'8" and click. At the Specify
other corner point or [Area/Dimensions/Rotation]: prompt, type 1,-5 .

Choose Home tab > Draw panel = Polygon. At the Enter number of sides <4>: prompt,
type 5 . At the Specify center of polygon or [Edge] : prompt, type 10,1'8 - to indicate
the center.

At the Enter an option [Inscribed in circle/Circumscribed about circle] <I>:
prompt, press Enter to accept the default. This means that you indicate the radius from the center
to the vertices. (If your prompt shows <C> as the default, type i J.)

At the Specify radius of circle: prompt, type 1/2 . AutoCAD or AutoCAD LT draws the
pentagon.

Repeat Steps 9 through 11 using a center of 1'5,1'8.

Start the POLYGON command again. At the Enter number of sides <5>: prompt, type 3 .
At the Specify center of polygon or [Edge] : prompt, right-click and choose the Edge
option.

At the Specify first endpoint of edge: prompt, choose the top-left corner of the faucet
rectangle (1'1",1'8"), which is on a snap point.

At the Specify second endpoint of edge: prompt, choose the top-right corner of the
faucet rectangle to complete the triangle.

Turn off the grid to get a better look at the drawing. You have completed the sink, which should
look like Figure 6.2. Save your drawing.

FIGURE 6.2

The completed sink, drawn with rectangles and polygons.

=/ o]

Thanks to Bill Wynn of New Windsor, Maryland, for this drawing, which he created in his AutoCAD class as
part of a plan drawing of an entire house.
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Creating Construction Lines

Sometimes you want to create a line that is used solely for the purpose of reference. A construction line is a
temporary or reference line used to help you draw or to show a relationship between objects. For example,
you might want to do the following:

B Draw two lines from the midpoints of two perpendicular lines so that you can use their intersec-
tion as the center for a circle.

B Draw a line from one object to another to visually indicate the relationship between the two
objects.

B Show the relationship between equivalent parts of a model shown in front and right-side views.

B Draw a line through the center of an object shown in cross-section so that you can show dimen-
sions from the centerline to the edge of the object.

You could use regular lines for these purposes. However, construction lines (also known as xlines) are
unique in that they extend infinitely in both directions. This makes them especially useful for seeing the
relationships among various objects in your drawing.

Of course, construction lines are not actually infinite. However, they extend to the edge of the drawing area
on your screen, and if you zoom out to see more of your drawing, they expand so that they always extend
to the edge of the screen. The object snap tracking feature sometimes eliminates the need for construction
lines; nevertheless, sometimes you can work more easily having a line visible for several commands and
then erasing it.

If you zoom to show the extents of your drawing, AutoCAD or AutoCAD LT ignores the xlines and shows
you just the extents of the regular objects in your drawing. Chapter 8 covers the ZOOM command.

The XLINE command offers several ways to create construction lines. Start the command by choosing
Home tab = Draw panel (expanded) = Construction Line. You see the following prompt:

Specify a point or [Hor/Ver/Ang/Bisect/Offset]:

Table 6.2 lists the possible options. AutoCAD or AutoCAD LT continues to prompt you for more points so
that you can continue to draw construction lines — much like the LINE command. Press Enter to end the
command.

XLINE Command Options

Option Description

Specify a point This option enables you to define the construction line with two points. At the first prompt, specify
a point. At the Specify through point: prompt, specify another point. The first point
becomes the base point for subsequent construction lines that you can draw by specifying other
through points.

Hor To draw a construction line parallel to the X axis, type h I to specify the Horizontal option. The
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Option Description

Ver To draw a construction line parallel to the Y axis, type v . to specify the Vertical option. The
command responds with the Specify through point: prompt. Specify one point.

Ang Type a J (for Angle). The command responds with the Enter angle of xline (0) or
[Reference] : prompt. If you enter an angle, the command asks for a through point. You can
also type r J and select a line as a reference, and then provide an angle and a through point.
AutoCAD or AutoCAD LT then calculates the angle of the construction line from the angle of the
reference line. This is useful for drawing a series of construction lines at a specified angle.

Bisect To draw a construction line that bisects an angle (divides the angle in half), type b .. The
command responds with the Specify angle vertex point: prompt. Choose any point that
you want the construction line to pass through. Then, at the Specify angle start point:
prompt, choose a point that defines the base of the angle. At the Specify angle end point:
prompt, choose a point that defines the end of the angle.

Offset To draw a construction line parallel to a line, type o . You can specify the offset distance by
typing in the number or using the Through option to pick a point through which the construction
line should pass. Either way, the next step is to select a line. If you specified an offset distance, the
command displays the Specify side to offset: prompt. Respond by picking a point on the
side of the selected line on which you want the construction line to appear.

Creating Rays

Rays are similar to construction lines, except that they start at a specific point and extend to infinity in one
direction only. If you need a line to extend only in one direction, using a ray may be less confusing.

fEREE You can use most object snaps with construction lines and rays. (You can’t use an endpoint for
SMANS construction lines or a midpoint for rays.) You can edit construction lines and rays like any
other object.

To draw a ray, choose Home tab => Draw panel (expanded) = Ray. At the Specify start point:
prompt, specify the start point for the ray. At the Specify through point: prompt, specify another
point. AutoCAD or AutoCAD LT continues to ask for through points. Press Enter to end the command.

2y The drawing used in this exercise on drawing construction lines and rays, ab06-b. dwg, is in
4 the Drawings folder on the DVD.

STEPS: Drawing Construction Lines and Rays

1. Open ab06-b.dwg from the DVD.

2. Save the drawing as ab06-03 . dwg in your AutoCAD Bible folder.
f 3. Choose Home tab &> Draw panel (expanded) => Construction Line.
4

. At the Specify a point or [Hor/Ver/Ang/Bisect/Offset]: prompt, choose point @),
shown in Figure 6.3.

5. Atthe Specify through point: prompt, choose point @), shown in Figure 6.3.

119



120

P

10.

Drawing in Two Dimensions

FIGURE 6.3

A pipe with cross-section.

Press Enter to end the command. Notice that the drawing has been set up so that the construction
line is drawn in green and with a noncontinuous linetype. This is to distinguish it from the main
drawing. (See Chapter 11 for details on how to set up a drawing in this way.)

Choose Home tab = Draw panel (expanded) = Ray.
At the Specify start point: prompt, choose point @), shown in Figure 6.3.

At the Specify through point: prompt, choose point @), shown in Figure 6.3. Press Enter to
end the command.

Save your drawing.

Summary

This chapter covered the ins and outs of lines. You read about:

Using the LINE command
Drawing rectangles
Drawing polygons

Creating construction lines, including xlines that extend infinitely in both directions and rays that
extend infinitely in one direction

The next chapter explains how to draw curves and point objects. Curves include circles, arcs, ellipses, and

donuts.



utoCAD and AutoCAD LT offer a number of ways to create curved

objects. You can draw circles, arcs, ellipses, and donuts (also spelled as

doughnuts). In this chapter, I also cover point objects, which are neither
curves nor lines but don’t deserve their own chapter.

TS G ' Several complex objects —such as polylines, splines, regions, and
CROS S:REF ! boundaries —involve curves. These are covered in Chapter 16.

Drawing Circles

Circles are common objects in drawings. In mechanical drawings, they often rep-
resent holes or wheels. In architectural drawings, they may be used for door-
knobs, trash baskets, or trees. In electrical and piping schematics, they are used
for various kinds of symbols.

Understanding the circle options

The CIRCLE command provides six ways to draw a circle. To draw a circle,
choose Home tab = Draw panel = Circle. The command responds with the
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:
prompt. Table 7.1 describes how to use these options. You can access the options
directly by clicking the down arrow next to the Circle button on the ribbon.

121

INTHIS C

Drawing circles

Drawing arcs

Creating ellipses

Drawing donuts

Creating points




m Drawing in Two Dimensions

TABLE 7.1

Option

Six Ways to Draw a Circle

Description

Center, Radius

This option is the default. Specify the center and then the radius. You can type the radius as
a distance, or pick a point where you want the circumference to be.

Center, Diameter

Specify the center. Choose the Diameter option and type the length of the diameter, or
pick a point to specify the diameter.

2P (2 Points) Choose the 2p option. Specify one point on the circumference, and then an opposite point
on the circumference. These two points define the diameter of the circle.
3P (3 Points) Choose the 3p option. Specify three points on the circumference.

Tan, tan, radius (Tangent,
Tangent, Radius)

Choose the Ttr option. The CIRCLE command prompts Specify point on object
for first tangent of circle: and provides an aperture to let you pick a point. Then
the command prompts Specify point on object for second tangent of
circle: and you pick a second point. These points can be any points on the object(s) to
which you want your circle to be tangent. Finally, type a radius.

Tan, tan, tan (Tangent,
Tangent, Tangent)

This option is available only from the Circle’s drop-down list on the ribbon. You are
prompted for three points, and AutoCAD automatically applies the Tangent object snap to
each point.

B You can also create a circle tangent to other objects by using the two-point (2P) method or

& three-point (3P) method, picking those points with the Tangent object snap.

Drawing circles

Drawing circles is fairly straightforward. Often, you can use object snaps to define part of the circle. In the
following exercise, you practice using the most common methods of creating a circle.

> The drawing used in the following exercise on drawing circles, ab07-a . dwg, is in the

# Drawings folder on the DVD.

STEPS: Drawing Circles
1. Open ab07-a.dwg from the DVD.

2. Save the file as ab07-01 . dwg in your AutoCAD Bible folder. This is a drawing of an air com-
pressor from which all the circles have been removed. Make sure that Object Snap is turned
on. Set a running object snap for endpoints only. You should be in the default 2D Drafting &
Annotation workspace (if necessary, choose it from the Workspace Switching button on the
status bar).

3. Choose Home tab = Draw panel = Circle, and use the down arrow to choose the 2-Point
@ option. At the Specify first end point of circle's diameter: prompt, pick
the endpoint at @), shown in Figure 7.1. At the Specify second end point of circle's
diameter: prompt, pick the endpoint at @@.
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FIGURE 7.1

The air compressor without its circles.
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z ,
AIR COMPRESSOR

Repeat the CIRCLE command by right-clicking and choosing Repeat Circle. Right-click and
choose 2P from the shortcut menu. Pick the endpoints at @) and @), shown in Figure 7.1.

Repeat the CIRCLE command by pressing Enter. At the Specify center point for circle
or [3P/2P/Ttr (tan tan radius)]: prompt, pick the endpoint at @. At the Specify
radius of circle or [Diameter] : prompt, pick the endpoint at @.

Repeat the CIRCLE command. At the Specify center point for circle or [3P/2P/Ttr
(tan tan radius) ] : prompt, pick the endpoint at @). At the Specify radius of circle
or [Diameter] : prompt, right-click and choose Diameter; then type .25 ..

Repeat the CIRCLE command by right-clicking and choosing Repeat Circle. At the Specify
center point for circle or [3P/2P/Ttr (tan tan radius)]: prompt, right-click and
choose 3P At the Specify first point on circle: prompt, pick the endpoint at @), shown
in Figure 7.1. At the Specify second point on circle: prompt, pick the endpoint at @. At
the Specify third point on circle: prompt, choose a Midpoint object snap and pick the
midpoint at ).

For the last circle on the right, choose any method that you want to use to draw a circle. The cir-
cle should be the same size and placement as the second circle from the left.

Repeat the CIRCLE command. At the Specify center point for circle or [3P/2P/Ttr
(tan tan radius) ] : prompt, choose the Center object snap ! and pick @. At the Specify
radius of circle or [Diameter]: prompt, type .05 .

Repeat Step 9 to create a circle inside the circle whose center is at @) and whose radius is 0.05.

Repeat the CIRCLE command. At the Specify center point for circle or [3P/2P/Ttr
(tan tan radius) ] : prompt, pick the endpoint at @). At the Specify radius of circle
or [Diameter] : prompt, pick the endpoint at @.

Repeat Step 11, choosing the endpoint at @) for the center of the circle and the endpoint at @ for
its radius, as shown in Figure 7.1.
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13. Save your drawing. It should look like Figure 7.2.

FIGURE 7.2

The completed air compressor.
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Thanks to the U.S. Army Corps of Engineers at Vicksburg, Mississippi, for this drawing. They maintain a Web
site of drawings athttp://cadlib.wes.army.mil.

"= It may have occurred to you that this task would have been easier if you could simply have
4 copied one circle to another location instead of creating each circle from scratch. I cover

copying in Chapter 9.

Drawing Arcs

An arc is a portion of a circle. Therefore, to define an arc, you have to define not only a circle— for exam-
but also the start and endpoints of the arc. The ARC command
offers several methods for defining an arc. The method you pick depends on the information that you have
about the arc that you want to draw.

S E'F You can close an arc to create a circle using the JOIN command. For more information, see
% Chapter 10.

Understanding arc options

After you understand the parts of an arc, you can choose the options that suit your needs. Figure 7.3 shows
the parts of an arc that you can use to draw an arc.

Figure 7.4 shows the flow of the arc options. When you start the ARC command, you have two options,
Start Point and Center. Depending on how you start, more options become available.

You can also press Enter at the first arc prompt to draw a second arc starting from the endpoint of the most
recently drawn arc, line, polyline, or other object. The new arc continues in the same direction as the end of
the first object. The only other prompt is the endpoint.
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FIGURE 7.3

The parts of an arc.
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The ARC command options.
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Drawing arcs

To draw an arc, choose Home tab = Draw panel = Arc, and follow the prompts. You can just click the Arc
r. button and follow the options on the command line, or access the options by clicking the button’s down
arrow. Object snaps are often helpful when drawing arcs.

When drawing an arc by using the Start, End, and Radius options, the three specifications actually define
two possible arcs, one minor and one major. The ARC command draws the minor arc by default, in the
counterclockwise direction. (A minor arc is less than half a circle.) If you enter a negative number for the
radius, the command draws the major arc. The options requiring an angle also define two possible arcs, one
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drawn counterclockwise and one drawn clockwise. AutoCAD and AutoCAD LT draw the counterclockwise
arc by default. If you type a negative number for the angle, the arc is drawn clockwise.

I The drawing used in the following exercise on drawing arcs, ab07-b. dwg, is in the
% Drawings folder on the DVD.

STEPS: Drawing Arcs

1. Open ab07-b.dwg from the DVD.

2. Save the file as ab07-02 . dwg in your AutoCAD Bible folder. Ortho mode is on, and units are
set to Fractional. Right-click the Object Snap button on the status bar and set running object snaps
for Intersection, Center, and Endpoint. Make sure Object Snap is on. You should be in the default
2D Drafting & Annotation workspace (if necessary, choose it from the Workspace Switching button
on the status bar). In this exercise, you draw part of the sealing plate shown in Figure 7.5.

3. Start the LINE command. Start at a coordinate of 2,3 and use Direct Distance Entry to create a
7-unit horizontal line to the right. End the LINE command. (See Chapter 4 for a full explanation
of how to use Direct Distance Entry.)

4. Draw another line starting at 5-1/2,1-5/8 and draw it 2-3/4 units long in the 90-degree direction.
These two lines are centerlines and would ordinarily appear in a different color and linetype than
the object you're drawing. (You can read about colors and linetypes in Chapter 11.)

5. Draw a circle with its center at the intersection of the two lines (use the Intersection object snap)
and a radius of 11/16.

6. Use the Center object snap to draw another circle with the same center as the first circle and a
radius of 1.

FIGURE 7.5

The dimensioned sealing plate for a valve.
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Thanks to Jerry Bottenfield of Clow Valve Company in Oskaloosa, lowa, for this drawing.
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Draw a third circle, using the From object snap (Shift+right-click to open the Object Snap menu,
and then choose From). For the base point, use the Center object snap and pick either of the first
two circles that you drew. The offset is @-1-15/16,0 (this means 1-15/16 units to the left of the
center of the first two circles). Its radius is %

Draw a fourth circle. Use the From object snap again. For the base point, use the Center object
snap and pick either of the first two circles. The offset is @1-15/16,0. The radius is %

Choose Home tab = Draw panel &> Arc. Follow the prompts:

Specify start point of arc or [Center]: Choose the From object snap.

Base point: Use the Center object snap to pick the center of the
leftmost circle.

<Offset>: @-5/8,0

Specify second point of arc or [Center/End]: Right-click and choose
Center. Use the Center object snap to pick the center of the
leftmost circle.

Specify end point of arc or [Angle/chord Lengthl]l: Right-click and
choose Angle.

Specify included angle: 67.23 J

Start the LINE command. At the Specify first point: prompt, press Enter to continue
the line in the same direction as the end of the arc. At the Length of line: prompt, type
1-13/16 4. End the LINE command.

Start the ARC command again. Follow the prompts:

Specify start point of arc or [Center]: Use the Endpoint object snap
to pick the end of the line that you just drew.

Specify second point of arc or [Center/End]: Right-click and choose
Center. Use the Center object snap and pick any point on one of
the large central circles.

Specify end point of arc or [Angle/chord Length]: Use Endpoint object
snap to pick the lower end of the vertical construction line.

Repeat the ARC command. Follow the prompts:

Specify start point of arc or [Center]: Right-click and choose
Center. Use the Center object snap and pick any point on one of
the large central circles.

Specify start point of arc: Use the Endpoint object snap to pick the
endpoint of the arc that you just completed.

Specify end point of arc or [Angle/chord Length]: Right-click and
choose Angle.

Specify included angle: 22.77 J

Start the LINE command. At the Specify first point: prompt, press Enter to continue
the line in the same direction as the end of the arc. At the Length of line: prompt, type
1-13/16 . End the LINE command.

Start the ARC command. Follow the prompts:

Specify start point of arc or [Center]: Use the Endpoint object snap
to pick the endpoint of the line that you just drew.

Specify second point of arc or [Center/End]: Right-click and choose
End.

Specify end point of arc: Choose the From object snap.

_from Base point: Use the Center object snap to pick the center of
the rightmost circle.
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<Offset>: @5/8,0 J
Specify center point of arc or [Angle/Direction/Radius]: r J
Specify radius of arc: 5/8

15. Save your drawing. Your drawing should look like Figure 7.6. You can complete this drawing in
Chapter 10 by creating a mirror image.

FIGURE 7.6

The partially completed sealing plate, created by using lines, circles, and arcs.
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Creating Ellipses and Elliptical Arcs

You can create ellipses (ovals) as well as elliptical arcs, which are partial ellipses. Like a circle, an ellipse has
a center. The difference, of course, is that an ellipse has a longer radius along its major axis and a shorter
radius along its minor axis.

Understanding ellipse options

You can draw an ellipse by defining the center first. Another option is to define the axis endpoints first. If
you want to draw an elliptical arc, you must specify the start and end angles.

Creating ellipses

The default option is to specify endpoints 1 and 2 of the first axis. Then you specify the second distance of
the axis, which is the distance from the first axis line to the circumference along the second axis.

Instead of specifying a second axis distance, you can choose the Rotation option. The Rotation option
defines the minor axis by specifying an angle from 0 degrees to 90 degrees, which is the ratio of the major
axis to the minor axis. (Actually, the command only accepts up to 89.4 degrees.) When the angle is 0,
you get a circle. As the angle increases, the ellipse gets flatter and flatter until you reach 89.4 degrees. A
45-degree angle results in a minor axis whose length is the square root of the major-axis length.

Instead of specifying endpoints, you can use the Center option to specify the center of the ellipse. Then
specify the endpoint of the first axis, which can be either the major or the minor axis. Finally, specify the
other axis distance, which is the radius from the center to the circumference along the second axis. Again,
instead of specifying the second axis distance, you can define the ellipse by using the Rotation option.
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Creating elliptical arcs

To draw an elliptical arc, use the Arc option of the ELLIPSE command. The first prompts are the same as for
an ellipse. Then the command continues with the Specify start angle or [Parameter] : prompt,
offering the following options:

B Start angle: This option is the default. Specify the start angle, which the command redefines to
start along the major axis. The command responds with the Specify end angle or
[Parameter/Included angle] : prompt.

B End angle: Specify the end angle to complete the ellipse arc.

B Included angle: After specifying the start angle, you can complete the arc by specifying the
included angle from the start point to the endpoint, going counterclockwise.

B Parameter: Choose this option to define the arc portion by the ellipse’s area rather than its
included angle (which defines the arc portion by its circumference). The command responds with
the Specify start parameter or [Angle]: and Specify end parameter or [Angle/
Included angle] : prompts. By typing in angles, you define the percent of the full ellipse’s area
that you want to include. (For example, starting at 15 degrees and ending at 105 degrees includes
90 degrees and therefore draws one-quarter of an ellipse.) The options in brackets let you return
to regular angle specification.

Drawing ellipses

To draw an ellipse, choose Home tab = Draw panel & Ellipse. You can also directly access the options by

‘3 clicking the button’s down arrow. In addition to the information that the command explicitly requests in the
prompts, you need to know the angle of the first axis that you define. Not all ellipses are horizontal or verti-
cal. You control the orientation when you stipulate the second point of the first axis. The second axis is
automatically perpendicular to the first axis.

To draw an elliptical arc, choose Ellipse Arc from the Ellipse button’s drop-down list (in AutoCAD) or use
the Arc option of the ELLIPSE command. When you draw an elliptical arc, the command introduces a help-
ful but sometimes confusing feature: While you're defining the arc angles, the command redefines 0 degrees
along the major axis. This helps you to define the included angle in an orientation that relates to the ellipse,
rather than the usual orientation where 0 degrees is to the right.

In this exercise, you practice drawing ellipses and elliptical arcs.

2y The drawing used in the following exercise on drawing ellipses and elliptical arcs, ab07-c.
# dwg, is in the Drawings folder on the DVD.

STEPS: Drawing Ellipses and Elliptical Arcs

1. Open ab07-c.dwg from the DVD.

2. Save the file as ab07-03 . dwg in your AutoCAD Bible folder. The drawing shows an empty
conference room. Snap is on, and set to 6". Ortho mode and Object Snap should be on, with a
running object snap set for Endpoint only. You should be in the default 2D Drafting & Annotation
workspace (if necessary, choose it from the Workspace Switching button on the status bar).

3. Choose Home tab = Draw panel = Ellipse. At the Specify axis endpoint of ellipse or
‘3 [Arc/Center] : prompt, right-click and choose Center. At the Specify center of ellipse:
prompt, choose 8',10', which is a snap point. At the Specify endpoint of axis: prompt,
move the cursor to the right until the coordinates read 3'<0 and click. (If necessary, right-click the
coordinates on the status bar and choose Relative, or look at the Dynamic Input tooltips.) At the
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Specify distance to other axis or [Rotation]: prompt, move the cursor up until the
coordinates read 6'6"<90 and click. This completes the conference table.

Repeat the ELLIPSE command. Follow the prompts:

Specify axis endpoint of ellipse or [Arc/Center]: Right-click and
choose Arc.

Specify axis endpoint of elliptical arc or [Center]: Right-click and
choose Center.

Specify center of elliptical arc: Pick 8',3', a snap point.

Specify endpoint of axis: Move the cursor to the right until the
coordinates read 1'<0 and pick. (You can also look at the Dynamic
Input tooltips.)

Specify distance to other axis or [Rotation]: Move the cursor up
until the coordinates read 6"<90 and pick.

Specify start angle or [Parameter]: 162 J

Specify end angle or [Parameter/Included angle]: 18 .

Turn off Ortho mode. Start the LINE command. At the Specify first point: prompt, use
the Endpoint running object snap and pick the right side of the elliptical arc. At the Specify
next point or [Undo] : prompt, right-click the coordinates and choose Absolute (if neces-
sary), and press and hold Shift+A to temporarily override Object Snap mode while you pick the
snap point 8'6",3". End the LINE command.

Start the LINE command. At the Specify first point: prompt, use the Endpoint object
snap to pick the left side of the ellipse arc. At the Specify next point or [Undo] : prompt,
press and hold Shift+A while you pick the snap point 7'6",3". End the LINE command.

Choose Ellipse again. Follow the prompts:

Specify axis endpoint of ellipse or [Arc/Center]: Right-click and
choose Arc.

Specify axis endpoint of elliptical arc or [Center]: Use the Endpoint
object snap to pick the free endpoint of the line on the right.
Specify other endpoint of axis: Use the Endpoint object snap to pick

the free endpoint of the line on the left.

Specify distance to other axis or [Rotation]: 3<90 J (If you don't
have Dynamic Input on and set to the default of relative
coordinates, then type @ before the distance.)

Specify start angle or [Parameter]: Use the Endpoint object snap to
pick the free endpoint of the line on the right.

Specify end angle or [Parameter/Included angle]: Use Endpoint object
snap to pick the free endpoint of the line on the left.

Choose Home tab = Draw panel = Ellipse. At the Specify axis endpoint of ellipse or
[Arc/Center] : prompt, pick point 2',18', a snap point. At the Specify other endpoint
of axis: prompt, pick point 2',16', also a snap point. (The coordinates on the status bar display
this point in absolute coordinate mode. The Dynamic Input tooltips show 2' and 90°.) At the
Specify distance to other axis or [Rotation]: prompt, move the cursor to the right
until the coordinates read 6"<0. (Right-click the coordinates and choose Relative, if necessary.)
This is also a snap point. Click the mouse button to complete the small side table.

Save your drawing. It should look like Figure 7.7.
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FIGURE 7.7

The conference room with a conference table, a chair, and a side table.

0

Making Donuts

A donut is a wide polyline that looks like two concentric circles, with the area between the circles filled in.
You define a diameter for the inner and outer circles. Donuts are often used in electrical drawings to create
symbols. If the inner circle’s radius is zero, you create a filled-in circle.

The setting of the FILL command determines whether the donut is filled. Type fill ! and type on  or
off 1. FILL is on by default. Turning FILL off displays a radial pattern of lines, as shown in Figure 7.8. Type
regen ! or choose Menu Browser = View &> Regen to update existing donuts to the new FILL setting.

FIGURE 7.8

The parts of a donut, shown with FILL off.

— Outside diameter

Inside diameter Center
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Understanding DONUT options

The DONUT command has the following prompts:

B Specify inside diameter of donut <0.5000>: Type the diameter of the inside circle or
pick two points to specify the inside diameter. The number in brackets is the last inside diameter
that you defined, or 0.5 if you haven't previously used the DONUT command in this drawing
session.

B Specify outside diameter of donut <1.0000>: Type the diameter of the outside circle or
pick two points to specify the outside diameter. The outside diameter must be larger than the
inside diameter. The number in brackets is the last outside diameter that you defined, or 1.0 if
you haven't previously used the DONUT command in this drawing session.

B Specify second point: If you define the inside or outside diameter by picking a point, the
command asks for a second point. Use this technique if you're using object snaps to define the
diameters.

B Specify center of donut or <exit>: Specify the center of the donut. Pressing Enter ends
the command.

Drawing donuts

To draw a donut, choose Home tab = Draw panel (expanded) &> Donut. Then specify the inner and outer
diameters and the center. The DONUT command continues to prompt for centers so that you can place
additional donuts. Press Enter to end the command. You draw some donuts in the next exercise.

You can use the hatch feature to fill in any object with a solid fill, with a great deal more flexi-
bility in the shape of your objects. (Chapter 16 discusses hatching.) As a result, the DONUT
command is not as essential as it once was.

Placing Points

A point simply marks a coordinate. Points are generally used for reference. It is sometimes helpful to mark a
point that you will use later as a guide to place an object or to help you return an object to its original posi-
tion. When it’s no longer needed, you may erase the point. This is a typical construction method. In some
cases, the From object snap or object snap tracking can be used instead of a point.

Ve == The DIVIDE and MEASURE commands place point objects along an object. Chapter 12 covers
5& £F P P ) s ) P Vi

= these commands.

Changing the point style

Because points can be hard to see, and because various disciplines have different conventions for drawing
point objects, AutoCAD and AutoCAD LT provide 20 types of point styles that you can use in your draw-
ing. Before you draw a point, you should set the point style. You can save this setting in your template.

Choose Menu Browser & Format = Point Style to open the Point Style dialog box, shown in Figure 7.9.

To set the point style, click the box showing the style that you want. Then set the point size, which has the
following options:
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B Set Size Relative to Screen: Use this option if you want the point to always appear the same size,
no matter how much you zoom in and out — for example, when you're using the point as a refer-
ence. The size is set as a percentage of the screen. This option is the default, with the size set to 5
percent of the screen.

B Set Size in Absolute Units: Use this option if you want the point to have a real size, just like any
other object. The size is set in units. Use this option when you want the point to stay the same
size relative to other objects in your drawing.

Click OK to close the dialog box.

FIGURE 7.9

Choosing a point style.

@ Set Size Belative to Screen
Set Size in Abechde Unie

ok || cancel ][ hHem

Creating points

After you determine the point style, you're ready to create points. Choose Home tab &> Draw panel
(expanded) = Point. You see the following on the command line:

Current point modes: PDMODE=0 PDSIZE=0.0000
Specify a point:

Specify the point that you want, either by picking a point on the screen or by typing coordinates. (You can
specify a Z coordinate to create a point in 3D space. For more information, see Chapter 21.) You can use
object snaps to specify the point. When you choose the POINT command from the Draw panel, the com-
mand automatically repeats the prompt so that you can continue to specify points. To end the command,
press Esc. However, you can click the button’s down arrow and choose Single Point or Multiple Point from
the submenu. Note that whichever of these options you choose, that option will appear on the Draw panel;
if you simply click the button, you get the last-used option from the drop-down list. The command-line
version draws single points.

If BLIPMODE is on and you're using the first point style —a small dot— you cannot see the point until you
use the REDRAW command to remove the blips.
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If you're using the points for temporary reference, instead of erasing them, you can set the
point style to the second style in the Point Style dialog box (no dot) before plotting. As a result,

the pomts do not appear on your plot. You can also put your points on a layer with a Not Plottable property.
(See Chapter 11 for more on layers.)

After you create a point, use the Node object snap to snap to the point.

' The drawing used in the following exercise on drawing donuts and points, ab07-d. dwg, is in
4 the Drawings folder on the DVD.

STEPS: Drawing Donuts and Points

1.
2.

Open ab07-d.dwg from the DVD.

Save the file as ab07-04 . dwg in your AutoCAD Bible folder. The drawing contains a rectangle
and connecting wires for an electrical switch. Make sure that Object Snap is on. Set running
object snaps for endpoint, center, node, and quadrant. This exercise assumes that you have
Dynamic Input on, with the default setting of relative coordinates.

Choose Menu Browser & Format = Point Style. The Point Style dialog box opens. Choose the
third point type, which is the plus sign. The Set Size Relative to Screen check box should be
selected. The Point Size should be 5.0000%. Choose OK.

Choose Home tab = Draw panel = Point. Follow the prompts:

Specify a point: Use the From object snap. (Shift+right-click to open
the Object Snap shortcut menu.)

Base point: Use the Endpoint object snap to pick the top-left corner
of the rectangle.

<Offset>: @.08,-.09 .

Specify a point: Press Esc to complete the command.

Choose Home tab = Draw panel (expanded) = Donut. Follow these prompts:

Specify inside diameter of donut <0.5000>: .04 .

Specify outside diameter of donut <1.0000>: .06 .

Specify center of donut or <exit>: Use the Node object snap to pick
the point that you drew.

Specify center of donut or <exit>: @.19,0 J

Specify center of donut or <exit>: J

Start the POINT command again. Follow the prompts:

Specify a point: Press Shift+right-click and choose Mid Between 2
Points from the shortcut menu.

First point of mid: Use the Center object snap to pick the center of
the right-hand donut. (You may have to press Tab until you get the
Center object snap, and not a Quadrant object snap.)

Second point of mid: Press and hold Shift to temporarily turn on
Ortho mode. Right-click and choose Snap OverrideswPerpendicular
and pick the lower horizontal line of the rectangle. Release the
Shift key.

Specify a point: Press Esc.

Start the LINE command. Follow the prompts:
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Specify first point: Use the Quadrant object snap to pick the right
(0 degrees) quadrant of the left donut. If you don't see the
Quadrant SnapTip, press Tab until it appears.

Specify next point or [Undo]: Use the Node object snap to pick the
point that you just drew. End the LINE command.

Save your drawing. It should look like Figure 7.10.

FIGURE 7.10

The completed electrical switch. The points show as plus signs.

__exxxg_

Summary

In this chapter, you learned how to draw curved objects and points in AutoCAD and AutoCAD LT. You

discovered:
B All the ways to draw circles
B How to define and draw an arc
B How to define an ellipse and an elliptical arc
B How to draw a donut
B How to set the point style and draw points

In the next chapter, you will learn how to display your drawing for the greatest ease and comfort.
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ften you may wish that you could zoom in to see a particular part of a

drawing more closely or move the display in a certain direction to reveal

an area that is hidden. You may also want to save a view so that you can
return to it at some other time. In this chapter, you read about controlling the
display of your drawing to meet all your drawing needs and increase your pro-
ductivity. This chapter covers viewing a 2D drawing.

If you’re using AutoCAD, this entire chapter assumes that

! you're using the 2D Drafting & Annotation workspace and the
2D ereframe visual style. To check, choose 2D Drafting & Annotation workspace
from the Workspace Switching pop-up list on the status bar. To set the visual style
to 2D Wireframe, choose Menu Browser = View = Visual Styles = 2D Wireframe.
Visual styles are mostly used for 3D drawings. I cover viewing 3D drawings in
Chapter 22.

Regenerating and Redrawing
the Display

AutoCAD and AutoCAD LT are vector programs, which means that they store
information about objects in your drawing in terms of coordinates and equations.
To display your drawing on your computer screen, the programs convert the vec-
tor information to pixels. Occasionally, you may need to redisplay the objects on
your screen. One way is to recalculate the entire drawing, in a process called
regenerating (the REGEN command). Another way is to quickly access a virtual
screen from your computer’s memory; this is called redrawing (the REDRAW com-
mand). Keep in mind that redrawing is quicker than regenerating.
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When should you use the REDRAW and REGEN commands?

B Use the REDRAW command to remove blips or to quickly refresh the screen. (In AutoCAD only,
the REDRAWALL command redraws the display in all viewports. Viewports are covered later in
this chapter.) To redraw the screen, type redraw ! at the command line.

B Use the REGEN command whenever you want to recalculate and redisplay the entire drawing. In
common usage, the word regen refers to the REGEN command as well as regenerate or regeneration.
To regenerate the entire drawing, type regen - at the command line. (The REGENALL command
regenerates all viewports.)

Panning

Often you cannot see the entire drawing on your screen. You therefore need a way to see the parts of your
drawing that are not currently visible.

To pan means to move the display without changing the magnification. The word pan refers to the expres-
sion of panning a camera across a scene or view. You pan to view a different part of your drawing.

Using the PAN command

The PAN command moves the display in the direction and distance that you indicate without changing the
magnification. Real-time panning moves the drawing as you move the cursor.

To pan the drawing, choose Home tab = Utilities panel = Pan, or click the Pan button on the status bar. The
cursor changes to a hand. Place the cursor anywhere in your drawing, then click and drag in the direction
that you want the objects to go. Instead, you can click and hold down the mouse wheel, and move your
mouse. You see the same panning cursor, the hand, as you do when you pan by clicking the Pan button.
Pan can be used transparently, while you're in the middle of another command.

3 You can pan past the edge of the screen (actually the viewport). This means that when the cur-
A sor reaches the edge of the screen, you can continue moving your mouse in the same direction
to continue the pan.

To leave Pan mode, press Esc or Enter, or start any command using a menu or toolbar. You can also right-
click to open the shortcut menu and choose Exit or one of the other display options. If you pan using the
mouse wheel, you don't need to press Esc or Enter to leave Pan mode.

Using the scroll bars

You can use the scroll bars to pan vertically and horizontally as you would with any Windows program.
However, you can't easily predict just how much the drawing view will move. Therefore, the scroll bars are
less useful than the PAN command.

Te , SEEEs You can turn the display of the scroll bars on and off. Choose Menu Browser => Tools => Options
SEEa

: to open the Options dialog box. On the Display tab, check or uncheck the Display Scroll Bars
in Drawing Window check box.

Using the ZOOM Command

The ZOOM command enables you to zoom in and out of your drawing, like the zoom lens of a camera.
When you zoom in, everything is magnified so that you can see it more easily, but you see less of the entire
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drawing. When you zoom out, objects look smaller, but you can see more of the drawing. The ZOOM com-
mand has several options that make it easy to see just what you need at an appropriate size.

5&\\_ ﬁf Zooming does not affect the actual size of objects, just as zooming with a camera lens does
i==Td==td not affect the size of the scene you're viewing. Chapter 9 covers changing the actual size of
objects, known as scaling.

When you use real-time zoom, the drawing zooms in and out as you move the cursor. To use real-time zoom,

q choose Home tab = Utilities panel = Zoom drop-down list = Realtime or click the Zoom button on the status
bar and press Enter at the prompt. The cursor changes to a magnifying glass with a plus sign on one side and
a minus sign on the other side. To zoom in, click and drag up in the direction of the plus sign. To zoom out,
click and drag down in the direction of the minus sign. Press Esc or Enter to leave Zoom mode.

You can zoom past the edge of the screen (actually the viewport) in Windows XP and Vista. As
you move the mouse up or down to zoom, when you reach the edge of the viewport, continue
to move the mouse in the same direction to continue the zoom in or out.

You can zoom by rotating the mouse wheel up to zoom in and down to zoom out. There is no Zoom
Realtime cursor, and you don't need to press Esc or Enter to leave Zoom mode. You can also double-click
the wheel to do a zoom to the extents of the drawing.

To control how much you zoom for each incremental movement of the wheel, change the
& ZOOMFACTOR system variable.

RS

Understanding ZOOM options

The ZOOM command has many options that let you fine-tune the process. Start the command by choosing
Home tab = Utilities panel and choosing one of the options on the Zoom drop-down list, or by clicking the
Zoom button on the status bar to start the command-line version. Table 8.1 outlines the Zoom options.

TABLE 8.1

Zoom Options

Button Option Description

Previous Redisplays the most recent display of your drawing. This option has its own button on
CQ the status bar.

Window Lets you define a rectangular window as the boundaries of the new display. Use the
@ Window option to zoom in on any area already displayed in your drawing. When you

use Zoom Window, the command displays everything in the window that you specify
but reshapes the display to fit your screen. As a result, you may see objects that were
outside the specified window. You can move the mouse past the drawing area to define
the window past the edge of the screen — the display moves to allow you to pick a
corner. You don’t need to specify this option separately, because the command initially
prompts you to specify the first corner of a window. When you do so, you're prompted
for the opposite corner.

Dynamic Enables you to zoom and pan in one operation. This option is covered in the next
section of this chapter.

continued
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TABLE 8.1 (continued)

Button Option Description

Scale Lets you enter a number to scale the display relative to the drawing limits (a kind of
absolute scaling). Enter a number followed by x to scale the display relative to the
current view (relative scaling). Enter a number followed by xp to scale the display
relative to paper space units (discussed in Chapter 17). A number less than 1 (such as
0.5) reduces the size of the objects on the screen (by half when you use 0.5). A number
greater than 1 (such as 2) increases the size of the objects on the screen (to twice the
size when you use 2).

®

Center Lets you specify a new center for the display, and then a new magnification/height. The
current magnification/height is shown in brackets for your reference. Type a smaller
number to increase the magnification, making the objects larger. Type a larger value to
decrease the magnification, making the objects smaller.

&

Object Lets you zoom in to selected objects.

In Uses the Scale option with a value of 2x. See the Scale option. It’s only available from
the ribbon drop-down list.

Out Uses the Scale option with a value of 0.5x. See the Scale option. It’s only available from
the ribbon drop-down list.

All Zooms the display to the greater of the drawing extents or the drawing limits.
Extents Zooms to the outer extents of the drawing. You can also double-click the wheel of your
mouse.

2 e s e

When you use one of the Zoom options, you see the objects in your drawing become larger or smaller in a
smooth transition. The smooth transition helps you to orient yourself to the new display. To turn off this
feature, use the VTOPTIONS command. In the View Transitions dialog box that opens, uncheck the Enable
Animation for Pan & Zoom check box.

I When you undo consecutive ZOOM or PAN commands, they count as one operation. Because
people often use several ZOOM or PAN operations together, combining them helps you to get
back to your previous state more quickly. To disable this feature, choose Menu Browser = Tools => Options.
On the User Preferences tab, uncheck the Combine Zoom and Pan Commands check box in the Undo/Redo
section.

Using ZOOM Dynamic

The Dynamic option of ZOOM enables you to pan and zoom in one operation. When you start ZOOM
Dynamic, you see the virtual screen area of the drawing in a blue, dashed rectangle; this view box represents
the drawing extents or limits, whichever is greater. Your current view is bounded in a green, dashed rectan-
gle. Your mouse cursor changes, based on the two modes of ZOOM Dynamic. Each time you click the left
mouse button, you switch modes. Heres how the two modes work:
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B Pan mode: The view box contains an X and can move freely around any displayed area of the
drawing.

B  Zoom mode: The view box contains an arrow. The left side of the box is fixed at the point where
you changed to Zoom mode. As you move the cursor, the box expands or shrinks, letting you
zoom to any magnification.

When the view box displays the view that you want, click the right mouse button and choose Enter (or
press Enter). The command pans and zooms to show that view. Figure 8.1 shows the screen during a
ZOOM Dynamic operation.

FIGURE 8.1

Using ZOOM Dynamic.

§<—Generated area of drawing
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>y The drawing used in the following exercise on panning and zooming, ab08-a. dwg, is in the
# Drawings folder on the DVD.

STEPS: Panning and zooming

1. Open ab08-a.dwg from the DVD. This is a drawing of a warehouse, as shown in Figure 8.2.
q 2. To read the text in the lower-right corner, choose Zoom on the status bar.

3. Atthe Specify corner of window, enter a scale factor (nX or nXP), or [All/
Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>:
prompt, pick @), as shown in Figure 8.2. At the Specify opposite corner: prompt, pick @.
AutoCAD or AutoCAD LT zooms in to display the window that you specified.

4. Choose Home tab = Utilities panel = Zoom drop-down list &> All.

141



m Drawing in Two Dimensions

142

QR
&

o ap O

5. Choose Home tab = Utilities panel &> Zoom drop-down list = Previous. You return to the previous
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display.

If you have a mouse with a wheel, double-click the wheel. Otherwise, choose Home tab =
Utilities panel & Zoom drop-down list & Extents. The drawing fills the screen. In this drawing,
the drawing extents are similar to the drawing limits, so that you see little difference between
using Zoom All and Zoom Extents.

FIGURE 8.2

A drawing of a large warehouse, with shelving and conveyor belts.
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Thanks to Bryan Kelly of ATI Corporation, Fairfield, lowa, for this drawing.

Choose Home tab = Utilities panel = Zoom drop-down list &> Center. At the Specify center
point: prompt, pick @), shown in Figure 8.2. At the Enter magnification or height
<5315.176>: prompt, type 500 . You zoom in on the office.

Choose Realtime from the Zoom drop-down list. Place the cursor at the top of the drawing, then
click and drag to the bottom of the screen. The display zooms out about 200 percent.

Choose Scale from the Zoom drop-down list. Type 2x . The display zooms in, doubling the scale
of the view and returning you approximately to the previous view of the office.

If you have a mouse with a wheel, press and hold the wheel and move the mouse to the left, hori-

zontally, until the office is on the left side of the screen. Otherwise, choose Pan from the status
bar, drag to the left with the mouse’s pick button, and then press Enter to exit Pan Realtime mode.

Choose Zoom Dynamic from the Zoom drop-down list. You now see the entire drawing. The cur-
rent view is shown with a green dashed line. The mouse cursor is a box with an X in it. You are
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now in Pan mode. To zoom in on the right side of the warehouse, move the Pan box to the lower-
right corner of the warehouse and click with the pick (left) button.

12. You are now in Zoom mode. The Zoom box contains an arrow. Move the mouse to the left to
shrink the Zoom box. Notice that the Zoom box is fixed at its left side. When the Zoom box is
about half of its original size, left-click again.

13. You are back in Pan mode again. Move the Pan box to the bottom-right corner of the warehouse.
Right-click and choose Enter to zoom in on this new view. Your display should look approxi-
mately like Figure 8.3.

FIGURE 8.3

The new view of the drawing after using Zoom Dynamic.

14. Choose Extents from the Zoom drop-down list. Do not save your drawing. If you're continuing to
@l the next exercise, leave the drawing open.

Using the SteeringWheel

The SteeringWheel is a navigation device that allows you to zoom and pan from a single interface. It also
lets you rewind through previous displays. Figure 8.4 shows the 2D Navigation Steering Wheel.

ra The SteeringWheel is new for AutoCAD 2009 and AutoCAD LT 2009. This wheel is an all-in-
>#as=d one navigation tool for both 2D and 3D use. For more information on 3D navigation, see
Chapter 22. In AutoCAD LT, the wheel offers only 2D navigation tools.
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FIGURE 8.4

The SteeringWheel is a quick navigation device that hovers at the cursor. It comes in several configurations.
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To open the SteeringWheel, click the SteeringWheel button on the status bar. This starts the NAVSWHEEL
command. The SteeringWheel appears at the cursor (and follows the cursor as you move it) and is divided
up into sections (called wedges), each of which offers a different navigational aid. To use the default wheel
configuration, do one of the following:

B Pan: Place the cursor over the Pan wedge, click and hold the pick button, and drag in the direc-
tion you want to pan. When you click, you immediately see the Pan cursor.

B Zoom: Place the cursor over the Zoom wedge, and then click and hold the pick button. Drag up
or to the right to zoom in. Drag down or to the left to zoom out. When you click, you immedi-
ately see the Zoom cursor.

B Rewind: Click and hold the Rewind wedge. You see a series of windows showing each view that
youw've displayed. Drag over the windows and release the mouse when you see the view that you

want.
B Orbit: Click and hold the Orbit wedge to view your drawing in various 3D views. I discuss Orbit
in Chapter 22.
B Center: Click a pivot point for 3D navigation. I discuss this feature more in Chapter 22.
B Walk: Lets you walk through a 3D drawing. I discuss walking through a drawing in Chapter 22.
B Look: Swivels the 3D view. I discuss this further in Chapter 22.
B Up.Down: Moves the view along the Y axis, like going up or down in an elevator. I discuss this

further in Chapter 22.

To exit, Press Esc or Enter or click the wheel’s X button. To configure the wheel, right-click and choose
SteeringWheel Settings. In the SteeringWheel Settings dialog box, you can configure both 2D and 3D fea-
tures. For example, you can change the wheel’s size and opacity, and display a mini wheel, which is a
smaller version of the SteeringWheel. You can also quickly choose one of the configurations from the short-
cut menu.

Using Aerial View

Aerial View functions like a souped-up version of ZOOM Dynamic. You can use Aerial View to pan and
zoom. If you need to pan and zoom often, you can leave the Aerial View window open and use it whenever
you need to. Aerial View is most useful with large maps or floor plans, or any drawing with a lot of detail.
You can use it transparently.

To open Aerial View, choose Menu Browser &> View &> Aerial View. The Aerial View window opens, as shown
in Figure 8.5. The Aerial View window can be active or inactive. Inside the window, you see your entire
drawing. To close Aerial View, click the Aerial View window’s Close button. Aerial View has its own toolbar
and menu.

While you work in your drawing, the drawing window is active and the Aerial View window is inactive. To
pan and zoom using Aerial View:

1. Click anywhere inside the Aerial View window to activate Aerial View. You see a pan/zoom box
that looks like the box that you see when you use ZOOM Dynamic. It has an X in it, indicating
that you can pan.

2. Move the pan/zoom box over the part of the drawing on which you want to zoom in. The display
in the main screen pans as you move your mouse.
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FIGURE 8.5

The Aerial View window.
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3. Click to switch to Zoom mode. You see the arrow in the box, indicating that you can zoom. Move
your mouse to resize the window so that it covers the area that you want to see. In the main
drawing window, you immediately see the new zoomed view.

Continue to click to switch between Zoom and Pan modes as necessary.

5. Right-click or press Esc to fix the new view.

To quickly zoom out in the Aerial View display, click Zoom Out on the Aerial View toolbar. To quickly
zoom in, click Zoom In on the toolbar. To see your entire drawing in the Aerial View display only, click
Global on the toolbar.

The Aerial View Options menu contains two options that affect how Aerial View works. Both features are
also available by right-clicking the Aerial View window shortcut menu.

B Auto Viewport applies only when you have more than one viewport. I discuss viewports later in
this chapter. If this option is checked, the view in the Aerial View window changes as you change
the active viewport in the main drawing area.

B Dynamic Update determines whether the view in the Aerial View window is continually (dynami-
cally) updated as you edit your drawing. If you find that Aerial View slows down your computer
(but you don't want to close it entirely), choose this option to turn Dynamic Update off. Choose
the option again to turn it on.

Creating Named Views

After you've done a lot of panning and zooming in a drawing, you may find that you return to the same part
of your drawing again and again, especially if the drawing undergoes a lot of changes. In a large drawing, it
can take some time to display the part of the drawing that you want. You can speed up the process by sav-
ing views.
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A view is simply a display of a drawing on your screen. A view can show any part of your drawing at any
magnification. After you have the display that you want, you give the view a name and then save it.
AutoCAD or AutoCAD LT then lets you retrieve that view at any time, without zooming or panning.

You can also turn a view into a floating viewport which you use to lay out your drawing for

: plotting. For example, if you have a top view, a side view, and a section view, you can easily
use these views for your final plot. You turn a view into a viewport usmg the Sheet Set Manager, which |
cover in Chapter 26. For now, you should be aware that you can use views both for the purpose of facilitat-
ing drawing and editing as well as for the final layout of your design for plotting (AutoCAD only).

Saving a view

First display the view that you want to save on the screen. Then choose Menu Browser = View > Named
Views to start the VIEW command and open the View Manager, as shown in Figure 8.6.

FIGURE 8.6

The View Manager dialog box.
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The Views pane lists the following types of views:

B Current: The current display.

B  Model views: All named views, including cameras, in model space. Model space is where you
draw. I cover the concept of model space in Chapter 17. Cameras are a way to define 3D views
(they are not available in AutoCAD LT); I explain cameras in Chapter 22.

B Layout views: All named views created in a layout (paper space). A layout is a mechanism for
laying out your drawing in preparation for plotting or printing. I explain layouts in Chapter 17.

B Preset views: Preset views that come with AutoCAD and AutoCAD LT. These are the same views
that you see by choosing Menu Browser = View = 3D Views.

When you choose a view in the Views panel, you see its properties in the central panel of the View Manager
dialog box. The available properties depend on the type of view. You can use the properties panel to change
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most of a view’s properties; some are for information only and are not editable. Some of the properties only
apply to 3D views, and some are not available in AutoCAD LT. Table 8.2 lists the properties that may appear
in the View Manager.

TABLE 8.2

View Properties

Property Description
Name Named Views, Cameras, and Layout Views
Category The category that you specify when you create a new named view. A category is optional and

Viewport Association

ucCs

Layer snapshot
Location
Annotation Scale

Visual style

Background

Live section

View type

Transition type

Transition duration
Playback duration

Camera X
CameraY

Camera Z
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applies only to model and layout views. If you specify a category, it appears on the Sheet
Views tab of the Sheet Set Manager (covered in Chapter 26).

Specifies whether the view is associated with a viewport on a sheet in a sheet set. This applies
only to layout views.

The name of the User Coordinate System (UCS) saved with the view. When you create a
named view, you can save a UCS with that view. | cover UCSs later in this chapter.

Specifies whether the current layer states are saved with the view. You can save this layer
snapshot with a model or layout view. | cover layer states in Chapter 11.

Specifies the layout tab name when you define a named view on a layout tab. See Chapter 17
for a discussion of layout tabs.

Stores the annotation scale that was current when you defined the view. See Chapter 17 for
more on annotation scales.

Specifies a visual style for the view. This applies only to model views. | explain visual styles in
Chapter 22; they apply mostly to 3D drawings. For 2D drawings, the visual style is 2D
Wireframe.

Specifies a background for the view. Backgrounds apply only to 3D model views (AutoCAD LT
does not offer backgrounds). Choose Solid, Gradient, Image, or Sun & Sky to open the
Background dialog box. | cover backgrounds more in Chapter 22.

Specifies a live section object applied to the view. See Chapter 24 for more on live sections.

Displays the type of shot, used for animation and playbacks. I discuss creating animated
presentations (the ShowMotion feature) later in this chapter.

Displays the type of transition between views, when shown as an animated presentation (the
ShowMotion feature).

Displays the length of the animation.
Displays the length of the display of the shot, when played back as an animated presentation.

Displays the X coordinate of the view’s camera. This is for information only and does not apply
to layout views.

Displays the Y coordinate of the view’s camera. This is for information only and does not apply
to layout views.

Displays the Z coordinate of the view’s camera. This is for information only and does not apply
to layout views.
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Property Description

Target X Displays the X coordinate of the view’s target. This is for information only and does not apply
to layout views.

TargetY Displays the Y coordinate of the view’s target. This is for information only and does not apply
to layout views.

Target Z Displays the Z coordinate of the view’s target. This is for information only and does not apply
to layout views.

Roll angle Specifies the angle that the view is tilted around the line of site. This is for information only
and does not apply to layout views.

Height Specifies the height of the view. This is for information only and does not apply to camera
views.

Width Specifies the width of the view. This is for information only and does not apply to camera

views.

Perspective

Specifies whether a view is a perspective view. This applies to model views. I discuss
perspective views in Chapter 22.

Lens length (mm)

Specifies the lens length in millimeters. This applies to perspective views only. The
LENSLENGTH system variable controls the default value for this setting. Changing this value
also changes the Field of View setting, which is another way of expressing this setting.

Field of view

Specifies the field of view of a perspective view. Changing this value also changes the Lens
Length setting. This does not apply to layout views.

Front plane Specifies the offset for the front clipping plane if you enabled front clipping. I cover clipping in
Chapter 22; it applies to 3D views only.

Back plane Specifies the offset for the back clipping plane if you enabled back clipping.

Clipping Turns clipping on or off.

To create a new named view, click New to open the New View / Shot Properties (or New View in AutoCAD
LT) dialog box, shown in Figure 8.7. Type a name for your view in the View Name text box. To specify a
view, you use the View Properties tab.

View names can be up to 255 characters and can include spaces. As explained in Table 8.2, you can save a
category, a layer snapshot, a User Coordinate System, a live section, and a visual style with a view. Select the
Current Display option button to use the current display as the view. Otherwise, click the Define View
Window button, and specify a window around the view that you want. Press Enter to return to the New
View / Shot Properties dialog box.

Click New again to define another new view, or choose OK to return to the View Manager dialog box,
where you see your new view listed. Click OK to return to your drawing.

In a very large drawing, you might create views as soon as you create the titleblock — for

ESS example, one for each quadrant of the drawing and another for the titleblock lettering. This
helps you move quickly from one section of the drawing to another. As you determine the need for more spe-
cific views, you can add them.
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FIGURE 8.7

The New View / Shot Properties dialog box, with the View Properties tab active.
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Displaying a view
The View Manager enables you to easily display any view that you have saved. Follow these steps:
1. Choose Menu Browser = View &> Named Views.
2. Choose the view that you want to restore.
3. Click Set Current.
4. Click OK.

Managing named views
You can use the View Manager to manage named views. You can also find these features by right-clicking
inside the View Manager.
B To delete a view, choose the view that you want to delete and click the Delete button or press the
Delete key on your keyboard.

B To rename a view, select it, type a new name in the Properties pane (next to the Name property),
and press Enter.
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B To change the layer states that you saved with the view, change the states of any layers before
opening the dialog box. Then open the View Manager dialog box, choose a named view, and click
Update Layers. The view now uses the current layer states. (I explain layers in Chapter 11.)

B To edit the boundaries of a view, choose the Edit Boundaries button. You are now back in your
drawing and the current view boundaries are shown in black or white (depending on the color of
your background). At the prompts, specify the two opposite corners that you want to serves as
boundaries for the view and press Enter.

Creating animated presentations from named views

You can create a presentation that displays one named view after another, as a way to show the drawing,
perhaps to a client or colleague. Each view can have a transition, as well as timing for the transition and the
display of the view itself; together, these properties are called a shot. You define the shot on the Shot
Properties tab of the New View / Shot Properties dialog box, shown in Figure 8.8.

& drawing. You can choose from two animated transitions and specify the length of time that
each slide is displayed. A looping feature lets you create an ongoing display of views. ShowMotion is not
available in AutoCAD LT.

FIGURE 8.8

ShowMotion is a new feature for AutoCAD, creating a slide show from named views in your

Use the Shot Properties tab of the New View / Shot Properties dialog box to create and configure a presentation of

your drawing.
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To configure the shot, first choose a view type. You can choose from the following view types:

B Cinematic: Allows you to choose a movement for the view. Most of the options are appropriate
for 3D drawings only. The options are Zoom In, Zoom Out, Track Left, Track Right, Crank Up,
Crank Down, Look, and Orbit. Each movement has its own controls. Try them out and click the
Preview button to see what they look like.

B Still: Displays a still view. You can specify the duration of the view.
B Recorded Walk: Lets you record a walk through a 3D model. I discuss this feature in Chapter 22.
Next, choose a transition from the Transition Type drop-down list. Then enter a duration for the transition

in the Transition Duration text box. Finally, use the Duration text box to specify how long the view displays.
Click OK when you’re done.

I The Fade from Black into This Shot looks best with a black background. The Fade from White
e =5 into This Shot looks best with a white background. See Appendix A for instructions on chang-
ing the background color of the drawing area.

oo To play the show or use other related features, click ShowMotion on the status bar to start the

El NAVSMOTION command. At first, you see one window, displaying the drawing, along with some
navigation tools. However, if you move the cursor over that window, thumbnails of all the views appear,
as shown in Figure 8.9.

FIGURE 8.9

The ShowMotion feature creates a slide show from named views.
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Use the navigation tools to do the following:

B Click any view to display that view.

@ B Click the Pin button to pin the ShowMotion box, so that it doesn't disappear when you click else-
where in the drawing area.

[::. B Click the Play All button to play the slide show. Click in the drawing area to hide the
ShowMotion window (if it isn’t pinned) so that it doesn't obscure the show.
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D m  Click the Stop button to stop the slide show.
l:'_'}_ W Click the Turn On Looping button to repeat the playback over and over.
.)IE B Click the New Shot button to open the New View / Shot Properties dialog box, with the Shot

Properties tab on top, so that you can create a new view and define its shot properties.

To edit the properties of a shot, right-click the thumbnail of an individual shot and choose Properties, or
use the EDITSHOT command and enter the name of the shot. The View / Shot Properties dialog box opens,
where you can change the settings of the shot.

>y The drawing used in the following exercise on working with views, ab08-a . dwg, is in the
@l Drawings folder on the DVD.

STEPS: Working with Views

1. Open ab08-a.dwg from the DVD if it is not already open from the previous exercise.
2. Save the file as ab08-01 . dwg in your AutoCAD Bible folder.

3. Choose Menu Browser = View &> Named Views to open the View Manager.

4

Click New to open the New View / Shot Properties (or New View in AutoCAD LT) dialog box,
with the View Properties tab on top.

o4

In the View Name text box, type top left.

6. Click the Define Window option button or the Define View Window button to return to your
drawing temporarily.

7. Atthe Specify first corner: prompt, pick the top-left corner of the drawing. At the
Specify opposite corner: prompt, pick somewhere around the center of the warehouse.
Press Enter to return to the New View / Shot Properties dialog box.

8. If you are using AutoCAD LT, go to the next step. Click the Shot Properties tab. Check that the

View type is set to Still. Change the Transition Duration to 0.5 seconds. In the Motion section,

change the Duration to 1 second.

9. Click OK once.
10. Click New again. Type bottom left in the text box of the New View / Shot Properties (or New
View in AutoCAD LT) dialog box.

11. Click the Define View Window button. At the Specify first corner: prompt, pick the
bottom-left corner of the drawing. At the Specify Opposite corner: prompt, again pick
around the center of the warehouse. Press Enter.

12. 1If you are using AutoCAD LT, go to the next step. If not, click the Shot Properties tab. Again
change the Transition Duration to 0.5 seconds. In the Motion section, change the Duration to
1 second, as you did previously.

13. Click OK. The View Manager dialog box should list both of your views. Click OK to close the
View Manager.

14. Choose Menu Browser &> View & Named Views. If necessary, expand the Model Views item, and
choose bottom left. Click Set Current, and then click OK. AutoCAD or AutoCAD LT displays
the view.

153



m Drawing in Two Dimensions

154

15. If you are using AutoCAD LT, go to the next step. If not, click ShowMotion on the status bar.

o0
El Click the Play button. The ShowMotion feature displays the two views, one after the other, using

the transition and timing that you specified.

16. Save your drawing. The views that you created are now part of the drawing database.

Using named views to manage a drawing
Using named views provides three additional advantages:
B You can use named views when you open a drawing so that one of its views is immediately
displayed.
B You can open only the part of a drawing contained in a view.

B You can turn a named view into a floating viewport for plotting purposes (AutoCAD only).

I explain these techniques in the next three sections.

A drawing with a view

After you've saved views, you can use them to open a drawing so that a view is immediately displayed.
Click Open on the Quick Access toolbar. In the Select File dialog box, choose the file that you want to open
and check the Select Initial View check box. Then click Open. In the Select Initial View dialog box, choose
the view that you want to display, and click OK.

Partially opening a drawing

You may have a very large drawing that is slow and cumbersome to work with when it is completely loaded.
For example, if you have a surveyor’s drawing of an entire county, but you need to work only with one plat,
you can open a named view containing only that plat. This feature is not available in AutoCAD LT.

To partially open a drawing from within AutoCAD, follow these steps:

1. Click Open on the Quick Access toolbar to open the Select File dialog box.

2. Choose a drawing and then click the Open button’s drop-down list. Choose Partial Open to open
the Partial Open dialog box, shown in Figure 8.10.

3. Choose a view from the list of named views.

Check the check box of one or more layers. To include all the layers, click Load All. If you don't
include at least one layer, no objects are loaded. (Chapter 11 covers layers.) Click Open.

After you've partially opened a drawing, you can load more of the drawing. Choose Menu Browser = File &
Partial Load. This item is available only if the current drawing has been partially opened. AutoCAD opens
the Partial Open dialog box. You can change the view. To display the entire drawing (from whatever is
loaded), choose the default view, *Extents*. To define a new view on the fly, click the Pick a Window
button and define the two diagonal corners of the view that you want to see. Check the layers that you want
to include or click Load All. Click OK to load the newly specified view and layers.

Using named views with sheet sets

You can combine layouts from more than one drawing into a sheet set. (AutoCAD LT doesn't include this
feature.) Sheet sets are a powerful way to organize many layouts. I cover them in detail in Chapter 26.
However, at this point you should know that named views have a value beyond helping you display an area
of your drawing. They can become your final layout for plotting.



FIGURE 8.10
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Use the Partial Open dialog box to open only the part of a drawing contained in a named view.
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Suppose that you're drawing a mechanical model with a top view, a side view, and a section view. In the
final plot, you want to display these three views on one sheet of paper. Without sheet sets, you would create
three floating viewports and individually pan and zoom to get the three views. (For more information on
floating viewports, see the “Floating Viewports” sidebar in this chapter, as well as Chapter 17.) Using the
sheet-set feature, as you work you can create named views of the three parts of the drawing. Then you can
use those same views to create the floating viewports for plotting.

Working with Tiled Viewports

Tiled viewports enable you to divide up the screen into rectangular bounding boxes. You can then show dif-
ferent views of your drawing in each viewport — at one time. The purpose of tiled viewports is to help you
draw. For example:

B You can see the whole drawing in one viewport and a zoomed-in portion of that drawing in
another viewport.

B You can see widely separated views of a large drawing at one time.

| There are two types of viewports — tiled and floating. For more information on floating view-
ports, see the “Floating Viewports” sidebar in this chapter. For a detailed discussion, turn to

)
Chapter 17.

Actually, you're already using a tiled viewport because the regular single view of your drawing that you've
been working with represents the default of a one-tile viewport. Tiled viewports have the following
characteristics:

B No matter how many viewports you have, they always collectively take up the entire screen. They
are not separate entities but a way of dividing the screen.

B Only one viewport can be active at a time. The active viewport has a bold border.
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The crosshairs appear only in the active viewport.
The UCS (User Coordinate System) icon (if set to On) appears in each viewport.

Any change that you make to your drawing in one viewport automatically appears in every other
viewport (or in viewports that show the part of the drawing where you made the change).

You can create up to 64 viewports — but you'll never want to create that many!

You can begin a command in one viewport and finish it in another. For example, you can start a
line in one viewport, switch to a second viewport, and end the line there.

You can save and restore viewport configurations.

Figure 8.11 shows a drawing divided into three tiled viewports. Each viewport shows a different view of the
same drawing.

FIGURE 8.11

A drawing showing three tiled viewports with a different view in each viewport.
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Thanks to Jerry Bottenfield of Clow Valve Company, Oskaloosa, lowa, for this drawing.

Configuring tiled viewports

Creating tiled viewports involves deciding how you want to divide up the screen. A set of tiled viewports is
called a configuration. A few simple configurations come with AutoCAD and AutoCAD LT, but you can cre-
ate your own by further dividing up any of the viewports. You can also join two viewports. Finally, you can
always return to the default of one viewport.

Creating tiled viewports
To add viewports, choose Menu Browser &> View &= Viewports. This opens a submenu from which you can
choose from the preset configurations.
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You can choose to create up to four tiled viewports from the submenu, at which point you respond to the
options that appear on the command line. For example, if you choose 2 Viewports, the command responds
with the Enter a configuration option [Horizontal/Vertical] <Vertical>: prompt.
Right-click and choose Horizontal or Vertical to create two horizontal or vertical viewports. If you choose 4
Viewports, you get four equal viewports, one in each corner. However, if you choose 3 Viewports, you can
choose from several options to configure the three viewports.

box opens with the New Viewports tab on top, as shown in Figure 8.12. You choose the configuration that
you want here. You see a preview of the configuration.

FIGURE 8.12

The Viewports dialog box makes it easy to choose a configuration.
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If you have named views in your drawing, you can specify a view for each viewport to display. Click a view-
port in the Preview pane and choose a named view from the Change View To drop-down list at the bottom
of the dialog box. You can also choose a visual style from the Visual Style drop-down list if you are using
AutoCAD. If your drawing is in 3D, you can choose 3D from the Setup drop-down list, and AutoCAD cre-
ates standard orthogonal views in the viewports. When you've specified your viewport configuration, click
OK to return to your drawing.

The Viewports dialog box is usually the best place to start creating viewports. However, if the standard con-
figurations do not meet your needs, you can use one of them as a starting point and then use the other
options.

Notice the Apply To drop-down list at the bottom-left corner of the Viewports dialog box in Figure 8.12. By
default, the tiled viewport configurations apply to the entire display, meaning that they replace your current
configuration. You can also choose to apply the configuration to the viewport that is currently displayed in
the drawing area. The active viewport has a bold border and crosshairs. To make a viewport active, click
anywhere inside that viewport. Then choose View tab = Viewports panel &> New, choose Current Viewport
from the Apply To drop-down list, and choose the configuration that you want for that viewport.

157



m Drawing in Two Dimensions

158

Let’s say that you have four equal viewports, and the top-left viewport is active. If you choose the Four:
Equal configuration from the Viewports dialog box while the top-left viewport is active and apply it to the
current viewport, the top-left viewport is divided into four viewports. Now you have seven viewports in the
drawing.

Removing tiled viewports

One way to remove a tiled viewport is to join it to another viewport. To join one viewport to another,
choose View tab = Viewports panel = Viewports & Join. At the Select dominant viewport <current
viewport>: prompt, click the viewport that you want to retain or press Enter if you want to retain the
current viewport. At the Select viewport to join: prompt, click the adjacent viewport that you want
to join into the dominant viewport. When the two viewports merge, you lose the display in this second
viewport. Together, the adjacent viewports must form a rectangle.

The only other way to remove all tiled viewports in one step is to return to the single viewport configura-
tion. Choose Menu Browser = View = Viewports & 1 Viewport. The display in the current viewport remains.

Using tiled viewports

After you've created the viewport configuration that you want, you're ready to use it. The first step is to cre-
ate the views that you need in each viewport. Just click in a viewport, and zoom and pan until you have the
view that you want.

Many users choose one viewport to display the entire drawing and the other viewports to dis-
AN play zoomed-in views of smaller sections.

After you have the viewport configuration and views that you need, you can start to draw. One of the great
advantages of viewports is that you can draw from one viewport to another. In a large drawing, you may
need to draw a line from one end of the drawing to another, but when you display the entire drawing, you
can't see the detail well enough to specify where to start and end the line. To draw from one viewport to
another, just click the viewport where you want to start. Start a command, specifying any necessary coordi-
nates. To continue the command in a second viewport, click to activate that viewport. Continue the com-
mand, specifying coordinates as necessary.

You can also use viewports to edit your drawing. All commands except those that change the display —
such as zooming, panning, and creating views — can be started in one viewport and continued in another.

Saving and restoring viewport configurations

You can save a tiled viewport configuration. Then you can restore it when needed. Viewport configuration
names can be up to 255 characters and can include spaces.

After you create a viewport configuration that you like, choose View tab = Viewports panel & New if you
aren’t already in the Viewports dialog box. Type a name in the New Name text box, and click OK.

After returning to one viewport or using a different configuration, you can restore a named viewport config-
uration. Choose View tab & Viewports panel = Named Viewports to open the Viewports dialog box with the
Named Viewports tab on top. Choose the viewport that you want to restore from the list,

and click OK.

¥ The drawing used in the following exercise on creating, naming, and restoring tiled viewport
@ configurations, ab08-b.dwg, is in the Drawings folder on the DVD.



Viewing Your Drawing _

Floating Viewports

utoCAD and AutoCAD LT have two types of viewports: tiled viewports, which are discussed here, and

floating viewports, which | cover in Chapter 17. These two types of viewports have many similarities, but
they have different purposes. Whereas the purpose of tiled viewports is to help you draw and edit your draw-
ing, floating viewports are used to lay out your drawing for plotting.

Floating viewports create layouts, which enable you to treat your screen like a sheet of paper. You create float-
ing viewports and perhaps a titleblock on this electronic sheet of paper. You can create one or more layouts.
Each floating viewport can show a different view of your drawing —just like tiled viewports. But floating
viewports then let you plot all those views on one sheet of paper. You can’t do that with tiled viewports, which
are just devices to let you temporarily display your drawing in a way that helps you draw and edit. However,
you can also draw and edit using floating viewports.

Tiled viewports are covered here because they are appropriate for learning how to draw and edit your draw-
ing. Floating viewports are covered in Chapter 17 because you use them to lay out your drawing for plotting.

STEPS: Creating, Naming, and Restoring Tiled Viewport Configurations

1. Open ab08-b.dwg from the DVD.
Save the file as ab08-02 . dwg in your AutoCAD Bible folder.
Choose View tab = Viewports panel &> New to open the Viewports dialog box.

}
oW

In the listing at the left of the dialog box, choose Three: Above. Click OK. You see three tiled
viewports.

5. Click the bottom-right viewport. Choose Zoom on the status bar and choose a window around
the left portion of the threaded model (the upper part of the drawing).

6. Click the bottom-left viewport. Again choose Zoom on the status bar and choose a window
around the bottom-left portion of the drawing (not including the titleblock).

7. Click the top viewport. Choose Home tab = Utilities and click the Zoom drop-down list. Choose
Extents. Figure 8.13 shows the results.

8. Choose View tab = Viewports panel & New. In the New Name text box, type 3 view O Ring and
click OK.

9. With the top viewport still active, choose Menu Browser = View = Viewports & 1 Viewport to dis-
play the view shown in the last active viewport.

10. Choose View tab = Viewports panel = Named.

11. Choose 3 view O Ring and click OK to restore the viewport configuration, including the views
in each viewport.

12. Save your drawing.
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FIGURE 8.13

The three tiled viewports now display three different views.
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Using Snap Rotation

Not all 2D drawings are vertical and horizontal. In some drawings, significant portions of your objects are
drawn at nonorthogonal angles. One example is an auxiliary view to show the “true size” of an inclined sur-
face. Sometimes it helps to rotate the crosshairs to match the major angles of the drawing.

Consider Figure 8.14. A great deal of this drawing is at an angle. You could handle this in four ways:

B Draw as normal, specifying the necessary angles.
W Rotate the snap, which also rotates the grid and crosshairs.

B Create a new User Coordinate System (UCS). (Creating a new UCS is covered later in this
chapter.)

B Draw the entire model vertically and rotate it afterward.

If you need to draw several objects at a certain angle, such as 45 degrees, you can rotate the snap to that
angle. The grid and crosshairs rotate to follow suit. This technique works best when the decimal point accu-
racy required lets you draw using snap points. You can also use this technique to guide the cursor at an
appropriate angle for direct distance entry, although polar tracking is another way to accomplish the same
task.

To change the snap rotation angle, you use the SNAPANG system variable. Enter snapang .| on the com-
mand line. At the Enter new value for SNAPANG <0>: prompt, enter an angle. For example, if you
enter 45 , the crosshairs, snap, and grid rotate 45 degrees.
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FIGURE 8.14

In 2D drawings such as this, you should consider various options, such as rotating the snap or creating a new UCS.
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Thanks to Robert Mack of The Dexter Company, Fairfield, lowa, for this drawing.

Note that you can also set an X base and a Y base. This simply ensures that the grid goes through a point of
your choice, which is very important if you're using Snap mode to draw. If you're just starting to draw an
object, use the 0,0 base and draw to the existing snap points. However, if you have an existing object and
need to add to it, changing the base can be very helpful. Setting X and Y bases does not change the coordi-
nates, which are tied to the UCS. (The UCS is discussed in the next section.) To set the base, use the
SNAPBASE system variable on the command line and specify a coordinate for the base. You can use an
object snap.

I You can use the ID command to get the coordinates of a point. Then use these coordinates as
4 the X and Y bases. Chapter 12 covers the ID command.

After setting the snap angle, you may want to turn the grid on to help you get your bearings. The crosshairs
and grid now reflect the new snap angle. Figure 8.15 shows the same drawing with a snap angle of 45
degrees. Notice how the crosshairs now match the angle of the drawing. The crosshairs have been set to 100
percent of screen size, which is useful when rotating the snap angle. (To reset the crosshairs size, choose
Menu Browser = Tools => Options and use the Crosshair Size section of the Display tab.)

Understanding User Coordinate Systems

You can create a new User Coordinate System (UCS) rather than rotate the snap angle. The results are simi-
lar, except that when you create a UCS, you also affect the X,Y coordinates. The UCS is much more flexible
when you start drawing in three dimensions.

By default, a drawing is set up by using a World Coordinate System. This sets the origin of the X,Y points at
0,0 and the angles using the familiar East (right-facing) equals O degrees system. Figure 8.16 shows the UCS
icon in its default display.
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FIGURE 8.15

The snap angle in this drawing has been changed to 45 degrees. Note that the grid follows the snap.
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FIGURE 8.16

The UCS icon in its default display.
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You can easily create your own UCS and even save it for future use in the drawing. To define a UCS in a 2D
drawing, you indicate the angle of the X and Y axes and an origin point. The origin point then becomes the
new 0,0 coordinate. You have several options for specifying the UCS.

Understanding UCS options

Understanding the UCS options will help you create a new UCS more easily, based on the information that
you have available. To create a UCS, choose Menu Browser = Tools &> New UCS. A submenu opens, offering
the options listed in Table 8.3. You can also find these options by choosing View tab = UCS panel and
choosing the appropriate button. You need to expand the UCS panel to access some of the options.
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TABLE 8.3

UCS Options
Button Option Meaning
@ World Specifies the default UCS, with the X axis horizontal, the Y axis vertical, and the
/ origin at the initial 0,0 location.
W) Previous Switches you to the previous UCS you were using.
—
E Face Aligns the UCS with the face of a 3D solid.
Object Enables you to align the UCS with an object. In general, this option uses the most
obvious object snap as the origin and aligns the X axis with the object. For example,

when you choose a line, the endpoint nearest your pick point becomes the origin and
the X axis aligns with the angle of the line. When you choose a circle, the X axis
points toward the point that you pick on the circumference.

View Aligns the X and Y axes with the current view. Used in 3D drawing. This option
arbitrarily sets the origin.

Origin Specifies a new 0,0 point of your choice, relative to the current origin.

v [V o

Z Axis Vector  Specifies which way the Z axis points. This option is not used in 2D drawing.

q 3 Point Enables you to specify three points. The first point is the origin, the second point
indicates the positive direction of the X axis, and the third point indicates the positive
* direction of the Y axis.
* X Keeps the current origin and rotates the Y and Z axes around the current X axis. You
b ] specify the angle. This is used in 3D drawing.
—_—
+ Y Keeps the current origin and rotates the X and Z axes around the currentY axis. You
¥ specify the angle. This is used in 3D drawing.
—
* z Keeps the current origin and rotates the X and Y axes around the current Z axis. You
. specify the angle. This option can be used in 2D drawing.
—_—

Saving and restoring a custom UCS

After you create a UCS, you can save it so that you can easily switch back and forth between the World
Coordinate System and your UCS. To save a UCS, follow these steps:
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FIGURE 8.17

1. Specify the UCS as described in the previous section.

@ 2. Choose Tools tab = UCS panel = Named to open the UCS dialog box with the Named UCSs tab

on top, as shown in Figure 8.17. If your current UCS is not named, it is listed as Unnamed and
highlighted. Previously named UCSs are also listed. You can also use this dialog box to return to
the previous UCS or the World Coordinate System (WCS).

3. Click Unnamed. Type a name for the UCS and press Enter. The name can be up to 255 characters
and can include spaces.

4. Click OK.

To restore a saved UCS, choose Tools tab = UCS panel &> Named. Choose the UCS that you want to use

and click Set Current. To return to the previous UCS that you used; choose Previous and click Set Current.
To delete a saved UCS, select it in the UCS dialog box and press the Del key. You can also select a UCS,
right-click, and choose one of the options from the shortcut menu. When you're done, click OK to close the
dialog box.

Use the UCS dialog box to save and restore a UCS.
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Current UCS: Unnaned
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Controlling the UCS icon

When you start a new drawing, the UCS icon is at the bottom-left of your drawing at 0,0. By default, the
icon remains at 0,0 even if you pan around the drawing. The icon may, therefore, end up in the middle of
your drawing. If 0,0 is off the screen, then the icon reverts to the bottom-left of your drawing.

You can turn off the UCS icon completely. If you aren’t working with customized UCSs, you often have no
reason to see the UCS in a 2D drawing. If you want the UCS icon on, you can also display it only at the bot-
tom-left of your drawing. This keeps the icon out of the way so that it does not obstruct your drawing.

If you create a new UCS, keeping the UCS icon at the 0,0 point (the origin) of your new UCS helps you to
get your bearings. A plus sign appears in the icon to indicate the origin. However, if the origin is out of the
current display or so close to the edge that the icon won fit, the UCS icon appears at the lower-left corner
of your drawing anyway.
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To control the UCS icon, choose Menu Browser = View = Display = UCS Icon. A submenu opens with the
following items:

B On: Toggles the display of the UCS icon on and off. You can also turn the display on and off by
choosing View tab & UCS panel (expanded) = Display UCS Icon.

B Origin: Toggles the placement of the UCS icon at the origin on and off.

You can customize the look of the UCS icon. To do this, choose Menu Browser & View = Display &> UCS
Icon = Properties to open the UCS Icon dialog box, shown in Figure 8.18. As you make changes, you can
see the result in the preview box.

FIGURE 8.18

Use the UCS Icon dialog box to customize the look of the UCS icon.
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Choose between 2D and 3D styles. The 3D style shows the Z axis, but you won't see it when you’re looking
at your model from the top (called Plan view). If you choose the 3D style, you can check the Cone box to
display a cone effect for the arrows of the X and Y axes. Either way, the Z axis has no arrow, which enables
you to distinguish it from the X and Y axes. You can also choose a line width from 1 to 3, 1 being the
default.

You can change the size of the icon. Just drag the slider up and down to get the result you like. Finally, you
can change the color of the icon, both in model space and in paper space layouts. (I cover paper space lay-
outs in Chapter 17.) Click OK to close the dialog box.

Using a custom UCS

In this exercise, you practice drawing with a custom UCS to create the basic framework for the drawing
shown previously in Figures 8.14 and 8.15, a bearing housing for a commercial dryer.

2y The drawing used in the following exercise on drawing with a custom UCS, ab08-c . dwg, is
@ in the Drawings folder on the DVD.

STEPS: Drawing with a Custom UCS

1. Open ab08-c.dwg from the DVD. This exercise assumes that you have Dynamic Input on, with
the default relative coordinates setting.
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7

10.

11.

12.

Save the file as ab08-03 . dwg in your AutoCAD Bible folder. Ortho Mode should be on. If
necessary, turn on Object Snap. Set a running object snap for Endpoints only.

Choose Tools tab = UCS panel = Z. Because no objects exist in the drawing, you cannot easily use
the 3 Point or Object options that might otherwise be useful.

At the Specify rotation angle about Z axis <90>: prompt, type 45 . The UCS icon
and crosshairs are displayed at a 45-degree angle.

Choose Home tab = Draw panel = Line. At the prompt, pick a point in the middle of your screen.
At the Specify next point or [Undo]: prompt, type 1.25<90 . End the LINE command.

Choose Home tab = Draw panel = Rectangle. Choose the From object snap. At the Base

point: prompt, use the Endpoint object snap to pick the endpoint of the line that you just drew.
At the <Of fset>: prompt, type @.875,0 . At the Specify other corner point or
[Dimensions] : prompt, type -5.5,1.5 . The command creates the rectangle at the proper
angle.

Start the LINE command again. Follow the prompts:

Specify first point: Choose the From object snap.

Base point: Use the Endpoint object snap to pick point a in
Figure 8.19.

<Offset>: Type @-.875,0

Specify next point or [Undol]: Move the cursor in the 90° direction
(which looks like the 135° direction because of the rotated UCS).
.625

Specify next point or [Undol: Move the cursor in the 180° direction.
3.75 J

Specify next point or [Close/Undo]: Move the cursor in the 270°
direction. .625 .

Specify next point or [Close/Undo]:

Start the LINE command again.
Turn on Object Snap Tracking on the status bar and follow the prompts:

Specify first point: Pass the cursor over 0 and then over o in
Figure 8.19 to acquire these points. Move the cursor to o at the
intersection of the two temporary tracking lines and click.

Specify next point or [Undo]: Move the cursor in the 270° direction
relative to the UCS. 1.25 .

Specify next point or [Undo]: J

Because you would normally continue working on this drawing, you should save the UCS.
Choose Tools tab = UCS panel = Named. In the UCS dialog box, click Unnamed. Type Rotated
45 and press Enter.

Still in the dialog box, choose World, click Set Current, and click OK to return to your drawing.
The UCS icon and crosshairs return to their familiar angle.

To return to the Rotated 45 UCS, choose Tools tab & UCS panel &> Named to open the UCS dialog
box. Choose Rotated 45 and click Set Current. Click OK to restore the Rotated 45 UCS.

Save your drawing.
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FIGURE 8.19

Using a customized UCS to start to draw a detail for a drill.
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After creating a new, rotated UCS such as the one in the previous exercise, type plan (to start
the PLAN command) and use the Current UCS option to remove the rotation. Now you aren’t
working at an angle in your UCS. To return to the World UCS, type plan again and choose the World option
to return to your drawing’s previous state.

N Ty

Creating Isometric Drawings

An isometric drawing is a 2D drawing made to look like a 3D drawing. Every child learns how to draw a box
that looks three-dimensional. By drawing parallelograms instead of squares, the drawing gives the impres-
sion of being in three dimensions. AutoCAD and AutoCAD LT enable you to do the same thing. However,
most people prefer to use true 3D tools these days. For more information, see Part IV of this book.

Understanding isometric planes

The ISOPLANE (short for isometric plane) command rotates the crosshairs to the special angles required for
isometric drawing. You then toggle the ISOPLANE setting from left to right to top, to draw on each of the
three “planes.” As you do so, the angles of the crosshairs, snap, and grid change to the appropriate angles.

These angles are 30 degrees for the X axis, 90 degrees for the Z axis, and 150 degrees for the Y axis. As you
toggle among the planes, you see the crosshairs take on various configurations of these angles. Figure 8.20
shows the standard isometric cube. You can see three sides —left, right, and top. In the figure, the
crosshairs are set to the right isometric plane.

Isometric drawing is not often used for precise drawing because specifying the exact points that you need
can be difficult. Also, true 3D drawing has mostly supplanted isometric drawing. It is, however, used for
piping work as well as for illustrations.
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Use snap points and object snaps as much as possible in an isometric drawing. Also, you can enlarge crosshairs to bet-
ter visualize the isometric planes. (Choose Menu Browser => Tools => Options and click the Display tab. Set
the Crosshair Size value to 100.) The grid is also a helpful aid.

FIGURE 8.20

The isometric cube.

Left plane Top plane Right plane

AT~
s TS
<4y
S 3 -~
\_‘_\ //

<—Y axis

v ///TL/;;X axis
P AN L R

Drawing in Isometric mode

To start Isometric mode, right-click the Grid button on the status bar and choose Settings to open the
Drafting Settings dialog box. On the Snap and Grid tab, in the Snap Type section, choose Grid Snap (if it is
not already selected), and then Isometric Snap to enter Isometric mode. While you're there, turn on Snap
and Grid if you want them on. Click OK. After you're in Isometric mode, press F5 to toggle from plane to
plane.

Drawing lines in Isometric mode is fairly straightforward if the lines are parallel to one of the isometric
plane angles. Circles and arcs in Isometric mode must be drawn as ellipses and elliptical arcs. When you're
in Isometric mode, the ELLIPSE command has an Isocircle option.

I Polar coordinate display is very helpful while drawing isometrically. The coordinates are easier
to understand than the unusual absolute snap point coordinates created by ISOPLANE.

Summary

In this chapter, you read how to control the display of your drawing. You learned about:

B The PAN and ZOOM commands, including real-time pan and zoom and the many ZOOM
options
B Using the Steering Wheel

Using Aerial View to pan and zoom
W Saving several views of your drawing so that you can retrieve them quickly
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B Creating animated presentations of your drawing

B Creating tiled viewports for drawing and editing, as well as naming and displaying useful view-
port configurations

B Rotating the snap and grid
B Creating a User Coordinate System, saving a UCS, and then setting it as current
W Setting the snap style to isometric to create isometric drawings

In the next chapter, you discover how to start editing your drawings.
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o drawing project is ever completed without changes. You make changes

in a drawing for many reasons. Some editing processes are simply part of

the drawing process, such as copying an object instead of drawing it a
second time from scratch. Other types of editing involve making changes to
many objects at once, such as moving an entire section of a drawing to make
room for additional objects. You often also need to erase, move, rotate, and resize
objects.

Editing a Drawing

INTHIS C

Erasing objects

Copying and moving objects

Rotating objects

Scaling objects

Using the CHANGE command

Making changes to a drawing is called editing. In order to edit an object, you need
to select it. AutoCAD and AutoCAD LT offer numerous techniques for selecting
objects. In this chapter, I cover basic editing commands as well as most of the
ways to select objects. The rest of the 2D editing commands, as well as additional
selection and editing methods — grips, the Properties palette, selection filters,
and groups — are covered in the next chapter.

Most of the editing commands are on the Home tab in the Modify panel. In most
cases, you can do either one of the following:

W Start the command first and then select the objects to which the com-
mand applies.

W Select the objects first and then start the command.

The question of which comes first, the command or the object, is fully covered
later in this chapter.
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Although you can use the editing tools that | describe in this chapter in a 3D environment, this
: chapter assumes that you are working in a 2D environment. (AutoCAD LT doesn’t offer a 3D
environment.) To make sure you're in a 2D environment, set the workspace to AutoCAD Classic or 2D
Drafting & Annotation (choose it from the Workspace Switching pop-up list on the status bar) and set the
visual style to 2D Wireframe (Menu Browser => View = Visual Styles => 2D Wireframe). If you still see the Z
axis on the UCS icon, choose Menu Browser &> View = 3D Views = Top. Another method is to set the work-
space to AutoCAD Classic or 2D Drafting & Annotation, and then start a new drawing based on the default
acad.dwt template. The chapters in this part of the book assume that you're using the default 2D Drafting
& Annotation workspace.

Understanding object-selection basics

When you start to edit drawings, it is important to first learn how to select objects. The simplest selection
technique is to place the pickbox — the box at the intersection of the crosshairs — over the object and click
with the pick button on the mouse. This is known as picking an object. By default, when you select an
object, the Quick Properties panel appears. I discuss this panel in Chapter 10.

When you pass the cursor over an object before choosing any editing command, the object becomes thicker
and dashed. This rollover highlighting helps you to know which object you will select when you click. This
feature is helpful in a busy drawing with many objects close together or overlapping. I explain how to fine-
tune the effect in the next chapter. You also see a rollover tooltip that displays some basic properties of the
object.

If you start an editing command before selecting an object, the command responds with the Select
objects: prompt. When you then pick an object to select it, AutoCAD or AutoCAD LT highlights it, usu-
ally by making the object dashed, as shown on the left side of Figure 9.1.

The command continues to provide Select objects: prompts so that you can select other objects.
Continue to select objects until you have selected all the objects that you want to edit. Then press Enter to
end the Select objects: prompt.

When you select an object before choosing an editing command, the lines of the selected object become
dashed and you also see one or more small boxes, called grips, as shown on the right side of Figure 9.1.
Chapter 10 covers grips. In the next few exercises, you use this picking technique to select objects. Other
selection methods are covered later in this chapter.

FIGURE 9.1
On the left, the selected line is dashed. On the right, the selected line also displays grips.
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Erasing objects
Somehow, no drawing is ever completed without erasing an object. The ERASE command is very simple —

]
_ :£ it has no options. To erase an object, select the object and choose Home tab => Modify panel = Erase, or
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press Del on the keyboard. Alternatively, choose Erase and then select the object.
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‘..,“ ! The drawing used in the following exercise on picking and erasing objects, ab09-a.dwg, is in
= _u:é the Drawings folder on the DVD.

STEPS: Picking and Erasing Objects

1. Open ab09-a.dwg from the DVD.

2. Save the file as ab09-01 . dwg in your AutoCAD Bible folder. This drawing is a schematic of a
gas extraction well, shown in Figure 9.2.

3. To erase the line at point @) of Figure 9.2, move the mouse until the pickbox at the intersection of
the crosshairs is anywhere over the line. The line thickens and is dashed. Click the line. Now the
line is dashed and displays grips.

Choose Home tab = Modify panel &> Erase. The line is erased.
Right-click and choose Repeat Erase.
At the Select objects: prompt, pick the line at point @), shown in Figure 9.2.

1
N oo

The command responds with 1 found and repeats the Select objects: prompt. Right-click
to end the Select objects: prompt. The line is erased.

8. Save your drawing.

FIGURE 9.2

The gas extraction well schematic.
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Thanks to the Army Corps of Engineers for this drawing. The COE maintains a Web site
of drawings athttp://cadlib.wes.army.mil.
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Il The OOPS command restores the most recently erased object and is covered in Chapter 18.

Moving objects
Use the MOVE command to move objects in your drawing. You need to specify the distance and direction
that you want the object to move.

To move an object, select it and choose Home tab &> Modify panel = Move. Alternatively, choose Move and
then select the object. When you choose the MOVE command and then select an object, the command
responds with the following prompt:

Specify base point or [displacement] <Displacement>:
You now have two ways of specifying how to move the object or objects:

B Displacement method: At the prompt, state the entire displacement as an X,Y coordinate such as
2,3 or a polar coordinate such as 2<60. The command responds with the Specify second
point of displacement or <use first point as displacement>: prompt. Because
you've already specified all the necessary information, press Enter. AutoCAD or AutoCAD LT uses
the first point you indicated as the displacement (the default) and moves the object. (Because the
word displacement already implies the relative distance from the object, you do not use @, even if
you have Dynamic Input on and set to Absolute coordinates.)

The MOVE command remembers the most recent displacement throughout a session. To
& move an object the same displacement as you just moved another object, press Enter at

Rewk

the Specify base point or [Displacement] <Displacement>: prompt. At the Specify

displacement <2.0000, 3.0000, 0.0000>: prompt, you see in angled brackets the last
displacement that you used. Press Enter to move the object using this displacement.

B Base point/second point method: At the Specify base point or [Displacement]
<Displacement>: prompt, pick a base point. This can be anywhere in your drawing but is
usually on or near the object that you want to move. When you specify a base point, choose an
object snap on the object or a nearby, related object for exact results. At the Specify second
point of displacement or <use first point as displacement>: prompt, specify the
distance and angle of movement either by picking a second point on the screen or by typing a rel-
ative coordinate. (If you have Dynamic Input on, set to the default of relative coordinates, you
don't need to add the @ symbol before the coordinates.)

The displacement method requires less input and is simpler when you know the exact displacement so that
you can type it in. The only disadvantage is that, as soon as you type in the displacement, you sometimes
see a confusing temporary drag line and copy of your object or objects. Ignore this display and press Enter.
Your object or objects move as you specified. The base point/second point method works best when you
want to move an object relative to another object on the screen.

You can use PolarSnap with the base point/second point method to move an object. Turn on PolarSnap and,
if necessary, use the Drafting Settings dialog box to set the increment. If the polar distance is 0, you can set
it to a new value. AutoCAD and AutoCAD LT use the Snap X spacing value that you specified in the
Drafting Settings dialog box. At the first prompt, pick a point such as an object snap on the object. At the
second prompt, drag the object in the desired direction. Use the tooltip to guide you and then click.

You can use drag-and-drop to move objects if you aren’t too particular about where they end up. Here’s how
it works:
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1. Pick an object.

2. Continue to pick as many objects as you want to move. They all show grips.

3. Pick any of the objects, but not on a grip. Keep the mouse button pressed until the cursor
changes to an arrow with a small rectangle.

4. Drag the object(s) to any other location in your drawing.

For a little more control over the placement of your objects, you can use the Windows Clipboard. Pick the
object(s) that you want to move. Right-click and choose Cut from the shortcut menu. Right-click a second
time and choose Paste. At the prompt for an insertion point, you can pick with an object snap or by typing
coordinates. However, you can’t control the base point (which is 0,0) as you can with the MOVE command,
because it’s always the lower-left corner of the object or of a bounding box around the object.

2y The drawing used in the following exercise on moving objects, ab09-b. dwg, is in the
é! Drawings folder on the DVD.

STEPS: Moving Objects

1. Open ab09-b.dwg from the DVD.

2. Save the file as ab09-02 . dwg in your AutoCAD Bible folder. This drawing shows the plan of a
bathroom. Each object is a block, a set of objects that you can select as one object. (Chapter 18
covers blocks.) Make sure that Object Snap mode is turned on. Set a running object snap for
Intersection only.

4 3. Pickanywhere on the tub to select it. Notice the rollover highlighting before you click, and the
"'E"' grip and dashed lines that appear after you click. Choose Home tab &> Modify panel = Move.

Follow the prompts:

Specify base point or [Displacement] <Displacement>: Move the cursor
to the Intersection at @ in Figure 9.3 and click.

Specify second point of displacement or <use first point as
displacement>: Move the cursor to the Intersection at o in
Figure 9.3 and click.

The tub moves to the bottom-right corner of the bathroom.
4. Choose Move again. Follow the prompts:

Select objects: Pick the sink.

Select objects: J

Specify base point or [Displacement] <Displacement>: 4'<0 J

Specify second point of displacement or <use first point as
displacement>: J

The sink moves 4 feet to the right.

5. Click Snap Mode on the status bar to turn it on. Now, right-click Snap Mode. Choose PolarSnap
On (unless it is already on, in which case it is unavailable). Click Polar Tracking on the status bar.

6. Pick the toilet and choose Move again. At the Specify base point or [Displacement]
<Displacement>: prompt, pick the intersection at the bottom-left corner of the toilet tank. At
the Specify second point of displacement or <use first point as displacement>:
prompt, move the toilet to the left until you see 0' -6"<180° on the tooltip, and click. The toilet
moves 6 inches to the left. (If you can’t get a 180° tooltip, check your polar angle settings.)

7. Save your drawing.
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FIGURE 9.3

The bathroom plan.
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Thanks to Bill Wynn of New Windsor, Maryland, for this drawing.

Copying objects
Copying is very similar to moving. In fact, the only difference is that AutoCAD or AutoCAD LT does not
remove the object from its original spot, so you end up with two objects instead of one.

To copy an object, select it and choose Home tab = Modify panel => Copy. Alternatively, choose Copy and
then select the object. When you choose the COPY command and have selected an object, the command
responds with the following prompt:

Specify base point or [Displacement/mOde] <Displacement>:
You now have two ways of specifying where to copy the object or objects:

B Displacement method: At the Specify base point or [Displacement/mOde]
<Displacement>: prompt, state the entire displacement as an X,Y coordinate such as 2,3 or a
polar coordinate such as 2<60. The command responds with the Specify second point of
displacement or <use first point as displacement>: prompt. Because you've
already specified all the necessary information, press Enter. The command uses the first point that
you indicated as the displacement (the default), copies the object, and ends the command.
(Because the word displacement already implies the relative distance from the object, you do not
use @, even if you have Dynamic Input on and set to Absolute coordinates.)

I The COPY command remembers the most recent displacement throughout a session. To copy
i an object the same displacement as you just copied any object, press Enter at the Specify
base point or [Displacement/mOde] <Displacement>: prompt. At the Specify displacement
<2.0000, 3.0000, 0.0000>: prompt, you see in angled brackets the last displacement that you used.
Press Enter to copy the object using this displacement.

B Base point/second point method: At the Specify base point or [Displacement/mOde]
<Displacement>: prompt, pick a base point. This can be anywhere in your drawing. At the
Specify second point of displacement or <use first point as displacement>:
prompt, specify the distance and angle of movement either by picking a second point on the
screen or by typing in a relative coordinate. (If you have Dynamic Input on and set to the default
of relative coordinates, you don't need to add the @ symbol before the coordinates.)

If you use the base point/second point method, the COPY command continues to prompt you for
additional copies. However, scripts and other routines use the earlier functioning, in which the
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command ends after creating one copy. After you make one copy, you see the Specify second
point or [Exit/Undo] <Exit>: prompt. Press Enter to use the Exit option and end the
command.

The COPYMODE system variable lets you specify if you want the COPY command to repeat or
& not. By default, as I just described, COPY repeats. Set the system variable’s value to 1 to end
the COPY command after one copy. You can also change how the COPY command works as you use it, with
the Mode option. Choose either the Single or Multiple (the default) suboption.

If you've created more than one copy, the Undo option enables you to undo the last copy that you've cre-
ated. You can then continue to make more copies or end the command.

You can use PolarSnap to copy objects in the same way that you use it to move objects. For details, see the
previous section. You can also use drag-and-drop to copy objects. Follow the steps in the previous section
on moving objects, but press and hold the Ctrl key as you drag the object. Notice the plus sign in the cur-
sor’s rectangle. As also described in the previous section, you can use the Clipboard to copy and paste
objects from one location in a drawing to another.

> The drawing used in the following exercise on copying objects, ab09-c . dwg, is in the
4 Drawings folder on the DVD.

STEPS: Copying Objects

1. Open ab09-c.dwg from the DVD.

2. Save the file as ab09-03 . dwg in your AutoCAD Bible folder. This drawing shows part of an
electrical schematic. Make sure that Object Snap is turned on. Set a running object snap for
Endpoint only.

3. Use ZOOM Window to zoom into the area of the drawing marked @), shown in Figure 9.4. This
shows a 24-volt transformer.

4. Note that three of the arcs that make up the right side of the transformer are missing. Pick the arc
U% at @), shown in Figure 9.5. Choose Home tab = Modify panel & Copy. Follow the prompts:

Specify base point or [Displacement/mOde] <Displacement>: Pick the
endpoint at the top of the arc at o (see Figure 9.5).

Specify second point of displacement or <use first point as
displacement>: Pick the endpoint at the bottom of the first arc
at @.

Specify second point or [Exit/Undo] <Exit>: Pick the endpoint at the
bottom of the second arc at @.

Specify second point or [Exit/Undo] <Exit>: Pick the endpoint at the
bottom of the third arc at @.

Specify second point or [Exit/Undo] <Exit>: J

5. Use ZOOM Previous to return to your previous view.

6. Pick the circle at @), shown in Figure 9.4 (which shows the entire schematic section). Note the
grips. You also want to select the text inside the circles, but it’s hard to see because of the grips.
Press Esc to remove the grips.

7. Choose Copy again. Now select the circle at @), shown in Figure 9.4, again. This time no grips
obscure the text. Separately pick both lines of text inside the circle.

8. Continuing to select objects to copy, select the circle at @), shown in Figure 9.4. Also select the
two lines of text inside the circle. Right-click to end the Select objects: prompt.
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The electrical schematic.
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Thanks to Robert Mack of the Dexter Company, Fairfield, lowa, for this drawing.

FIGURE 9.5

Close-up of the transformer.
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9. Atthe Specify base point or [Displacement/mOde] <Displacements>: prompt, pick
the endpoint at @), shown in Figure 9.4. At the Specify second point of displacement
or <use first point as displacement>: prompt, pick the endpoint at @), shown in
Figure 9.4. Press Enter to end the COPY command. This action copies the two circles with the
text.

10. Save your drawing.

Copying and moving objects from one drawing to another

If you use other Windows programs, you often use the CUT command to move and the COPY command to
copy objects. Then you use the PASTE command to specify a new location. In AutoCAD and AutoCAD LT,
these commands are called CUTCLIP, COPYCLIP, and PASTECLIP. (The CLIP refers to the Windows
Clipboard.) Although the MOVE and COPY commands provide more accuracy within one drawing, you
can use the Clipboard to move and copy objects from one drawing to another.

You can copy objects from one drawing to another by using the drag-and-drop technique. The easiest way is
to open both drawings and then choose View tab &> Window panel &> Tile Vertically. Select the object(s) that
you want to copy, point to one of them, and drag them to the second drawing. However, you don’t have
much control over the exact placement of the new objects. From drawing to drawing, AutoCAD or
AutoCAD LT copies the objects, instead of moving them.

For more control over the placement of your objects, use the Windows Clipboard. A special feature, Copy
with Base Point, gives you control over the placement of your objects. Follow these steps:

1. Pick the object(s) that you want to copy.

2. Right-click and choose Copy with Base Point from the shortcut menu.

3. Atthe Specify base point: prompt, specify a base point. An object snap is a good idea here.
This action copies the object(s) to the Clipboard, including the base point.

Switch to the second drawing.
5. Right-click in the drawing area and choose Paste (or click Paste on the Standard toolbar). At the

prompt for an insertion point, specify the insertion point by picking, using an object snap, or typ-
ing coordinates. This action pastes the object.

To copy the object(s) to the same coordinates as the original drawing, in Step 5 choose Paste to Original
Coordinates from the shortcut menu. AutoCAD or AutoCAD LT pastes the object(s) in the second drawing,
matching the coordinates. Depending on your drawing, you may need to ZOOM and PAN to see the pasted

copy.

You cannot specify a base point for moving (cutting) an object, but you can specify the insertion point when
you paste it. The lower-left extent of the selected object(s) is the base point.

7 | You can drag objects from a drawing into another application, such as a word-processing doc-
ATl ument. For more information on working with AutoCAD or AutoCAD LT and other applica-
tions, see Chapter 27.

Rotating objects

If your design changes or you drew at an incorrect angle, you may need to rotate one or more objects. You
can easily rotate an object or objects around a base point that you specify. The base point is usually an
object snap point on the object. To indicate the rotation, specify an angle of rotation. As explained in
Chapter 5, by default, zero degrees is to the right, and degrees increase counterclockwise. (To change the
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default, choose Menu Browser => Format = Units.) By specifying a negative angle, you can turn objects
clockwise.

To rotate an object, choose Home tab = Modify panel = Rotate. Alternatively, select an object and then
choose Rotate. At the Specify base point: prompt, indicate the point around which you want to
rotate. At the Specify rotation angle or [Copy/Reference] : prompt, type an angle at the com-
mand line.

Use the Copy option to create a copy of the original object. After you use this option, the same
i prompt returns so that you can specify a rotation angle. You end up with two objects, one at
the original rotation angle and one at the new rotation angle.

The most recent rotation angle that you specify becomes the default for other rotations during the same ses-
sion. For example, if you rotate an object 330°, the next time you rotate an object, the prompt appears as
Specify rotation angle or [Copy/Reference] <330>:. Press Enter to rotate the object using the
default rotation.

The purpose of the Reference option is to let you specify an absolute rotation angle for an object. For
example, let’s say you want to rotate a line, whose angle you don’t know, to 45°. At the Specify the
reference angle <0>: prompt, you type in an angle or specify an angle by picking two points. These
can be object snap points on the object that specify the object’s current angle; in the example, you would
use the endpoints of the line. At the Specify the new angle or [Points] <0>: prompt, type or pick
a new angle or specify two points to determine the new angle. You can also pick an object snap on another
object in the drawing to indicate this new angle. In the example, you would enter 45 to rotate the line to
45°. You can use the Reference option to align the object with the X or Y axis or with another object in
your drawing.

> The drawing used in the following exercise on rotating objects, ab07-03 . dwg, is in the
& Results folder on the DVD.

STEPS: Rotating Objects
1. Open ab07-03.dwg from the Results folder of the DVD. If you did the exercise on ellipses in
Chapter 7, you can open this drawing from your AutoCAD Bible folder.

2. Save the file as ab09-04 . dwg in your AutoCAD Bible folder. This drawing shows a conference
room, as shown in Figure 9.6.

3. Set Center, Quadrant, and Perpendicular running object snaps. Object Snap mode should be on.
Polar Tracking should be off.

Modify panel & Rotate.

{) 4. Pick the small elliptical table at the top-left corner of the conference room. Choose Home tab =

5. Atthe Specify base point: prompt, pick the top quadrant of the ellipse. At the Specify
rotation angle or [Copy/Reference] : prompt, type 90 .. This action rotates the small
table 90 degrees around the base point.

6. Click Snap Mode on the status bar to turn off snap.

7. To make a copy of the chair and rotate it at the same time, start the ROTATE command. At the
Select objects: prompt, pick the arc that makes the back of the chair at the bottom of the
drawing. The command responds 1 found. Continue to pick the two lines that make the arm-
rests and the arc that makes the front of the chair, making sure, each time, that you see the
response 1 found, for a total of 4. Press Enter to end the Select objects: prompt.
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FIGURE 9.6

The conference room.
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To copy and rotate the selected chair, follow the prompts:

Specify base point: Use the Center object snap to select the center
of the large table.

Specify rotation angle or [Copy/Referencel] <90>: Right-click and
choose Copy.
Specify rotation angle or [Copy/Reference] <90>: 180 .

Start the COPY command and select the four objects in the new chair. Press Enter to end object
selection. Follow the prompts:

Specify base point or [Displacement/mOde] <Displacement>: Use the
Center object snap to select the center of the arc that makes up
the back of the chair.

Specify second point of displacement or <use first point as
displacement>: Pick a point about a third of the way around the
right side of the conference table.

Specify second point or [Exit/Undo] <Exit>: Pick a point about
halfway around the right side of the conference table.

Specify second point or [Exit/Undo] <Exit>: Pick a point about two-
thirds of the way around the right side of the conference table.

Specify second point or [Exit/Undo] <Exit>: J

Start the ROTATE command and select the four objects in the first of the three chairs (the top

one) that you just created. Right-click to end object selection. At the Specify base point:

prompt, pick the Center object snap of either arc of the chair. At the Specify rotation
angle or [Copy/Reference] : prompt, move the cursor around, watch the image of the
chair rotate, and click when the chair faces the angle of the table.

Repeat Step 11 for the second chair.

Start the ROTATE command and select the four objects in the last chair that you created by using
the COPY command. Follow the prompts:

Specify base point: Choose the Center object snap of either of the
chair arcs.
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Specify rotation angle or [Copy/Referencel: Right-click and choose
Reference from the shortcut menu.

Specify the reference angle <0>: Use the Quadrant object snap to pick
the back arc of the chair.

Specify second point: Use the Quadrant object snap to pick the front
arc of the chair.

Specify the new angle or [Points] <0>: Use the Perpendicular object
snap to choose the conference table next to the chair.

13. Save your drawing.

Scaling objects

Scaling, or resizing, objects is another common editing task in AutoCAD or AutoCAD LT. As with rotating
objects, you specify a base point, usually an object snap on the object. The base point is the one point on
the object that does not move or change as you scale the object. The most common way to resize an object
is to specify a scale factor. The current object has a scale factor of 1. Therefore, to increase the size of the
object, type in a number greater than 1. For example, a scale factor of 2 doubles the size of the object. To
decrease the size of the object, type in a number less than 1. A scale factor of 0.25 creates an object one-
quarter of its previous size. The most recent scale factor that you specify becomes the default for other scal-
ing operations during the same session.

Use the Copy option to create a copy of the original object. After you use this option, the same prompt
returns so that you can specify a scale factor. You end up with two objects, one at the original scale and one
at the new scale.

As with the ROTATE command, you can scale by using the Reference option to specify an absolute length.
You specify the reference length, usually the current length of the object, by typing it in or using object
snaps on the object. At the Specify new length or [Points] <0'-1"> prompt, you can type a new
length or pick two points. You can use the Points option to match the size of another existing object.

To scale an object, choose Home tab => Modify panel &> Scale, and select the object. Alternatively, you can
select the object and choose Scale.

I The drawing used in the following exercise on scaling objects, ab09-d. dwg, is in the
i Drawings folder on the DVD.

STEPS: Scaling Objects

1. Open ab09-4d.dwg from the DVD.

2. Save the file as ab09-05 . dwg in your AutoCAD Bible folder. This drawing, shown in Figure 9.7,
shows part of a valve that is manufactured in several sizes. In this exercise, you scale both views
to represent a different-sized valve piece. Ensure that Object Snap is on. Set running object snaps
for Quadrant and Endpoint.

1 3. Choose Home tab = Modify panel = Scale. At the Select objects: prompt, pick both circles
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in the top view (they’re actually arcs because they’re broken at the bottom) and the two short lines
at the bottom of the circles. Press Enter to end object selection. Follow the prompts:

Specify base point: Use the Quadrant object snap to pick the left
quadrant of the inner circle.

Specify scale factor or [Copy/Reference]: Right-click and choose
Reference.

Specify second point: Use the Quadrant object snap to pick the right
quadrant of the inner circle.
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FIGURE 9.7

The valve piece in two views.

Thanks to Jerry Bottenfield of Clow Valve Company, Oskaloosa, lowa, for this drawing.

Specify reference length <1>: Use the Quadrant object snap to pick
the left gquadrant of the inner circle again.
Specify new length or [Points] <1.000>: 1

Because the distance between the two quadrants that you chose is 2.5 units, the SCALE command
scales the objects to 40 percent (1 divided by 2.5).

Right-click and choose Repeat Scale. Select all eight lines in the bottom view, including the green
dashed lines. Be sure that you see 1 found each time. If necessary, use ZOOM Window to zoom
in. Right-click to end object selection after you finish selecting the lines. Follow the prompts:

Specify base point: Use the Endpoint object snap at point o in
Figure 9.8.
Specify scale factor or [Copy/Reference]: .4 J

Save your drawing. It should look like Figure 9.8.

FIGURE 9.8

The valve piece has now been scaled down.

O
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FIGURE 9.9

Using the CHANGE command

The CHANGE command changes the endpoint of a line and the radius of a circle. Note that you can also
use grips and the Properties palette, both of which are covered in the next chapter, to change line endpoints
and circle radii (among other object properties).

f You can use the CHANGE command to change text (which I cover in Chapter 13), the text and
S5 text properties of block attributes (not yet contained in a block), as well as the location and
rotatlon of blocks (Chapter 18), but other newer commands do those jobs better. The Properties option of
this command can change many object properties, but it’s generally easier to use the Properties palette.
However, these features of the CHANGE command can be useful when writing scripts or AutoLISP code,
covered in Parts VI and VII of this book.

To change an object, select it and type change I on the command line. Alternatively, you can type change !
on the command line and select the object.

The CHANGE command works differently, depending on whether you select lines or circles.
i For this reason, it can give unexpected results if you choose lines and circles at the same time.

Use the command for either lines or circles but not for both at once.

Changing lines

If you select one line, the CHANGE command changes the endpoint closest to where you picked the line.
The command prompts you for a change point. When you pick the point, the command brings the end-
point of the line to that change point, as shown in Figure 9.9. You can use an object snap to specify the
change point. If Object Snap is on, the line becomes orthogonal, bringing the endpoint of the line as close
as possible to the change point that you specify, as shown in Figure 9.9.

Using the CHANGE command on one line.
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If you select more than one line, CHANGE works differently: It moves the nearest endpoints of all the lines
to the change point so that all the lines meet at one point, as shown in Figure 9.10.

Changing circles

Changing the radius of a circle has the same result as scaling it. When you select a circle, the command
prompts you for a change point. If you pick one, AutoCAD or AutoCAD LT resizes the circle so that it
passes through the new point. You can also press Enter. You then get a prompt to enter a new radius.
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Using the CHANGE command on several lines. The original lines are shown as continuous. The new lines, after
using the CHANGE command, are dashed.
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If you select more than one circle, the command moves from circle to circle, letting you specify a new radius
for each, one at a time. You can tell which circle is current because of its drag image, which lets you drag
the size of the circle.

If you select more than one circle and try to pick a change point, the command responds with Change
point ignored. At that point, one circle becomes active, and you can then pick a change point.

Selecting Objects

If you've been following through this chapters exercises, you've probably thought it tedious to pick several
objects one at a time. Imagine trying to individually pick every object in a drawing just to move all the
objects one-half unit to the left! Of course, there is a better way. In fact, AutoCAD and AutoCAD LT offer
many ways of selecting objects. Selected objects are called the selection set of objects.

Selecting objects after choosing a command

When you choose an editing command, you see the Select objects: prompt. This prompt has 16
options —all you could ever want for selecting objects — but these options are not shown on the command
line or in the Dynamic Input prompt. To specify an option, type the option abbreviation. Because the
Select objects: prompt repeats until you press Enter, you can combine options to select objects for
any command. In the following list of options, the capitalized letters of the option are the abbreviation that
you type (uppercase or lowercase letters work) at the Select objects: prompt.

B  Window: The Window option lets you pick two diagonal corners that define a window. All
objects entirely within the window are selected. Figure 9.11 shows the process of picking the
window on the left and the result on the right — to indicate that the selected objects are high-
lighted, they display dashed instead of continuous lines. As you move your mouse to specify the
second diagonal corner, a blue transparent rectangle appears to help you preview which objects
will be selected.

You can drag past the edge of the screen (actually the viewport) to specify a window. Hold

&% down the mouse button and continue to move the mouse in the same direction. The display
automatlcally pans so that you can see objects that were off the screen. When you see all the objects that
you need to select, pick the second corner of the window.
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FIGURE 9.11

Selecting objects with a window. The window selects only objects that lie entirely within the window.
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B Last: The Last option selects the last object that was created and is visible within the current view.
Often you create an object and then want to move or copy it. In this situation, the Last option is
an easy way to select the object that you just created.

B Crossing: Crossing enables you to pick two diagonal corners that define a window. All objects
entirely or partly within the window are selected. As you move your mouse to specify the second
diagonal corner, a green transparent rectangle appears to help you preview which objects will be
selected. Figure 9.12 shows the process of picking the window on the left and the result on the
right — the selected objects are highlighted.

I You can drag past the edge of the screen (actually the viewport) to specify a crossing window.

55 Hold down the mouse button and continue to move the mouse in the same direction. The dis-
play automatically pans so that you can see objects that were off the screen. After you see all the objects that
you need to select, pick the second corner of the crossing window.

FIGURE 9.12

Selecting objects with a crossing window. The crossing window selects any objects that lie
within or partly within the window.

Crossing window Selected objects
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B BOX: The BOX option is a combination of the Window and Crossing options. If you pick the two
window corners from left to right, the selection functions as if you used the Window option. If
you pick the two points from right to left, the selection functions as if you used the Crossing
option. By default, you can select objects this way without specifying the BOX option. See the
description of implied windowing later in this chapter.
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B ALL: The ALL option selects all objects on thawed and unlocked layers in the drawing. (I discuss
layers in Chapter 11.) Use the ALL option when you want to select everything, including objects
that you can't currently see on the screen.

To select all objects, choose Home tab = Utilities panel => Select All.

B Fence: The Fence option enables you to specify a series of temporary lines to select any object
crossing the lines. Figure 9.13 shows the process of defining a selection fence on the left and the
result on the right — the selected objects are highlighted.

FIGURE 9.13

Using a fence to select objects.

B  WPolygon: The Window Polygon option (WPolygon) is like the Window option, except that you
create a polygon instead of a rectangular window. This option selects all objects that lie entirely
within the polygon.

B CPolygon: The Crossing Polygon option (CPolygon) is like the Crossing option, except that you
create a polygon instead of a rectangular window. This option selects all objects that lie entirely or
partly within the window.

B Group: The Group option selects a named group of objects. (Chapter 10 covers groups.) If you
need to work regularly with a certain set of objects, you can place them in a group and then easily
select them with one click.

B Remove: The Remove option enables you to deselect objects. After you use this option, all objects
that you select are deselected and are therefore removed from the selection set. Use the Add
option to once again select objects.

An alternative to using Remove to deselect objects is to press Shift and deselect objects by
picking or implied windowing. Implied windowing is discussed later in this chapter.

B Add: The Add option sets the selection mode to add objects to the selection set. Use the Add
option after using the Remove option to start selecting objects again.

B Multiple: The Multiple option turns off highlighting as you select objects. However, you cannot
preview which objects are in the selection set.

B Previous: The Previous option automatically selects all objects that you selected for the previous
command. Objects selected and edited by using grips are not remembered for this option. (The
next chapter covers grips.)
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B Undo: The Undo option deselects the object(s) selected at the last Select objects: prompt.
(If you removed objects from the selection set at the last Select objects: prompt, Undo
reselects them.)

B AUto: The AUto option combines picking with the BOX option. By default, you can select objects
this way without specifying this option. See the description of implied windowing later in this
chapter.

B SIngle: When you specify this option, you get another Select objects: prompt. You select
objects by using any option, and then AutoCAD immediately ends the selection process. You
don’t have to press Enter.

B SUbobject: The SUbobject option is used only for 3D solids and allows you to select vertices,
edges, and faces. For more information, see Chapter 24.

B Object: This option ends the selection of subobjects so that you can select other objects.

B ClLass: The CLass option allows you to select certain objects that were created in another applica-
tion. Certain applications, such as Autodesk Map, can add a feature classification to an object.
Doing so creates an associated classification (XML) file. If you have such an object and the XML
file is present, you can select objects by classification property (AutoCAD only).

Cycling through objects

It may happen that you have many objects close together in a drawing, making it hard to select the object
or point that you want. You could always zoom in, but in a complex drawing this can take some time.
Another trick is to use object cycling. At the Select objects: prompt, place the cursor over the area
where more than one object overlaps. Then hold down the Shift key and press the Spacebar. One object is
highlighted. If it is not the one you want, with the Shift key still down, press the Spacebar again. AutoCAD
or AutoCAD LT cycles through the objects. When the object that you want is highlighted, pick the object.
You can continue to select other objects or end object selection by pressing Enter.

Selecting objects before choosing a command

If you select objects before choosing a command, your options are more limited than if you choose a com-
mand first. Nevertheless, you have enough flexibility for most situations. The reason for the limitation is
that the Command: prompt is active, and anything that you might type at the keyboard to indicate a selec-
tion option could be confused with a command. You can pick the object to highlight it, use implied win-
dowing, or use the SELECT command on the command line to select objects in advance.

The purpose of the SELECT command is simply to select objects. This command then saves these objects
for use with the Previous selection option. Choose an editing command and type p  at the Select
objects: prompt to select the objects that you selected with the SELECT command.

Implied windowing

Implied windowing is equivalent to the Auto selection option discussed earlier in this chapter. By default,
implied windowing is always active. As a result, implied windowing is useful for selecting objects before or
after choosing a command. By carefully choosing which way you create a selection window, you determine
how you select objects:

B From right to left: If the first window corner is to the right of the second one, you create a
crossing window. The crossing window selects all objects that lie entirely or partially within the
window.

B From left to right: If the first window corner is to the left of the second one, you create a regular
selection window. The window selects all objects entirely within the window.
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Y The drawing used in the following exercise on selecting objects, ab09-e. dwg, is in the
4 Drawings folder on the DVD.

STEPS: Selecting Objects

1. Open ab09-e.dwg from the DVD, as shown in Figure 9.14.

2. Save the file as ab09-06 . dwg in your AutoCAD Bible folder. Make sure that Object Snap
mode is on. Set running object snaps for Endpoint and Perpendicular.

3. Draw a line from 1 to 2, shown in Figure 9.14. You will use this later to illustrate the Last selec-
tion option.

FIGURE 9.14

A kitchen floor plan.

O-

Type select .

5. To select the six-burner stovetop, pick a point near 3, being careful that the pickbox at the inter-
section of the crosshairs doesn't touch any object. Transparently zoom in and back out, if neces-
sary. Then move the mouse to 4 and pick again. The objects that you have chosen appear dashed
to indicate that they have been selected.

6. To select the last object that was created — the line drawn in Step 1 —type 1 . It now appears
dashed.

7. Turn off Object Snap mode. To select the interior lines on the kitchen’ island by using a fence,
type f 4. Then pick points 5, 6, and 7. Press Enter to end the fence.

8. Typer  atthe Select objects: prompt (the prompt changes to Remove objects:) and
pick the line at 8 to remove the external island line picked in Step 7. At this point, all the selected
items should be dashed, as shown in Figure 9.15.
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10.

11.

FIGURE 9.15

Kitchen floor plan with all selected items shown with dashed lines.

0

Press Enter to complete the command.

Turn on Object Snap mode. Start the MOVE command. At the Select objects: prompt,
type p < and then press Enter again to end object selection. At the Specify base point
or [Displacement] <Displacement>: prompt, pick the endpoint at 9, shown in
Figure 9.14. At the Specify second point of displacement or <use first point
as displacement>: prompt, pick the endpoint at 0. All the objects move.

Save your drawing.

Customizing the selection process

You can customize the way that you select objects. To do so, choose Menu Browser &> Options and click the
Selection tab, as shown in Figure 9.16.

Selection preview

The Selection Preview option applies to rollover highlighting and the transparent selection rectangle. You
can specify whether you want these effects to appear only if a command is active or even when no com-
mand is active (when you are selecting objects before choosing a command).

Click the Visual Effect Settings button to open the Visual Effect Settings dialog box, where you can specify
the following settings:

B Rollover highlighting: In the Selection Preview Effect section, you can choose the thicken effect,

the dash effect, or both. The default is to show both. Click the Advanced Options button to
exclude certain types of objects from the rollover highlighting effect. Some people find this effect
distracting, but by customizing these settings, you may find a solution that works for you (other
than turning it off).

Selection rectangle: In the Area Selection Effect section, you can turn the effect off, change the
colors for the window and crossing rectangles, and change the opacity percentage.
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The Selection tab of the Options dialog box.
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Noun/verb selection

As you already know, the editing process consists of two parts: using a command, such as COPY or MOVE,
and selecting objects. In AutoCAD/AutoCAD LT lingo, noun means an object in your drawing. Verb refers to
a command because a command acts on an object. This option lets you decide whether you want to be able
to select objects before starting a command.

In Windows programs, you typically select objects before starting a command. For example, if you're using
Microsoft Word and want to erase a sentence, you select the sentence first, and then press Del.

By default, noun/verb selection is available, as shown in the first option in the Selection Modes section of
the Selection tab in Figure 9.16. With this option enabled, you can select objects first, without giving up the
ability to choose commands first. This gives you maximum flexibility.

The advantage of selecting objects first is that, when you switch between Windows programs, you don’t
have to change habitual ways of selecting objects. The disadvantage of selecting objects first is that some
AutoCAD and AutoCAD LT commands don't let you select objects first, which can be confusing. Also, when
you select objects first, grips appear — sometimes obscuring the objects that you need to select.

Use Shift to Add to Selection

Use Shift to Add to Selection is the second option in the Selection Modes section of the Selection tab of the
Options dialog box. By default, this option is not checked. In AutoCAD and AutoCAD LT, you often select
more than one object at a time for editing. Therefore, the default is to simply let you select object after
object— when you select a second object, the first object stays selected — so that you can easily select any
number of objects you want.

However, Windows programs typically enable you to select only one object at a time. To select multiple
objects, you need to hold down Shift as you select. Similarly, if you check the Use Shift to Add to Selection
option, then after selecting one object, you must hold down Shift to select any additional objects.
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Commands and Object Selection

ertain commands require you to choose objects in a specific order or require you to choose objects that

have a certain relationship to each other. For example, the TRIM command (covered in the next chapter)
requires that you first select an object to trim to (the cutting edge), and then the object to trim. If you selected
the objects in advance, the program wouldn’t know which object to trim. Only after you start the TRIM com-
mand does AutoCAD or AutoCAD LT know to prompt you exactly for the objects that it needs to complete the
command. Other commands require that you select objects that are related in some way. The FILLET com-
mand (also covered in the next chapter) joins objects that meet— or would meet if extended — by drawing an
arc to create a rounded corner. Here again, the command would be meaningless if, say, you selected three or
more objects, so the command requires that you use the command first and then specifically prompts you to
select the first object and then the second object.

Many commands allow you to select objects first, but the following are some of the most common:

B ARRAY B ERASE m OFFSET

m BLOCK m EXPLODE B ROTATE
B CHANGE m HATCH m SCALE

m CHPROP W LIST B STRETCH
m COPY ® MIRROR ® WBLOCK
m DVIEW m MOVE

These commands enable you to select any number of objects without restriction, so that selecting the objects
first and the command second works well.

Press and Drag

One of the ways to select objects is to create a window that includes a number of objects. You're already
familiar with creating a similar window from using ZOOM with the Window option. If the Press and Drag
option is checked, you need to pick at one corner of the window and, without releasing the pick button,
drag the cursor to the diagonally opposite corner. This type of action is typical of Windows programs.

By default, this option is not checked, which means that to create a window, you pick at one corner of the
window, release the mouse button, and pick again at the diagonally opposite corner.

I This setting does not affect the ZOOM Window operation, which always requires two separate

ik picks, one for each corner.

Implied windowing

By default, this option is on. Implied windowing means that, if you pick any point not on an object,
AutoCAD or AutoCAD LT assumes that you want to create a selection window. You can then pick the oppo-
site corner to select objects. If you pick the corners from right to left, you get a crossing window. If you pick
the corners from left to right, you get a standard selection window. If Implied windowing is not on when
you pick a point not on an object, the program assumes that you missed some object and gives you this
message on the command line:

0 found
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This option applies only when you have started a command and see the Select objects: prompt. If you
turn this option off, you can still enter the Crossing or Window selection options manually (by typing ¢
or w ). When selecting objects before starting the command, implied windowing is always on.

Object grouping

Creating groups of objects is discussed in the next chapter. Groups are sets of objects that you name. If
object grouping is on (the default) when you select one object in a group, all the objects in the group are
automatically selected. Object grouping is a global setting; you can also set object grouping on or off for
individual groups.

Associative Hatch

If checked, the Associative Hatch option selects boundary objects when you select a hatch within the
boundary. This option is off by default. Checking this option is equivalent to setting the PICKSTYLE system
variable to 2. Chapter 16 covers hatches.

Pickbox Size

The pickbox is the box that you see at the intersection of the crosshairs when selecting (or picking) objects.
The Pickbox Size area lets you set the size of the pickbox.

If Noun/Verb Selection is off and grips are disabled, no pickbox appears at the intersection of

: the crosshairs until you start an editing command and the command line displays the Select
objects: prompt. However, if either Noun/Verb Selection or grips are on, the pickbox is always at the
crosshairs, letting you select objects at any time.

Summary

All drawings need to be edited, either as part of the drawing process or to make corrections. In this chapter,
you read about:

B Erasing objects

Moving objects

Copying objects

Rotating objects

Scaling objects

Using the CHANGE command on lines and circles

The many ways of selecting objects

B Customizing the object-selection features

The next chapter covers the more-advanced editing commands and options.
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geometric editing commands — covering the more complex commands

used to refine the details of your drawing. These commands enable you to
copy, move, resize, break, and cover objects, as well as construct corners. I also
discuss grips, which make it easy to move, mirror, rotate, scale, and stretch
objects, and I explain how to use the Quick Properties panel and the Properties
palette to edit objects. I end the chapter with a discussion of three ways to con-
trol the selection of objects — groups, filters, and the Quick Select feature.

This chapter completes the discussion, started in the previous chapter, of

Although you can use the editing tools that I describe in this

: { chapter in a 3D environment, this chapter assumes that you
are working in a 2D environment, using the default 2D Drafting & Annotation
workspace. (AutoCAD LT doesn’t offer a 3D environment.) To make sure you're in
a 2D environment, set the workspace to 2D Drafting & Annotation (from the
Workspace Switching pop-up list on the status bar) and set the visual style to 2D
Wireframe (Menu Browser = View = Visual Styles => 2D Wireframe). If you still

see the Z axis on the UCS icon, choose Menu Browser => View => 3D Views = Top.

Another method is to set the workspace to 2D Drafting & Annotation, and then
start a new drawing based on the default acad.dwt template.

Copying and Moving Objects

IN THIS CH

Using advanced copying and
moving commands: MIRROR,
ARRAY, OFFSET, and ALIGN

Using advanced resizing
commands: TRIM, EXTEND,
STRETCH, and LENGTHEN

Using construction commands:
BREAK, JOIN, CHAMFER, and
FILLET

Creating a revision cloud and a
wipeout

Double-clicking to edit objects

Editing objects with grips, the
Properties palette, and the
Quick Properties panel

Three commands enable you to copy objects in very specific ways. MIRROR cre-
ates a mirror image. ARRAY copies objects in a rectangular or circular pattern.
OFFSET creates parallel objects. Although these commands make copies of
objects, they produce a result that would be difficult or impossible to produce
simply by using the COPY command. The ALIGN and 3DALIGN commands
move objects by aligning them with other objects in the drawing.
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Using selection filters and Quick
Select

Creating groups of objects
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Using the MIRROR command

Many drawings have symmetrical elements. Often, especially in mechanical drawings, you can create one-
half or one-quarter of a model and complete it simply by mirroring what you have drawn.

To mirror, select an object or objects and then choose Home tab &> Modify panel &> Mirror. Alternatively,
start the MIRROR command first and then select an object or objects.

The command prompts you for the first and second points of the mirror line. This is an imaginary line
across which the command creates the mirrored object. The length of the line is irrelevant — only its start
point and direction are important.

Most mirror lines are orthogonal. Therefore, after you specify the first mirror point, you can
turn on Ortho mode and move the mouse in the direction of the second point. You can then
quu:kly pick the second point. Polar tracking can also easily guide you to specify an orthogonal mirror line.

The command then asks if you want to erase the source objects. The source objects are the objects you have
selected to mirror. If you want to keep them, type n ! or press Enter. You keep the source objects when
you're building a symmetrical model and want the mirror image to be added to the original object(s). Type
y < when you want to edit an object (change its orientation) so that only the mirror image is retained in the
drawing.

% The drawing used in the following exercise on mirroring objects, ab07-02 . dwg, is in the
4 Results folder on the DVD.

STEPS: Mirroring Objects

1. Open ab07-02.dwg from the Results folder of the DVD. If you completed the exercise on
arcs in Chapter 7, you can open this drawing from your AutoCAD Bible folder.

2. Save the file as ab10-01.dwg in your AutoCAD Bible folder. Make sure Object Snap mode is
on. Set a running object snap for Intersection only.

3. Choose Home tab & Modify panel & Erase. At the Select objects: prompt, pick the line and
two arcs to the bottom-right of the two centerlines, and then press Enter. The resulting model
should look like Figure 10.1.

4. Choose Home tab &> Modify panel = Mirror. At the Select objects: prompt, pick the remain-

_ﬂlh ing exterior line and two arcs, and press Enter.

5. Atthe Specify first point of mirror line: prompt, pick intersection ), shown in
Figure 10.1. At the Specify second point of mirror line: prompt, pick intersection @.

6. The command prompts Erase source objects? [Yes/No] <N>: Press Enter to accept the
default, No.

7. Start the MIRROR command again. At the Select objects: prompt, type p < to pick the orig-
inal lines. Then pick the new exterior line and two arcs, and press Enter.

8. Atthe Specify first point of mirror line: prompt, pick intersection @. At the
Specify second point of mirror line: prompt, pick intersection €. Press Enter again at
the Erase source objects? [Yes/No] <N>: prompt.

9. The command completes the mounting plate. Save your drawing. It should look like Figure 10.2.
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FIGURE 10.1

A partially completed mounting plate.
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FIGURE 10.2

The completed mounting plate.
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Using the ARRAY command

The ARRAY command creates a rectangular or polar (circular) pattern by copying the object(s) you select as
many times as you specify. The ARRAY command is a powerful drawing tool. It can quickly create large
numbers of objects, thus saving a huge amount of time and effort.

Rectangular arrays
A rectangular array creates a grid of rows and columns of one or more objects. Figure 10.3 shows an exam-
ple of a rectangular array. To create a rectangular array, follow these steps:

oo 1. Choose Home tab = Modify panel (expanded) = Array, and select the object or objects. You can
oo choose the objects first if you want. The Array dialog box opens, as shown in Figure 10.4.
2. Click Rectangular Array at the upper-left corner of the dialog box (if it is not already selected).

3. Ifyou've already selected one or more objects, the dialog box indicates the number of selected
objects. If you haven't selected any object, click Select Objects to return to your drawing and
select objects. Press Enter to end object selection and return to the dialog box.
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FIGURE 10.3

The garage door was drawn with one panel, as shown on the left side. A rectangular array cre-
ated the rest of the door panels, as shown on the right.

v

Thanks to Henry Dearborn, AlA, Fairfield, lowa, for this drawing.

FIGURE 10.4

The Array dialog box.
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In the Rows and Columns text boxes, type the total number of rows and columns that you want.

Type the distance you want between the rows in the Row Offset text box, and type the distance
you want between the columns in the Column Offset text box. If you want to specify the offsets
by picking points on your screen, click the Pick button next to the Row Offset or Column Offset
text box, or use the longer Pick button spanning both text boxes to pick diagonal points and
specify both offsets at once.

If you want to change the angle of the array, type an angle in the Angle of Array text box. The pre-
view panel displays the results of this value. To specify the angle by picking, click the Pick Angle
of Array button.
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7. To preview the array, click Preview. Click anywhere (pick) or press Esc to return to the Array dia-
log box if you want to make changes; otherwise, right-click to accept the array and end the com-
mand. If you change the snap angle or the UCS (as explained in Chapter 8), AutoCAD and
AutoCAD LT create the rectangular array at the angle of the snap or UCS.

Polar (circular) arrays

A polar array creates copies of one or more objects arrayed in a circle around a center point. An example of
a polar array is shown in Figure 10.5.

FIGURE 10.5

The pulley was drawn with one spoke, as shown on the left. A polar array created the additional spokes.

Thanks to Robert Mack of the Dexter Company, Fairfield, lowa, for this drawing.

To create a polar array, follow these steps:
g 1. Choose Home tab= Modify panel (expanded) = Array, and select the object or objects. You can
oo choose the objects first if you want. The Array dialog box opens.
2. Click Polar Array at the top of the dialog box (if it is not already selected).

If you've already selected one or more objects, the dialog box indicates the number of selected
objects. If you haven't selected any objects, click Select Objects to return to your drawing and
select objects. Press Enter to end object selection and return to the dialog box.

4. Specify the center point by typing X and Y coordinates, or click the Pick Center Point button. If
i} you selected an object first, check that the center point displayed is what you want.

5. Select the two items that you want to specify from the Method drop-down list. You can choose
any two from the three choices:

Total Number of Items: Sets the total number of items in the resulting array, including the
one that you are arraying.

Angle to Fill: Sets the number of degrees that the polar array covers. For example, to array
around half of a circle, specify 180°.

Angle Between Items: Specifies the number of degrees between each item in the polar array.

6. Complete the values of the two items that you specified. You can click the buttons to pick the
angle to fill or the angle between items on the screen.
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7. Check the Rotate Items as Copied check box to rotate the objects that you are arraying. Uncheck
the box to leave them unrotated.

8. Click Preview to preview the array. Click anywhere (pick) or press Esc to return to the Array
dialog box if you want to make changes; otherwise, right-click to accept the array and end the
command.

You can specify which point on the last object selected that AutoCAD or AutoCAD LT uses to array the
objects. The command makes a calculation of the distance from the center point of the array to a base point
on the last object selected. Otherwise, the command uses a default point based on the type of object
selected. Table 10.1 lists the default base points. If you are arraying more than one object, you may not
obtain the result you want without specifying the base point. Even for one object, you may want to change
the base point that is used.

To specify the base point, click the More button at the bottom of the dialog box. The dialog box opens up to
display the Object Base Point section. Uncheck Set to Object’s Default. You can then either type in coordi-
nates or, more likely, click the Pick Base Point button and use an object snap to pick the desired point on an
object. The preview box adjusts according to your choice, but because the preview only shows rectangles in
the place of your object, the display may not be very helpful. You can click the Preview button to preview
the result in your drawing.

SR \tB ‘E{ You can use the Express Tools COPYM command to enhance your copying options. Choose

S ANNELE Menu Browser = Express = Modify => Multiple Copy. You can create evenly spaced copies
between two points, copy objects according to a specified measurement, and create arrays. For information
on installing the Express Tools, see Appendix A.

TABLE 10.1

Object Base Points for Arrays

Type of Object Default Base Point
Arc, circle, or ellipse Center point
Polygon or rectangle First corner

Line, polyline (2D or 3D), ray, spline, or donut Starting point

Text (single-line or paragraph), block Insertion point
Construction line (xline) Midpoint

Region Grip point

T The drawing used in the following exercise on arraying objects, ab10-a.dwg, is in the
§ Drawings folder on the DVD.

STEPS: Arraying Objects

1. Open abl0-a.dwg from the DVD.

2. Save the file as ab10-02.dwg in your AutoCAD Bible folder. It looks like Figure 10.6. Object
Snap mode should be on. Set Center and Intersection running object snaps.
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FIGURE 10.6

A partially completed mounting bracket.
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Choose Home tab => Modify panel (expanded) = Array. The Array dialog box opens.

Click the Select Objects button of the Array dialog box. In the drawing, pick the horizontal cen-
terline @, shown in Figure 10.6, and then press Enter. You return to the dialog box.

Make sure that Rectangular Array is selected at the top of the dialog box.
In the Rows text box, type 4. In the Columns text box, type 1.

In the Row Offset text box, type 1. (You don't need to specify the column offset because you are
creating only one column.)

Click Preview. You should see a total of four horizontal lines, as shown in Figure 10.7. Right-click
to accept the array. (If you don't see the four lines, click anywhere in the drawing area and
recheck the settings in the Array dialog box.)

To add the holes to the pattern, again start the ARRAY command.

Click the Select Objects button in the Array dialog box. In the drawing, pick circle @), shown in
Figure 10.6, and then press Enter.

Back in the Array dialog box, type 4 in the Rows text box and type 2 in the Columns text box.

Click the Pick Both Offsets button. In the drawing, pick the center of circle @ (or the intersection
of the centerlines at the center of circle @) and the intersection of centerlines near €, shown in
Figure 10.6. (If necessary, press Tab until you see the object snap that you want.)

Click Preview to preview the array. If the circles look like Figure 10.7, right-click. Otherwise,
click in the drawing area or press Esc and check your settings. After you're done, the command
arrays the holes to fit the centerlines.

To create a six-hole bolt circle, pick hole @), shown in Figure 10.6.
Start the ARRAY command again.
In the Array dialog box, choose Polar Array.

Next to the Center Point text boxes, click the Pick Center Point button. In the drawing, pick the
center of the large circle at @), shown in Figure 10.6.

Make sure that the Method reads "Total number of items & Angle to £i11." In the Total
Number of Items text box, type 6. In the Angle to Fill text box, type 360.
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19. Click Preview to see the array. It should look like Figure 10.7. If it does, right-click. Otherwise,
click in the drawing area or press Esc and recheck the settings in the Array dialog box. AutoCAD
or AutoCAD LT completes the mounting bracket.

20. Save your drawing. It should look like Figure 10.7.

FIGURE 10.7

The completed mounting bracket.

Offsetting objects

The OFFSET command creates lines or curves parallel to one existing object. The beauty of this command
is apparent when you start to create complex objects, such as polylines, which are covered in Chapter 16.
Polygons and rectangles are polylines, which means that all the line segments are one object. For example,
using OFFSET, you can create concentric polygons in one step. Figure 10.8 shows two concentric polygons.
The outside polygon was created with the POLYGON command, and the inside polygon was created by
using OFFSET.

FIGURE 10.8

Use OFFSET to create concentric polygons.

E" To offset an object, choose Home tab &> Modify panel &> Offset.
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The command responds with the following list of settings and prompt:

Current settings: Erase source=No Layer=Source OFFSETGAPTYPE=0
Specify offset distance or [Through/Erase/Layer] <Through>:

The settings show how the OFFSET command’s options will function. Set the Erase option to Yes to erase

the selected object and leave only the offset. Use the Layer option to specify if you want the new object to

be on the same layer as the source object or on the current layer.

G ' &l The OFFSETGAPTYPE system variable determines what the command does to close gaps when
o LSS you offset closed polylines. By default (a value of 0), AutoCAD extends the polyline segments.

A value of 1 fills the gaps with arcs, and a value of 2 fills the gaps with chamfered corners. (I cover chamfers
later in this chapter.)

The OFFSET command offers two ways to specify the offset:

B If you type an offset distance, the command responds with the Select object to offset or
[Exit/Undo] <Exit>: prompt. You can select one object. Then the Specify point on
side to offset or [Exit/Multiple/Undo] <Exit>: prompt appears. Pick a point to
indicate on which side of the object you want to create the offset copy. The command creates the
offset and continues to show the Select object to offset or [Exit/Undo] <Exit>:
prompt so that you can offset other objects by using the same offset distance. Press Enter to exit
the command.

B If you want to indicate a through point (a point that the offset passes through, such as an object
snap on another object), type t J or right-click and choose Through from the shortcut menu. The
command displays the Select object to offset or [Exit/Undo] <Exit>: prompt. Pick
one object. At the Specify through point or [Exit/Multiple/Undo] <Exit>:
prompt, pick a point through which you want the offset to go to create the offset.

Use the Undo option if you don't like the result of the offset. After you offset an object, the prompt repeats
so that you can offset additional objects. Press Enter to end the command.

% The drawing used in the following exercise on using the OFFSET command, ab10-b.dwg, is
i in the Drawings folder on the DVD.

STEPS: Using the OFFSET Command

1. Open abl0-b.dwg from the DVD.

2. Save the file as ab10-03 . dwg in your AutoCAD Bible folder. It looks like Figure 10.9. Set a
running object snap for Center, and turn on Object Snap mode.

E" 3. Choose Home tab = Modify panel = Offset. Follow the prompts:

Specify offset distance or [Through/Erase/Layer] <Through>: . or
specify the Through option if it does not appear as the default.

Select object to offset or [Exit/Undo] <Exit>: Pick 0 in Figure
10.9.

Specify through point or [Exit/Multiple/Undo] <Exit>: Pick the center
of Q

Select object to offset or [Exit/Undo] <Exit>: J

This action copies the centerline through the upper circles.
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FIGURE 10.9

A tension arm for a commercial dryer.
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Thanks to Robert Mack of the Dexter Company, Fairfield, IA for this drawing.

4. Repeat the OFFSET command. At the Specify offset distance or [Through/Erase/
Layer] <Through>: prompt, type 4-19/64 1. Pick the centerline @ at the Select object
to offset or [Exit/Undo] <Exit>: prompt, and then click near @ at the Specify
point on side to offset or [Exit/Multiple/Undo] <Exit>: prompt. Press Enter to
end the command. The vertical centerline appears 4-19/64 units to the right of the original.

5. Save your drawing. It should look like Figure 10.10.

FIGURE 10.10

The completed tension arm.
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Aligning objects
The ALIGN and 3DALIGN commands let you move and rotate an object or objects in one procedure. They
are useful in both 2D and 3D environments. By specifying where selected points on an object move, you

can align the object with other objects in your drawing, as shown in Figure 10.11. You can align in two
ways:

B ALIGN command: This command prompts you by point. You specify the first source point (on
the object you're aligning), then the first destination point (where that source point will end up).
Then you specify the second set of source and destination points. For 3D, you go on to a third
set. Finally, you can scale the selected object to match the destination points.

B 3DALIGN command: This command prompts you by object. You specify two or three points on
the source object, then the points at the destination location. As you specify destination points,
you see the object move and align in real time. You cannot scale the object. See Chapter 24 for an
exercise that uses the 3DALIGN command in 3D editing.

Aligning requires several steps. Even so, it can save you time when you need to move and rotate at the same
time, especially if you don’t know the rotation angle that you need.

I AutoCAD LT doesn’t include the ALIGN or the 3DALIGN command. Instead, you would
& need to use a combination of the MOVE and ROTATE commands. The Reference option of

the ROTATE command would be helpful to align objects. I discuss the MOVE and ROTATE commands in
Chapter 9.

FIGURE 10.11

Aligning a door with a wall.

1st source point

1st destination point

L 2nd destination point

2nd source point

Before After

Using the ALIGN command

g| I you prefer to think, “This point will go here and that point will go there,” use the ALIGN command. You
=] can also scale the object that you're aligning. Choose Menu Browser &> Modify = 3D Operations = Align and
select an object or objects. You can also select the object or objects first. Then follow these steps:

1. The prompt asks for the first source point. Specify a point, usually an object snap on the object
that you want to move.

2. The prompt asks for the first destination point. Specify the point where you want the first source
point to end up.
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3. The prompt asks for the second source point. If you press Enter, AutoCAD simply moves the
selected objects. To continue to align, specify another point, usually another object snap on the
object that you want to move.

4. The prompt asks for the second destination point. Specify the point where you want the second
source point to end up.

5. The prompt asks for the third source point. You use this for 3D alignment, to specify how you
want to rotate the object in the third dimension. For 2D alignment, press Enter to continue the
command.

6. The prompt displays the Scale objects based on alignment points? [Yes/No] <N>:
prompt. If the distances between the source and destination points are not the same, type y if you
want to scale the original object so that the source and destination points match exactly.

Using the 3DALIGN command

If you like to think, “These are the points on the source object that I want to align and then these are

% the destination points that I want to align them to,” and if you don't need to scale your object, use the
3DALIGN command. To align an object using the 3DALIGN command, choose Menu Browser = Modify =
3D Operations = 3DAlign, and select an object or objects. You can also select the object or objects first. (In
the 3D Modeling workspace in AutoCAD, you can choose Home tab => Modify panel = 3D Align.)

Then follow these steps:

1. The message, Specify source plane and orientation, explains that you now need to
specify the source points, which define the plane and orientation of the source object. The first
prompt asks for the base point. Specify a point, usually an object snap on the object that you
want to move. This point will match the first destination point. You can use the Copy option to
make a copy of the object rather than move it. If you use the Continue option here, you only
move the object.

2. The prompt asks for the second point. Specify another point on the source object. This point will
match the second destination point. Use the Continue option to start specifying destination
points.

3. The prompt asks for the third point. In 3D models, you need the third point to specify the plane.

The message, Specify destination plane and orientation, explains that you now need
to specify the destination points for the base points you just specified. The prompt asks for the
first destination point. Specify the point where you want the first base point to end up. As soon as
you do this, the object moves to match the first base and destination points so that you can see
how the object will look.

5. The prompt asks for the second destination point. The second base point will match this point. If
you press Enter at this point, the command aligns the object with the X axis of the current UCS.

6. The prompt asks for the third destination point. You use this for 3D alignment, to specify how
you want to rotate the object in the third dimension. For 2D alignment, you can place the cursor
on either side of the aligning line you specified, to mirror the object in either direction. When you
see the direction that you want, press Enter to end the command and align the object.

The following exercise uses the 3DALIGN command to align objects.

SV py The drawing used in the following exercise on aligning objects in two dimensions, ab10-c.
Lwcé dwg, is in the Drawings folder on the DVD.
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STEPS: Aligning Objects in Two Dimensions

1. Open abl0-c.dwg from the DVD.
2. Save the file as ab10-04 . dwg in your AutoCAD Bible folder. It looks like Figure 10.12.

FIGURE 10.12

A base assembly for a commercial washing machine.
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Thanks to Robert Mack of the Dexter Company, Fairfield, lowa, for this drawing.

% 3. Choose Menu Browser = Modify => 3D Operation = 3D Align, and follow the prompts:

Select objects: Select the horizontal angle by using a window,
picking near @ and then @. Press Enter to end object selection.
This angle needs to be aligned with the long, diagonal support
angle.

Specify base point or [Copyl: Pick the endpoint at e in Figure 10.12.

Specify second point or [Continue] <C>: Pick the endpoint at o

Specify third point or [Continue] <C>: J

Specify destination plane and orientation ... Specify first
destination point: Pick the endpoint at o

Specify second destination point or [eXit] <X>: Pick the endpoint at
0.

Specify third destination point or [eXit] <X>: Place the cursor to
the right of the new location of the horizontal angle so that it
is aligned as shown in Figure 10.13, and press Enter.

4. Save your drawing. It should look like Figure 10.13.
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FIGURE 10.13

The washing machine base.

LRI = Tl

Resizing commands

Four editing commands resize objects in specific ways. The TRIM and EXTEND commands change the end-
point of an object to meet another object. LENGTHEN lets you lengthen or shorten a line, polyline, arc, or
elliptical arc. STRETCH is used to stretch (longer or shorter) a group of objects, letting you change their
direction at the same time.

Trimming objects

As you edit a drawing, you may find that lines or arcs that once perfectly met other objects now hang over.
To trim an object, you must first specify the cutting edge, which defines the point at which to cut the object
you want to trim. You define the cutting edge by selecting an object. You can select several cutting edges
and several objects to trim at one time, as shown in Figure 10.14. When you select an object to trim, you
must pick the object on the side that you want trimmed (not on the side that you want to remain). A com-
mon use for the TRIM command is to create intersections of walls in architectural floor plans.
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] While using the TRIM command, you can switch to extending objects by pressing the Shift key
R A

i as you select objects to trim.

The object you want to trim does not have to actually intersect the cutting edge. You can trim an object to a
cutting edge that would intersect the object if extended. This is called trimming to an implied intersection, an
example of which is shown in Figure 10.15.

You can trim arcs, circles, ellipses, elliptical arcs, lines, polylines, xlines, rays, and splines. You can use poly-
lines, arcs, circles, ellipses, elliptical arcs, lines, rays, regions, splines, text, or xlines as cutting edges. An
object can be used as both a cutting edge and an object to be trimmed in the same trimming process. You
can also trim to objects within blocks. (Chapter 18 covers blocks.)
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FIGURE 10.14

Trimming two objects by using two cutting edges.
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FIGURE 10.15

Trimming two arcs to an implied intersection.
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To trim an object, choose Home tab = Modify panel &> Trim. The command displays the Current

_.l"l-" settings: Projection=UCS, Edge=None Select cutting edges . . . Select
objects or <select all>: prompt. The prompt lets you know the values of the two system vari-
ables that affect trimming. The Projection setting is used only for 3D models and can trim based on either
the current UCS or the current view. The Edge setting is used for implied intersections. When Edge is set to
Extend, the command trims to the implied intersection of the cutting edge and the object to be trimmed. At
this prompt, pick the object(s) that you want to use as a cutting edge or press Enter to select all objects as
edges. Press Enter to end object selection.

You can trim to an actual or an implied intersection (an intersection that would exist if objects were
extended):

B If you want to trim to an actual intersection, at the Select object to trimor shift-select
to extend or [Fence/Crossing/Project/Edge/eRase/Undo] : prompt, select the
objects that you want to trim. You can use the Fence option to draw lines that criss-cross the
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objects that you want to trim. Use the Crossing option to select the objects with a crossing win-
dow. Be sure to pick each object between the cutting edge and the end you want to trim off. Press
Enter to end object selection. This action trims the object(s).

If you want to trim to an implied intersection, at the Select object to trimor shift-
select to extend or [Fence/Crossing/Project/Edge/eRase/Undo] : prompt,
type e . The Extend option responds with the Enter an implied edge extension mode
[Extend/No extend] <No extend>: prompt. Type e . Then select the objects that you
want to trim at the Select object to trim or shift-select to extend or [Fence/
Crossing/Project/Edge/eRase/Undo] : prompt. Be sure to pick each object at or near
the end that you want to trim. Press Enter to end object selection and trim the object(s).

Use the Undo option if the results of the trim are not what you want. You can then continue to select
objects to trim. The eRase option lets you erase an object instead of trimming it, without leaving the TRIM
command.

T The drawing used in the following exercise on trimming objects, ab10-d.dwg, is in the
i Drawings folder on the DVD.

STEPS: Trimming Objects

1.
2.

—l.'{" 3.

4.

Open ab10-d.dwg from the DVD.
Save the file as ab10-05 . dwg in your AutoCAD Bible folder. It looks like Figure 10.16.

Choose Home tab = Modify panel = Trim. At the Select objects or <select all>: prompt,
pick lines at @ and @, shown in Figure 10.16, and then press Enter.

At the Select object to trimor shift-select to extend or
[Fence/Crossing/Project/Edge/eRase/Undo] : prompt, again pick lines at @ and @,
shown in Figure 10.16. Be sure to pick them outside the intersection, as shown. Press Enter to
end the command.

The command trims the lines. Each line is used as the cutting edge for the other line.
Again start the TRIM command. At the Select objects or <select all>: prompt, pick the
line at @), shown in Figure 10.16, and press Enter.

At the Select object to trimor shift-select to extend or [Fence/Crossing/
Project/Edge/eRase/Undo] : prompt, right-click and choose Edge. Then right-click and
choose Extend at the Enter an implied edge extension mode [Extend/No extend]
<Extend>: prompt.

Pick the line at @), shown in Figure 10.16, to trim the line. Press Enter to end the command.

Start the TRIM command again. At the Select objects or <select all>: prompt, pick @
and press Enter. At the Select object to trimor shift-select to extend or
[Fence/Crossing/Project/Edge/eRase/Undo] : prompt, pick the lines at @ and @.
Press Enter to end the command.

Save your drawing. It should look like Figure 10.17.

I Express Tools contains a command, EXTRIM, which is available on the command line. EXTRIM
& can use a polyline, line, circle, arc, ellipse, image, or text as the cutting line. You specify one

snde of the cutting object, and EXTRIM trims everything on that side. For example, if you choose a closed
polyline and pick inside it, every object inside the polyline is trimmed.
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FIGURE 10.16

A schematic of an air compressor.
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FIGURE 10.17

The completed clamp in two views.
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Extending objects

The EXTEND command has similar prompts to the TRIM command, but instead of trimming objects to a
cutting edge, it extends them to a boundary edge (see Figure 10.18). As with TRIM, when you select an
object to extend, you must pick the object on the side that you want extended (not on the side that you
want left as is).

The object you want to extend does not have to actually intersect the boundary edge after its extension. You
can extend an object to a boundary edge that would intersect the extended object if it were longer. This is
called extending to an implied intersection, an example of which is shown in Figure 10.19.

FIGURE 10.18

Extending two lines by using an arc as the boundary edge.
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FIGURE 10.19

Extending a line to an implied intersection.
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You can extend arcs, elliptical arcs, lines, open polylines, and rays. You can use polylines, arcs, circles,
ellipses, elliptical arcs, lines, rays, regions, splines, text, or xlines as boundary edges. An object can be used
as both a boundary edge and an object to be extended in the same extending process.

| While using the EXTEND command, you can switch to trimming objects by pressing the Shift
& key as you select objects to trim.
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To extend an object, choose Home tab = Modify panel = Extend. The command displays the Current

_"lu'll settings: Projection=UCS, Edge=Extend Select boundary edges ... Select
objects or <select all>: prompt. The prompt lets you know the values of the two settings that
affect how the object is extended. Projection is used only for 3D models and can extend based on either the
current UCS or the current view. Edge is used for implied intersections. When Edge is set to Extend, the
command extends to the implied intersection of the boundary edge and the object to be extended. At this
prompt, pick the object(s) that you want to use as the boundary edge(s) or press Enter to select all objects.
Press Enter to end object selection. You can extend to an actual or implied intersection:

B If the extension will result in an actual intersection, at the Select object to extend or
shift-select to trimor [Fence/Crossing/Project/Edge/Undo] : prompt, select
objects to extend. You can use the Fence option to draw lines that criss-cross the objects you want
to extend. Use the Crossing option to select the objects with a crossing window. Be sure to pick
each object at the end that you want to extend. Press Enter to end object selection and extend the
object(s).

B If you want to extend to an implied intersection, at the prompt, right-click and choose Edge.

The option responds with the Enter an implied edge extensionmode [Extend/No
extend] <Extend>: prompt. Right-click and choose Extend. Then select the objects that you
want to extend at the Select object to extend or shift-select to trimor [Fence/
Crossing/Project/Edge/Undo] : prompt. Be sure to pick each object at the end that you
want to extend. Press Enter to end object selection and extend the object(s).

Use the Undo option if the results of the extension are not what you want. You can then continue to select
objects to extend. You can use the Fence object selection method to select objects to extend the side of the
object that the fence line crosses.

>y The drawing used in the following exercise on extending objects, ab10-e . dwg, is in the
# Drawings folder on the DVD.

STEPS: Extending Objects

1. Open abl0-e.dwg from the DVD.
2. Save the file as ab10-06 . dwg in your AutoCAD Bible folder. It looks like Figure 10.20.

3. Choose Home tab &> Modify panel = Extend. At the Select objects or <select all>:
_“lu"l prompt, pick the line at @), shown in Figure 10.20, and then press Enter.

FIGURE 10.20

An electrical schematic.
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214

4. Atthe Select object to extend or shift-select to trimor [Fence/Crossing/
Project/Edge/Undo] : prompt, pick the line at @), shown in Figure 10.20. Press Enter to fin-
ish selecting objects. The command extends the line.

5. Repeat the EXTEND command. At the Select objects or <select all>: prompt, pick the
lines at @ and @), shown in Figure 10.20, and then press Enter.

6. Atthe Select object to extend or shift-select to trimor [Fence/Crossing/
Project/Edge/Undo] : prompt, right-click and choose Edge. Right-click and choose Extend
at the Extend/No extend <No extend>: prompt.

7. Pick lines @ and @), shown in Figure 10.20, again at the points shown. The lines extend to meet.
Press Enter to end the command.

8. Save your drawing. It should look like Figure 10.21.

FIGURE 10.21

The completed electrical schematic.
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Lengthening objects

The LENGTHEN command both lengthens and shortens. It works on open objects, such as lines, arcs, and
polylines, and also increases or decreases the included angle of arcs. (You can change the length of an arc as
well as its included angle by using LENGTHEN.) AutoCAD and AutoCAD LT offer several ways of defining
the new length or included angle. Use LENGTHEN if you want to lengthen or shorten an object when there
is no available intersecting edge or boundary to use with TRIM or EXTEND.

In the LENGTHEN command, the length of an arc is measured along its circumference. Don’t confuse this
with the Length of Chord option of the ARC command, which refers to the length of a line stretched from
one endpoint of the arc to the other endpoint.

To lengthen (or shorten) an object, choose Home tab = Modify panel (expanded) => Lengthen. You cannot
select objects before the LENGTHEN command. The command responds with the Select an object
or [DElta/Percent/Total/DYnamic]: prompt. Choose one of the following options:

B Select object: This is the default. However, its purpose is to display the current measurements of
the object. This can help you to decide how to define the final length or angle of the object. The
current length is displayed at the command line, and the previous prompt is repeated.

B DElta: Right-click and choose DElta. Delta means the change, or difference, between the current
and new length or included angle. The option responds with the Enter delta length or
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[Angle] <0.0000>: prompt. If you want to change an included angle, right-click and choose
Angle. Then type the change in the included angle. Otherwise, simply type the change in the
length of the object. A positive number increases the length or included angle. A negative number
decreases the length or included angle.

B Percent: Right-click and choose Percent. At the Enter percentage length <100.0000>:
prompt, type in what percent of the original object you want the final object to be. Amounts over
100 lengthen the object. Amounts under 100 shorten the object. You cannot change an included
angle using this option.

B Total: Right-click and choose Total. At the Specify total length or [Angle] <1.0000)>:
prompt, you can either choose the Angle suboption, as described for the DEIta option, or use the
default total-length option. Either way, you enter the total angle or length you want.

B DYnamic: Right-click and choose DYnamic. This option lets you drag the endpoint of the object
closest to where you picked it. You can use an object snap to specify the new endpoint.

After you've used an option to specify the length you want, you see the Select an object to change
or [Undo] : prompt. Here you select the object you want to change. Be sure to pick the endpoint of the
object for which you want to make the change.

The same prompt continues so that you can pick other objects by using the same length specifications.
Choose Undo to undo the last change. Press Enter to end the command.

Y The drawing used in the following exercise on lengthening and shortening objects, ab10-£.
& dwg, is in the Drawings folder on the DVD.
STEPS: Lengthening and Shortening Objects

1. Open abl0-£.dwg from the DVD.

2. Save the file as ab10-07 . dwg in your AutoCAD Bible folder. It is a capacitor symbol from an
electrical schematic, as shown in Figure 10.22.

FIGURE 10.22

A poorly drawn capacitor symbol.
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.8 3. Choose Home tab = Modify panel (expanded) => Lengthen, and follow the prompts:

-

o Select an object or [DElta/Percent/Total/DYnamic]: Pick the line at
@ in Figure 10.22.
Current length: 0.200
Select an object or [DElta/Percent/Total/DYnamic]: Right-click and
choose Delta.
Enter delta length or [Angle] <0.000>: .07 J
Select an object to change or [Undol: Pick the line at ﬂ in Figure
10.22.
Select an object to change or [Undo]l: J
This action lengthens the line.
4. Start the LENGTHEN command again and follow the prompts:
Select an object or [DElta/Percent/Total/DYnamic]: Pick the arc at Q
in Figure 10.22.
Current length: 0.407, included angle: 150
Select an object or [DElta/Percent/Total/DYnamic]: Right-click and
choose Total.
Specify total length or [Angle] <1.000)>:)>: Right-click and choose
Angle.

Specify total angle <57>: 120 J

Select an object to change or [Undol: Pick the arc at 0 in Figure
10.22.

Select an object to change or [Undo]l: J

This action shortens the arc.

5. Save your drawing. It should look like Figure 10.23.

FIGURE 10.23

The completed capacitor symbol.

Stretching objects

The STRETCH command is generally used to stretch groups of objects. For example, you can use this com-
mand to enlarge a room in a floor plan. You can also shrink objects. You can change not only the length of
the objects but the angle as well. You use a crossing window to choose the objects to be stretched. All
objects that cross the boundaries of the crossing window are stretched. All objects that lie entirely within
the crossing window are merely moved. Successful stretching involves precise placement of the crossing
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window. Figure 10.24 shows the process of stretching a garage. Note that the walls that cross the bound-
aries of the crossing window are stretched. However, the dormer that is entirely within the crossing window
is just moved. This maintains the integrity of the model.

You cannot stretch circles, text, or blocks. You can stretch arcs, although the results may not be what you
expect.

The real power of the STRETCH command is in stretching a number of objects at once. However, you can
also stretch one line. The results are similar to using the CHANGE command to change the endpoint of a
line or to editing with grips (discussed later in this chapter).

FIGURE 10.24

Stretching a garage.
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= To stretch objects, choose Home tab &> Modify panel = Stretch. The command responds with the Select

[_"_II'. objects to stretch by crossing-window or crossing-polygon . . . instruction and then the
Select objects: prompt. Create the crossing window and select the objects that you want to stretch.
(You can also use a crossing polygon — type cp at the Select objects: prompt.) After completing the
crossing window, check to see which objects are highlighted. This helps you avoid unwanted results. You
can use the object selection Remove option (type r I at the Command prompt) to remove objects by pick-
ing the objects that you don’t want to stretch or move. Then use the Add option (type a J) to continue
selecting objects if necessary.

The STRETCH command remembers the most recent displacement throughout a session. To stretch an
object by the same displacement that you most recently used, press Enter at the Specify base point or
[Displacement] <Displacement>: prompt. At the Specify displacement <2.0000, 3.0000,
0.0000>: prompt, you see in angled brackets the last displacement that you used. Press Enter to stretch
the object using this displacement.

You can use multiple crossing windows to select the objects that you want to stretch. You can
also pick to select objects, although these objects are simply moved.
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When you've finished selecting objects, you see the Specify base point or Displacement
<Displacement>: prompt. This step is just like moving objects, and you can respond in two ways:

B Pick a base point. At the Specify second point or <use first point as displacement>:
prompt, pick a second point. Object snap and PolarSnap are helpful for picking these points.

B Type a displacement without using the @ sign. For example, to lengthen the objects by 6 feet in
the 0-degree direction, type 6'<0 . Then press Enter at the Specify second point or <use
first point as displacement>: prompt.

[ Usually, you want to stretch at an orthogonal angle. If you're going to stretch by picking, turn
% Ortho mode on. Object snaps, polar tracking, and Snap mode are other helpful drawing aids
for stretching.

When specifying a displacement by typing at the keyboard, you can use both positive and negative dis-
tances. For example, 6'<180 is the same as —6'<0. Both would stretch the objects 6 feet to the left.

>y The drawing used in the following exercise on stretching objects, ab10-g. dwg, is in the
§ Drawings folder on the DVD.

STEPS: Stretching Objects

1. Open abl0-g.dwg from your DVD.

2. Save the file as ab10-08.dwg in your AutoCAD Bible folder. This drawing is the plan view of
a garage, as shown in Figure 10.25. Turn on polar tracking by clicking Polar Tracking on the sta-
tus bar. Click Snap Mode on the status bar and then right-click the Snap Mode button to make
sure that PolarSnap is on (the PolarSnap item will be unavailable if it is already on); otherwise,
choose PolarSnap. Turn on Object Snap mode and set a running object snap for endpoints.

= 3. Choose Home tab = Modify panel = Stretch. At the Select objects: prompt, pick @), shown
[_"_II'. in Figure 10.25. At the Specify opposite corner: prompt, pick @. The prompt notifies you
that it found 32 objects. Press Enter to end object selection.

4. Atthe Specify base point or [Displacement] <Displacement>: prompt, pick the
endpoint at the bottom-right corner of the garage. At the Specify second point or <use
first point as displacement>: prompt, move the cursor to the right until you see the
polar tracking tooltip. Click when the tooltip says 6'-0"<0. (If you can’t find it, type 6',0 . If
you’re not using Dynamic Input or have Dynamic Input set to absolute coordinates, add the @
symbol first.) This action stretches the garage by 6 feet.

5. Save your drawing. It should look like Figure 10.26.

Using Construction Commands

Four additional commands are commonly used in the process of constructing models. The BREAK com-
mand removes sections of objects at points that you specify. JOIN, a new command, joins co-linear lines,
polylines, arcs, elliptical arcs, or splines. CHAMFER creates corners, and FILLET creates rounded corners.

Breaking objects

Drawing a long line and then breaking it into two or more shorter lines is often much easier than drawing
two separate lines. A common use for BREAK is to break a wall at a door or a window in an architectural
floor plan. You specify two points on the object, and the command erases whatever is between those two
points. Typically, you use object snaps to specify the points. Sometimes, you can use TRIM to break an
object, but if you have no convenient cutting edge, you may find BREAK more efficient.
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FIGURE 10.25

A plan view of a garage.

FIGURE 10.26

The longer garage.
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You can break lines, polylines, splines, xlines, rays, circles, arcs, elliptical arcs, and ellipses.

To break a line, choose Home tab => Modify panel = Break. You cannot select the object first. The command
responds with the Select object: prompt. (Notice that you can only select one object to break.) At this
prompt, you have two choices:

B Select the object at one of the break points that you want to create. You then see the Specify
second break point or [First point]: prompt. Because you have already specified the
first point, you can now specify the second point. The command breaks the object between the
two points.

B Select the object by using any method of object selection. You then see the Specify second
break point or [First point]: prompt. Right-click and choose First point. At the
Specify first break point: prompt, pick the first break point. At the Specify second
break point: prompt, pick the second break point. The command breaks the object between
the two points.

I—_I- Sometimes you may want to break an object into two pieces at a point, without erasing
any part of the object. Choose Home tab = Modify panel (expanded) = Break at Point
to help you easily break an object at a point. After selecting the object, pick where you want to break the
object at the Specify second break point or [First point]: prompt. The two new objects look
the same as before on the screen — until you select one of the objects. AutoCAD and AutoCAD LT use @ to
signify the last point entered; thus, the first and second break points are the same.

You can use BREAK to shorten an object. Pick one point on the object where you want the new endpoint to
be. Pick the other point past its current endpoint to cut off the object at the point you picked on the object.

Joining objects

The opposite of breaking objects is joining them. The JOIN command lets you join lines, polylines, arcs,
elliptical arcs, and splines. The objects must be along the same linear, circular, or elliptical path. The objects
can overlap, have a gap between them, or touch end-to-end.

To join objects, choose Home tab = Modify panel (expanded) = Join. Follow these prompts:

Select source object: Select the first object that you want to join.

Select lines to join to source: Select the second object. (AutoCAD
knows which type of object you've selected for the first prompt and
inserts it into the second prompt.) You can continue to select other
objects. Press Enter to end selection.

AutoCAD joins the objects.

A nice touch is the ability to close arcs (to circles) and elliptical arcs (to ellipses). If your first object is either
type of arc, you see the Select arcs to join to source or [cLose] : prompt. Use the cLose option
to close the arc.

5y The drawing used in the following exercise on breaking and joining objects, ab10-h. dwg, is
% in the Drawings folder on the DVD.

STEPS: Breaking and Joining Objects

1. Open abl0-h.dwg from your DVD.

2. Save the file as ab10-09 . dwg in your AutoCAD Bible folder. This is a site plan, as shown
in Figure 10.27. Turn on Object Snap mode and set running object snaps for Endpoint and
Intersection.
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3. Choose Home tab=> Modify panel = Break. At the Select object: prompt, pick the line at @.
| | At the Specify second break point or [First point]: prompt, pick @. This action
shortens the line.

4. Repeat the BREAK command. At the Select object: prompt, pick the circle (it's a maple tree)
anywhere along its circumference. At the Specify second break point or [First
point] : prompt, right-click and choose First Point. At the Specify first break point:
prompt, pick the intersection at €). At the Specify second break point: prompt, pick the
intersection at @) to break the circle.

AutoCAD and AutoCAD LT break circles counterclockwise. If you had picked @), and then @,
only the smaller arc would have remained.

5. Lets say that you decide this is a mistake. Choose Home tab = Modify panel (expanded) = Join.
-+ At the Select source object: prompt, select the circle (tree) that you just broke into an arc.
At the Select arcs to join to source or [cLose] : prompt, right-click and choose cLose.

The arc becomes a full circle again.

. To break the line at @), click the Object Snap Tracking button on the status bar. Start the BREAK
command again. Follow the prompts:

Select object: Pick the line at @.

Specify second break point or [First point]: Right-click and choose
First point.

Specify first break point: Move the cursor to O to acquire it as a
tracking point. Then move the cursor to the right onto the line
you are breaking. When you see the Endpoint: Intersection tooltip,
click. (You have no visual confirmation yet that you picked the
right point.)

Specify second break point: Move the cursor to ﬂ to acquire it as a
tracking point. Then move the cursor onto the line you are
breaking. At the Endpoint: 4'-2 3/4"<0.0000 tooltip, click.

)

7. Start the JOIN command. At the Select source object: prompt, select the line at @. At the
Select lines to join to source: prompt, select the line at @). Press Enter to end the selec-
tion and join the lines into one.

8. Save your drawing. It should look like Figure 10.28.
@ g'-‘;:g" B v For AutoCAD only: Two AutoLISP programs on the DVD can help you with breaking and
£ ’A:tl il unbreaking objects. Pend puts a break line at the end of a pipe. See \Sof tware\Chapter
10\Pend. Br draws a line with a break symbol. See \Software\Chapter 10\Br.

‘50&h¥= The Express Tools contain a command, BREAKLINE, to create a break symbol. Choose Menu
& ANSLE Browser = Express = Draw = Break-Line Symbol. Another Express Tools command, OVERKILL
(available on the command line), deletes objects that are on top of other objects.

Creating chamfered corners

The CHAMFER command creates corners from two nonparallel lines. You can also chamfer xlines, rays, and
polylines. You can simply extend the lines to meet at an intersection (a square corner), or create a beveled
edge. If you create a beveled edge, you define the edge by either two distances or one distance and an angle
relative to the first line that you're chamfering. Figure 10.29 shows the elements of a chamfered corner.

Chamfering is a two-step process. First you define how you want to chamfer the corner, specifying either
two distances from the corner or a distance and an angle. Then you select the two lines that you want to
chamfer.
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FIGURE 10.27

A site plan.
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The edited site plan.
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FIGURE 10.29

A chamfered corner.

Second chamfer distance

Second line
———
=
Chamfer angle N | First chamfer
| distance
l«— First line

/ To chamfer, choose Home tab = Modify panel => Chamfer/Fillet drop-down list = Chamfer. You cannot

J select objects before the CHAMFER command. The command responds with the (TRIM mode) Current
chamfer Distl =0.0000, Dist2 =0.0000 Select first line or [Undo/Polyline/
Distance/Angle/Trim/mEthod/Multiple] : prompt. The command starts by listing the current set-
tings. (The CHAMFER command remembers the last-used chamfer data.) You can define two distances
from a corner or one distance and an angle:

B To define two distances from the corner, right-click and choose Distance. At the Specify first
chamfer distance <0.0000>: prompt, type the first chamfer distance or press Enter to
accept the default (which is the last distance that you defined). At the Specify second cham-
fer distance <0.0000>: prompt, type the second distance. The default for this is always the
first chamfer distance because equal chamfer distances are so common.

B To define a distance (from the corner) and an angle, right-click and choose Angle. At the
Specify chamfer length on the first line <1.0000>: prompt, enter a distance. This
is the same as the first chamfer distance. At the Specify chamfer angle from the first
line <0.0000>: prompt, type the angle between the first line and the chamfer line.

Now that you have specified the settings that you want, you're ready to chamfer. Your distances or distance
and angle are displayed as you just specified them. The command repeats the Select first line or
[Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple] : prompt. Select the first line. If
you aren’t creating a chamfer with equal distances, the order in which you select the lines is important. The
command trims the first line selected by the first distance, and the second line selected based on either the
second distance or the angle. At the Select second line or shift-select to apply corner:
prompt, select the second line to chamfer the lines.

If the lines already intersect, the command trims them to create a corner. The pick points on intersecting
lines should be on the part of the lines that you want to keep, not on the part of the lines that you want to
trim off.

To quickly create a square corner if you have non-zero settings, press Shift as you select the
i second line. Of course, you can still set each distance to zero.

=1 Choose the Polyline option to chamfer an entire polyline at once. Chapter 16 covers polylines,
4 and Chapter 24 discusses chamfering 3D models.
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By default, CHAMFER trims the original lines that it chamfers. If you want to keep the full original lines
when you add the chamfer line, choose the Trim option and choose No Trim. Use the Multiple option to
continue the prompts and chamfer several corners in one command. The Undo option lets you undo your
last chamfer and try again.

2y The drawing used in the following exercise on chamfering lines, ab10-1 . dwg, is in the
# Drawings folder on the DVD.

STEPS: Chamfering Lines

1. Open abl0-1i.dwg from your DVD.

2. Save the file as ab10-10.dwg in your AutoCAD Bible folder. This drawing is a very small sec-
tion of a “porcupine” mixer, as shown in Figure 10.30.

FIGURE 10.30

A mechanical drawing showing a small section of a “porcupine” mixer.
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/ 3. Choose Home tab &> Modify panel &> Chamfer/Fillet drop-down list > Chamfer. CHAMFER states

J the current mode and distances. At the Select first line or [Undo/Polyline/Distance/
Angle/Trim/mEthod/Multiple] : prompt, pick @), shown in Figure 10.30. At the Select
second line: prompt, pick @. (If the current distances are not zero, press Shift as you pick
@) The command chamfers the two lines to make a corner. (If this doesn’t work, you may have
the Trim option set to No Trim. Change the setting to Trim and try again.)

4. Repeat the CHAMFER command. Follow the prompts:

Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/
Multiple]: Right-click and choose Angle.

Specify chamfer length on the first line <1>: 9/16 J

Specify chamfer angle from the first line <0>: 45 J

5. Atthe Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/
Multiple] : prompt, pick @), shown in Figure 10.30. At the Select second line: prompt,
pick @. The command chamfers the two lines, as shown in Figure 10.31.

6. Save your drawing.
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FIGURE 10.31

The edited drawing after using the CHAMFER command.
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Creating rounded corners

The FILLET command creates rounded corners, replacing part of two lines with an arc. Fillets are often
used in mechanical drawings. In certain cases, you can use FILLET instead of the ARC command to create
arcs. As with CHAMFER, you can fillet lines, xlines, rays, and polylines — they can even be parallel. You
can also fillet circles, arcs, elliptical arcs, and ellipses.

The FILLET command defines the fillet arc by its radius, as shown in Figure 10.32.

FIGURE 10.32

A fillet consisting of two lines and an arc.

- «—Fillet arc
Radlus—yl: 4

Arc center

Like chamfering, filleting is a two-step process. First you define the radius of the fillet arc. Then you select
the two lines that you want to fillet. You cannot select objects before the FILLET command.

To fillet, follow these steps:

responds with the Current settings: Mode = TRIM, Radius = 0.0000 Select first

/"J 1. Choose Home tab =>Modify panel => Chamfer/Fillet drop-down list = Fillet. The command
object or [Undo/Polyline/Radius/Trim/Multiple] : prompt.
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2. Right-click and choose Radius.

3. Atthe Specify fillet radius <0.0000>: prompt, type the radius you want. The default is
either 0.0000 or the last radius that you specified.

4. The command repeats the Select first object or [Undo/Polyline/Radius/Trin/
Multiple] : prompt. Select the first object that you want to fillet.

5. Atthe Select second object or shift-select to apply corner: prompt, select the
second object that you want to fillet. This action creates the fillet.

By default, FILLET trims the original lines that it fillets, but the FILLET command recalls the last setting
you used. If you want to keep the full original lines when you create a fillet, right-click and choose the Trim
option, and then choose No Trim.

"= Choose the Polyline option to fillet an entire polyline at once. Chapter 16 covers polylines, and
& Chapter 24 discusses filleting 3D models.

Filleting with a zero radius gives the same results as chamfering with distances set to zero. (See the previous
section on chamfering.) If your existing settings are non-zero, you can press Shift as you select the second
object to create a square corner.

The order in which you select the two objects to be filleted is not important. However, where you pick the
objects is quite important. If two objects intersect, the command keeps the objects on the same side of the
intersection as your pick point and fillets them. Those parts of the objects on the far side of the intersection
are erased.

When you fillet arcs and lines, if more than one fillet is possible, FILLET connects the endpoints closest to
your pick points. Filleting circles and lines can produce unexpected results. Sometimes you need to experi-
ment to find the proper pick points.

Use the Multiple option to continue the prompts and fillet several corners in one command.

™ The drawing used in the following exercise on filleting objects, ab10-1i . dwg, is in the
i Drawings folder on the DVD.

STEPS: Filleting Objects

1. Open abl0-1i.dwg from your DVD.

2. Save the file as ab10-11.dwg in your AutoCAD Bible folder. This is the same drawing used in
the previous exercise. It is shown in Figure 10.33.

first object or-[Undo/Polyline/Radius/Trim/Multiple] : prompt, right-click and
choose Radius. At the Specify fillet radius <1/2>: prompt, type 5/8 .

J/"J 3. Choose Home tab &> Modify panel => Chamfer/Fillet drop-down list = Fillet. At the Select

4. Atthe Select first object or [Undo/Polyline/Radius/Trim/Multiple] : prompt,
pick the line at @), shown in Figure 10.33. At the Select second object or shift-select
to apply corner: prompt, pick the line at @ to fillet the two lines.

5. Repeat the FILLET command. At the Select first object or [Undo/Polyline/Radius/
Trim/Multiple] : prompt, right-click and choose Radius. At the Enter fillet radius
<5/8>: prompt, type 1/4 .

6. Atthe Select first object or [Undo/Polyline/Radius/Trim/Multiple] : prompt,
right-click and choose Multiple. Pick the line at @), shown in Figure 10.33. At the Select
second object or shift-select to apply corner: prompt, pick the line at @ to fillet
the two lines. The prompts continue. This time pick at @ and @.
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A mechanical drawing showing a small section of a “porcupine” mixer.

If you want, you can connect the two loose lines that the fillets created and create some more
fillets in the drawing.
Save your drawing. It should look like Figure 10.34.

FIGURE 10.34

The filleted drawing.
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Creating a Revision Cloud
You may need to mark areas of your drawings that contain revisions in order to draw attention to these revi-

sions. A common method is to draw a revision cloud around the revised objects. Figure 10.35 shows a draw-
ing with a revision cloud, which is a series of arcs that indicate that an area of the drawing has been revised.

FIGURE 10.35

The revision cloud shows where the drawing has been modified.
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To create a revision cloud, follow these steps:

E E! 1. Choose Home tab = Draw panel (expanded) = Revision Cloud.

2. Atthe Specify start point or [Arc length/Object/Style] <Object>: prompt, you
can choose from three options:

To change the length of the arc, right-click and choose Arc Length. Then specify a new arc
length. For a variable, hand-drawn look, you can specify a minimum arc length and a maxi-
mum arc length that is up to three times the length of the minimum.

To change a closed object into a revision cloud, right-click and choose Object. Then pick a cir-
cle, ellipse, closed polyline, or closed spline. You can choose to reverse the direction of the
revision cloud. The object is converted to a revision cloud, and the command ends.

To choose from two available cloud styles, right-click and choose Style. At the next prompt,
choose either the Normal or Calligraphy option. A calligraphy revision cloud has a variable
line width so that it looks as if you drew it with a calligraphy pen.

3. Click where you want the revision cloud to start. You also see an instruction, Guide
crosshairs along cloud path . . ., which means that you don't have to pick to create
the arcs. You just have to move the crosshairs along the path of the desired cloud.

228



Editing Your Drawing with Advanced Tools m

4. Move the crosshairs counterclockwise to create a circular or elliptical shape. When you approach
the start point, the command ends automatically. (You can end the cloud at any time by pressing

Enter.)

' . If you want, you can pick each arc endpoint to control the size of the arcs. However, if you
S move the crosshairs farther than the arc length, an arc is created automatically. REVCLOUD
multiplies the arc length by the Overall Scale factor (see Chapter 15) to adjust for different scale factors.

Hiding Objects with a Wipeout

A wipeout covers existing objects in order to clear space for some annotation or to indicate that the covered
objects will be changed and should therefore be ignored. A wipeout is a polygonal area with a background
that matches the background of the drawing area. The WIPEOUT command creates a polygon of the same
color as the background of your drawing area.

To create a wipeout, follow these steps:

4 1. Choose Home tab = Draw panel (expanded) = Wipeout.

i:ﬁ 2. Atthe Specify first point or [Frames/Polyline] <Polyline>: prompt, specify the
first point of a shape that will cover existing objects. To use a polyline as the shape, right-click
and choose Polyline. (The polyline can’t contain any arcs when you use it for this purpose.) Then
select the polyline and choose whether or not to erase the polyline.

3. Atthe Specify next point or [Undo] : prompt, if you specified a point, specify the next
point.

4. Atthe Specify next point or [Close/Undo] : prompt, specify another point or use the
Close option to close the wipeout shape. You can also press Enter to end the command and use
the shape that you specified.

By default, the wipeout has a frame around it, using the current layers color. You can hide the frames of all
wipeouts by starting the WIPEOUT command, choosing the Frames option, and then choosing Off.

! You can create a background mask especially for text. This mask covers a rectangle around
your text so that you can read the text more easily. For more information, see Chapter 13.

Double-Clicking to Edit Objects

You can double-click objects to edit them. What happens after you double-click depends on the type of
object. In most cases, double-clicking an object just opens the Quick Properties panel where you can
change the object’s properties. For more information about using the Quick Properties panel and Properties
palette, see the section “Editing with the Quick Properties Panel and the Properties Palette” later in this
chapter.

When you double-click certain types of objects in a drawing, you see a dialog box that is specific to these
objects, or a related editing command starts:

B Attribute definition: Opens the Edit Attribute Definition dialog box (the DDEDIT command).
See Chapter 18 for more information.

B Attribute within a block: Opens the Enhanced Attribute Editor dialog box (the EATTEDIT com-
mand) in AutoCAD and the Edit Attributes dialog box (the ATTEDIT command) in AutoCAD LT.
See Chapter 18 for more information.

229



m Drawing in Two Dimensions

230

B Block: Opens the Edit Block Definition dialog box. You can choose the block from a list and click
OK to enter the Block Editor. See Chapter 18 for more information.

B Hatch: Opens the Hatch Edit dialog box (the HATCHEDIT command). See Chapter 16 for more
information.

B Image: Opens the IMAGEADJUST command. See Chapter 27 for more information.

B Livesection: Starts the LIVESECTION command. See Chapter 24 for more information.

B Mline: Opens the Multilines Edit Tools dialog box (the MLEDIT command). Mlines are not

available in AutoCAD LT, which has a similar feature, called Dlines. See Chapter 16 for more
information.

B Mtext or leader text: Opens the In-Place Text Editor (the MTEDIT command). See Chapter 13
for more information.

B Spline: Starts the SPLINEDIT command.

B Polyline: Starts the PEDIT command.

B Text (TEXT or DTEXT commands): Opens the In-Place Text Editor (the DDEDIT command).
See Chapter 13 for more information.

B Xref: Opens the Reference Edit dialog box (the REFEDIT command) in AutoCAD. In AutoCAD
LT, displays the Properties palette. See Chapter 19 for more information.

f You can customize what happens when you double-click an object. For example, you could
i choose to display the Properties palette instead of the Reference Edit dialog box when you
double click an xref. See Chapter 33 for details.

The DBLCLKEDIT system variable specifies whether double-clicking opens a dialog box in these instances.
To turn off double-clicking to edit objects, choose Menu Browser & Tools &> Options and click the User
Preferences tab. Uncheck the Double Click Editing check box in the Windows Standard Behavior section of
the dialog box.

Grips

Grips offer a way to edit objects without choosing commands. By using grips, you can quickly stretch,
move, rotate, scale, copy, and mirror objects.

When you select an object without first choosing a command, the object appears highlighted with

grips — small boxes at preset object snap points. (If you don't see grips, they may be turned off. See the
“Customizing grips” section later in this chapter to find out how to turn them back on.) You can continue to
select more objects in this way.

You then click to activate a grip and use the grip to manipulate the object. When the grip is activated, it
turns red (by default). An activated grip is also called a hot grip, as shown in Figure 10.36. In some cases,
you activate more than one grip at a time. To activate more than one grip, hold down Shift and then click
the grips. If you activate a grip in error, click it again to deactivate it. Grips are so called because you can
“hold on to” the object by dragging the grips with the mouse.

After you activate a grip, right-click with the mouse to open the Grip shortcut menu, which lists all the grip
options.
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FIGURE 10.36

Moving a line. Grips appear at preset object snaps. You use the hot grip to manipulate an object.
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You can also press the Spacebar or Enter to cycle through five possible commands on the command line. As
long as you're familiar with the STRETCH, MOVE, ROTATE, SCALE, and MIRROR commands, you can
easily learn how to accomplish the same edits by using grips because the prompts are so similar. After you
complete the edit, the object remains highlighted and the grips remain so that you can further edit the
object. If you want to edit another object, press Esc once to remove the grips. Then select another object or
objects or choose another command.

If you use Dynamic Input, you can customize how many and which tooltips appear when you
=ANESSE grip edit. Right-click the Dynamic Input button on the status bar and choose Settings to open
the Draftmg Settings dialog box with the Dynamic Input tab on top (I explain this dialog box in Chapter 4).

Click the Settings button in the Dimension Input section to open the Dimension Input Settings dialog box.
The settings here apply to grip editing. By default, the Show Two Dimension Input Fields at a Time option is
selected. Although this setting usually works well, you can go down to one input field or specify additional
fields. When you select multiple grips to edit an object, no Dynamic Input field appears.

Stretching with grips

Stretching with grips involves understanding how the grip points relate to the object. For example, you can-
not stretch a line from its midpoint — if you think about it, there’s no way to define in which direction to
stretch the line. Also, you cannot stretch a circle, you can only scale it. Aside from these types of limitations,
anything goes.
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Stretching one line

You can stretch one line. The result is similar to using the CHANGE command to change a line’s endpoint.
To stretch a line, select it, and click the grip at the endpoint that you want to stretch. The prompt on the
command line responds with

**% STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]:

STRETCH is the first grip-editing command on the command line. Simply specify the new endpoint for the
line, using any method of specifying a coordinate, to stretch the line. The other options work as follows:

B Base point lets you define a base point— other than the activated grip— and a second point.
Right-click to open the Grip shortcut menu and choose Base Point. The option displays the
Specify base point: prompt. Define a base point. Again you see the original Specify
stretch point or [Base point/Copy/Undo/eXit]: prompt. Define the second stretch
point to stretch the line.

W Copy puts you in Multiple mode. Right-click to open the Grip shortcut menu and choose Copy.
Again you see the original Specify stretch point or [Base point/Copy/Undo/eXit]:
prompt. Specify a new point to keep the original line, and create a new line stretched to the new
point. You can continue to create new stretched lines.

B Undo undoes the last edit. Right-click to open the Grip shortcut menu and choose Undo.

B eXit returns you to the Command prompt. Right-click to open the Grip shortcut menu and
choose Exit. Esc also returns you to the Command prompt.

Stretching multiple lines
Stretching more than one line at a time is similar to the most common use of the STRETCH command.
However, it can also be somewhat confusing.

As explained earlier in this chapter, when you use the STRETCH command, objects that cross the crossing
window are stretched, while objects entirely within the crossing window are moved. When you stretch mul-
tiple lines, you should activate endpoint grips to stretch lines, and activate midpoint grips to move lines.
Picking all those grips accurately can be difficult and time-consuming. Also, small objects that are close
together create a lot of overlapping grips that are hard to select. For this reason, stretching multiple lines
works best with simple models.

To stretch multiple lines, follow these steps:
1. Choose the objects that you want to stretch. The objects are highlighted and display grips. You
can use any method of choosing objects — you are not limited to crossing windows.

2. Hold down Shift and pick each grip that you want to stretch. If there are internal objects that you
want to move with the stretch, select their grips, too; these include the midpoints of the lines and
arcs, and the centers of the circles.

3. Release Shift and pick a grip to use as a base point. You see the prompt:

**% STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]:

4. Specify a new stretch point. You can also use any of the other options.

At the end of this section on grips, you have the opportunity to try them out in an exercise.
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Moving with grips
It’s easy to move objects with grips. First, choose all the objects that you want to move. Then click any grip
to activate it. This becomes the base point. Right-click to open the Grip shortcut menu and choose Move.

I You can also press the Spacebar to cycle through the grip editing modes. For example, to move
an object, press the Spacebar once.

After you choose Move Editing mode, you see the prompt:

* % MOVE * %
Specify move point or [Base point/Copy/Undo/eXit]:

Use any method to specify the second point. Be sure to use @ if you're typing in relative coordinates. The
selected objects move. The other options work as follows:

B Base point lets you define a base point other than the activated grip. Right-click to open the Grip
shortcut menu and choose Base Point. You see the Specify base point: prompt. Define a
base point. The original Specify move point or [Base point/Copy/Undo/eXit]:
prompt returns. Define the second move point to move the objects.

B Copy puts you in Multiple mode and lets you copy objects. Right-click to open the Grip shortcut
menu and choose Copy (or type ¢ J_). You see the original Specify move point or [Base
point/Copy/Undo/eXit] : prompt. Specify a new point to keep the original object and create
a new object where you specify. You can continue to create new objects.

B Undo undoes the last edit. Right-click to open the Grip shortcut menu and choose Undo.

B eXit returns you to the Command prompt. Right-click to open the Grip shortcut menu and
choose Exit. Esc also returns you to the Command prompt.

Rotating with grips

Rotating with grips is very similar to using the ROTATE command. First, choose all the objects that you
want to rotate. Then click any grip to activate it. This becomes the base point. Right-click to open the Grip
shortcut menu and choose Rotate. You see the prompt:

** ROTATE **
Specify rotation angle or [Base point/Copy/Undo/Reference/eXit]:

Type in a rotation angle or pick a point to rotate the objects. The other options work as follows:

B Base point lets you define a base point other than the activated grip. Right-click to open the Grip
shortcut menu and choose Base Point. You see the Specify base point: prompt. Define a
base point. The original Specify rotation angle or [Base point/Copy/Undo/
Reference/eXit] : prompt returns. Specify the rotation angle to rotate the objects.

B Copy puts you in Multiple mode and lets you copy objects. Right-click to open the Grip shortcut
menu and choose Copy. Again, you see the original Specify rotation angle or [Base
point/Copy/Undo/Reference/eXit] : prompt. Specify a rotation angle to keep the original
object and create a new rotated object where you specified. You can continue to create new
objects.

B Undo undoes the last edit. Right-click to open the Grip shortcut menu and choose Undo.
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B Reference lets you specify both a reference angle and a new angle. Right-click to open the Grip
shortcut menu and choose Reference. You see the Specify a Reference angle <0>: prompt.
Type an angle or pick two points to specify an angle. The Specify new angle or [Base
point/Copy/Undo/Reference/eXit] : prompt appears. Type an angle or pick a point.

This works like the Reference option for the ROTATE command. (See Chapter 9.)

B eXit returns you to the Command prompt. Right-click to open the Grip shortcut menu and
choose Exit. Esc also returns you to the Command prompt.

Scaling with grips

Scaling with grips is very similar to using the SCALE command. First, choose all the objects that you want
to scale. Then click any grip to activate it. This becomes the base point. Right-click to open the Grip short-
cut menu and choose Scale. You see the prompt:

** SCALE **
Specify scale factor or [Base point/Copy/Undo/Reference/eXit]:

Type a scale factor to scale the objects. The other options work as follows:

B Base point lets you define a base point other than the activated grip. Right-click to open the Grip
shortcut menu and choose Base Point. You see the Specify base point: prompt. Define a
base point. The original Specify scale factor or [Base point/Copy/Undo/
Reference/eXit]: prompt appears. Define the scale factor to scale the objects.

W Copy puts you in Multiple mode and lets you copy objects. Right-click to open the Grip shortcut
menu and choose Copy. You see the original Specify scale factor or [Base point/
Copy/Undo/Reference/eXit] : prompt. Specify a scale factor to keep the original object
and create a new scaled object. You can continue to create new scaled objects.

B Undo undoes the last edit. Right-click to open the Grip shortcut menu and choose Undo.

B Reference lets you specify a reference length and a new scale. Right-click to open the Grip short-
cut menu and choose Reference. You see the Specify reference length <1>: prompt. Type
a length or pick two points to specify a length. You see the Specify new length or [Base
point/Copy/Undo/Reference/eXit] : prompt. Type a length or pick a point. This works
like the Reference option for the SCALE command. (See Chapter 9.)

W eXit returns you to the Command prompt. Right-click to open the Grip shortcut menu and
choose Exit. Esc also returns you to the Command prompt.

Mirroring with grips

Mirroring with grips is similar to using the MIRROR command. First, choose all the objects that you want
to mirror. Then click any grip to activate it. This becomes the first point of the mirror line. Right-click to
open the Grip shortcut menu. Choose Mirror. You see the prompt:

** MIRROR **
Specify second point or [Base point/Copy/Undo/eXit]:

Specify the second point of the mirror line to mirror the objects.

By default, AutoCAD and AutoCAD LT erase the original objects. To keep the original objects,
you must use the Copy option. This feature is the opposite of the MIRROR command, where
the default is to keep the original objects.
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The other options work as follows:

W Base point lets you define a base point other than the activated grip, as well as a second point.
Right-click to open the Grip shortcut menu and choose Base Point. You see the Specify base
point: prompt. Define a base point— that is, the first point of the mirror line. The original
Specify second point or [Base point/Copy/Undo/eXit] : prompt appears. Define the
second point of the mirror line to mirror the objects.

B Copy puts you in Multiple mode and lets you keep the original objects. Right-click to open the
Grip shortcut menu and choose Copy. You see the original Specify second point or [Base
point/Copy /Undo/eXit]: prompt. Specify the second point to keep the original objects and
create new mirrored objects. You can continue to create new mirrored objects.

B  Undo undoes the last edit. Right-click to open the Grip shortcut menu and choose Undo.
B eXit returns you to the Command prompt. Right-click to open the Grip shortcut menu and
choose Exit. Esc also returns you to the Command prompt.

DVD: The drawing used in the following exercise on editing with grips, ab10-7 . dwg, is in the
- ;.nté Drawings folder on the DVD.

STEPS: Editing with Grips

1. Open abl0-7.dwg from the DVD.

2. Save the file as ab10-12 . dwg in your AutoCAD Bible folder. This is a small section of a drive
block, seen from above, as shown in Figure 10.37. Make sure that Ortho mode and Object Snap
mode are on.

3. Use a selection window to select the entire model. Now hold down Shift and place a selection
window around the small circles and rectangle at the center of the model to deselect them.

4. Pick the grip at @), shown in Figure 10.37, to activate it. You see the following prompt:

** STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]:

5. Right-click and choose Mirror from the shortcut menu. You see the following prompt:

** MIRROR **
Specify second point or [Base point/Copy/Undo/eXit]:

6. Right-click and choose Copy so that the original objects that you mirror are not deleted.

At the Specify second point or [Base point/Copy/Undo/eXit]: prompt, move the
cursor to the right. You can see the mirror image of the model. Pick any point to the right (in the
0-degree direction) of the activated grip.

8. Right-click and choose Exit to return to the command line. The original objects are still
highlighted.

9. Use a large selection window to select all the new objects, including the small rectangle and cir-
cles in the middle. Everything (old and new) should be highlighted and display grips.

10. Pick the grip at @), shown in Figure 10.37, to activate it. Right-click and choose Rotate from
the shortcut menu. At the Specify rotation angle or [Base point/Copy/Undo/
Reference/eXit] : prompt, type 90 . This action rotates the model.

11.  Pick the bottom-right grip to activate it. Right-click and choose Scale from the shortcut menu. At

the Specify scale factor or [Base point/Copy/Undo/Reference/exXit] : prompt,
type .5 . This action scales the model.
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12.

13.

14.

15.

FIGURE 10.37

This small section of a drive block, seen from above, can be edited with grips.

|

Pick the grip at the midpoint of the bottom line. Right-click and choose Move from the shortcut
menu. At the Specify move point or [Base point/Copy/Undo/eXit] : prompt, type
0,-3 . The model should look like Figure 10.38.

FIGURE 10.38

The drive block section, after several grip edits, looks a little like a cookie jar.

[ ]

Press Esc to remove all grips. Define a crossing window by picking first at @), and then at @ (see
Figure 10.38).

Hold down Shift and pick all the grips along the bottom three lines. Release Shift and pick the
grip at the middle of the bottom line. At the Specify stretch point or [Base point/
Copy/Undo/eXit] : prompt, type 0,1 ! to shrink the model.

If the stretch does not come out right (it might be hard to see and activate all the grips), choose
Undo from the Standard toolbar to undo the stretch and try again.

Save your drawing.

Customizing grips

You can turn grips on and off and customize their size and color. Choose Menu Browser = Tools & Options
and click the Selection tab to open the dialog box shown in Figure 10.39.
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FIGURE 10.39

Use the Selection tab of the Options dialog box to customize grips.
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By default, grips are enabled. Also by default, grips are turned off for blocks. (Chapter 18 covers blocks.)
When grips are off for blocks, you see only one grip when you select a block; this is its insertion point.
When grips for blocks are on, you see all the grips you would normally see for objects.

In the Grips section, you can choose the colors that you want for unselected and selected (hot) grips. Click
the drop-down lists to choose a color.

The Grip Size section lets you drag the slider bar to set the size of the grips. Click OK after you have made
the desired changes.

Editing with the Quick Properties
Panel and the Properties Palette

The Quick Properties panel and Properties palette are windows that show the properties of a selected object
and allow you to change those properties by entering or choosing new values. The Quick Properties panel is
small and is useful for simple, quick changes; it is also highly customizable. The Properties palette offers
more options for each object.

Using the Quick Properties panel

By default, when you select an object, the Quick Properties panel appears, displaying some basic properties
of the object, such as its layer, color, and linetype. Other properties that appear depend on the type of
object. For example, you see the length of a line, as shown in Figure 10.40. To change an object’s proper-
ties, enter or choose a new value in the Quick Properties panel. If you select more than one object, you see
properties that apply to all the selected objects.
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FIGURE 10.40

The Quick Properties panel shows you an object’s properties in a small space and allows you to change those

properties.
e ®
Colur W ByLayer
[ Layor i
Linetype ByLayer

= The Quick Properties panel is new for AutoCAD and AutoCAD LT 2009. It’s a small version of
i the Properties palette and appears automatically when you select an object.

Right-click any blank area on the panel for further configuration:

B Close: Closes the panel.

B Customize: Opens the Customize User Interface dialog box, where you can define which objects
open the panel and which properties appear. For more information, see Chapter 33.

B Settings: Opens the Quick Properties tab of the Drafting Settings dialog box, shown in Figure
10.41, where you can control the functioning of the panel in one location. You can also set the
default height of the panel to display more or fewer properties.

B Location Mode: Choose Cursor or Float. By default, the panel displays at the cursor. Choose
Float to display the panel in the drawing area, wherever you drag it. These options control the
QPLOCATION system variable.

B Auto-Collapse: By default, the panel is small and you usually need to expand it to see all
the properties. You can uncheck this option to display the panel big enough to show all the
properties.

Click the Quick Properties button on the status bar to turn the Quick Properties panel on
and off.

The rollover tooltip is a smaller version of the Quick Properties panel that appears when you hover your
cursor over an object, without selecting it. You can't change properties in the rollover tooltip; they’re just for
your information. You can customize which properties appear, and synchronize the tooltip, with the Quick
Properties panel; see Chapter 33 for more information.

Using the Properties palette

The Properties palette displays an extended list of the properties of selected objects. You can also use the
Properties palette to change the properties of objects.

;2 To open the Properties palette, click View tab = Palettes panel = Properties, or press Ctrl+1. The Properties

palette, shown in Figure 10.42, opens on your screen.
Properties
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You can configure the Quick Properties panel from the Drafting Settings dialog box.
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FIGURE 10.42

Use the Properties palette to edit objects and their properties.
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The auto-hide feature of the Properties palette makes it easy to work with the palette open all the time.
Whenever the cursor moves off the palette, it collapses to just display the title bar. To auto-hide the palette,
right-click the title bar and choose Auto-hide. You can also dock it; choose Anchor Left or Anchor Right
from the title bar’s shortcut menu. The Allow Docking item should also be checked; if it isn't, choose it from
the same shortcut menu.

I The Properties palette has its own undo function. Right-click the palette (but not on the item

B ‘ A !
: .:}f.-lix\:."'\. SESSEE that you changed) in the Properties palette and choose Und